GETTING STARTED. MHOGA 4.0.

Updated Dec. 21, 2024

Several example projects are shown to illustrate how MHOGA works. You can find more
information in the User's Manual (https://ihoga.unizar.es/en/descarga/)

This guide is designed to follow sequentially.

Sections 41 and 42 could be done regardless the previous sections.
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BEFORE STARTING TO WORK:

MHOGA needs to run:

- Internet connection to check the license validity (and to import irradiation, temperature and

wind speed data).

- A printer (physical or virtual) installed in the computer. This is necessary to print the reports.

You can install a virtual pdf printer, for example the free doPDF (http://www.dopdf.com/es/)

Virtual machines:

MHOGA software does not run under virtual machines or hypervisors. Even if you do not use it,
virtualization is enabled by default in many new computers BIOS.

Deactivate virtual machines or hypervisors if, after installing, when you open the software you
obtain the following message "Failed to start the trial: The function failed because this instance
of your program is running inside a viertual machine / hypervisor and you've prevented the
function from running inside a VM." (it can happen due to the default virtualization activation
in the computer BIOS, in this case you must disable it in BIOS, see the last page of the following
document):

How to deactivate virtual machine / hypervisor



http://www.dopdf.com/es/
http://ihoga.unizar.es/Desc/DEACTIVATE%20VIRTUAL%20MACHINE.pdf

Screen settings:
In Windows, select Settings > System > Display > Scale and layout (in your language).

Usually the optimal display resolution is the recommended value, but in some cases the software
visualization improves with other values. Also, in the field “Change the size of text, apps, and
other items” usually it is better to use 125% or even higher. We recommend using at least 125
percent scaling on 1080p display resolutions and higher to make it easier on your eyes, but find
the scaling that works best for you.

Depending on these settings, the visualization of the software will be better or worse.
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1. Create a new project.

In the top menu, click Project->New.

The first time we create a project, MHOGA asks us if we want to change the default currency
(which is EURO).

Confirm *

f ™ 1 Do you want to use as default currency in IHOGA a currency different from EURO (€)7
- If you want a default currency different from EURO (£), press 'OK'

- If you want to keep EURO (€) as default currency, press 'Cancel’

Cancel

This starting guide is prepared with the EURO currency, so we set the EURO as the default
currency, by clicking “Cancel”. However, if you prefer another currency you can click on "OK"
and change the default currency to another by following the steps on section 3 of the user
manual (https://ihoga.unizar.es/en/descarga/). In that case the economic results that will

appear later in this guide (in €) will be different from yours (in another currency).

After selecting the default currency, a window appears where we must indicate the location of
the project and its name. MHOGA projects are files with extension .mho.

The full path from the root directory to the file .mho that will be created

should not contain more than 60 characters, otherwise an error may occur.

Al Create new project X
Guardaren: | , DATOS (D) ~] = E@-
E} Nombre Fecha de modifica... Tipo  *
|8m.mh 26/05/2021 12:39 Arch
Acceso rapido J mmne § e !V
| 7mumho 26/05/2021 710 Archiv
[ “J6m.mheo 26/05/2021708  Archiv
Escriorio ] 5m.mho 26/05/2021 7:05 Archiv
| 3m.mho 26/05/2021 7:02 Archiv
[ | | 4m.mho 26/05,/2021 T:02 Archiv
Bibliotecas _]10-5G170-6.0.mho 26/05/2021 7:02 Archiv
|\-] | 2M.mho 26/05/2021 6:55 Archiv
| 1M.mho 26/05/2021 €45 Archiv
Este equipo ] 1.mho 26/05/2021 5:52 Archiv
|\]$ _| solidera2.mho 25/05/202113:13 Archiv
R"ed | 1.mho 23/05/2021 9:29 Archiv
12.mho 21/05/2021 16:31 Archiv ¥
< >
Nombre: | ~| | Guardar
Tipa: [MHOGA project (*mho) | Cancelar

In our case we create it directly in the root directory (or in the folder where you want provided
the full path should not be longer than 60 characters) and call it “MHOGA1.mho”, then clicking
on “Save”.

Note that, in some computers, writing in C: needs administrator permission. If MHOGA reports
an error related to writing access, you should close the software, open it again, create the
project again and save it in another root (D:, E:...).


https://ihoga.unizar.es/en/descarga/

You can check that the file MHOGA1.mho will be created in the folder selected, and a folder with
the same name (MHOGAZ1) will also be created. If, later, after closing the project, you want to
move or copy your project to another folder or share it with another person, you must move /
copy / share the .mho file and also the folder with the same name (in this case, you must move /
copy / share MHOGA1.mho file and MHOGAI1 folder).

We can choose general options of the project (upper menu Project-> OPTIONS):

W Project: DMHOGAT.mho

Project Data Calculate Data
O Mew
& Open
G Save Ctrl+5
E Save as

Save as Default Project

OPTIONS

Restore Original Tables
Create Tables backup
Restore backed up Tables
Restore Default Currency

Fl Exit

A window appears, where:

In the Simulation and optimization selection, we can select that the simulation is just for one
year (extrapolating the results of that year, by default) or multiperiod, simulating the whole
lifetime of the system (by default 25 years). We leave the default value.

MAIN OPTIONS:

Sirmulation and optirmization:

(@ Simulation of the 1styear and extrapolate results

Multiperiod: simulate all the years of the system lifetime 25 ears
i ¥ b !

Economic optimization:

Min. MPC
Wdin. LCOH
Min. Payhack period

() Minimize MNet Present Cost [MFC), usually for off-grid systems and high load on-grid >

(@) Maximize Net Present Value (NPY), usually for low load or no-load on-grid systems

(@ M NPY
() Min. LCOE

[] Dafine wWind Farm with 16 power curves, one for each wind direction sector (I Min. LCOH

D DC renewable include own charger and controller O sz (CERIF. i (LI
(O Max IRR

[(J'when saving the project update all the results ofthe table 1o the present conditions (I Min. Payhack perind

[inthe simulation window, shew the probability density function (PDF) of the: main results

[]t#hen clickin 2 companent in a table, update the companent with the values of the database
Mumber of decimal places in results of costs 3 v

MNumber of decimal places in results of energy 3 ™

0].9

In the Economic optimization selection, we can choose between minimizing the net present
cost (NPC) of the system (for off-grid systems of grid-connected systems with load consumption)
or maximizing the net present value (NPV) of the system (for grid-connected power generators
without load or with low load, as default).



We leave the default value. For maximizing NPV projects, we can choose between maximizing
NPV (default) or minimizing LCOE or optimizing other variables (LCOH, IRR...) we leave the

default value.
We click OK.

The default project is a Photovoltaic-Battery grid-connected power generating system, without
any load consumption. However, later we can change any of the data that appears by default.
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2. Type of system.

By default, the system to be optimized would be the grid-connected PV generator with batteries,

evaluating different combinations of systems.

We are going to assume that we are also interested in testing combinations with wind turbines,
that is, that the system can be PV-wind-batteries.

In the main screen, in the default tab (GENERAL DATA), we click "Wind turbines", this way the
system will also consider them.

GENERAL DATA | oPTIMIZATION | CO

COMPONENTS
¥ PV Gen.

Hydro T.

E
i3

Battery bank
Backup Gen.

Inverter/cha

< T

-

H2 [F.C. - Elyzer. ]



In the group of buttons on the left, the buttons "WIND" and "WIND TURB." are enabled, showing
the "!" symbol indicating that data must be entered for wind speed and wind turbines.
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3. DC and AC nominal voltages.

In the main screen, under the components buttons (central left zone), the nominal DC and AC
bus voltages of the system are defined. DC bus voltage will be the voltage of the battery bank.
Let's use the ones that appear by default.

DC %alkage |1 kv [ S0Cd
ACWolage |20 kv

If the check box "SOC d." is marked, the DC voltage will vary depending on the state of charge
(SOC) of the lead-acid batteries, situation more similar to the real one than if we consider DC
voltage is fixed (without marking that checkbox). However, as we will use Li-ion batteries, we
will leave this check box unchecked.

4. Load data and options to purchase / sell electricity to the AC grid.

By clicking on the "LOAD / AC GRID" button, we can modify the load data (electrical demand AC
and/or DC, hydrogen loads for external consumption or water consumption pumped from a river
or a well to a water storage tank or reservoir) and the data of purchasing and selling electrical
energy to the AC grid or selling surplus hydrogen.

1l Project: DAMHOGAL.mho

Project Data Calculate DataBase Re

" LOAD /AC GRID | GEME
RESOURCES COk
o soR | "

! WIND |

e

Into the window of the LOAD / AC GRID, “AC LOAD” tab is selected by default.



By default, the load profile “Zero” is selected, this means no load consumption in our system.
The default tab shown is the AC LOAD (MW), we see this load is O for all the hours of the different
months. If we click in the different tabs of DC LOAD, H2 LOAD and WATER, we see there is no
load (in the WATER tab the daily water consumption in dam3/day is O for all the months).
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At the bottom of the screen it is shown the average daily total load, which is now 0 GWh/day.
We could use a different load profile (selecting it where now is “Zero” selected).

For each type of load, we could introduce the data by importing from a table file with the hourly
load profile of each month. We could also import from a file with the data of the whole year in
hourly or in lower time steps (see the user manual for details).

However, in this case we will suppose there is no load and we will not add any load.

To see the options of purchasing and selling electricity to the AC grid, click on the last tab
("PURCHASE / SELL E").
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By default, the purchase from AC grid is not allowed (the box "Purchase from AC grid Unmet
Load ..." is unchecked) therefore our system won’t import any power from the AC grid. We don’t
need it as there is no load, however, in projects with load consumption you should check that
box so that the system could import power from the AC grid.

By default, injecting (selling) electricity to the AC grid is allowed (the box "Sell Excess Energy to
AC grid” is checked). There is a fixed default price for the electricity sold to the AC grid (0.12
€/kWh), with a 3% annual inflation and a maximum power for the grid-connection of 30 MW. By
default, no energy generation charge (transfer charge) is applied (it is fixed at 0 €/kWh) (in some
countries, for generating systems a generation charge is applied for each kWh it injects into the
AC grid, but we won’t consider this). Also no net metering policy is applied and no taxes area
applied.

In all MHOGA data boxes, the decimal spacing must be entered as defined in the Windows

environment. The computer with which this quide was made has in Windows the decimal

spacing as the dot (".") so for example the fixed sell price is “0.12” €/kWh; if your computer

uses comma as decimal spacing, you will see “0,12” in that box.

5. Hourly price and other options for the electricity sold to the AC grid.

We can change these values related to the electricity sold to the AC grid.

Now let’s suppose that the electricity sell price is hourly (real time pricing tariff) and it has high
differences between the minimum and maximum hourly price of each day. This hypothetical
hourly price file can be downloaded here:

http://ihoga.unizar.es/Desc/Hypothetical hourly pirce.zip

Download and unzip, you will get “Hypothetical_hourly_pirce.txt” file.

In the LOAD / AC GRID window, PURCHASE / SELL E tab, uncheck “Fixed Sell Price” and click in
“Hourly Price” button.


http://ihoga.unizar.es/Desc/Hypothetical_hourly_pirce.zip
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When clicking in “Hourly Price” button, a small window appears, where you can import the
downloaded hourly file. Click in “From file (8760 hourly values)” and click in the button “Import
hourly file” and import the “Hypothetical_hourly_pirce.txt” file you downloaded.

When MHOGA imports a file, the decimal spacing of the values of the file must ALWAYS BE DOT

(.). If you open the downloaded file, you will see the dot as the decimal spacing. Even if your

computer uses comma as decimal spacing, in the files that MHOGA will import the DECIMAL

SPACING MUST BE DOT {(.).

HOURLY PRICE OF THE ELECTRICITY SOLD TO AC GRID
Hourly Prica Data (E/kWh)
(OHourly, all days the same

From file (6760 hourly valugs)

Graph D.masemin
Import haurly Price ] b5 Grap B
I Houy Penads

{=FDF | E=POFDmm

oK

After importing the file, you can click in the button “Graph” and see the hourly sell price:
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V' Graph - [m] x

Price of the electricity SOLD to AC grid

Price per kWh

0 1 2 3 4 5 6 7 8 9 10 11 12 13 W 15 16 17 18 19 20 21 2 23 0
1 January

< >
Sell price: Average 0.06 £/kWh; Max: 0,323 £Ah: Min: 0.001 £kWWh [Horizantal Grid ]k []Vertical Grid _Days display

Scroll change (days)> small: large:

3 Back

In all the graphs, you can zoom in the graph (draw a window with your mouse over the area to
be enlarged: click from top left to bottom right); later you can undo the zoom (click and drag
from bottom right to top left).

We can see that average hourly price is 0.06 €/kWh, its maximum is 0.329 and its minimum
0.001 €/kWh.

Click “Back”.

With the button “PDF” it shows the probability density function (PDF) of the price, showing also
(below the graph) the mean and standard deviation (and, with these values, it shows in green
the Gaussian curve). Next figure shows an example, where most of the time price is near 0, and
also there is a lot of hours with price around 0.06 €/kWh; the Gaussian curve does not fit well in
this case (that is, the original data does not follow a Gaussian normal PDF).

¥ M Data W= Gaussian

30
25

20

Probability Density Function
o

0 0.05 0.1 0.15 0.2 0.25 0.3
Purchase pirce

Purchase pirce -» Mean: 0.0598; Std. desw: 0.056 £/wh

QK

Click “OK”.
With the button “D.max-min” it shows, for each day, the difference between the maximum price
and the minimum price of that day. This graph is interesting to see the daily price difference

(max.-min.), important for arbitrage energy cases (for example, charging batteries at low price
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hours and discharging during hours at high price hours). Showing 365 days display, se can see
many days, in this example of prices, the difference is higher than 0.2 €/kWh, which could make

profitable (in some cases) the energy arbitrage:
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A8 U2 1502 13 153 14 154 U5 1S5 U6 156 U7 157 U8 1S/ U9 15/ 1410 1510 11115111 112 1512
January-December

< > |364
Daly max-tnin. clifl. of Purchase price: Average 0.181 £/kWh: Mao: 03219 £kWWh: Min: 0.0293 £kAh [Herizontal Grid []At [ ]vertical Grid _Days display

Soroll chenge (dayey small [} lorges
With the button “PDF Dm-m” it shows the probability density function (PDF) of the previous
graph (values of difference between the maximum price and the minimum price of that day),
showing also the mean and standard deviation (and, with these values, it shows in green the
Gaussian curve). In next figure we can see that, in this case, the most of the values (difference
between max. and min. price for each day) is around 0.18 €/kWh, and the PDF curve is not very

different from a Gaussian PDF curve.

|I7. Data W= Gaussian

- =
= =

Probability Density Function

L R R S = R = - I 1=

0 0.05 01 0.15 0.2 0.25 0.3
Purchase pirce: Daily max.-min. difference

Purchase pirce: Daily masx-min. difference -» Mean: 0.181; Std. dew: 0.0485 £/kWh

OK

Click “OK” to return to the options of selling electricity to the AC grid.

Let’s suppose that the annual inflation price of the electricity sold to the AC grid is 2%, we change
it. Also, the maximum power to be injected to the grid (the limit of the injecting point) is 23 MW.
We leave the taxes in 0%, therefore we suppose the hourly price we introduced includes taxes.
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] Sell Excess Energy to AC grid
q¥ g

[] Fixed Sell Price (E/k\Wh) 0.1z Hourly Frice

[ Pr.sell=pr.buyx |1
[ Annual Inflation (%) |2 ]
e Power(hv) -h =Proax buy

Energy Generation Charge (Transfer Charge) Price (£/kYvh

Fixed Transfer price (£/kWh) D Hourly Price

SelFconsumption and Mat Matterin Sellonty

|ND net mettering v|

Cost of net metering service [£/kWh) D
Buy-back: Expont E is paid at (£/kWh)

Total tax for electricity sold (#4) D Los

Now we have defined everything we need of LOAD / AC GRID, so we can return to the main
screen of the software by clicking in “OK” button (left bottom corner).

Remember to save the project periodically (in the main screen, upper menu Project-> Save):

1 Project: DAMHOGA1 mho

Project Data Calculate Data Bi

O New
& Open
o ST —

ﬂ Save as
Save as Default Project

OPTIONS

Restore Original Tables
Create Tables backup
Restore backed up Tables
Restore Default Currency

q&\t

6. Grid-connected battery management.

In the main screen, CONTROL STRATEGIES tab, we can set the options for the control strategies.
The left part of this tab (global strategy and variables to optimize relative to the global strategy)
is only used when there is consumption load: the control strategy selects which component must
supply the load when the renewable sources cannot do it, etc. This has no sense in the cases
without load consumption, therefore in our case we will not consider anything of this.

In the right part of this tab we can set the energy arbitrage (management of the grid-connected
batteries), as we have in our project batteries and grid connection.

We can set the conditions so that the batteries will be charged by the AC grid and the conditions
to discharge them, in terms of electricity price. As the checkbox “(Compare with Sell price)” is
checked (by default), the electricity price to be considered in the control strategy is the sell price,
and this also implies that batteries will never be charged from the grid (they will be charged just

from the renewable sources), even if the purchasing electricity price from the grid was lower
than the limit.
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GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

CONTROL STRATEGY AND WARIABLES TO OFTIMIZE

ENERGY ARBITRAGE: System with batteries and grid connected
Global strategy:

(@ Load Following Batt. charged by the AC grid /¥ discharged if (alsa for Elyzer-> H2) [[]Elyzer. full lnad
() Cycle Charging  [+] Continue up to S0C stp Frice E<= Dﬁfk\f\f'h i Price E>= €#kWh 0% [v]iCompare with Sell price;
{:} Try Both |:| Optimize strategy of grid-conneted batteries:

Yariables to optimize relative to the global strategy:

Frin_gen Frin_FC H2TAMEstn
F1_gen F1_FC Fz
DSO_Cg SO_C o DSOC [Batteries can inject electricity to the AC grid ]
stp_gen sip_| min 1 day atlow SOC -> charge battany with AC gricl Brateri ilabil
Feritical_gen Poritical_FC Flirm_charge CliSiEs ety

[]when hatteries are of,. compensate autodisch

[Js0Cmeax | Fixvariakbles Wariahles accuracy: =100%

If S0OCmin reached, disch. not allowed if SOC(%) < SOCmin(%) + EI

By default:

e The batteries never charge from the grid (“(Compare with Sell E)” is selected) and they
will never be charged from the renewable sources (they would be charged when sell
price E <= 0 €/kWh, that is, never); however, they will be charged from the renewable
sources when the renewable power is higher than the maximum power that can be
injected to the AC grid (defined in previous section, 23 MW) with the surplus power.

e Batteries are discharged, injecting electricity to the grid (“Batteries can inject electricity
to the AC grid” is selected) when the price of the electricity sold to the grid is higher than
0.11 €/kWh.

Therefore, energy arbitrage will be: the batteries will only be charged with the power from the
renewable sources that cannot be injected to the grid, if it is higher than 23 MW (the maximum
power allowed to inject to the grid), and the batteries will inject their energy to the grid when
the sell price is higher than 0.11 €/kWh.

7. Irradiation data.

In the main screen, by clicking on the "SOLAR" button we can modify the solar resource data.

W Project: DAMHOGAT.mho

Project Data Calculate Datal

RESOURCES
« SOLAR

The following screen appears:
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) SOLAR RESOURCE

Get data from local DB #1: PV panels slope () - P panels Azimuth () El

Download hourly data.

Latitude (%) (+M, -5)
Longitude (%) (+E. ) : n
PV gen. #1: Ground Reflectance: D
| 1Al .
Locate on map | Lpdate coord. Download NASA manthly data [V]Fixed albedo L[R! Gr.

Optimal Slope#] [ optimize Pv#1 panels slope during the optimization of the system
Data source for Global irradiation

Steps
@ Monthly Average O Import from File Hour (kKWhmz) Hariz Tilt
[ Generation of P gen. (M) normalized to 1 M 1~ | Minutes- each hourin 1 row (il in kiidm2) I
{equivalentto irradiance kifme x PR) Minutes- 1 per row (tilt surf. in kiW/mz) mpor
Diata Source for Manthly Average Daily Iradistion: | Radiation Horizontal Surface (KWhim2)  ~ Calculation Method far Hourly Iradiation
e LT P Tracking System: Mo Tracking w~ OLiu & Jardan OFErs etal

aw horiz.s.  awtilts
315 kiwh/m? Factor Fl) for the back albedo (@ Collares-Feraira & Rabl () Graham

anuery {bifacial modules) (Durusoy 2020): 033
Februray 457 kiWhim2 3 )

MONTHLY AVERAGE DAILY IRRADIATION, HORIZ. / TILTED SURF. ummer:
hdarch 547 Kivhim2 Official hour advances:
April 552 KWh/m2 h o solar hour

30
May - 5.6 kKwhimz From day
of manth |3
Juna £.12 Ki¥hjm2 3]
Todey

July 6.77 6.28 kiwh/m2

fraonth 10
August 5.99 kKywh/m?2 of man

Winter:

September 453 B34 Kiwh/m2 J E M A M J J A s o0 N D Official hour achvances:
October | 3.03 4714 K\Whjms MONTH hto solarhour

- |I7 B Horizontal & M Tilted | :
November 319 Kih/m2 Import from houry file

Cfficial hour

Decarber |1.59 2,62 Kivh/m?2

b Farce Elcluudy consecutive days (only difuse iradiation) in month

SHADOWS. Daily Average Irradiation (Horiz. Sud): 4.21 kKWhim2 Daily Average radiation (TitSurt): 486 KWhim2
Total Annual lrradiation (Horiz, Surf):  1537.92 KiWh/m2 Total Annual Irradiation (Tilt Surf): 1774.31 KWhmz
Sealelaetrtly) Annual I, Back sutace { Directfor CPY:  183.79 Kiwhym2 / 1380 45KWhym?
“ariability minutes: correlation factor std dev, Update minutes Irnport Back (hourly, fil) Import Direct thourly: tilt)
0K Calculate E= Graph in steps of G0 ~ | min Expart G. tilted Export G. horiz.

Within the irradiation screen, we must indicate the latitude and longitude of our location (left
top corner). If we know them, we indicate them directly.

If we do not know them, we can obtain them directly with the button "Locate on map" (the first
time they must introduce a Google Maps JavaScript APl key, which can be obtained free of
charge as shown in the user manual, section 3.3.2), then Google Maps open in your web
browser, you click in the location, click in the “Confirm” button of the web and go back to
MHOGA, irradiation screen, and click in “Update coord” button, then the coordinates are
updated to the value of the location selected in the web (more info in the user manual, section
3.3.2).

If you don’t want to use that option, you can search in hiips://www.qgoogle.com/maps the
location, once found, click the right button and you will see the latitude and longitude.
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https://www.google.com/maps

) Museo Elderdela
Galdar Cienciayladecnologia
Las Pdynas de
Arucas Gran Canaria

GC-70
Agaete

Teror

Pa;quf g/zilljtjfﬂ/ 28.06063,-15.51512
amadaba {6C-21] y
Ruta desde aqui
[ GC-15 i
< Ruta hacia aqui
 Biia i
uMﬂ'mf Pico. ch LQUE Ay agi
e Viento
> 5 las Nieves Buscar en alrededores

Imprimir

GanCanars Afiadir un sitio que falta

Afiadir tu empresa

Mogén Notificar un problema con los dat..

Parque Natural
de Pifancones | Medir distancia

[Cc- TP

Acmlo

Suppose that the system will be near Las Palmas de Gran Canaria, latitude 28.06 ° (north,
positive) and longitude -15.5 ° (west, negative). Enter these values (top left corner of the screen):
Latitude (2] (+M, -5} : Get data from local DB

Longitude (%) (+E. W) :

Download hourky data

Locate on map | Update coard. Download MNASA maonthly data

MHOGA can download resources data (irradiation, temperature, wind speed) from:
- Monthly average data:

-NASA POWER (https://power.larc.nasa.gov/) for a specific year

- Local database: monthly average values of 22 years from NASA (if you have installed
the database)

- Hourly data:

-PVGIS (https://re.jrc.ec.europa.eu/pvg tools/en/tools.html)

-Renewables Ninja (https://www.renewables.ninja/)

- NASA (https://power.larc.nasa.gov/)

First we will use NASA monthly average data.

Then click on "Download NASA monthly data". A window appears asking us what data we want
to download (we can also choose the year of the data to be downloaded):
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https://power.larc.nasa.gov/
https://re.jrc.ec.europa.eu/pvg_tools/en/tools.html
https://www.renewables.ninja/
https://power.larc.nasa.gov/

Data to download: Year 2019 w

Manthly &wverage Irradiation
[ Monthly sverage Temperature [ For Bat
Manthly Awverage Wind Speed
[#]At10 m height  [«] Consider roughness
[CJAt50 m height
[#]wind Speed Weibull Shape Factor
[“] attitude ahove sea level

QK Cancel

We use the default values (2019 data) and click "OK". After some seconds (be patient, it can take
even 30 seconds) the confirmation of the downloaded data appears:

HOGA X

Data downloaded from https://power.larc.nasa.gov
Data updated for lat. 28.06, long. -15.5, year 2019:

-Monthly average daily irradiation: 3.6 4.92 538 6.28 5.86 7.26 6.02 6.21 5.92
433 3.58 344 . Average of the year: 5.23 KWh/m2/day

-Monthly average temperature: 17.59 17.94 17.77 18.46 19.4 20.82 21.66
22.37 22,37 22.01 2046 19.17 . Average of the year: 20.01 2C

-Monthly average wind speed at 10 m height: 4.73 4.39 5.12 4.65 5.49 4.61
6.97 7.05 5.48 4.86 6.33 4.57 . Average of the year: 5.35 m/s. (Converted from
downloaded data of land type airport)

-Wind speed Weibull shape factor: not updated (not found local database)

-Altitude above sea level: 109 m

Note that these values are average values of year 2019 for 12 lat x 12 long. around the location
(solar data source is a global 1° x 1° latitude/longitude grid while the meteorological data sources
are %° x %° latitude/longitude grid). Weibull shape factor will only appear if you have previously
installed the local database, available in the download area of the iIHOGA / MHOGA website (not
necessary at the moment).

By clicking "OK", we return to the irradiation screen.

In this screen the average monthly data of irradiation in kWh/m2 have been updated:

Iiradiation

are. horiz. 5.
January m
Februray  [4-92

March
September i8]
October m
Nowember
December



If NASA database fails (server error), you can introduce the data manually. We won’t
do it, but you could use the local database of iIHOGA/MHOGA (you must have
previously installed the database by downloading and executing the self-extracting rar
file “RESOURCES-ENG.exe”, installing into the MHOGA installation folder, subfolder
“RESOURCES”. (Availalbe in
https://www.dropbox.com/s/p3sd0t3rul9lros/RESOURCES-EDU-eng.exe?e=1&dI=0)..

To use the local database, in the irradiation screen, click on the button “Get data from

local DB”.

We could use as input data source data a file with data of global irradiation on horizontal surface
(hourly values, file of 8760 rows, in each row the value in kWh/m? of each hour), a file with data
in minutes (inclined surface) or average monthly data (12 data, one for each month, in different
formats).

When downloading from NASA (monthly values) we obtain average daily data per month in
kWh/m?, so we don’t change the default option "Monthly average", Radiation Horizontal
Surface (kWh/m?).

PEESEEESSSSSSSS |
['ata sowrce
Steps
i Monthly Average Import from File * O i
[/ Generation of PV gen. [MW] normalized to 1 Mwp (5 1
[equivalent ta iradiance kiw/m2 « BR =
Data Source for Monthly dverage Daily Inadiafin: | Radiation Horizontal Surface (kw'hém2) + aloulation Method for Hourly Iradiation:

Ilradlal_lon Inad!allon PV Tracking 57T —— T ™ Liy b Jordan " Erbsetal
av. horiz. 5. av. hilt 5. )
JevED 57 312 Kwhim2 % Collares-Pereira & Rabl Graham
— FETEEEL

In this case we will assume that there is no solar tracking system (modules with fixed orientation
and slope) and we will use the method of calculation of the hourly irradiation of Collares-Pereira
and Rabl (default values).

We must indicate the slope and the azimuth of the PV modules. You can use two zones for the
PV generator, with different slope and azimuth, PV gen. #1 (100% default) and PV gen. #2 (0%
default). By default, all the PV modules will be in #1 (100%), but we could change it. We leave
100% for zone #1 as default, defining 352 for the slope and 02 for the azimuth (that is, south
oriented).

#1: P panels slope [!]F‘"-.-f panelz Azimuth d]ﬁl
0

=]
PY¥ gen. #1: 4 Ground Reflectance:
Optirmal Slopett Optimize PY#1 panels slope during the optimization of the system

The optimal azimuth will be 02 (for northern hemisphere, that is, orientation towards the south)
but maybe the slope is not optimal. The optimal inclination for our case will be obtained by
pressing the button "Optimal slope#1". After some seconds the screen shown below is shown:
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https://www.dropbox.com/s/p3sd0t3ru19lros/RESOURCES-EDU-eng.exe?e=1&dl=0

A Optimal slope for PV panels - O X

Average daily irradiation for each month and for the whole year. Slope: 0, 15, 30, 45, 60, 75, 90* and optimal

Azimuth (02) is optimal for northern latitudes

Rad. D2 fkihyday) Rad. 152 (kwhfday) Rad. 302 (kwhiday) Riad. 452 (kwhiday) Fiad. 502 (kiwhiday) Rad. 75¢ (KWhiday) Rad. 90¢ (KWhiday) Slope Opt (2 Rad. Slope Opt. (kiWh/da,
January 367 459 527 5.65 569 54 48 55 572
February 473 559 532 5.57 542 53 502 47 557
March 54 534 616 5.02 555 476 373 32 516
April 61 8.27 £.09 558 478 376 259 15 8.27
Way 6.1 5.96 554 484 396 292 18 0 61
June 6.93 86 5.95 493 387 263 151 0 5.93
July 62 599 551 475 382 277 176 0 6.2
August 617 8.21 591 531 444 339 224 g 8.23
September 574 615 522 5.34 533 442 EE] 25 5.24
Octaher 436 4,96 53 5.34 509 456 379 El 5.36
Movember 359 435 487 514 51 479 421 51 516
December 34 433 503 5.44 555 532 477 57 555
WHOLE YEAR 52 558 567 5.45 436 421 329 27 568

Month of lowest iradiation ower horizontal sudace is DECEMBER
Optimal slope to maximize the irradiation in DECEMBER (fixed PV modules) is 57 *

Optimal slope for the whole year (no load, fix modules) is 27 *

2 Back

If the screen does not appear, but the main screen of the program appears, click on the MHOGA
icon in the Windows taskbar (lower part of the computer screen) and the screen shown will
appear.

Irradiation for slope 0, 15, 30, 45, 60, 75 and 902 and for the optimal slope is shown for every
month and for the whole year.

In generating systems (as our case), with no load, in red it is shown the optimal slope for
maximizing the PV generation during the whole year, in our case 279.

We click “Back” to return to the irradiation screen. A message appears showing that the slope
of the PV modules has been updated to the optimal value. We see the change in red.

#1: P panels slope (%) ; F

35

PV gen. #1: %

Optirnal Slope# [ ] Optirnize P

Shadows that affect our PV generator must be defined before calculating the irradiation or
before downloading hourly irradiation data from PVGIS, Renewables Ninja or NASA.

By clicking the button "SHADOWS" (down left) we access a window where we can define the
existing obstacles that can shade the photovoltaic modules. Suppose that between -75 and -90°
azimuth exists a 40° elevation obstacle, and that this obstacle eliminates 50% of the direct
irradiation (because it occupies the middle of the strip between -75 and -90° of azimuth), we
introduce these data:
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For each range of azimuth, indicate elevation of obstacles [*] and the percentage of reduction in direct irradiation:

pogimu FOM 1 1BDN) 185150 ; 60 45 30 15
"To [ 85 50 43 - J 4 5 - 45 30 15 0(3)
Obstaclescevation) [0 | [0 | [2 ] (I ) O O O A I

Feduction in direct irradiation (%) 100

sy FEM () 0(5] 18 120 135 150 165
"To [ 15 ] 135 150 165 180(N)
Obstacles sevationt) (0| [0 | O N N O Y O R

Feduction in direct irradiation (%] 100

Elevation (")
£ [=r] 2]
= 8 8

=]
=

=

-185 -150 -135 -120 -105 -80 -75 50 -45 -30 15 0 15 30 45 &0 75 S0 105 120 135 150 165 180
Azimuth (*)

For reference solar trajectaories are shown for winter and summer solstices for latitude 28,082

0K

By clicking "OK", we return to the irradiation screen.

We are using irradiation in monthly average values. The software must convert it to hourly
values and later in minute values so that any time step can be used in the simulations and
optimizations.

Before clicking on the “Calculate” button, we must define how the irradiation values of each
minute will be obtained, since a first order autoregressive model is used. We must indicate the
correlation factor and the standard deviation (kW/m?). We use the default values (down left):

W ariability minutes: corelation factorn: ; std. dew.:

Then click the "Calculate" button (down) to obtain the 8760 values of hourly radiation on the

tilted surface (26°) and for all the minutes within each hour:

Calculate | B0~ |min Export horiz. E=port tilted

The software also calculates the irradiation of the back surface (needed if we would consider

bifacial PV modules) and the direct irradiation over the tilt surface (needed if we would consider
concentrating PV, CPV).

After calculation, it is shown (above the button Calculate) the daily global average and annual
irradiation on horizontal surface and on tilted surface, the total annual irradiation over the back
surface of the modules and the total direct irradiation over the titl surface, for CPV (note that
the user can obtain values slightly different because a correlation factor and standard
deviation have been applied, implying that a randomness is applied; it will also happen in the
next sections).
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Baiywverage rradiation (Horiz. Sud): 5.1 kKWh/m2 Daily Average Iradiation (Tilt Surf): 5.6 kith/m?2
Tatal Annual lradiation (Horiz. Sud): 186217 kKvvhim?2 Total Annual lrradiation (TilkSud): 204598 Kvwhim?
Annual Irr. Back surface / Directfor CPY: 14428 KWh/m?2 / TERE.44 K\vh
I Std. dew.:

Update minutes [mpor Back thourly, 1) | | Import Direct (hourly, til)
Calculate ﬁ Graph in steps of 50 v

e Export G tilted Export G. horiz.

The "Graph in steps of" button is enabled. The display can be in intervals of between 1 minute
and 60 minutes.

We use 60 minutes and when clicking in "Graph in steps of" the representation of the global
irradiation on the tilted surface (272) in shown in green, the irradiation on horizontal surface in
red (without random variability), the direct irradiation over the tilt surface (for CPV) in blue and
the global irradiation over the back surface in teal.

V' Graph - O X

Irradiance

1,000

900 -
~
800 /
/
700 / \

600 /

// \'\
500 /,’/_\‘
400 / >

300 e

Wim2

200

100 Vs

1 January

% — Horizontal surf. [¥ — Global Azimuth 0°, slope 27° [¥ — Direct (for GPV) [¥ — Back surface (for bifacial) |

< >
[Horizontal Grid [1Ak []Verical Grid _ Days display

Scroll change (days)> small Jarge

[ Bock

You can see the horizontal grid by clicking on the “Horizontal grid” checkbox. Horizontal axis
labels can be seen in alternate positions by clicking on “Alt” checkbox (if you have select less
than 60 min. for the graph, you will see the hours and the half hours). Vertical grid is shown by
clicking on “Vertical grid” checkbox. Scroll change in days can be set for small changes (changes
in the screen when you click in the arrow of the scroll) and for large changes (changes in the
screen when you move the scroll cursor or when you click in the scroll bar).

For example, we can see 3 days at the same time (3 Days display), with horizontal grid (darker
grey at 12:00 h of each day if more than 1 day displayed) and vertical grid, and each time we
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click in the scroll arrow the graph will move 0.1 days, and each time we move the scroll cursor
the graph will move 1 day):

Vi Graph - [m] X

Irradiance

1,000

900

800

700

~ 600
E

£ 500

400

300

200

100

0

17 21 3n
1 January - 3 January
¥ — Horizontal surf. [¥ — Global. Azimuth 0°, slope 27° [¥ — Direct {for CPV) [ — Back surface (for bifacial) |
<l D

[V Horizantal Grid [ _JAlt [ Verical Grig_ Days display
Scroll change (days)> small: (01 | large

Back

If we change the days of visualization to 365, we see the distribution of the irradiation during a
whole year:

ﬁi Graph — O X

Irradiance

1,000
300
800
700
600

Wim2

500

400

300

200

100

0
11 151 /2 1512 13 15/3 /4 15 /5 15/5 /6 15/6 /T 15/7 /8 15/8  1/9 15/9 1101510 17111511 1/12 15/12
January-December

¥ — Horizontal surf. |¥— Global Azimuth 0°, slope 27° | — Direct (for CPV) ||7— Back surface (for bifacial) |

> |365
[ Horizontal Grid [_Jak []vertical Grid Days display

Scroll change (days)-» small: large:

Back

We change again the days of visualization to 1, we return ("Back" button) and change to 1
minute and click again on "Graph in steps of" button, after some seconds (be patient, please)
we obtain the graph in minutes of the global irradiation on tilted surface, the global over the
back surface and the direct over the tilted surface.
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By clicking "Back" we return to the irradiation screen.

We could use these values of irradiation for our simulations and optimizations. But we could
also download hourly values from PVGIS, Renewable Ninja or NASA.

8. Using hourly irradiation and wind speed data from Renewable Ninja, PVGIS or NASA.

We can use hourly data for irradiation, temperature and wind speed data obtained from the
databases of PVGIS, Renewable Ninja or NASA.

In the SOLAR resource windows, click in “Download hourly data”.

) SOLAR RESOURCE

Latitude (2 (+M,-5):  [28.0B Get data frarm local DB

Longitude (%) (+E, ) [-15.5

Download hourly data.

Locate on map | Wpdate coord. Download NASA monthly data

Then a small window appears, showing the database to choose (PVGIS, Renewable Ninja or
NASA) and the that can be downloaded.

Renewable Ninja hourly data:

First we select the database of Renewable Ninja (year 2019). This database has some
restrictions: with this database we can only download data of year 2019, and we can do only 5
downloads per day (each download of irradiation/temperature is counted and also each
download of wind speed is counted) however if you can change your IP (for example using a free
VPN service as https://www.tunnelbear.com/) you can do 5 downloads each time you have a
new IP. These restrictions are not for PVGIS or NASA databases.
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https://www.tunnelbear.com/

Download from: () PYGIS-vear 2016~

(@ Fienewahle Ninja (year 2019)
(I NAZA- Year U
Hourly Irradiation
Hourly Temperature for: P[] wind T
I [ ] Hourly Yind Speed I

o

[ ]Batt

OK. Cancel

We could download irradiation, temperature and also wind speed. However, as now we only
want to download irradiation and temperature, we uncheck “Hourly Wind Speed”. The
temperature of the batteries is not checked and we will leave it, because we can suppose the
batteries temperature is different from ambient temperature, assuming they are into a building
and not in the outdoor (their temperature will be defined later in the batteries window).

By clicking “OK”, an info message appears, we click “OK” again and hourly data of irradiation
and temperature are downloaded.

In the irradiation window we see the average values of the downloaded irradiation over tilted
surface (daily average for each month and annual).

W SOLAR RESOURCE

#1: PV panels slope (%)

PV gen. #1: -

Optimal Slope#]

Latitude (2 (+N,-5):  |28.06
Longitucle [2) (+E, ) :

Upcdlate coord.

Get data fram local DB

- FY panels Aziruth (2) EI E

Ground Reflectance: D
[v]Fixed albeda \mpnrtA\h Gr
Optirnize PV#1 panels slope during the optimization of the system

Dowmload houry data

Locate on map Download NASA monthly data

Data source for Global irradiation

Steps
O Monthly Average © Import from File  FROM RENEWAEBLE NIMJA © Hour (kWhim2) O Hariz @T\\t
[ Generation of P4 gen (M normalized to 1 kwp (O 1~ Minutes- sach hourin 1 row il in kKiW/m2) —
{equivalentto irradiance kiv/mz x PR) @] Minutes- 1 per row itilt surf. in KiW/m2) mpo

Data Source for Monthly Average Daily Iradiation:  Radiation Horizontal Surface (Kidhimz) Calculation Method for Hourly Iradiation

0K Calculate

“ariakility minutes: correlation factor: std.dev.: Updlate minutas

\rrachhhatlon P Tracking System: |Na Tracking - Liw & Jarclan Erbs etal
Factor F([) for the back albedo Collares-Pereira & Rakl Graharm
lantaiy SR L2 (bifacial modules) (Durusoy 2020): 0.33
Februray B.53 kWwh/m2 o .
MONTHLY AVERAGE DAILY IRRADIATION, TILTED SURFACE ummer:
March 6.7 kiwh/m2 7 Official hour achvvances:
April 7.2 Kvhym? 6 @ o= ety
3
My 7.15 Kiwh/m2 5 IFm ey
of month |3
June 7.08 kWwhim2 i
Today e
Jul 7.7 kihim2
& 2 of month
August B.97 kiwWwh/m2 1 )
Winter:
Septermber B.72 kKWh{m2 0 I F M A J M s o N D Official hour advances:
Octaber £.87 Kih/m? MONTH hita solar hour
O 518 Kvhym2 ¥ M Horizontal ¥ M Tilted Import from hourly file:
Official hour
December 5.23 kivh/m2
1] January
SHADOWS Daily Average [rraciation (Tilt Surf): 6.4 kih/m2
Total Annual Irradiation (Tilt Surf.): 2337.3 kivh/m2
SeaElettd) Annual In. Back suriace / Dirsctfor CPY: 144,26 kih/m? { 187095 Kihym2

Import Back (hourly. tilf)

E= Graph in steps of 1 Export G. tited

™ Imin

Import Direct thoury, til)

Export G. horiz.

Total annual irradiation over the inclined surface is 2337 kWh/m?, compared to 2046 kWh/m?

obtained with NASA monthly data (obtained in the previous section).
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If we click on the button “Graph in septs of” (60 min.) we see the hourly irradiation downloaded

from Renewable Ninja:

Irradiance
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< %
[JHorizontal Grid  [_JAlt [ Vertical Grid Days display

Scroll change (days)-> stall large:

We could use the data form Renewable Ninja for the simulations or optimizations, we could also
use the data from PVGIS or NASA. We can see the difference in irradiation is low.

Now we will download NASA hourly data to see the difference with the other databases.

NASA hourly data:

Click in “Download hourly data” button. Now we select the database of NASA. We can select
any year from 1990 to 2020, for example select 2015. We leave unchecked “Batt.” We could also
download wind speed data at 10 or 50 m height (not at any height as Renewable Ninja can do),

but we will not do it later.

Download fram: (O PYGIS-Year 20168 v
() Renewable Minja, fyear 2014)
@ NASA- Year 2018 v

Hourly Irradiation {inc. albedao)
Hourly Temperature for: Py [wind T | ]Batt.

I | |Hourly Wind Speed I @10m  (OSim
[«] Altitude above sea level

oK. Cancel

By clicking “OK” an info message appears, we click “OK” again and hourly data of irradiation and
temperature are downloaded. Be patient, it can take even more than one minute.

After downloading, in the irradiation window we see the average values of the downloaded
irradiation over horizontal surface (downloaded) and over tilted surface (calculated by MHOGA).
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Optimal Slope#] Optimize PV#1 panels slope during the aptimization of the systerm

Data source for Global irradiation

Steps
O Monthly Average @ Import from File  FROM MASA pear 2015 @ Hour (kWhm2) Haoriz Tilt
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[ Generation of P gen. (M) normalized to 1 M (O 1 Minutes- sach hourin 1 row (tl, in km2) I o
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Data Source for Monthly Average Daily Irradiation:  Fadiation Horizontal Surace (KAhim?) Calculation Method for Hourly Iradiation
Irrad\afion \rraqiation P Tracking System: Mo Tracking - Liu & Jardan Erbs etal
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Factor F([) for the back alkedo Collares-Pereira & Rakl Graharm
ey 26 415 Lt (bifacial modules) (Durusoy 2020): 0.33
Februray 353 416 k\whim?2 s ]
MONTHLY AVERAGE DAILY IRRADIATION, TILTED SURFACE ummer-
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April B.45 B.16 Kyh/mz 5 o et i@
30
May B.63 6.06 Kiwh/m? 4 IR Ey
of month |3
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Today e
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August B.24 5.88 Kiwh/m2 1 _
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Septernber 5.89 .09 kivwh/mZ 0 1 F M A M J M A s 0 N D Official hour adhvances:
Octaber 453 5 49 Ky¥hjm2 MONTH ln® Sl ey
Mowvember 3.7 5 kiwhim2 '@ Horizontal @ Titted Impart from hourly file
Official hour
December 341 4.87 Kwhim2
1] January
SHADOWS Daily Average [rradiation (Tilt Surf): 5.4 kihfm2
Total Annual Irradiation (Tilt Surf): 19739 kivh/m2
S e {5 Annual In. Back surface / Dirsctfor CPY: 144,26 kih/m2 / 153065 kKihym2

“ariakility minutes: correlation factor: std.dev.: Updlate minutes

0K

Import Back thourly, tilf) Import Direct thourky:. tilf)

Calculate 4= Graph in steps of B0 Export G. tilted Export G. horiz.

* min

Total annual irradiation over the inclined surface is 1974 kWh/m?, compared to 2337 kWh/m?
obtained with Renewables Ninja and 2046 kWh/m? obtained with NASA monthly data.

Now we will download PVGIS hourly data to see the difference with the other databases.

PVGIS hourly data:

Click in “Download hourly data” button. Now we select the database of PVGIS. We can select
any year from 2007 to 2015, for example select 2015. We leave unchecked “Batt.” But we check
“Hourly Wind Speed” so that the wind speed at height 10 m will also be downloaded from PVGIS
(in PVGIS we cannot change the height at which the wind speed was measured, PVGIS database
only supplies wind speed at 10 m height).

LV

Download from) (@ PYGIS -Year 2015
() Renewahle Minja (year 2019)
(O NASA- vear 2015
Hourly Irradiation

Hourly Tempearature far: P [v]wind T}

I Hourly Wind Speed I

R

[ ]Batt.

84 Cancel

By clicking “OK” an info message appears, we click “OK” again and hourly data of irradiation and
temperature are downloaded.
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In the irradiation window we see the average values of the downloaded irradiation over tilted

surface (daily average for each month and annual).

Data Source for Morthly Average Daily Irradiation:  Fadiation Horzontal Surface (Kdh/mz)

Irradiation

A tilt s
January 418 kiwh/m2
Februray 3.73 Kwh/m2
kdarch 5.37 kWh/m2
il 5.7 kKiwhfmz
hay 6.95 kwh/m2
June 6.55 KiWh/m2
July 6.68 kiwh/m2
August 587 KWhfm2
Septernber 5.73 KWhfm2
Octoher 4 75 kih/m2
MNovember 476 kKWh/m2
Decamber 5.32 kiWh/m2

SHADOWS

Scale factor (x by)

“ariability minutes: correlation factor: sld. dew Update minutes

0OK

P Tracking Systern: | Mo Tracking Liu & Jardan

Factor F(l) for the back albedo
(bifacial modules) {Durusoy 2020)

Collares-Fereira & Fahl
0.33

Calculation Method for Hourly Iradiation:

Eths etal

Graham

MONTHLY AVERAGE DAILY IRRADIATION, TILTED SURFACE

[ R N L

M J A 3 o} N D

J
MONTH

¥ M@ Horizontal v M Tilted

Summer:
Dfficial hour achvances:

hto solar hour
From day

of month

To day

af month

Winter:
Official hour ackvances:

h 1o salar hour

Import fram hourly file

] January

Official hour

Daily Awverage Iiradiation (Tik Surf):
Total Annual Iradiation (Tilt Surf)
Annual Irr. Back surface / Direct for CPY;

5.48 kivhim2
2001.2 kiwh/m?2
144.26 kiwhim2 §1221.25 Kivhfm2

Import Back (hourly, til)

Calculate = Graph in steps of B0~ min

Impart Direct (houtly. tilf)

Expart G tilted

Export G. horiz.

Total annual irradiation over the inclined surface is 2001 kWh/m?, compared to 1974 kWh/m?
from hourly NASA, 2337 kWh/m? obtained with Renewables Ninja and 2046 kWh/m? obtained

with NASA monthly data.

As before, we could see the downloaded data in hourly steps by clicking “Graph in steps of”.

Finally, we will use these data for irradiation (PVGIS year 2015).

Clicking "OK" it returns to the main screen of the program.

9. Wind speed data.

By clicking on the "WIND" button we can define the wind resource data.

The Wind screen appears.

1 Project: D:\Prl.hoga

Project Data Calculate Dati

«f LOAD /AC GRID |

RESOURCES
 sosr |

T« WIND\F
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V' WIND RESOURCE - m} X

Latitude ) (+N.-5)*  |28.08 Get data fram local DB Monthly Average Dite
Langitude (%) (+E. ) Download hourly data Anemameter Height | @) Monthly Averags Speed
i () Night speed. Amplitude. F Factor and Hour max speed

Laocate onmap | Update coorel. Download NASA Monthly data

Surface Roughness
Data source
Steps Class 1 ¥ Lengh 003 m

(O Monthly Average @) Import data file (inm/s) | FROM PYGIS year 2015 §HDW5

Minutes- each hourin 1 raw Import Agricultural open area without fences
D Generation of wind turb. (M) normalized to 1 bW rated p

Minutes- 1 per row neither hedges and with very dispersed
buildings. Only sroathly rounded hills

A sp. (/]
Jan 534

Feb: 561 ~ M Daia ¥ — Fil
Mar 479
Apr 402 0.35
My 463
Juni433 | S
Jul: 575 E
Aug:47 =
ug =
Sep: 312 2
oct26s | S
Now37d | £
Dec 296 | =
2
a
Carrelafion factar.
Calculation of wind speed for each minute: std. dew. mfs Update min.
0 5 10 15 20 25 30
Wind speed (m/s)
Calculate = Graphinstepsof | |60~ min Export 2. vear (m/s Info time of calm wind
43 Calmis considered
Form factor of the wind speed serial: 2.8 < Tﬂﬂ'S
ScdedsmogeSpesd g || ok |
Scale by (<by) j:aaled Average Speed (m/s 0K

The data downloaded previously from PVGIS in the irradiation screen are already placed here:
latitude and longitude, Anemometer height (10 m) and Monthly average wind speed (m/s). The
distribution of the downloaded wind speed at 10 m height is shown in the probability density
function (PDF). Average monthly values of the downloaded data are shown close to the PDF,
and annual average (4.3 m/s at 10 m height). Weibull shape factor of the Weibull curve that best
fits the downloaded data is 2.8 (shown under the probability density function PDF).

A scale factor could be set to multiply the wind speed downloaded (for example, to see the
effect of having a wind speed 20% higher than the downloaded, we would set 1.2 for the “Scale
by (x by)”. In this case, we will use the data downloaded, “Scale by (x by)” 1.

Renewables Ninja wind speed data is usually more accurate than PVGIS and NASA, also it can be
downloaded for any hub height. As we will use wind turbines of hub height 100 m, we will
download data at that height.

First, we set the height of the anemometer:

Anemaometer Height

0] m

Then, we click in “Download hourly data” button, selecting just wind speed (irradiation and
temperatures were already downloaded from PVGIS). We select Renewable Ninja (year 2019)
as the database, and we uncheck “Hourly Irradiation” and “Hourly Temperature for”, leaving
“Hourly Wind Speed” as the only one checked.

28



(I PYGIS - Year
(@) Renewahle Ninja (year 2019)
(I NASA-Year [cU15

Download from:

[ ]Houtly Irradiation
[ Hourly Temperature far| [P [#]Wind T. [ ] Batt

I Hourly ‘Wind Speed I

(04 Cancel

We click “OK” and the wind speed data at 100 m height is downloaded:

1 WIND RESOURCE - ] X
Latitude (%) (+M, -5) 28.06 Get data from local DB
Longitude &) (+€,4) Bl s Anemomater Heigh
-100 m
Locate onmap | Update coord Download NASA tMaonthly data -

Surface Roughness
Data source

Steps Class 1 ™| Lengh 003
Hours -
(O Monthly Average (@) Import data file (inm/s) |FROM RENEWABLE NINJA T R - D] cEe Gl e e
D Generation of wind turb. (MW/) normalized to 1 MW rated p ™ Minutes- 1 per row neither hedges and with very dispersed
buildings. Onby smoothly raunded hills
Av. sp. (mfs]
Jan: 7.64
Feb. 736 ~ M Data B — Fit
Mar: 8.09
Apr: 7 66 016
Many: 868
Jun7ss | § 014
w0 | g
Aug: 1062 ; 01
Sep:ase | B
oct7as | S 008
Nowdd | £ .
z
Dec: 7.56 =
o 0.04
o
Cornrelation factor: 0.02
Calculation of wind speed for each minute: std. dew. mfs Upclate min
0 5 10 15 20 25 30
Wind speed (m/s)
Calculate = Graphinstepsof | B0 min Av. yeat (mfs Info time of calm wind
B Calm is considered

< |3 mfs
Scaled Average Spasd (mfs % Form factor of the wind speed serial: 3.7 - /'
Scale by (x by

85

Annual average wind speed is 8.5 m/s at 100 m height and the Weibull shape factor of the
Weibull curve that best fits the downloaded data is 3.7.

These data will be the wind speed data that we will use in the simulations and optimizations of
this guide.

Finally clicking "OK" return to the main screen of the program.

10. Components Databases.

By clicking on the top menu Data Base -> Components Data Base it displays the components
defined in the databases.
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1l Project: D\Prl.hoga
Project Data (Calculat

g Data Base FReport Help
«f LOAD /AC GRID Components Data Base

The following screen appears:
\ Databases of components - O X
PV Gen. Wind turbines Batteries AC Generators InverteriChargers Hydro turbines Electrolyzers Fuel cells
M| < & || =-

Name P nom(MWp_dc Cost(ME)  C.O&M (%A1 Liefyears) NOCT()C) PowerTcost (%C) BIFACIALTY(-1) CPV  Emissions (kgCO2/KWi) ~

Zerg i} 0 i} 100 43 -0.4 0 NO 800

PV 1 1 1 25 43 04 0 NO 800

PV1D 10 10 1 25 43 0.4 0 NO 300

PV100 o0 100 1 25 43 -0.4 0 NO 800

CPY10 1o 12 1 25 43 014 0 OK 800
» PVID-BIF 10 Il 1 25 43 04 0.7 NO 800

v
Multiply costs of PV by
Clone selected component Add components from the project

The different tabs show the components stored in the databases. We can modify the data of
each component, eliminate components or add others. We can also multiply all the prices of a
given component by a factor, clone a selected component (and later changing whatever you
want) or adding components from the project.

It should be noted that the prices of the components vary by country, even within the same
country it depends on different variables. Therefore, the designer must verify or modify the
prices conveniently.

All the data are “generic”, and the user can change them to his/her specific situation.
We will leave everything as it is by default, later the designer can change what he/she wants.

Finally clicking "OK" it returns to the main screen of the program.

11. PV generators data.

By clicking on the "PV GEN." button we can define the different photovoltaic generators to take
into account into the simulations and optimizations.

COMPONENTS
R A == -

The following screen appears:
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VPV GENERATORS - a X

v

W< [+ =1~ A
AP Gan.famiy
PHOTOVOLTAIC GENERATOR DATA:
Narme Powei(MWE)  CostME)  COSM(%AN  Litelyears) NOCT(C) — PowsrT.cost(%AC) BIFACIALIT(O-1) CPV  ErissionsikgCO2KWE)
» PY10 (BT BT 1 25 3 04 0 NO 800
< >
Fixed Operation and
Efficiency dus to degradation ofthe modules, losses inwires, dittin pansls, etc "

Maintenance Cost
Standard conditions

e

Consider effect of Temperature

Data of ambienttemperature (:C)
J[176 [F117.9 |M178 [A185 [M/19.4 |J 208 W 217 |A 224 |5/224 |02 N[205 D192 | [ windforcpyv,

(O Monthly average Erbs model
@ Fromfile (8760 hourly values) Import FROM PYGIS year 2015 1 Graph
PV inverter data.
Annual Inflation Pate for PY | . Max. Variafion of P gen. Cost (.. for an expected 70%
Generator Cost E2 reduction on current Py gen. cost introduce *-70%"): %

Liritis reached in 53.6 years

OK

By default, there is only one type of photovoltaic generator to consider, as, by default, there is
just one row in the table, the one of 10 MWop (in the optimization there will be several of this
type in parallel, later we will define the minimum and maximum number in parallel allowed).
We could add more different generators in the table using the button “+” of the button set in
the upper area, and defining their values. We could also add from the database using the buttons
“Add PV Gen” or “Add PV Gen. family”. We could delete rows of the table with the button “-“.

Suppose we think the size of the PV generator is too high and we want more precision, wanting
to use several of 1 MWp in parallel instead of several of 10 MWp in parallel.

Then, we delete the generator of 10 MWp:
Step 1: Select with your mouse the row of the table.

Step 2: Click in “-“

V[ PV GENERATORS - O X
e
TG AR E

PHOTOVOLTAIC GENERATOR DATA:

Power(MWp_dc)  CostiME) C.O&M(%%AY)  Lifefyears) NOCT(C)  PowerT. coef(%/C) BIFACIALITY(0-1) CPY  Emissions(kgCO2 ki)
» PV10 10 10 1 25 43 -0.4 0 NO 800

MHOGA ask you “Delete record?”. Respond yes and the generator will be deleted.

Now we want to add from the database the PV generator of 1 MWp. The quickest way to add it
is:

Step 1. Select from the list close to the "Add PV Panel" button the type “PV1”, which is the one
of 1 MWp.

Step 2. Click on the button "Add PV Gen.".
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V| PV GEMERATORS

Add PY Gen, | [ E

Add PV Gen. family |2

PHOTOVOLTAIC GENERAH.EWEE.H.

I Thiamma =T

Now the project will take into account the type of 1 MWp (later we will define how many of
them in parallel will be allowed):

VI PV GENERATORS - O X
Add P Gon fariy LR + | =
PHOTOVOLTAIC GENERATOR DATA:
MName Power(Wp_dc)  Cost{ME) CO&MAn  Lifelyears) NOCT(C)  PowerT.coef(%:/2C) BIFACIALITY(D-1) CPY  Emissions{kgCO2ikiWp)
P PVI 1 1 1 25 43 04 0 NO 800

Suppose in our case we want to consider that the cost of the PV generator of 1 MWp is not the
one that appears (1 M€) but it is 1.2 M€ (take into account that this would be the total cost of
the PV generator of 1IMWop, including PV modules, mounting structures, inverters, wiring,
protections, transformers, buildings, etc).

We can modify it in the database (see point 8) and then, in the PV screen, add it from the
database (if in Project->Options it is checked the box “When clicking a component in a table...”,
by clicking on the row of this PV generator, its cost would be updated).

Another option is to change the name on the screen (for example, add "-mod") and change the
price. If in Project->Options it is checked the box “When clicking a component in a table...”, if we
do not change the name, any changes we make will not be effective because the software will
consider the data in the database. Keep in mind that the number of characters in the name is
limited.

We change the name by clicking in the cell and adding at the end of the name “-mod”:

MName f
PY1-mod

And then we change the cost to 1.2 M€ (if the decimal spacing of your computer is dot, write
“1.2”; if it is comma you should write “1,2").

1 P¥1-mod 1 25 43 04 0 NO 800

Mame PDWer(MWp_d:@O&M(%M) | Lifefyears) MNOCT(C) Power T. coef(%/2C) BIFACIALITY(0-1) CPY  Emissions(kgCO2Z/kWa)
1 2 ......
We can see in the table that O&M annual cost (OPEX) is 1% of the CAPEX (which now is 1.2 M€),
that is, now it will be 12,000 €/year. We could change this percentage, but we will leave in 1%.

It is important to note that, when you change the values of the tables (the tables of the
components, tables of the database and tables of load), the changes done in the tables will
remain even if you do not save the project.
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In the central area of the screen we see the efficiency due to degradation, losses, dirt (default
0.95), the fixed O&M cost (default 0 €/year, this is a fixed cost which is added to the total O&M
cost of the group of individual PV generators of 1 MWp in parallel) and the button “Standard
conditions” (where the standard conditions for the PV and CPV data are set).

Fixed Operation and
Efficiency due to degradation of the modules, losses in wires, dirtin panels, stc. [0.95
&7 d 2 Maintenance Cost

Standard conditions

Ehvr

Consider effect of Temperature
Data of ambient temperature (2C)
(O Monthly average Etbs model

(@ Fram fils (8750 haurly valuss) Impart FROM PYGIS pear 2015 &= Graph

JUIFE F 70 MI7E ATEE MI104 0 208 g 217 m224 5224 @22 MZ0E D192 wingioroPy

Also the effect of the temperature is by default taken into account (we could uncheck the
“Consider effect of Temperature” check box in order to not consider it). We will consider it so
we leave that check box checked. The ambient temperature is from hourly file as we have
downloaded it previously by PVGIS, year 2015. By clicking the “Graph” button we can see the
temperature downloaded:

Ambient Temperature

14
12
10
8
6
4
2
0
1 2 3 4 5 6 7 3 9 10
January
< >

[ Horizontal Grid - [_] Al [_]vertical Grid Days display

Scroll change (days)-> small: large

Back in the PV generators screen, in the bottom of the screen we can set the PV inverter data,
by clicking in the “PV inverter data” button.

" Monthly average = B L T L e e LRy T P BT Ly P ey P P N T T

& From file (8760 hourly values) Impoit FROM PYGIS pear 2015

P inverter data

A small window appears, where we must define if the PV inverter cost is included in the PV cost
(by default it is), we must set the rated power of the inverter in times the peak power of the PV
generator (default 1) and the inverter efficiency (%) vs. the output power (% of rated) curve.

33



PY inverter cost included in the PV cost; PV inv. replacement
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We leave the default inverter data and click “OK”.

At the top bottom of the PV generators window we can set the annual inflation rate for the PV
generators CAPEX (default -2%, this means that each year we expect that the PV generator cost
will be reduced in 2%) and the maximum variation of that cost, by default -70% (reduction of
70%). This means that after 59.6 years (shown below, as (1-0.02)%%¢=0.3), the cost will be 30%
of the initial cost, i.e., reduction of a 70%. This limit of -70% in the PV cost reduction will be
reached in 59.6 years, then after that year the technology will be considered as mature and the
cost will be increased with general inflation.

nwene uaa

Annual Inflation Rate for Py B . Max. Variation of P gen. Cost [e.g., for an expected 70%
Generator Cost : % reduction on current PY¥ gen. cost, introduce '-70%"] -7 %

Limit i reached in 53.6 years

|

This values would be used to calculate the replacement cost of the PV generator, if its lifetime
was lower than system lifetime (it is not our case, as PV generator lifetime is 25 years, the same
as the system lifetime). If, for example, we had defined the system lifetime (study period of the
system) to be 40 years, then in the year 25 the PV generator should be replaced, and the
replacement cost would be the initial investment cost multiplied by (1-0.02)%. And in the year
40 the residual cost would be also calculated considering this inflation rate.

Finally clicking "OK" it returns to the main screen of the program.

12. Wind turbines data.

By clicking on the "WIND TURB." button we can define the wind turbines to take into account.

COMPONENTS
o PYGEN. |

R AT A |
|

A screen appears with a table where a predetermined wind turbine of 2 MW with a tower of
100 m is shown. As we did with the PV generator, we could change to another wind turbine, but
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we will leave the default values. The cost (“Cost (M€)”) is the CAPEX, which should include all
the costs relates to the wind turbines. The (“C. Repl.”
lifetime ends it is usual that not all the components are replaced, therefore replacement cost
(referred to the installation time) is lower than the CAPEX.

) is the replacement cost, as when its

1 WIND TURBINES / GROUPS OF WIND TURBINES - O X
ks e Tune W =
Add aWind Turhines famiky
GENERAL DATA Qutput Power (MW) vs Wind Speed
Name Bus Cost(ME) C.Repl (ME) C.O&M (%A Lifespan (w) Height(m) Emis.CO2(k) 1mfs 2mfs 3mfs am/s Bmjs Bm/s mjis amfs 9mfs  Im
» WWincT1 AC 2 16 I3 20 100 15 0 1} 0 0.05 0z 03 05 07 1
< >

Fixed O i d
Iwind speed fram the wind resource will be converted to the WindT1 lvi(:\ntenpair::%”n::
hub height consideting roughness 2
B

Losses wires, transformer:
%

z
Lera 059 | m 2

iAgricutiural open area without fences neither hadges
and with very dispersed buildings. Only smaothly

rounded hills
0
0 2 4 6 8 10 12 14 16 18 20 22 24 26
Power curve measured atair density (kg/m3): 1,225 WIND SPEED (m/s)
N [] Wake effect

Height ahove sea level m o [~ P. in standard conditions (sea level, 15°C), 1225 kg/m3
Ait density atthat height s (54) 1212 kg/m3 W — P at altitude of the place (109 m), 1.212 kg/m3 Wake effect
Consider the effect of temperature
When simulating, adjust pawer curve with air density: Ambient Temperature at hub height (2C) - AN e 0 w03 a7 o i 2 s 0
(@ Use height above sealevel andterp, | Graph (O Monthly average Erbs model o F b A M J J A s o N o

(@ File with 8760 hourly valuss Impart
O Import air density ki | IMBOTE p FROM PVGIS year 2015 = Graph
Do nat congider reduction in Power after. Annual Inflation Rate expectad for\Wind | Max. ariation of Wind Turbines Cost expectad (2.g. for an expected 36% [ .

Turhing Costs: % reduction on current\Wind Turhines cost, introduce "-35%6"): “

14mfs v | (checkifwindt are pitch controlled)

Limitis reached in 42.9 years

We must indicate the kind of roughness of the surface of the terrain (already chosen on the wind
screen, but here it could be changed). Let’s suppose the terrain is of Class 2, we change it:

surtace Houghness

Clas Length 01 m

Agricultural area with some buildings and preserving
hedges 8 meters high with an approximate distance
of 500 m.

Fower curve measured at air density (kgfm3): l 1.225 J
2 |] m
1.221 kg/m

In our case it will have no effect as the wind speed was downloaded at 100 m height, same
height as the wind turbine height, therefore the wind speed will not have to be converted to the
hub height.

Height above sea lewel:

Air density atthat height is (1S

We suppose the air density conditions of the power curve supplied by the wind turbines
manufacturer is the default at standard conditions, sea level and 159C, that is, 1.225 kg/m?3,
therefore we don’t change it.

The altitude above sea level was already updated when we obtained data from NASA, in our
case 109 m above sea level. This is an average value for several km?, let’s suppose we know the
height for our location and it is 30 m, we change to this value.
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MHOGA shows the air density at the height above sea level (in our case 1.221 kg/m3) and it
shows the power curve of the wind turbine selected by the mouse in red in standard conditions
and in green (over the other curve) the power curve considering the air density at the height
above sea level of our case. In our case, as the altitude above sea level is 30 m (very low), the
two curves are practically the same.

WindT1

VY

0 2 4 6 8 10 12 14 16 B 20 2 24 2
WIND SPEED (m/s)

W — P_in standard conditions (sea level, 13°C), 1.225 kg/m3
W— P_at altitude of the place (30 m), 1.221 kg/m3

We will consider the effect of the ambient temperature (the corresponding box is selected by
default), using the previously PVGIS temperature downloaded.

Arnbient Temperature at hub height (BC)

© Monthly average [0 J 182 F7.9 M181 A[BS M[19.4 J|207 J|216 Al225 5|23 0225 Mj209 D194
&+ File with 3760 hourly alues Import FROM PYGIS pear 2015 »
-

If we click on "Graph" we see the representation of the hourly temperature, same as the shown
for the PV generator. Click on “Back” to return to the wind turbines screen.

When MHOGA performs the simulation of the different combinations of components (when
optimizing the system), for each hour of the year it will adjust the power curve of the wind
turbines to the air density of that hour. We can choose to calculate the hourly air density by
using the height above sea level and temperature (if the temperature effect is considered by
checking its checkbox, as default) or we can import the air density hourly file (8760 rows, in each
row the hourly air density in kg/m3). We don’t change it.

YWhen simulating, adjust power curve with air denszity:
* |lze height above zea level and temp.

(_Graph
" Irmport air dengity [kgfm3)

By clicking the “Graph” button we can see the hourly air density, calculated for each hour
considering the height above sea level and the hourly temperature:
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Air Density
134
132

128
1.26
124

122WWM

1.18

kg/m3

1.16
1.14
1.12

< > -10
[JHorizontal Grid  [JAR [ Vertical Grid Days display

Scroll change (days)-> small: large

Click “Back” to return to the wind turbines screen.

In the bottom of the wind turbines screen we can select (as default) not to consider the
reduction in the output power of the wind turbine (due to the density lower than standard) after
a specific wind speed. It must be selected if the wind turbine is pitch controlled (usual for wind
turbines as the one of 2 MW), as the output power above around 14 m/s is limited to its rated
power, so after that wind speed the power curve isn’t reduced. We leave this check box checked,
as by default.

[v Do not consider reduction in Power after:

|'I4 miz | [check if wind t. are pitch controlled)

Also in the bottom of the screen we should set the annual inflation rate expected for the wind
turbine costs (default -1%) and the maximum variation expected for that rate (default -35%).
We leave the default values and MHOGA informs us that this maximum reduction in cost will be
achieved in 42.9 years: (1-0.01)*°=0.65. These data will be used to calculate the replacement
cost when the wind turbines must be replaced (after 20 years lifetime) and to calculate the
residual value of the wind turbines when the system lifetime ends (in the year 25).

[v Do not consider reduction in Power after: Annual Inflation Rate expected for Wind ’1— . M ax. Wariation of Wind Turbines Cost expected (e.q., for an expected 35% ’T .
14mis v [check if windt, are pitch controlled) Turbine Costs: % reduction on curent Wind Turbines cost, introduce "-35%"): %
0K Limit is reached in 42.9 pears

In the right part of the window we can select to consider wake effect in the wind farm by
selecting the checkbox “Wake effect”.

) Fixed Operation and
WindT1 Maintenance Cost

2 -
Losses wires, transfarmer.
%

VY

0 2 a4 6 8 10 12 14 16 18 20 22 24 26
WIND SPEED (mis)
[ Wake effect
¥ = P.in standard conditions (sea level, 15°C), 1.225 kg/m3
[#— P. at aliitude of the place (30 m), 1.221 kg/m3 Wake effect
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By clicking in the button “Wake effect” we can see the parameters to be considered in the wake
effect.

WAKE EFFECT: Thrust coefficient (Ct)

(Gonzalez-Longatt, et al., Renewable Energy, 2012)

Wind turbines divided in number of rows: 06

Distance between rows / rotor diameter:

alpha coefficent: ~|0.07

0 2 4 6 8 10 12 14 16 18 20 22 24 26
‘Wind turbines thrust coefficient (Ct): WIND SPEED (m/s)

im/s 2m/s 3m/s 4mfs Sm/s 6m/s Tm/s 8m/s Im/s 10m/s M mis 12m/s 13m/s

o 1b b Jps |pm oo Joro | ars Jors | Ipw s o |

14m/s 15m/fs 16m/s 17m/s 18m/s 19m/s 20m/s 21 m/fs 22 m/fs 23 m/s 24 m/s 25m/s 26 m/s
ors Jfss Jfore Jon ]|

OK

In this case we will not consider the wake effect (we suppose all the wind turbines are in the
same row” therefore we will not check the “wake effect” checkbox).

Finally clicking "OK" it returns to the main screen of the program.

13. Batteries data.

By clicking on the button "BATTERIES" we can define the batteries to be taken into account in
the project.

« BATTERIES

The battery screen shows a table where by default just one type of battery is taken into account.
Itis a battery of 5 MWh (5 kAh x 1 kV = 5 MWh), with an acquisition cost (CAPEX) of 1.5 M€ and
an annual O&M cost (OPEX) of 1% of the CAPEX. The minimum SOC allowed is 10% and the self-
discharge is 1%/month. Its maximum allowed current is 2.5 kA (that is, C/2), roundtrip efficiency
92% and float life at 202 of 15 years (conservative value). The cycles to failure vs. depth of
discharge (DOD) curve is shown in the table, from 10% DOD to 90% DOD (shown in the graph
below in red, while in green it is shown the cycled energy during its lifetime, under the graph
the average value of the full equivalent cycles is shown, in this case 4799.9 cycles).

We could change some of these data (first modifying the name) and we could add more batteries
to the table, but we will not do it.
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VI BATTERIES - [m] X

M| « & | =
Add Batteries family | | <]
BATTERIES DATA: Float life at °c Cycles to Failure vs. Depth of Discharge (%)
Name Cnom.(kAh) Vol(ky) CostME) COWMZ]  SOCmin(%) Seli_c(%/mon) Imax(kd) Efi(%) Floatyr) 10%  20%  30%  40% 50% 60% 70% &80% 980% 100% TYPE
» Batihivh 5 1 15 1 10 1 H 52 15 48000 24000 160O0 12000 9600  BOD0  BB57  BODD 6333 4000  Li
Batteries Model
@®ah [ Liion model Ah Fixed Operation and Maintenance Cost: El £hr Equivalent CO2 emissians (manufacturing..) key CO2 equiv/ kWh capacity
i Ausliary cooling, BMS... cons. AC (% of max. P} S0C atthe begining of simulation: {100 | % of SOCmax
O KiBaM (Marwell-McGowan 1993) U a ( ) gining
() Copetii 1994 [Joccans. Li-ion batteries masdrnurm SOC: %

() Schiffer 2007 Bat5MWh of 5 kAh

=
'é'ernp Jfie ] MAMJN;'EB” Q) W 40960 \ m?
(0 d[z_lafee ]szz Jofo |nfie [ofs | o ;51 32,768 15%
e et [TREARUAR] O S 2157 g
Flaatlfe reduces 50% foreven[10 |‘Cincresse | 5 T Graph £ 530 wg
[<] Cyele life depends on T Data. é 0162 5 &
[]Capacity depends on T Data , , E
Lead-acid Aging battery model  Liion Aging battery model o oW N 0 @ 7w e w0 0

DEPTH OF DISCHARGE (%)
Wang et al, 2011 (LFePO4
8G,:?Sé‘,azmg (Ll(FIEPEOﬂ) ) Number of full equivalent eyeles fanky > SOCmin: 4798.9

O saxenaetal. 2016 (LiCo02)
O Full equivalent cycles

(®) Rainflow (cycle counting) Parameters Annual Inflation Fiate expected for % Max. \Variation of Wind Batteties expected (2.q. far an expected 60% .
(O Naumann, 2020 (LiFePod cycreal) Batteries Costs ° reduction on current Batteries cost introduce "-50%") %
Limitis reached in 45.4 years
PRernaining capacity ot battery end of life (56) :

[ifthere s an An AC Gen. every days or squivalentfull cycles -> chargs battery bank at leastup o %

In the last column of the table it is seen that the battery is Li-ion type (defined by “Li”).

We will take into account the standard Ah battery model. Regarding the average monthly
temperature, we leave the default values, taking into account that the temperature is the
average at which the batteries are estimated to be (we could import hourly values but we will
not do it, we will use the same value for all the hours of each month, considering the batteries
are into a building and the temperature is similar for all the hours of the month; we can see the
graph by clicking “T Graph” button). The lifespan of the Li-ion batteries will be calculated
according to the Rainflow (cycle count) aging model.

Bamareshiodel Fixed Operation and k
@ Li-ion model Ah

(O KiBaM (Manwel-cGowan 1993)
(O Copetti 1994
() Schitfer 2007

e [ [ e |

E A |

[ Except Schiffer model, consider @ von.

L
Import hourly file
Tmean>=Tfloat life P () Hour
oC increase 1= T Graph

Lead-acid Aging battery model Li-ion Aging battery model

() Wang et al., 2011 (LiFeP04)
() Grot et al., 2015 (LiFePO4)

OSaxena et al., 2016 (LiCo02)
Equivalent cycle
© Ramﬂow (cyc\e countmg]

Farameters

Cycle life depends on temperature, we leave the checkboxes “Cycle life depends on T” and
“Capacity depends on T” checked.

39



With lithium-ion batteries, we can use specific ageing models, however if we are not sure our
battery is the same as the one tested in the different models, the best option would be to use
Rainflow model (it will consider the cycle life vs depth of discharge DOD).

After you select the model, click in “Parameters” button and you should be sure that the
calendar ageing model is included, then both calendar and cycle degradation will be considered.
In some cases (specially in stand-alone systems where cycling degradation is low), if you do not
include calendar ageing you can obtain very high battery lifetime, which would be not real.

Wang Grot  Saxena Calendar ageing Naumann

[]Include calendar ageing : ;
Petityet al., 2016 .+ [0.05
in ‘Wang and Saxena modeals ® ’ - Llimit (cycle / calendar): C
() swigrczynski et al., 2015
[+|Include Calendar in Full eq. cycles and Rainflow models
Data (Fetitet al.. 2016): Data (Swiefczynski etal, 2015);
ade(7e)=8 expL AR )] T2 B0E(00)=(a-S0C b+c) (d- T e+)tg
S0C 30% 65% 100% a |U-019 | b |U-923 |
B |739:3 | [675E3 | [228e3 | ¢ [o5105 | d [3258 |-10m0
A [73369 | [69804 |[56937 \ e [s.087 | f [n.295 |
z |u.943 ||0.9 ||D.683 | .
graph T(°C): graph: T(°C): SOC(%]:
g€ _ 40
g > < 3
< 16 8
= 2 »
g 8
2 £ 16
S 0 4
0 5 10 15 20 25 g 8
Time (years) 0
0 10 20
= S0C 30% - S0C65% =-— S0C 100% EOL o
Time (years)

oK

You should set a threshold limit to consider cycle or calendar ageing, by default a C-rate of 0.05
is the limit (we leave the default value). During the simulation of each combination of
components, in the time steps when the C-rate is lower than this value calendar ageing will be

considered and when it is higher cycle ageing will be considered. Then click “OK” to save the
changes.

If we click in “Data” button close to “Cycle life depends on T”, we can see the following window,
where the parameters a, b and c show the temperature dependence of the cycles to failure (%),
being 100% for 202C and being reduced as temperature increases (curve obtained from
https://midsummer.ie/pdfs/fronius-performance-solar-battery.pdf). By default, the
temperature considered is the temperature during all time (not only during charge/discharge),
and below 202C there is not considered any increase in cycle life. We leave the default values.
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Cycles to failure (%) vs Temperature (*C): (forfull eq. cycles and Rainflow models)
Cycles (%)=100 (a+bT+cT

100 g
804
s04--

a=[162 ]
FIE .

b =[-0.0354 20§ : ; :
ot : ; -

c=|0.0002 20 30 40 50

Temperature (°C)

Cycles (%)

Temperature iz the average:

% Ambient temperature during all time " Ambient temperature during charge/discharge

v Below 20°C no increase in cycle life

OK.

If we click in “Data” button close to “Capacity depends on T”, we can see the following window,
where the parameters a, b and ¢ show the temperature dependence of the capacity (%), being
100% for 20°C. In the simulations, considering the hourly temperature of the battery, the
maximum capacity (energy that the battery could discharge if it was at full SOC) during each
time step will be calculated with this curve.

Capacity (%) ws Temperature {*C

Capacity (%) =100 [a + bT + cT72)

a=|0.8
b=0.012
c=|[-0.00011

Capacity (%)

Temperature (°C)

At the bottom, we can set the remaining capacity at battery end of life (default 80%), that is, we
consider that when the remaining capacity is 80% the battery will be dead and it must be
replaced, we leave the default value.

Also, we can check the box “If there is an AC Gen., every ....” so that the backup generator will
charge the batteries after a specific number of days without full charge or after a specific number
of full equivalent cycles. In this case we leave this unchecked, as this has no sense because there
is no load consumption, there is no AC generator and we have the AC grid.

Remaining capacity at hattery end of life () |80
[ithereis an An AC Gen., every days or equivalent full cycles -> charge battery bank at least up to ES

An annual decrease of the battery acquisition cost of 2% is set by default, with a limit of -60%
(reached in 45.4 years), therefore when the batteries must be replaced, the acquisition cost will
be obtained considering this reduction.

Annual Inflation Rate expected for . tdaw. Wariation of *ind B atteries expected [e.q., for an expected B0% -
Batteries Costs: 2 2 reduction on current B atteries cost, introduce "-B0E"); £0 =

Lirit is reached in 45.4 vears

We will use the rest of the default data. Finally, we click “OK” to return to the main screen.
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14. Minimum and maximum number of components allowed in parallel.

In the main screen of the software, GENERAL DATA tab, we can see a box where we must set
the minimum and maximum number of components allowed in parallel. Default numbers are:

MIN. AND Mak. No COMPOMNENTS IN PARALLEL:

Bateries in parallel: ki, |1 [LENS ’5—
P gen. in parallel: Min. |0 [LETS ,S—
Wind T. in parallel Min. [ Maw [T

LS

These values must be selected by the designer, depending on the minimum and maximum size
he/she wants to allow of the different components.

In our case, we want to consider the possibility of not having batteries nor wind turbines in the
system, therefore min. number of batteries and wind turbines in parallel will be changed to 0.
The maximum number of batteries in parallel is 5, it is ok (if 5 in parallel, the whole battery bank
will be of 5 parallel x 5 MWh = 25 MWh). As the maximum output power to be injected in the
grid (defined previously) is 23 MW, 8 PV generators of 1 MWp in parallel can be too few. We
change the max. number of PV gen. in parallel to 30 (therefore the maximum PV generator will
be of 30 x 1 MWp = 30 MWp). We will change the max. number of wind turbines in parallel to
15 (therefore the maximum wind turbines group will be of 15 x 2 MW =30 MW).

Therefore, the final values will be:

MIM. AND Mé No COMPOMEMTS IM PARALLEL:

Batenes in parallel: Min. |0 Maw. |5
P gen. in parallel: Min. |0 Maw. |30
“Wind T. in parallel: Min. |0 Max, |15

S

15. Inverter-chargers data.

By clicking on the "INVERTER/CHAR." button we can define the inverter-chargers to take into
account in the project.

|7 e RTER/CHAR |

The table shows three inverter/chargers considered by default, of 5, 10 and 20 MW.
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A INVERTER/CHARGERS - [m] X

Add from Database = ~

"R + | =
Include anly VDC suitable from family. | ~]
GENERAL DATA EFFICIENCY (%) vs. OUTPUT POWER (%) ->
Name Power(MyA) Lilespan () Cost () Imax_ch_DC(kA) Ef_charger(%) Vdomin(ky) Vdcmax(k) Pmax_ren(Mv) 0% 2% 3% 4% 5%  10%  20% A
In-ChEMWY 5 15 05 5 9% 09 11 1ETS 10 30 50 70 8 93 92
Inv-Ch O/ 10 15 1 10 9 09 11 1ETS 10 30 S0 70 8 93 92
» Imu-Ch20mi 20 15 2 20 a8 09 11 1E15 10 30 50 70 85 93 92
v
< >
Inv-Ch20MW Mesc output powsr in sumultaions of
o 30 minutes % higher than naminal
80 15 minutes: higher than naminel
_ 2 10 minutes %% higher than nominal
£ 6
= <=6 minues: [30 ] % bigherthan nominal
% 56
G 48
o
0 IfP. max. renewable DC » P max. ren.
32
24 (O Limit P. from renew. DCto P ma ren
16 @
Discard that combination
[CPraportional to 15t ane:

Inverter rated power far 0 10 20
bat, duration (hours)

30 40 50 60 70
OUTPUT POWER (% OF RATED)

We can see, for the different inverter/chargers, nominal power (MVA), lifespan (15 years),
CAPEX, maximum current in DC (kA, we can see it is the same as the power in MVA as voltage is
1kV), charger efficiency (%), minimum and maximum DC voltage (as DC bus voltage was defined
1 kV, these limits must be around this value), and efficiency vs. output power of the inverter.

As the maximum capacity of the battery bank can be 25 MWh (max. 5 in parallel of 5 MWh) with
a maximum power of 5x2.5=12.5 kW, the maximum inverter power (20 MW) is enough, also
considering that the maximum output power to be injected to the grid is 23 MW. We will add
an inverter of Zero to consider the possibility of not including inverter (select in the list close to
the “Add from database” button and then click that button):

GENERAL DATA EFFICIENCY (%) vs. OUTPUT POWER (%) ->
Marne Powst(Mvis) Lifespan () OostME) Imax_ch_DO{ka) Ef chargar®s) Vdomin(kv) Wiomex(ky) 0% 2% 3% 4% &% 10%  20%  30%  40% ~
Im-ChEhdv 5 15 05 5 98 03 1110 o s 0 8k 93 57 30 B4
n 15 1 10 i 03 11 10 a5 0 #E 93 57 N B3
3% 20 15 2 20 98 0.8 1110 3w s 0 EE 93 52 30 B
0 100 i 0 100 03 11 700 100 100 100 100 00 100 100 100
v
< >

Finally clicking "OK" it returns to the main screen of the program.

16. Constraints.
In the main screen, in the "GENERAL DATA" tab, there are five possible restrictions:

-The maximum investment cost (maximum system CAPEX). Let’s suppose we don’t want it to be
higher than 100 M€ (combinations with total investment cost higher than this value will be
discarded). We change the value to 100.

- The minimum renewable capacity factor (annual energy sold divided by the peak renewable
power multiplied by 8760 h) (by default 0%, so by default this constraint is not considered). We
leave the default value. If you check the box “Pmax_sell”, then the capacity factor will be
calculated as the annual energy sold divided by the maximum power that can be exported to
the AC grid (23 MW in our case) and multiplied by 8760 h.
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- The minimum renewable fraction (by default 0%, so by default this constraint is not
considered). It is calculated as the annual energy injected to the grid minus the annual energy
injected to the grid by the fossil fuel generator, divided by the annual energy injected to the grid.

- The maximum unmet load (load energy not served, by default allowed 100%, so by default this
constraint is not considered). This is the unmet load that cannot be supplied by the system nor
by the AC grid. In our case we have no load therefore it has no meaning.

- The maximum unexported energy (by default 100%, so by default this constraint is not
considered  %). Unexported energy (%) id defined as: (Exported_energy-
Sold_energy)/Exported_energy*100.

- The maximum land use (by default a very high value, that is 1E10 ha, so by default this
constraint is not considered). We leave the default value. With button “Data” we can set the
land occupied by each technology.

Constraints under NP maximization:

bax. nvestment cost 1E10 hAE

Ik

tin. Capacity Factor 2 [ ] Prax_sell
tin. Fenew. Fraction %

bax. Unmet load 100 S

Max. Unexpored E. S

hax. Land use ha | Data

17. Maximum execution time allowed.

In the main screen, in the "GENERAL DATA" tab we should set the maximum execution time
(maximum time the optimization can last) and who (the user or MHOGA) must set the
optimization parameters (recommended MHOGA). The longer the time allowed the more likely
it is that all the possible combinations can be evaluated and thus obtain the global optimum. If
sufficient time was not allowed, genetic algorithms metaheuristic technique will be used to
optimize the system (without evaluating all combinations) in the allowed time. We will leave the
15 minutes by default, enough time in this case so that all possible combinations can be
evaluated (enumerative method).

OPTIMIZATION PARAMETERS SELECTED BY:

(@) HOGA (JUSER
M aximum execution time:

||] |h. |15 | min. Parameters
birirmum time for the Genetic Algarithms

If we pass with the mouse on the zone of maximum and minimum number of components in
parallel (see section 14) we are informed that the method chosen for the optimization will be
the enumerative method (EVAL. ALL, to evaluate all the possible combinations), since the
allowed time (15 minutes) is greater than that needed to evaluate all the combinations. There
are 11904 possible combinations: 1 type of PV gen. multiplied by 31 possible cases in parallel
(from 0 to 30) multiplied by 1 type of wind turbine multiplied by 16 possible cases in parallel
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(from 0 to 15) multiplied by 1 type of battery multiplied by 6 possible cases in parallel (from 0 to
5) multiplied by 4 types of inverter/chargers. In this computer the estimated calculation speed
is 21.3 cases per second, so in 9'17" it is expected that all combinations will be evaluated and
the optimum will be found.

NUMBER OF CASES AND TIME EXPECTED

Computation speed: 21.368 cazes/zecond

EVAL. ALL POP. [ ALL) GEM.ALG. [%ALL)
MalN ALG. [COMB. COMPOMENTS): 11904 1358 (11.41%) 19223 (161.53%)
[1x11304]
SEC. ALG. [COMEB. STRATEGIES): 1 3(300%) 41 [4100%)
MalM ALG.  SEC. ALG.  NWUMBER OF CASES 4 i RECTED

OFTION 1. EVAL ALl EMAL ALL. 11304 100 % @
OFTIOM 20 EWAL ALL  GEM.ALG. 483064 100%  BR20
OFTION 3 GEN. ALG.  EWal ALL. 13223 161.5% 0Oh14'63"
OFTIOM 4 GEM.ALG. GEM.ALG. 783389 EE229% 10h14

O ptimization by means of enumerative method [evaluating all combinations). |t iz guaranteed to obtain the optimal
s0lution

18. Financial data.

In the main screen, in the "FINANCIAL DATA" tab, we must set several economic variables
(nominal interest rate or nominal discount rate, general inflation, study period, currency,
installation costs, and loan). Let's leave the data by default.

By default, at the end of the study period (25 years) the residual cost of the components will be
considered as incomes.

Also, by default the LCOE (levelized cost of energy) and the LCOH (levelized cost of hydrogen)
will be calculated considering in the energy the real discount rate (see user manual, section
3.1.4). By default, in maximize NPV systems, for calculating LCOE or LCOH it will use the
electricity sell price inflation and the hydrogen sell inflation instead of the general inflation.

The installation cost and variable initial cost considered is 25% of the initial cost. This means that
the total CAPEX of all the components will be multiplied by 1.25 to obtain the investment cost.

Also, by default, 100% of the CAPEX is obtained with a loan of interest 7% and duration 25 years.
No corporate taxes are considered by default (0%).

GENERAL DATA OPTIMIZATION CONTROLSTRATEGIES FINANCIAL DATA RESULTS CHART

ECOMNOMIC DATA:

Mominal interest rate (capital cost) % Annual real discount ratel (%) Loan (constant quota, French systerm)
(nominal discount rats) .

. 43% Armount of loan %
Annual inflation rate (O&M..): % [“]In LCOE / LCOH include real disc. rate in Enargy ofthe initial cost of investment

| In maximize NPY systems uze Inf. sell fH2Z
Study period (systemn lifetime) years 4 ! Loan Interest o

[in max. NP, LCOE calculated with Esell+Eload
[+] Atthe end of the study period consider the residual cost of the components

Currency |Eura (£) ~

Installation cost and wariable initial cost D A€ Fix + % of initial cost

If in & year costs>incomes, taxes=0 thatyear
Corporate taxes (3] EI
Megative taxes accumulate and are offset later when taxes >0

Duration of loan: ML

Extra Cash Flow
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18. Optimization type.

In the main screen, tab "OPTIMIZATION" we can see that for maximization of NPV projects just
mono-objective optimization (economic optimization) is allowed.

GENERAL DATA  OFTIMIZATION l CONTROL STRATEGIES l FIMAMNCIAL DATA] RESULTS CHART
OPTIMIZATION TYPE:

In WP Optimization kono-objective optimization only [maximization of MEY)

[~ Show diagram

If the project type was maximization of NPC, multi-objective optimization could be chosen.

19. Calculate (optimize the system).

Before calculating, it is recommended to save the project (in the main screen, upper menu

Project-> Save). Also, periodically you should save the project.

In the general screen, clicking on the "CALCULATE" button, the calculation of the optimization
begins. In our case, the only restriction is the maximum investment cost allowed.

88 CALCULATE

20. Results. Best solution found

MHOGA evaluates all the possible combinations of components and control strategies (but in
this case the control strategy is the grid-connected batteries management for energy arbitrage,
fixed in this case). Each combination is simulated during a whole year, in this case in steps of 1
hour. If that simulation meets the constraint (max. investment allowed is 100 M€), then it
calculates the Net Present Value (NPV), considering all the costs and incomes during the lifetime
of the system (25 years) and converting all of them to the first year (taking into account inflation
and interest rate). The combinations that do not meet the constraint are discarded, assigning
them a NPV of —infinite (and showing them in the results graph with 0 NPV).

The optimization time depends on the computation speed of the computer. In this case the real
computation time has been a bit lower than the expected time.

Once the evaluation of the different combinations is finished, the results are shown.
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GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

Mono-objective optimization. Total No. of cases evaluated: 11904. Time: §' 39"
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1 2 3 4 5 6 7 8 9 10
GENERATIONS
[] show diagram
Total NPV (M€) Ernission (COZA7) Unmet(GWhin) IRR(:)  Land(ha) Investment(ME) CapF(%) LCOE(€KAN)  Simulate  Report
1 49.929 112 0 1859 540 375 43.59 00295 SIMULATE.. REPOR
2 49514 116 0 1609 543 39 4268 00304 SIMULATE.. REPOR
3 9.1 112 0 1826 540 38125 4359 00303 SIMULATE.. REPOR
4 19.069 119 0 1783 546 05 4181 00311 SIMULATE.. REPOR
5 48.696 116 0 177 543 39,625 4268 0.0303 SIMULATE.. REPOR
6 48.584 122 [T 549 4 40.98 0.0316 SIMULATE.. REPOR
7 48.292 112 [REET] 540 3875 4359 00308 SIMULATE.. REPOR
8 48.25 119 0 173 546 41125 4181 00316 SIMULATE.. REPOR
El 48.065 1.25 0 1677 562 a5 4018 00324 SIMULATE.. REPOR
v
< >
COMPONENTS: 15Wind Turb. WindT1 (2 MW at 15 m/s) /¥ Unmetload = 0% 4 Total Net Present Value (NPY) = 49.928 ME, IRR - 16.6%
STRATEGY: There is no lnad cansumption -> no contral strategy related to the load consumption supply. Ab.: Contral variables for gric-connected bateries: charge
(onlyfrom renewsble, not from grid) i price of E. (sell)is lower than 0 Adwh: disch. (load + injecting tathe grid) i price E. (sell) higher than 0.11 £4Wh

Seeben SaveEvcariatie

Note that the user can obtain values slightly different because a correlation factor and
standard deviation have been applied in the internal calculation of the 1-minute step
irradiation and wind speed, implying that a randomness is applied. It will also happen in the
next sections.

In the "RESULTS CHART" tab it is shown the graph of the total cost of the best solution (in red)
and of the life cycle annual CO2 equivalent emissions (green) of the 10 best solutions found.
MHOGA has used the ENUMERATIVE METHOD, that is, all possible combinations have been
evaluated. In addition, instead of the scheme of the components, a table with the results of the
best combinations appears. The table shows the 10 best combinations ordered from best to
worst: the best is the first of the table (#1), second best is the #2,....

The number of the best combinations shown (in this case the 10 best ones) can be modified in
the text field of the bottom left corner, and then clicking in the button “See best”. For example,
change it to 100 and click that button:

Seebest | 100

The first 100 best solutions are shown now:
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GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

Mono-objective optimization. Total No. of cases evaluated: 11904. Time: 8' 38"
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4 & 12 16 20 24 28 32 36 40 44 48 52 56 60 64 68 72 76 80 84 88 92 96 100
GENERATIONS
[ Show diagram
#  Total NPY (£) Emission (KCOZ4T) UnmetfGWhiy)  IRFR(%)  Land(he) InvestmentiME) CapFi%) LCOE(EMWH)  Simulate Report ~
1 49.929 112 L] 1859 540 375 4359 00248 SIMULATE.. REPOR
2 49.514 116 L] 18.09 543 k] 4268 00304 SIMULATE.. REPOR
3 49.11 112 0 18.26 540 38125 4358 0.0303 SIMULATE.. REPOR
4 49.069 1.19 0 1763 546 40.5 4181 0.0311 SIMULATE.. REPOR
5 46.696 1.16 0 17.78 543 39625 4268 0.0309 SIMULATE.. REPOR
4 48.584 122 o 1719 549 42 4098 00318 SIMULATE.. REPOR
7 48.292 112 1] 17.84 540 38.75 4359 00308 SIMULATE.. REPOR
8 48.25 119 1] 17.33 546 41125 41.87 00316 SIMULATE.. REPOR
9 48.065 125 1] 16.77 552 435 4018 00324 SIMULATE.. REPOR "
< >
COMPOMNENTS: 15 %ind Turb. WindT1 (2 MW at 15 my/s) /f Unmetload = 0 % /f Total Net Present Value (NPY) = 49.929 ME, IRR = 18.65%%
STRATEGY: There is no load consumption -> no contral strategy related to the load consumption supply. Arb. Control variables for grid-connected batteries: charge
{only from renewable, nat fram gric) if price of E. {sell) is lower than  £/kih: disch. (load + injecting to the grid) if price E. (sell) higher than 0.11 £/Wh

100 Sewe Excel tahle

To see the diagram of the components, click on the "Show diagram" button above the table, on
the right:

Show diagram

Appearing again the diagram instead of the table:

IV Show diagramt

Wind T.

I

] \
BB BDD
_ @

AC

InverteriCharger Load /

(Bi-directional rid

inverter) pc g
Battery

Seebest ||100 Save Excel table

To see the results table again, uncheck "Show diagram".

Below the table the characteristics of the optimal solution (corresponding to the first row of the
table) are shown. This text can be copied (select and Ctrl + C).

COMPONENTS: 15 Wind Turb. WindT1 (2 MW at 15 m/s) // Unmet load = 0 % // Total Net
Present Value (NPV) = 49.929 M€, IRR = 18.6%.

STRATEGY: There is no load consumption -> no control strategy related to the load consumption
supply. ARB.: Control variables for grid-connected batteries: charge (only from renewable, not
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from grid) if price of E. (sell) is lower than 0 €/kWh; disch. (load + injecting to the grid) if price E.
(sell) higher than 0.11 €/kWh

We can see the best solution (first row) in this case is a wind farm of 15 wind turbines, without
PV nor batteries. If we move through the table with the bottom bar, and focus on the 1% row,
we can see there is no PV (0x1 MWp, that is, O in parallel), no battery (1x0x5 Ah, that is, 1
series x 0 in parallel), no inverter.

Costs F. PV (Mwvp_clc) Sloped1(§)  Cn Bat (kah) . Gen (M) P | Poing T. (M) F Tk (m3fs) PFC (MW) P Ebez. (MW) HZ tank () A
COSTSN_ 01 105 1x0 15x2 0 0 0

21. Simulation of the best solution.

We can see the simulation of the operation of the optimal solution (first row) by clicking on the
first row of the table, in "SIMULATE":

Emizzion (CO247 Unmet{GWhan)  IBR(*)  Land(ha) Investment(ME) CapFi(%) LCOEEMWH) Simulate Report ~
112 0 168.52 540 378 43.45 ™z99 SIMULATE.. REPOR

The simulation screen appears as shown below (if it has not appeared, click on the HOGA icon
in the taskbar at the bottom of the computer screen and the simulation screen will appear):

Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator \Waterload /PHS  MULTIPERIOD

Simulation of 1 year, all the years the same.

POWER (MW) /H2 Tank AVATER tank (Mh)

14
12
10
8
6
4
2
5 0 1 2 3 4 5 3 7 8 9 0 1 2 13 14 15 16 47 18 19 20 24 2 23 0
Legend 1 January
< > Days disp.
POWER CONSUMED OF: SUPPLIED (M) F— [Jsee Over
Batter bank Discharge Plim Charge Legend
P2 BATTERY ENERGY (Miwh) [JHLGr
| O Electrolyzer soc ClHAGH
0 E mix disch. hatt E.H2tank (HHYH2) R P1 [Jv.Grid
S0C limits et
Battery bank Charge P critical Gen.
[] Export Energy Cap. Max Scroll
Efa supply FC P critical Fuel Cell changs
Wind Turb S0C setpoint Gen (days)
| e 30C setpoint FC Small:
Wtor B E bought to AC grid || Prmax P
ater Pum)
P AC Generatar E sald to AC grid Pmasx Large:
[] Pmeax input Inverter H2 TANK satooint (HHY H2) SOC(0-1)| | T full charge
[ Pmax Gen
Simulation step (min): (60~ [2 Back Seve data Save Simulation Data Save Prob. Dats

COMPONENTS: Wind turhines of 30 M

STRATEGY: There is no load consumption -> no control strateqy related to the load consumption supply. Arbitrage: Control variables for grid-connected batteries: charge (only from renewahble, not from
grid) if price of E. (sell) is lower than 0 £/kWh; disch. (load + injecting to the grid) if price E. (sell) is higher than 0.11 £/kwh

There is no load consumption

We can move through the days of the year moving the bottom bar cursor or clicking in the
bottom bar. We can see the legend clicking in “Legend” at the left bottom corner of the graph.

We can see several days in the screen changing the number of days to display, for example to
10. Also, clicking in the “H.L.Gr” se see the horizontal left axis grid, clicking in the “V.Grid” we
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see the vertical grid, and with Scroll change (days) Small: 0.1, each time we click the scroll arrow

it moves 0.1 day, and with Large: 1, each time we click in the scroll it moves 1 day. Moving the

scroll we can see for example the days 13-23 of April. We can check to make visible and uncheck

to make invisible the checkboxes of the different variables (load, wind turbines power

generation, electricity sold to the grid...).

Hourly simulation  Hourly values separately  Monthly and Annual Average Fower  Monthly Energy  Annual Energy  Hydrgen  AC Generator Waterload /PHS  MULTIPERIOD

30 4
23
26
24
22

POWER (M) /H2 Tank /WATER tank {MVh)

a1
61
4]
2]
o4

[lLegend
<

| O
O

[] Export Energy

Water Pump
[ Pmax. input Inverter

Simulation step (min): B0

Simulation of 1 year, all the years the same.

13
Q April
POWER CONSUMED OR SUPFLIED (M)

Batter bank Discharge
Electrolyzer
E. max disch. batt E. H2 tank (HH H2) R
Battery bank Charge
E ta supply FC

Wind Turb.
R E boughtto AC grid Pmax
AC Generator E sold to AC grid Pmax
[ Pmax Gen

[ Back

COMPONENTS: Wind turhines of 30 Mid'

Plim Charge
P2

P1
P critical Gen.

P eritical Fuel Cell

H2 TANK setpaint (HHY HZ)

Save daia

21 22

Energy price
BATTERY ENERGY (MWh)
sS0C
SO0C limits
Cap. Max.
S0C setpoint Gen
S0C setpoint FC

S50C (0-1) T. full charge:

Save Simulation Data

Total Load

Unmet Load
= Wind T

Sell E to grid

° Days disp
DSEE Owver

Legend

[ Grid
[
Serall
change
(days)
Small
Large:

Sawve Prob. Data

STRATEGY: There is no load consumpation -> no control strategy related to the load consumption supply. Arbitrage: Control variables for grid-connected batteries: charge (only from renewable, not from
grich) if price of E. (sell) is lower than 0 £/kivh: disch. (load + injecting to the gric) if price E. (sell) is higher than 011 £/kivh

There is no load consumption

We can see the different tabs of the simulation screen (“Export” is the energy which can be

exported, that is, excess energy not used by the system). As we have no load, no storage, the

system does not use any energy, so all the energy generated by the sources is export energy.

However, not all the export energy is sold to the grid, because in our case we have a grid limit

power of 23 MW, and during some time steps the generation is higher (up to 30 MW), therefore

there is a small curtailment which cannot be sold to the grid (sold power limited to 23 MW).
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Hourly simulation  (Hourly values separately) Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Waterload / PHS  MULTIPERIOD
HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
30
. (gl i D
0 0 J # ! ‘, 1
10 1 ) e
| | | 1 |
0 '
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator Export
30 T = ] ,» T
MMEmr [T a I il
. : ol B o e AL [
i | § " i
10 'bw}‘ lﬁ“l'; { l.!'f i %h R uﬂ
IS ALy (MY LA R AL M
0 2.000 4.000 6,000 8.000 0 2.000 4,000 6.000 8,000 0 2.000 4,000 6,000 8.000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
0 0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0
Battery bank Charge Battery bank Discharge Energy in Battery bank
0 0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
20
0 0 10
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Simulation step (min): B0~ Back Sewve data Save Simulation Data Save Prob. Data

In the third tab, the PDF (probability density function) graphs, by default, are not shown. To
show them, go to the OPTIONS (main menu of the software, Project -> OPTIONS) and check the
box “In the simulation window, show the probability density function (PDF) of the main
results”:

In the simulation windaw, shaw the probahility density function (FOF) of the main results

When this option is selected, we see something like the following figure, third tab of the
simulation screen.

Each PDF graphs shows the probability density for each interval between the minimum and the
maximum of the power / energy of that variable. For example, for the wind turbines output
power, we can see the minimum column is for the interval between the minimum power and
the minimum power+ (maximum power — minimum power) / Number of columns. As min.
power is 0 and max. is around 30 MW, the first column is for the interval between 0 and 0 + (30-
0)/20 = 1.5 MW, that is, interval 0 MW — 1.5 MW. We can see that, for that interval, probability
density is around 0.04. For each PDF graph, the area (integral of the PDF graph) is 1. Below the
graphs we can see the mean power / energy and the standard deviation (for the wind turbines
output, mean 13.432 MW, standard deviation 7.999 MW).

We can see in the last PDF graph (lower right area) that the sold power during the year is a lot
of time the maximum power allowed by the grid (23 MW).
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Hourly simulation Huur\yva\uesﬁeparate onthly and Annual Average Power  Monthly Energy Annual Energy  Hydrogen —AC-G TS i
PROBABILITY DENSITY FUNCTION (P8 POWER (MW) OR VS, ENERGY (MWh) DURING THE YFAR - ttumber of colurmns (2] Show PDF first cal

Total Load power. PDF

PV generator power. PDF

PBf

0.04
0.02
e ———T———T—rr T

0
Power Mean: 0: Std. dewv: DMWY
Hydro turbine / TEG power. PDF

0
Power. Mean: 0: Std. dew: DM
AC generator power. PDF

0 5 10 15 20 25
Pover. Mean: 13.432: Std. dew: 7. 399MW
Export power. PDF

0.04
0.02
e ———T——— T

0
Power. Mean: 0; Sid. dev: DMWY
Fuel Cell power. PDF

0
Power. Mean: 0; Std. dev: DWW
Electrolyzer power. PDF

0 5 10 15 20 25

Pover. Mean: 13.432; Std. dew. 7.999M
Energy in H2 tank // accum. Sold. PDF

(1]
Power. Mean: 0; Sid. dev: DMWY
Battery bank Charge power. PDF

(1]
Power. Mean: 0; Std. dev: DWW
Battery bank Discharge power. PDF

0

Energy. Mean: [; Std. dew: OMwh
Energy in Battery bank. PDF

0
Power hean: 0; Std. dew: Db
Unmet load (by the standalone syst.) power. PDF

0
Power. Mean: 0: Std. dev: Dy
Purchased from AC grid power. PDF

0

Energy. Mean: 0: Std. dev: OvvWh
Sold to AC grid power. PDF

0.15
01
0.05
e —

0
Power, Mean: 0; Std, dew: Dby

0
Power. Mean: 0 Std. dev: O

0 5 10 15 20
Power. Mean: 13.077; Std. dew: 7.455MW

In the upper right area, we can change the number of columns of the PDF graphs and we can set
the first column of each PDF not to be shown, and also for the last column. For example, if we
had PV generator (it is not our case), as the most of the time its power is 0 (night time), we can
uncheck “Show PDF first col.” and we will see the PDF of the PV power without the first column.

The monthly and annual average power (fourth tab):

Hourly simulation  Hourly values separately  PDF  (Monthly and Annual Average Power

Monthly Energy  Annual Energy  Hydrogen  AC Generator Water load [ PHS MULTIPERIOD

MONTHLY AND ANNUAL AVERAGE POWER (MW)

20
19
18
17
16
15
14
s 13
s 12
§ 11
o 10
=5
3 3
7
6
5
4
3
2
1
0
1 2 3 4 5 6 7 8 9 10 1 12 13
Month YEAR
¥ [ Total Load ~ @ Unmetload M PVgen. WM WindT. O Hydo T./TEG WM ACGen. W@ Fuel Cell W@ E. bought to AC grid

VB E soldto AC grid M @ Electrolyzer

The monthly energy:
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Hourly simulation  Hourly values separately

tonthly and Annual Average Power

Manthly Energ
(ONTHLY EN

Annual Energy
RGY (GWh)

Hydrogen

AC Generator Water load /PHS  MULTIFERIOD

Total Load FV generator Wind Turbines
15
10
0 0
5
0
2 4 [ 8 10 12 2 4 [ 8 10 12 2 4 6 8 10 12
Hydro Turbine AC Generator Export energy
15
10
0 - — —
5
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Fuel Cell Electroyzer Energy (HHV of H2) in H2 tank, end of the manth
0 {-—--- - — 0
2 4 6 8 10 12 2 4 6 8 10 12 0
Battery bank Charge Battery bank Discharge Energy in battery bank at the end of the month
0
I e S S [ e T S T 0
0
2 4 6 8 10 12 2 4 6 8 10 12 0
Unmet load (by the standalone system) Energy purchased from the AC grid Energy sold to the AC grid
15
10
0 i ———————r
5
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Simulation step (min): B0 v ‘ Back Save data; Sawve Simulation Data Sewve Prob. Data

The annual energy:

Hourly simulation  Hourly values separataly  Manthly and Annual Average Power  Monthly Energy

TOTAL ANNUAL ENERGY (GWh)

Energy (GWWh)

Annual Energy \Hydrogen AC Generstor ‘Waterload / PHS  MULTIPERIOD

LOAD

Simulation step (min.): B0~ ‘

EXPORT

SOLD

WIND T

Back Save data: Save Simulation Data Sawve Prob. Data

We can save the simulation data in Microsoft Excel format. To do this, click the "Save Simulation
Data" button. Once the Excel file has been saved, when opening the Excel file it warns us about
opening the file, to which we respond "Yes".

The Excel file opens perfectly, showing for each hour of the year the different power of the
different components. At the end it shows the monthly and total annual values, the values of
the purchase and sale of energy to the AC grid (if any)...
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We must save this file by the option "Save As" of Microsoft Excel in Excel file (*.xIsx) and the
next time we open it, it will no longer show the previous warning.

A B c D E F G H ! J K L M N o P Q R s -
Project: D:\PHOYECTOS MHOGA 3.4-202403XX\MHOGAL.mho. Solution # 1

CCOMPONENTS: Wind turbines of 30 MW.
STRATEGY: There is no load consumption -> no control strategy related to the load consumption supply. Arbitrage: Control variables for grid-connected batteries: charge (only from renewable, not from grid) f price of E. (sell)is lower than 0 €/kWh; disch. (load + injecting to

HOURLY VALUES. All power values are expressed in MW (H2.load is in MW referring to the HHV of H2). The SOC data of the batteries in energy (MWh).
Water tank (Water_tank) is energy needed to pump the water (MWh) while (Water_tank_volume) is the volume stored (dam3).

No.Gen_on is the number of AC generators that are running during this time step. Hours_eq_Gen is the number of equivalent hours (including out-of-range penalty and start-up penalty) of AC generators. The fuel consumption of the Gen. AC (Fuel.Gen) is expressed in x1E6litr
Costs of purchasing energy to the grid, the fuel cost of the AC Gen. (Fuel.Cost), the cost of the external fuel used by the fuel cell (C.fuel.ext_FC) and incomes of selling E and costs of buying E to the AC grid (Inc.Sell and Cost.Buy) are expressed in M€. They are cash flow values
10 | Load of Hydrogen (H2_load_mass) is expressed in t/h of H2. H2 in tank (H2_Tank_mass), H2 used by fuel cell, from H2 tank (Fuel.FC) or externally purchased (Fuel.ext_FC) and hydrogen generated by the electrolyzer (Prod_H2) are expressed in t of H2.

11 | Hydrogen stored in H2 Tank (H2_Tank_HHV) is expressed in MWh HHV of H2

I

12 |Date Hour Load(MW)  AC_load(MW] DC_load(MW H2_load(HHV, H2_load_mas Water_load(NPV(MW)  Wind(MW)  Hydro(MW) _Ef_turb(perce AC.Gen.(MW) No.Gen_on  Hours_eq_Ge Cons.Fuel(x1E Fuel. Cost(ME]F.C.(MW)  FuelFClt)  F
13 |01-January 0:00 0 0 0 0 0 0 0 3.34 0 1 0 0 0 0 0 0 0
14 |01-January 1:00 0 0 0 0 0 0 0 3.08 0 1 0 0 0 0 0 0 0
15 |01-January 2:00 0 0 [ [ 0 0 [ 3.05 0 1 [ 0 0 [ [ 0 0
16 |01-January 3:00 0 0 0 [ 0 0 0 3.34 0 1 [ 0 0 [ [ 0 0
17 | 01-January 400 0 0 0 [ 0 0 0 3.81 0 1 o o 0 0 o o 0
18 |01-January 5:00 0 0 0 0 0 0 0 5.53 0 1 0 0 0 0 0 0 0
19 |01-January 6:00 0 0 0 0 0 0 0 921 0 1 0 0 0 0 0 0 0
20 |01-January 7:00 0 0 0 0 0 0 0 1335 0 1 0 0 0 0 0 0 0
21 |01-January 8:00 0 0 [ [ 0 0 [ 14.26 0 1 [ 0 0 [ [ 0 0
22 |01-January 9:00 0 0 [ [ 0 0 [ 12.94 0 1 [ 0 0 [ [ 0 0
23 |01-January 10:00 0 0 0 [ 0 0 0 11.73 0 1 [ 0 0 0 [ o 0
24 | 01-sanuary 11:00 0 0 0 0 0 0 0 1012 0 1 0 0 0 0 0 0 0
25 | 01-January 12:00 0 0 0 0 0 0 0 876 0 1 0 0 0 0 0 0 0
26 |01-January 13:00 0 0 0 0 0 0 0 7.62 0 1 0 0 0 0 0 0 0
27 |01-January 14:00 0 0 [ [ 0 0 [ 6.77 0 1 [ 0 0 [ [ 0 0
28 |01-January 15:00 0 0 [ [ 0 0 [ 6.29 0 1 [ 0 0 [ [ 0 0
29 |01-January 16:00 o 0 [ [ 0 0 0 6.46 0 1 o o 0 0 [ 0 0
30 | 01-January 17:00 0 0 0 0 0 0 0 7.25 0 1 0 0 0 0 0 0 0
31 | 01-January 18:00 0 0 0 0 0 0 0 7.78 0 1 0 0 0 0 o 0 0
32 |0-lanuarv 19:00 o 0 0 o 0 0 o 841 0 1 o o 0 0 o o 0
sim [ @ < »

In the simulation screen, clicking in “Back” button we return to the main screen.

22. Report of the best solution.

If we move through the table with the bottom bar, and focus on the 1°* row (optimal solution),
we can see many results. In blue we can see the results of the annual energy, all of them in GWh:
load (Etotal); energy from renewable generation (Eren); energy from PV generation (Epv);
energy from wind turbines generation (Et); energy that can be exported, from renewables +
from backup generator + from the storage, that cannot be used by the load, in this case all the
energy (E export); energy injected and sold to the AC grid (E Sell); energy bought to the AC grid
(E Buy)... We can see E Sell is lower than Eexport because during many hours the power
generated by the wind turbines is higher than the maximum power that can be injected to the
AC grid (23 MW), therefore these hours the injected power is limited to 23 MW.

EtataliGih) Eren(Ghy EpviGWh)  Ew(GWh  ENGWH) E export{Gyvhy E SellGivh) E Buy(Gvh) E ch. bat(Gih) ~
0 117661 0 17661 0 117661 114555 0
~ 1] IRERE] TERT TT7ERT 1] T19.27 17589 1]
0 117661 0 17661 0 117661 114585 0
0 120,762 3101 117661 0 120,762 117.193 0
0 19212 1551 117661 0 119.212 115.89 0
0 122313 4652 117661 0 122,313 116.457 0
0 117661 0 17661 0 117661 114585 0
0 120,762 3107 17661 0 120.762 117.193 0
0 123863 5202 117661 0 123,863 87 0 .
( m )

We can see the report of the optimal solution by clicking on the first row of the table, in
"REPORT".

Total NPV (ME£) Emizsion (KCOZAr  Unmet(GWwhin)  IRR32) Landiha)  IneestmentbE) CapF3)  LCOEE/MKWh) Simulate
49.929 112 0 18.59 540 375 43.59 0.0298 SIMULATI

Report
.. IREPORT..)

The screen of the report of the best solution appears.

(The same report would have been obtained if we click in the bottom left corner button

repoRt | showing this button the best solution found)
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W Preview

SEHRA Q we-QRB | EMEHF| K 41 o3 b W Close

MHOGA software. Report

t: MHOGAT.mho. Solution # 1
BCVelage. 1, A 20
COMPONENTS:

1 Ptod 01 Wil a0 Ui d (100% PUKY)

Bt BatsMh, 106 AN Etota =0 OWh (0 dat)
AT T G P o 50w
bine

Land use: 540 ha

CONTROL STRATEGY:

THERE IS NO LOAD CONSUMPTION > NO CONTROL STRATEGIES RELATED TO THE LOAD CONSUMPTION
UPPLY

CONTROL STRATEGY FOR CHARGE/DICHARGE (Ioad + injecting to the grid) OF GRID-CONNECTED
BATIERES
Max.slsctricty prce (sel)forcharging: (only from ranewabla) 0 €kWn: Min. slectr. pice for discharging: 0.11 €/kiAh,

ECONOMIC CALCULATIONS:
Iniial Investment: 37.6 M€. Loan: 100 %, int. 7% in 25 years, annual quota: 3218 M€,
NPV OF THE SYSTEM (25 years lfetime) (incomes +, expenses -)

Total Net Present Value (NPV): 49 929 € Intemal Rate of Retu (IRR): 1859 %. LCOE  0.0298 €/kWh,

NPC / NPV (M)

ragy/(snow._peak_powsr"G76D): 4359 %; Ranew. faction: 00 %

7503 Gy
0 punped 0 oMty

Erery chrged vy Batnes. 0 G
Energy discharged by Batteries: 0 GWhiyr

OTHER RESULTS:

By Namborfstarts all uns): 0

e

el T —  bought E.). Sold Energy: Elctrical E. (1PV): o
cnn%) % e ome S i state
ach (VPV): 7 51€ Ao o

) 12k\COZJyv

ENERGY BALANCE DURING 1 YEAR (GWhiyear)

T III

Page Tof 3

The report can be printed, on paper or in PDF format (if you have installed a virtual Pdf printer,
for example Adobe Acrobat or doPDF, which is free).

Press the print button
Adobe PDF):

and then select the physical or vitual printer (in the example,

Print X
=y “
Name: Il_E! Adobe PDF '
D ——
Where: [ print to fie
Pages Copies
®u Numberofcopes 1|3
(O current page
O pages: ' ' Colate
Enter page nurnbers and/or page ranges,
separated by commas. For example, 1,3,5-12
Other Print mode
prnt Mpages - [ ot .
Order Direct (1-9) -
Duglex Print on sheet Defaut E

Cancel

Once the printer is selected (physical or virtual PDF), the report is printed or the PDF file is
created by clicking OK (a dialog appears in the Windows taskbar, where you must select the
location of the PDF file).

By clicking on the "Close" button, the software ask us if we want to save the report in word
format (.doc or .rtf) or in .txt format. We click YES, save in .doc format, we save it and then we
can open it with Word:
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{University of Zaragoza (Spain), with the colaboration of SISENER
Ingenieros

Project: MHOGAl. Solution # 1
DC Voltage: 1 kV. AC: 20 kv.

COMPONENTS :

] PV gen. PVl-mod, Oxl MWp. P total = O Map (100% PV#1)
M Batt. Bat5MWh, 1x0x5 kAh. E total = 0 GWh (0 d.aut)
15 Wind T. WindT1l, 15x2 MW (@14m/s). P. total 30 MW
Without Hydro Turbine
Without AC Generator
Without Fuel Cell
- Without Electrolyzer
Without Inverter-charger

X CONTROL STRATEGY:

b CONTROL STRATEGY FOR CHARGE/DICHARGE (load + injecting to the grid) OF
GRID-CONNECTED BATTERIES:

Max. electricity price (sell) for charging: (only from renewable) 0
€/kWh; Min. electr. price for discharging: 0.11 €/kWh.

23. Costs of the best solution

In the main screen, we click on the "COSTS" button of the results table (close to "REPORT"
button), in the first row:

UnmetGWhiyrl  IRR(*)  Landiha)  InvestmentbE) CaplFii)  LCOEEMYH) Simulate Report o B P (M) Slope#l () Cn o~
0 16.48 540 378 433 0.03 SIMULATE.. P 1 26 1L

The following screen appears, informing us graphically of the different costs throughout the
life of the system:
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Project: MHOGAT mhe. Solufion # 1

Distributicn of Incemes ) and costs (, NPV, during the years. RED: acqu. costs, replac. costs and incomes for final sale
BLUE: Q&M Currency: ME.
Total NPV: 45583 ME, IRR =18.5 %. Inversion cos oan of 100 %, int 7% in 25 yr., quota 3218 MEHT.

TOTAL MPV: 45 553 ME

LI L L I LB B B | L
0 24 8 810 13 16 19 22 25

Totd Cost of PV Generator (MPV): OME

[|_
0248681 13 18 19 2 26 248 810 13 18 1\%/;2\55
Total Cost of Hydio (WPV): O ME Total Cost of AC Genarator (MPV): D ME
it
0246310 13 18 18 2 26 0246810 13 18 18 2 25
Total Costof Inverter (NP OME Total Cost of Batteries Bank (MPV): DME
0 a
0246810 13 168 18 2 25 0246210 12 16 18 2 35
Totsl Cost of Eectrohyzer {(NPV): O ME Totsl Cost of Fuel Cell (NPV): O ME
H a
024681 13 16 18 2 25 024681 12 16 19 2 2
Totsd Costof HZ Tank (MPV): O ME Totsl Costof AC Gen Fuel (NPV) O ME
a
024651 13 168 19 2 25 02 4 8510 13 18 19 22 25
Total Ciost of Exiernal Fuel for FC NPV D ME Total Cost of E purchased from AC grid (NP O ME
a
0246810 13 16 19 2 25 024681 13 16 19 2 25
== of E sold to AC grid (NPV): 58126 ME Total Incomes of HZ sold (NPV): O ME
0
0246810 13 18 189 22 25

We can see the investment costs are 37.5 M€, that is, CAPEX of the wind turbines (2 M€/wind
turbine * 15 wind turbines = 30 M€) multiplied by 1.25 (we set in the FINANCIAL DATA tab that
a 25% would be added to the initial cost of the system): 30*1.25 = 37.5 M€.

All the costs shown are present cost or present value. For costs or incomes that are the same all
the years (but updated by their inflation), the cash flow corresponding to the year 0 is converted
to the cash flow of year y multiplying by (1+interest rate)Y, and this cash flow is converted to
present cost or present value dividing by (1+inominal discount rate)’.
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We suppose all the costs and incomes are paid at the end of each year, except for the CAPEX of

the different components, which would be paid at year 0 (beginning of the system lifetime) if
there was no loan. All the costs defined in the different windows of the software are for the year

0 (beginning of the system lifetime).

For example, for the OPEX costs of the first year, or the incomes due to selling electricity to the
AC grid of the first year, the costs defined must be updated with the inflation of 1 year, as the
payments and the incomes are at the end of the first year.

Costs due to the wind turbines:

In the graph of the costs of wind turbines we can see all the costs related to the wind turbines:
the year 0 (when the system lifetime starts) the cost is the CAPEX (2 M€/wind turbine * 15 wind
turbines = 30 M&€). Costs are represented as negative values as the type of project is
maximization of NPV.

From year 1 to 19 the costs are OPEX (operation and maintenance, O&M): during year 1 the
OPEX would be 1% of the wind turbines CAPEX, therefore 30-0.01 = 0.6 M€, but it is paid at the
end of the year adding the general inflation (2%). Therefore, the wind turbines OPEX during the
1%tyear is 0.6 M€, but it is converted to cash flow at the end of the 1%t year, it is 0.6:1.02= 0.612
ME; this cash flow will be converted to present cost considering the nominal discount rate of
7%, thatis: 0.612/1.07'=0.572 M£ (it cannot be correctly seen in the graph due to the low value).
The same for the rest of the years, changing the number of the year.

Total Cost of Wind Turbines group (NPV): -41.033 ME
0 i -
-10
-20

0 5 10 15 20 25

In year 20, a reposition cost must be considered, as wind turbines lifetime ends. The
replacement cost set in the wind turbines window is 1.6 per wind turbine -> 24 M€, but this cost
would be in year 0, however in year 20 this value will be different. We set in the wind turbines
window an annual inflation rate for wind turbines costs of -1%, with a limit of -35% (limit would
be reached in 42.9 years, see wind turbines window). That means that, in year 20, the 24 M€ are
converted to 24:(1-0.01)?° = 19.63 M€ of cash flow in year 20. However, we must convert this
cash flow to present cost dividing by 1.07%°, obtaining 19.63/1.07%° = 5.073 ME, shown in the
graph.

In year 25, there are incomes due to the residual cost of the components, in this case the wind
turbines will be working for 5 years (from year 20 to 25), therefore 15 years of useful life will be
remaining, with a cash flow value of 24 M€*15/20 = 18 M€ (value referred to year 0). In year 25,
considering the annual inflation rate for wind turbines costs of -1% (with a limit of -35%), the
cash flow will be 18:(1-0.01)?° = 14.001 M€ of cash flow at the end of year 25. This cash flow
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must be converted to present cost by dividing by 1.07%°, obtaining 14.001/1.07%° = 3.618 M€,
shown in the graph (value positive as it is an income).

Financial costs:

In our case, in FINANCIAL DATA tab we set that 100% of the initial cost of components and
installation (100% of the total initial CAPEX) would be financed by a loan of 7% interest rate and
25 years. As the interest rate is the same as the nominal discount rate and the years are the
same as the system lifetime, the effect in the NPV would be the same as if the CAPEX payment
would be done in year 0 (37.5 M€). However, in other cases the effect would be different.

If the percentage of the initial cost financed was lower than 100%, in year 0 (the beginning of
the system) there would be a financial cost corresponding to the non-financed cost. However,
in this case, as 100% is financed, in year 0 there is no financial cost.

In the top right graph, we can see the financial costs, which are the costs during the years (in
present cost values) that the owner of the system must pay to cover the CAPEX of the system.

Financial Cost (NPV ): initial payment + annual quotas: -37.5 M€

The annual quota (a) is calculated as:

;
S R
=t Ty

Where Co is the total financed cost (37.5 M€), i is the interest rate of the loan (7%) and n is the
number of years to return (25). The annual constant quota is a = 3.218 M€, which will be the
cash flow of each of the 25 years. But this must be converted to present cost, dividing by 1.07,
obtaining for year 1 the present cost of 3.218/1.07' = 3.007 M€ and for the last year 3.218/1.07%
=0.593 M€, shown in the graph.

Incomes of selling electricity:

We can see the incomes due to selling electricity to the AC grid (bottom left corner graph).

59



The year 0 (when the system lifetime starts) these incomes would be 6.8803 M€ (sum of the
energy injected by the grid multiplied by its cost, which is variable as we introduced an hourly
file). In our case the inflation of the price of the electricity sold to the AC grid was set to 2% and
the nominal discount rate is 7%. The first year (as always, the payment is at the end of the first
year), the cash flow received at the end of the 1% year (as it has passed one year since the
beginning, the costs and incomes are supposed to be incremented by inflation) will be
6.8803-1.02'= 7.018 ME£. It is converted to present value by dividing by 1.07%, obtaining
7.018/1.07'= 6.559 M£. The same for the rest of the years, changing the number of year, for the
last year (25) it would be the cash flow 6.8803-1.02%°= 11.289 M€ and the present value
11.289/1.07%= 2.08 M€. The sum of all these present value incomes is 97.936 M€.

Total Incomes of E sold to AC grid (NPV): 97.936 M€

&

fa =
6 ms=lE @)

4
2
0

0 2 4 6 810 13 16 19 22 25

Total NPV:

In the top left graph we can see the total NPV for the different years (all the values added are
the NPV of the system, 49.403 M€£).

In this case, the CAPEX is financed 100%, we have also OPEX costs (each year OPEX of the wind
turbines) and cost of replacement of the wind turbines in year 20, incomes of residual cost of
wind turbines in year 25 and incomes are just the incomes from the selling electricity to the AC
grid, therefore the value of each year will be the present value of the incomes of selling
electricity minus the present cost of the financial minus the OPEX present cost of the wind
turbines (in year 20 also minus the replacement cost of the wind turbines; in year 25 plus the
incomes of residual cost of the wind turbines).

The 100% of the CAPEX of the wind turbines (plus the 25%, that is, the total CAPEX of 37.5 M€)
are in the financial costs. Therefore, in year 0 (at the beginning of the system) there is no cost (0
incomes — 0 cost of CAPEX (100% CAPEX is financed) — 0 cost of wind turbines OPEX).

TOTAL NPV: 49.403 M€

| Lo

0 2 4 6 810 13 16 19 22 25

For year 1: 6.559 M€ incomes (present value of incomes of year 1) - 3.007 M€ (present cost of
the financial cost of year 1) - 0.572 M€ (present cost of the wind turbines OPEX of year 1) = 2.98
ME (seen in the graph for year 1).
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If we save the results of the cost (when closing the costs window we will be asked), we can see
the values calculated previously in an Excel file.

As in the case of the report screen, you can print or create the PDF. If we close (“Close” button)
it asks if we want to save the cash flows in Excel.

Save Data

Do you want to save cash flow?
o

We save the file. Open the saved file with Microsoft Excel (or equivalent software). When
opening it we will see a warning:
Microsoft Excel X

I El formato y la extension de archivo de 'pruebaltabla.xls’ no coinciden. Puede que el archivo esté danado o no sea seguro. Mo lo abra a
menos que confie en su origen. ;Desea abrirlo de todos modos?

We answer "Yes" and the Excel file opens perfectly, showing the table of costs.

- Keep in mind that the decimal separation appears as a point. If the decimal separation
defined in Windows is comma (usual in Spain and other countries), for Excel to treat the
data as numbers we have to:

- Select the entire Excel sheet and change points by commas
- Or, in the properties of the Excel sheet, indicate that the decimal separation is the point
for this file.

on and initial variable costs of 7.5 Me). Loan: 100 %, int. 7% in 25 years.

b or ash i eer e
7 08M PV Gen ndT. HydroT.

8 cashyear NPV cashyesr NPV cashyear NPV coshyear NPV cashyear c o

9 o ) o o o -0 o o o ) ] o ) o o o ° o o o o o d
10 1 o o o o o o o o o o o o o o o o o o o o o q
n 2 o o o o o 0 o o o ] o o 0 o o o ] o o o o q
2 3 o o o o o o o o o o o o o o o o o o o o o q
B3 4 ) o o o ) o o o o o o o o o o o o o ) o o q
" s o o o o o 0 o o o o o o o o o o o o o o o q
15 5 ) 0 o o o o o o o o o o 0 o o 0 ] o o o o q
16 7 o o o o o o o o o o o o o o o o o o o o o q
7 s ) o o o o o o o o o o o o o o o o o ) o o q
18 B o o o o o o o o o o o o o o o o o o o o o q
19 10 o o ] o o 0 o o o o o ) 0 o o o o o o o o q
» 1 o ° o o o o o o o o o o o o o o o o o o o d
il 2 ) o o o o o o o o o o ) o o o o o o ) o o q
2 5 o o o o o o o o o o o o o o o o o o o o o q
5 1 o o o o o 0 o o o o o o 0 o o o o o o o o d
u 5 o o o o o o o o o o o o o o o o o o o o o q
2 16 ) o o o o o o o o ] o o o o o o o o o o o q
% . o o o o o o o o o o o o o o o o o o o o o q
2 15 o o ] o o 0 o o o o o o 0 o o o o o o o o q
» 1 o o o o o o o o o o o o o o o o o o o o o d
» 20 ) o o o 963 o o o o o o ) o o o ° o o o o o d
0 21 o o o o o o o o o o o o o o o o o o o o o q
3 2 o o o o o 0 o o o o o o 0 o o o o o o o o q
2 23 o o o o o o o o o o o o o o o o o o o o o d
B 2 ) o o o o o o o o o o ) o o o o o o ) o o q
3 2 o o o o 14001 o o o o o o o o o o o o o o o o q
35[TOTAL PVGen. 0&M PV Gen. WindT. HydroT-TEG 0&M Hydro T-TEG AcGen O8BMAC Gen. Inverter Batteries 0&M Batteries Charge Reg. Rect

36 NPV ° o o o o o o o o o

38 |TOTAL Net present Value (NPY) = 9 403 Me.
39 |INTERNAL RATE OF RETURN = 18.5 €%

We can save this Excel file by the "Save As" option of Microsoft Excel in Excel format (*.xlIsx) and
the next time we open it, the previous warning will no longer appear.

24. First solution found which includes battery and inverter/charger.

If we move right through the table with the bottom bar, and focus on the columns “Cn Bat (kAh)”
and “P.inv (MW)”, we move down until we se the first case with battery and inverter both
different from 0. In our case, it is row # 20. It is the first solution that includes both battery and
inverter/charger.
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Report Costs F.PY (M¥Wp_dc) Slope#1(?) CnBat (kAh) F. Gen (M) F. Iy (W) FOWind T.(MW) F Turb (m3/s) P.FC (MW) P Elve. (MY A~
REPORT.. COSTS.. 3«1 27 1x0x5 1x0 5 16x2 0 0

REPORT.. COSTS.. Bxl 27 1x0x5 1x0 0 15x2 0 0

REPORT... COSTS... D0x1 27 1x1x5 1x0 0 15x2 0 0

REPORT... COSTS... 1x1 27 1xix5 1x0 0 14x2 0 0

REPORT... COSTS... 2x1 27 1xx5 1x0 10 15x2 0 0

REPORT.. COSTS... 4x1 27 1xlx5 1x0 5 16x2 0 0

REPORT.. COSTS... 2x1 27 Txllxb 1x0 0 14x2 0 0

REPORT. COSTS 1x1 1x1xh 1x0 015 0 0

EPORT... COSTS.. Ox1 27 1x1x5 1x0 5 16x2 0 0 v ]

< >

Focusing on row 20 (solution 20t"), we can see that this row has 15 wind turbines, a battery bank
of 5 MWh (5 kAh x 1 kV) and an inverter/charger of 5 MW.

# Total NPY (M£) Ermizsion (MCO20  UnmetiGwhix)  IRR(3) Landthe)  Ineestrnent(ME) Cap Fi34)  LCOEEKWhH) Simulate Report A
12 47.766 1.22 0 1531 543 42 625 4093 0.0322 SIMULATE.. REPOR
13 47503 1.28 0 1637 555 45 3343 0.0331 SIMULATE.. REPOR
14 47.494 114 0 1782 B4005 33376 4359 0.0313 SIMULATE.. REPOR
15 47.49 1.08 0 1834 507 365 4322 0.0301 SIMULATE.. REPOR
15 47.432 1.19 0 1708 545 41.75 4151 0.0321 SIMULATE.. REPOR
17 47.246 1.25 0 165 552 44125 40.18 0.0323 SIMULATE.. REPOR
18 47.138 11 0 1788 510 38 42.31 0.0307 SIMULATE.. REPOR
19 47 8 1148 n 1218 4308 AN B7E A7 BE 00319 SIMULATE RFPOR
R 5 1.14 0 1739 540005 40 4364 0.0317 SIMULATE.. REPOR V]

< >

We can see many results. In blue we can see the results of the annual energy. The energy
generated by the wind turbines, Ew (GWh) is the same as the optimal solution, however the
export energy, Eexport (energy that is not used in the system) is higher. During some hours,
when the wind generation is higher than the maximum power allowed to be injected to the grid
(23 MW), the batteries are charged using energy from the wind turbines that in the optimal
solution was lost; later the batteries inject that energy to the grid, that’s why E export is higher
than in the optimal solution.

EpviGih)  Ew(GWh) Et(GWh) E expart{Givh) E Sell{Gvh) E Buy(GwWh) E ch. hat(GWwh) Edisch hat[GWh)  Eelaer. A
4652 17661 0 122313 118,457 0 0 i
7.752 117661 0 125.414 120,884 0 0 0
0 117661 0 117661 114555 0 0 0
1,551 109.817 0 111.368 109,788 0 0 0
3101 117661 0 120,762 17193 0 0 0
£.202 117661 0 123,863 119687 0 0 0
3101 109.817 0 12418 11182 0 0 i
1651 117 661 0 18212 11589 0 0 i
0 17 661 0 117 528 114683 0 0166 0157 .
£ >

Energy injected in the AC grid, E sell, in this case is a bit higher than in the optimal solution.

Energy charged by the battery bank (energy that enters into the battery) is 0.166 GWh/yr while
the discharged energy (energy that effectivelly supplies the battery, considering efficiency) is
0.157 GWh/yr (we must take into account that in the simulation we can see that at the beginning
of the simulation, January 1%, battery is fully charged; at the end of the year is fully discharged).

We can see the incomes due to energy sold the first year are 6.942 ME£.
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E Sell (MeAm) Sell HZ (MEAY  NEVPY(ME) NPV Bat (ME) NPV Aw (ME) NPV (ME) NPV Gen, (ME) NPV WIndT (M) C. Hydro (NPC) (M1 A
7175 ] 411z ] 0 -0.694 ] -41.033 ]
7.334 1] -6.954 1] 0 1] 1] -41.033 1]
EA18 1] 1] -2.059 ] 1] 1] -41.033 1]
E.E36 1] -1.371 1] 0 1] 1] -38.298 1]
7082 1] 2,742 1] ] -1.387 1] -41.033 1]
7.256 ] -5.483 ] 0 -0.694 ] -41.033 ]
6724 1] -2.742 1] ] 1] 1] -35.298 1]
] -1.371 -2.059 0 ] ] -41.033 ]
1] 1] -2.059 0 -0.694 1] -41.033 1] o
< >
Also the total incomes due to energy sold, in present value (NPV), 98.811 M€.
NP WA T (ME) C. Hydro (MPC) (W NPY FC (ME) MPY Ebyz. (ME) NP Fuel Gen (ME) NPV Fuel FCME) NPV Buy (ME) NPY Sell (E) NPy A
-41.033 1] 1] 1] 1] ] 0 10213
-41.033 ] ] ] ] 0 0 104.391
-41.033 1] 1] 1] 1] ] 0 98462
-38.298 1] 1] 1] 1] 0 0 94.459
-41.033 ] ] ] ] 0 0 100.944
-41.033 1] 1] 1] 1] ] 0 103.281
-38.298 1] 1] 1] 1] 0 0 98777
-41.033 1] 1] 1] 1] ] 0 99.718
-41.033 ] ] ] ] 0 0
v
< >

Many of these results can be seen in the report (in the 20" row or the table, click in REPORT):

MHOGA software. Report

Project: MHOGA1.mho. Solution # 20
DC Voltage: 1 kV. AC: 20 KV.

COMPONENT S:

PV gen. PV{-mod, 0x1 MWp. P total = 0 MWp_dc (100% PV#1)
Batt. BatsMWh, 1x1x5 kAh. E total = 0.005 GWh (0 d.aut)

15 Wind T. WindT1, 15x2 MW (@14nvs). P. total 30 MW

Without Hydro Turbine 20
Without AC Generator 2
Without Fuel Cell E
Without Electralyzer
Inverter Inv-ChSMW, SMW

POWER (MW)

Land use: 54005 ha
wr N

CONTROL STRATEGY:

THERE IS NO LOAD CONSUMPTION -> NO CONTROL STRATEGIES RELATED TO THE LOAD CONSUMPTION
SUPPLY

SOC min. batteries = 10 %

CONTROL STRATEGY FOR CHARGE/DICHARGE (load + injecting to the grid) OF GRID-CONNECTED
BATTERIES:

WMax. electricity price (sel) for charging: (only from renewable) 0 €/kWh: Min. electr. price for discharging: 0.11 €/kWh

ECONOMIC CALCULATIONS:

Initial Investment: 40 ME. Loan: 100 %, int. 7% in 25 years, annual quota: 3.432 M€

NPV OF THE SYSTEM (25 years lifetime) (Incomes +, expenses -}

Total Net Present Value (NPV); 47.025 ME. Intemal Rate of Retum (IRR): 17.39 %. LCOE : 0.0317 €/kWh

Distribution of NPV
Battery bank (NPV): -2.059 M€

Wind turbines (NPV): 41.033 M€

Inverter (NPV): -0.694 ME

Buy/Sell. Bought Energy (NPV): 0 ME (included 0 M€ due emssions of bought E.). Sold Energy: Electrical E. (NPV),
98.811 ME (FCR 0%). H2 (NPV): 0 ME

Installation + financing + extra cash (NPV): -8M€&

NPC / NPV (Me)

BATIERES

TNV, -AUX.

ENERGY BALANCE DURING 1 YEAR (GWh/year):

Overall Load Energy: 0 GWhiyr
Unmet load: 0 G¥Whyr (0 % load)

E. Purchased from AC grid- 0 GWhryr

Export Energy: 117.829 GWhiyr

E. sold to AC grid: 114.683 GWhiyr

Renewable Capacity Factor (sold_energy/(renew_peak_power'8760)): 43.64 %: Renew. fraction: 100 %
Energy delivered by PV generator: 0 GWhiyr

Energy delivered by Wind Turbines: 117.661 GWhiyr

E. delivered by Hydro Turbine: 0 GWh/yr. Pumped 0 GWhiyr

Energy delivered by AC Generator: 0 GWh/yr

Energy delivered by Fuel Cell: 0 GWhiyr

Energy at Electrolyzer: 0 GWhiyr

Energy charged by Batteries: 0.166 GWhiyr

Energy discharged by Batteries: 0.157 GWhiyr

OTHER RESULTS:

Batteries Lifetime: 15 years

Hours eq. of AC Generator aperation (all units): 0 hfyr. Number of starts (all units): 0
Hours of Electrolyzer operation: 0 hiyr. Number of starts

Hours of Fuel Cell operation: 0 hiyr. Number of starts: 0

Hours of Hydro Turb. 0 hiyr: starts: 0. Hours of Pump: 0 hiyr: starts: 0

Total CO2 emissions: 1.14ktC O2/yr

H2 sold in one year: 0 t H2/yr

ENERGY BALANCE DURING 1 YEAR (GWhlyear)

100
0
&
@

In the main screen again, we can see the simulation of the operation of this solution by clicking

on the 20" row of the table, in "SIMULATE":
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Waterload /PHS  MULTIPERIOD

Electricity price (E/kWh) — Sel
0.3 ¥ — Low limit disch
pr— prm— I3 High limit char.
" N N A
N~~~ — WjN
0
16/1 17 181 191 201
16 January - 20 January
=
£ of 1 year, all th same.
30 55
E N I - e Total Load
& 25 T \ 152 Unmet Load
w
u = — Disch. Batt
g SN—"] ‘;5 5 ~ Charge Batt
o — Wind T.
= 15 3B
£ /\_\ 250 Sell E to grid
s - -
10 > soC
z —=1:2
£ 0 \
1<
: ] A o 05 %
E 1611 17 181 191 201
E 16 January - 20 J —
< s disp.
FOWER CONSUMED OR SUPPLIED (M) Enaray pfice [~]See Over
Batter bank Discharge Plim Charge Ebid Legend
P2 BANERY ENERGY (hyvh DH.L Gr.
O O (] Electrolyzer s0C CIHRGr
]
0 [] E. s disch. bat E. HZtenk (HHYVHZ) | R P S0C limit [Iv.Grid
] imits Alt
[ Export E Battery bank Charge Fuel Cell P critical Gen. Can. M EE’D”
xport Energy ap. Max.
] Eta supply FC P critical Fuel Cell . change
D Wind Turb E i [FE S0C setpoint Gen. (dsari:‘i
R i :
Water P E bought ta AC grid Pmax SOC setpoint FC
ater Pump
AC Generator E sold to AC grid Pmax Large:
H2 TANK setpaint (HHY H2: S0C (01 T.full chi
[ Pmax. input Inverter ] Pmex Gen setpoint { ) (0-1) ull charge
Simulation step (min); B0 Back Save data; Save Simulation Data. Save Prob. Data

COMPONENTS: Wind turbines of 30 M. Battery bank of 5 Mywh. Bat. Inverter of 5 by,

STRATEGY: There is no load consurmption -> no control strategy related to the load consumption supply. SOC min.: 10 % Arbitrage: Control variables for grid-connected batteries: charge (only from
renewable, not from grid) if price of E. (sell) is lower than 0 £/k\h; disch. (load + injecting to the grid) if price E. (sell) is higher than 0.11 £/kiWh

In the first tab (Hourly simulation), we can see the energy price and the limits to
charge/discharge the batteries by clicking “Energy price” button. But we can see this over the
power graph by checking “See over” checkbox (with the “Legend” checked we see the legend
of both graphs).

In the screenshot above 5 consecutive days are shown. We can see that batteries are only
charged when wind generation is higher than 23 MW (maximum power allowed to be injected
into the grid), the rest from that value is used to charge the batteries until they are fully charged
(SOC=100% is the red line of 5 MWh). When the sell electricity price is higher than 0.11 €/kWh
and wind generation is lower than 23 MW, batteries are discharged at the maximum rate but
not exceeding 23 MW together with the wind generation.

In the second tab of the simulation screen we can see the whole year:
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power

Monthly Energy  Annual Energy  Hydrogen

AC Generator Water load / PHS  MULTIPERIOD

HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
30
20
0 0
10
0
0 2,000 4.000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator Export
] | nm
: : w "
AR
l.'s ! 1 l 1’ ¥
0 2.000 4.000 6.000 8.000 0 2,000 4,000 6,000 8,000 0 2.000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
0 0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0
Battery bank Charge Battery bank Discharge Energy in Battery bank
2 2 4
LRy * L :
7 l Al 1 0 i A 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8,000
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
20
s s 10
0
0 2,000 4.000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2.000 4,000 6,000 8,000
Simulation step (min): B0 Back Save data: Sawve Simulation Data. Sawve Prob. Data

Third tab:

Hourly simulation

MONTHLY

Hourly values separately  Monthly and Annual Average Power

AND ANNUAL AVERAGE POWER (MW)

MWonthly Energy  Annual Energy  Hydrogen

AC Generator SWater load / PHS  MULTIPERIOD

Ayerage Power (MW)

S oMWk oL@ @

6 7 8 9
Month

YEAR

¥ [ Total Load
@ E soldto AC grid ¥ B Electrolyzer

W@ Unmetload ¥ PV gen. @ Wind T

V@ Hydro T /TEG VB AC Gen

@ Fuel Cell @ E.bought to AC grid

Other tabs:
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Hourly simulation  Hourly values separately  Manthly and Annual Average Pawer  Monthly Enerdy  Annual Energy  Hydrogen AC Generator Materload /PHS MULTIPERIOD
MONTHLY ENERGY (GWh)
Total Load PV generator Wind Turbines
15
10
0 0
5
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Hydro Turbine AC Generator Export energy
15
10
0 === —=r—=—=
5
0
2 4 [ 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Fuel Cell Electroyzer Energy (HHV of H2) in H2 tank, end of the manth
0 {f-—- - — —- — — 0
2 4 6 8 10 12 2 4 6 8 10 12 0
Battery bank Charge Battery bank Discharge Energy in battery bank at the end of the month
0.02 oz 0.004
0.01 0.01 0.002
0 0 0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10
Unmet load (by the standalone system) Energy purchased from the AC grid Energy sold to the AC grid
15
10
0 0
5
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12

Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen AC Generator ‘Walerload /PHS  MULTIPERIOD

Energy (GWh)

LOAD

EXPORT

TOTAL ANNUAL ENERGY (GWh)

SOLD WIND T

25. Simulation in steps lower than 1 h.

Charge BAT. Disch. BAT.

In the simulation screen, we can change the simulation time step, under the checkboxes, in the
left area, and the simulation will be updated to the new time steps.

For example, change to 5 minutes. After several seconds (please, be patient) the simulation
results are updated, seeing now the simulation in 5 minutes time steps. We can see the
variability of the wind generation due to the variability of the wind speed.
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Waterload /PHS  MULTIPERIOD

Electricity price (€/kWh) P— sal

0.3 ¥ — Low limit disch

. I#— High limit char

0.2 H |" |'|

01 n n

0
1611 171 18/1 191 201
16 January - 20 January
% Simulation of 1 year, all the years the same.
= 3 55
E PR——— 5 E Total Load
e 25 = Unmet Load
u =4 ~ Disch Batt
§ 20 o} == Charge Batt
& = Wind T.
w

£ z Sell E to grid
it > - s0C
ES &
;e :
2 P n 052
E 16/1 171 18/1 191 201
E 16 January - 20 January

< > Days disp
POWER CONSUMED OF: SUPPLIED (M) Er— [F]See Over
Batter bank Discharge Plim Charge MLegend
p? BATTERY ENERGY (Mwh) [IHLGr
O O ] Electralyzer s0c [CIHRGr
0O [ E max disch. bat E.H2tank (HHVHZ) []R ] SOC mit v Grid
7 imits
Batlery bank Charge Fuel Cell P critical Gen. Clan
[ Export Energy Cap. Max. Serall
[ E.to supply FC P critical Fuel Call ) change
Wind Turb B i [FE S0C setpoint Gen. (days)
R - Small
P O E boughtta AC grid [ ] Pmax S0C setpaint P
SR AC Generator E sold to AC grid [] Pmax Large
[ Pmax. input Inverter ] P o Gen Hz TANK setpaint (HHY H2) SOC(0-1) | T.fullcharge
[ Sirulafion step (min): |5 ~ ] Back Save data: Save Simulation Data Save Prab. Data.

—
COMPONENTS: Wind turbines of 30 M. Battery bank of & kMh. Bat. Inverter of 5 MyA,

STRATEGY: There is no load consumption -> no contral strategy related 1o the load consumption supply. SOC min.: 10 %. Arbitrage: Control variables for grid-connected batteries: charge (only from
renewable, notfrorm grid) if price of E. (sell) is lower than 0 £/k\Wh; disch. (load + injecting to the grid) if price E. (sell) is higher than 0.11 £/kivh

By clicking on the simulation screen in "Back" button we return to the main screen.

In the main screen, the results of the solution 29" has been updated to the simulation step of 5
min: the NPV has been slightly increased.

20 47.079 1.14 0 174 540.06 40

SIMULATE.. REPOR - ‘

We could optimize the system with this time step (even with lower time step, until 1 min.),
however the optimization would take a lot of time and we will not do it in this guide.

In the WIND screen, we can see the simulation of the wind speed in steps of 5 min (Graph in
setps of 5 min. button).

67



mis

WIND SPEED

9 10 11 12 13 14 15 16 A7 18
1 January

[JHerizontal Grid [ Ak []Vertical Grid

Days display

Scrall change (days)> small: large:

In the main screen again, GENERAL DATA tab, we can return to the 60 min time step by selecting

it in the Simulation section:

«f LOAD/AC GRID
RESOURCES
+f SOLAR
f \WIND
HYDRO
COMPONENTS
' P GEN
 WIND TURB
HYDRO TURB
+f BATTERIES
«f INVERTER/CHAR
BACKUP GEN.

L2 O _Eloana

COMPONENTS
PY Gen.

[]Wind Turbines
[JHydra T.
Battery bank
[]Backup Gen.
Inverter/char.

[JH2 (F.C.- Elyzer)

GENERALDATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

MIN.AND MAX Mo COMPOMNENTS IN PARALLEL:

Bateriesin parallel:Min [0 | Max

PV gen.in parallel Min [0 |Max

Wind T in peraliel bin. [0 | wax
1 1

Constraints under NPV maximization:

e
l:l o [IPmax_sell

bz, Investment cost
Min. Capacity Factar
Min. Fenew. Fraction

hax Unmet load

hax. Land use

OFTIMIZATION PARAMETERS SELECTED Byv:

@ HOGA (QUSER

Maximum execution time:

 n 5 Jmin | emmess
[ inirnurm time for the Genetic Algaritims
Sirnulation:
Step (min.), Simulation starts

v fpou s Jemfi Jmonni ]

- o

Then, if we click in the 20" row, we can see how it returns to the results of the 60 min time step

simulation:

1.14

26. Save results table.

0 17.39 540.05 40

4364 0.0317 SIMULATE.. REPOR v |

In the main screen, we can save the results table by clicking on the button "Save Excel table"

O D m M W o —

<

#  Total NPV (ME£)

49.929
49514

4911
49.069
48.696
48.584
48.292

48.25
48.065

Ernission (kiCO20

112
1.16
112
1.19
1.16
1.22
1.12
1.19
1.25

Unmmet(Gihir

coo0 o0 oo oo o

IFR3)  Landiha)  Investment(ME) CapF(3%)  LCOEERWH) Simulate Report A
1859 540 375 4359 00255 SIMULATE.. REPOR
18.09 543 34 4268 0.0304 SIMULATE.. REPOR
18.25 540 38125 4359 0.0303 SIMULATE.. REPOR
17.63 546 405 41.81 0.0311 SIMULATE.. REPOR
17.78 543 35.625 42 .68 0.030% SIMULATE.. REPOR
17.14 549 42 40.98 0.031% SIMULATE.. REPOR
17.94 540 38.75 43.59 0.0308 SIMULATE.. REPOR
17.33 546 41.125 41.81 0.0316 SIMULATE.. REPOR
16.77 562 435 40.18 0.0324 SIMULATE.. REPOR o

>

COMPONENTS: 18 %vind Turb. WindT1 (2 My at 16 m/s) f Unmetload = 0 % /4 Total Met Fresent Value (MFV) = 45.929 ME. IRR = 18.6%.

STRATEGY: There is no load consumption -> no control strategy related to the load consumption supply. Contral wariahles for grid-connected batteries: charge {only
from renewable, notfrom grid) if price of E. (sell) is lower than 0 €/kMyh; disch. (load + injecting to the grid) if price E. (sell) higher than 0171 £/kWh

f Save Excel takle

The table is saved where we choose. When we open the file with Microsoft Excel, after accepting

the warning, the table appears.
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A B c D E F G H ! J K L M N o [ Q R s
1 [Project: D:\PHlOYECTOS MHOGA 3.4-202403XX\MHOGAL mho.

2 [No NPV(ViE) Em.CO2(kt/yr) Unmet(GWh/yr) Unmet(%) IRR(%) Land use(ha) Investment(M€) Capacity Factor (%) LCOE (€/kwh)
=i

4 1 49.929 1.125 0 0 18.59 540 375 43.59 0.0298
el 2 49.514 1.157 0 0 18.09 543 39 42.68 0.0304
6 3 2911 1125 0 0 18.26 540 38.125 43.59 0.0303
7 a4 49.069 1.189 0 0 17.63 546 405 41.81 0.0311
8 5 48.696 1.157 0 0 17.78 543 39.625 42.68 0.0309
= 6 48.584 1.221 0 0 17.19 549 42 40.98 0.0318
10 7 48292 1125 0 0 17.94 540 38.75 43.59 0.0308
1 8 48.25 1.189 0 0 17.33 546 41.125 41.81 0.0316
12 9 48.065 1.253 0 0 16.77 552 43.5 40.18 0.0324
13 10 47.877 1.157 0 0 17.48 543 40.25 42.68 0.0314
14 11 47.82 1.05 0 0 18.86 504 35 44.18 0.0294
15 12 47.766 1.221 0 0 16.91 549 42.625 40.98 0.0322
16 13 47.503 1.285 0 0 16.37 555 45 39.43 0.0331
17 14 47.494 1.143 0 0 17.62 540.05 39.375 43.59 0.0313
18 15 47.49 1.082 0 0 18.34 507 36.5 43.22 0.0301
19 16 47.432 1.189 0 0 17.05 546 4175 .81 00321
20 17 47.246 1.253 0 0 16.5 552 44.125 40.18 0.0329
21 18 47.138 1114 0 0 17.85 510 38 4231 0.0307
22 19 47.08 1175 0 0 17.18 543.05 40.875 42.68 0.0319
23 20 47.025 1143 0 0 17.39 540.05 40 4364 0.0317
24 21 47.001 1.05 0 0 185 504 35.625 44.18 0.0299
25 22 46.947 1.221 0 0 16.64 549 43.25 40.98 0.0327
26 23 46.897 1.317 0 0 15.98 558 46.5. 38.7 0.0337
Fij 2 46.751 1146 0 0 174 513 395 4144 0.0314
28 25 46.685 1.285 0 0 16.11 555 45.625 39.43 0.0335
29 26 46.672 1.082 0 0 18.01 507 37.125 43.22 0.0306
30 27 46.655 1.125 0 0 17.33 540 40 43.59 0.0318
31 28 46.634 1.207 0 0 16.76 546.05 42375 4181 00326
32 29 46.612 1175 0 0 16.96. 543.05 415 42.72. 0.0324 7

table [ @ « »

We can save this Excel file by the "Save As" option of Microsoft Excel in Excel format (*.xlIsx) and
the next time we open it, the previous warning will no longer appear.

27. Save the project.

In the top menu of the main screen, click Project-> Save, the project will be saved. It should have
been done periodically.

1l Project: DAMHOGAT.mho
Project Data Calculate DataE
[ Mew
[ Open
& Saveas

Save as Default Project

OPTIONS

Restore Original Tables
Create Tables backup
Restore backed up Tables
Restore Default Currency

B it

28. Save as default project.

You don’t have to do it in this case, however, in the top menu of the main screen, clicking
Project-> Save as Default Project we can save the present project to be the default project when
we create new projects. Later we can change the default project to another one that interests
us more.

29. Optimize grid-connected battery management.

Save the project (Project->Save) and then save it with another name (Project->Save as) and give
the name “MHOGA-optCont.mho”.

Maybe the battery management that we set is not optimal for this case. Now we will optimize
the control strategy for the battery.
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In the main screen, CONTROL STRATEGIES tab, check “Optimize strategy of grid-connected
batteries”. We could optimize 3 or 2 variables (see the user manual), in this case, as we don’t
want to take a lot of time in the optimization, we select “2 variables: price E min. and max.”. At
its right the limits are automatically set (considering max. and min. prices of the electricity sold
to the AC grid), we don’t change them.

GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

CONTROL STRATEGY AND VARIABLES TO OFTIMIZE
ENERGY ARBITRAGE: System with batteries and grid connected
Global strategy:

© Load Following I:‘ Batt. charged by the AC grid // discharged if: (also for Elyzer-» HZ) D Elyzer. full load

(O Cycle Charging [“] Cartinue up to SOC stp (Compare with Sell price]

() Try Both ]| Optimize strateqy of grid-conneted @

i ; D 2 0029 gy 03251
Variables to optimize relative to the global strategy: © 3 verisbles: X1(dt). X2i%), %3(%)
2 varighles: price E. min.and max, Min> 10008 | hewe |[I 3616 ‘ £kWwh_[TERCh<PD

Prain_gen Prin_FC HZTANKstD
F1_gen P1_FC

- . Fe . Batteries can inject electricity to the AC grid
S0Cstp_gen S0Cstp_FC D S0Cmin |:|‘\ day atlow SOC-» charge batten, with AC grid

i Batteties availability
Puiiical_gen HZTANKstp Plim_charge []'hen hatteries are off compensate autodisch

DSOCmax Fixwariahles “Wariables accuracy: =100%
I SOCmin reached, disch. not allawed it SOC(%) < SOCminGa) + |9 |

Now for each combination of components, there will be 36 possible solutions of control strategy
(we have 2 control variables, and each one can take 6 values, as in variables accuracy 5=100%,
therefore each variable con take the values of 0%, 20%, 40%, 60%, 80% and 100%, where 100%
is the maximum value of each variable; therefore 6*6=36 possible combinations of control

variables).

In the main screen, GENERAL DATA tab, we reduce the search space in order to do the
optimization quickly (in a real project we would leave the original values).

MIM. AND A, No COMPOMENTS IN PARALLEL:

B atenes in parallel: Ming|0 Max. |1

Py gen. in parallel: Mind |0 Max (10

“Wind T, in parallel: Minj |13 Max. |15
"I—

Also, in the INVERTER/CHARGERS screen, we delete the ones of 10 and 20 MW (select the row
of the table and click “-“ button at the top right), leaving only the ones of 0 and 5 MW:

V' INVERTER/CHARGERS - O X
#dd from Database [zeno ~
M4 > | M|+ |-
Include only VDG suitable from famiky: | V‘
GENERAL DATA EFFICIENCY (%) vs. OUTPUT POWER (%) ->
MName Power(MyvA) Lifespan () Cost(ME) Imax_ch_DC(k&) Ef_charger(%s) Vdomin(ky) Vdomex(k) PmesCren(My) 0% 2% 3% 4% 5% 10% 20% A
Iny-ChEhii/ 5 15 05 5 a8 0.4 11 118 10 30 &0 70 13 a3 92z
3] Zero 0 100 0 a 100 0.4 11 1E18 100 100 100 100 100 100 100

In the main screen, save the project and then click CALCULATE.

After several minutes, the optimization finishes. The optimal (first row) is the same as before
(section 24), as it is just a wind park of 15 wind turbines, without batteries nor inverter/charger
(and in this case the control strategies have no meaning as there is no battery bank).
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# Total NPY (ME) Erizsion (CO247) Unmet(GWhi)  IRR(%)  Land(ha)  InvestmentME) CapF(%)  LCOEE/KWWh) Simulate Report A

1 49.929 112 0 18.59 540 375 4353 0.0233 SIMULATE.. REPOR

2 49.514 1.16 0 18.09 543 34 42.68 0.0304 SIMULATE.. REPOR

3 49.11 1.12 0 18.26 540 38125 43.59 0.0303 SIMULATE.. REPOR

4 49.069 119 0 17.63 546 40.5 41.81 0.0311 SIMULATE.. REPOR

5 48.696 1186 0 17.78 543 39625 42.68 0.0309 SIMULATE.. REPOR

[ 45.584 1.22 0 17.14 549 42 40.98 0.0318 SIMULATE.. REPOR

7 48.25 1.19 0 17.33 548 41125 41.81 0.0316 SIMULATE.. REPOR

3 48.067 1.15 0 17.6 540.05 40 43.49 0.0321 SIMULATE.. REPOR

9 48.065 1.25 0 16.77 552 435 40.18 0.0324 SIMULATE.. REPOR g
< >

COMPONENTS: 16 Wind Turb. “WindT1 (2 bW at 15 m/s] /f Unmetload = 0 % jf Total Net Present Value (NPV) = 45,929 ME, IRR = 18.6%%

STRATEGY: There is no load consurnption -» no control strategy related to the load consumption supply. ARB.: Contralwariables for grid-connected batteries: charge
(anky frarn renewakle, notfram grid) if price of E. (gell) is lower than 0.3675 £/kWh; disch. (load + injecting to the grid) if price E. higher than 0.3615 £/kiWh

If we search in the table, we can see that now the best solution which includes battery and
inverter/charger is the number 8 (same solution as before the 20" one of section 24, but with
different control strategy). We can see it has the same components as the previous # 20
(section 24), that is, 15 wind turbines, battery bank of 5 MWh and inverter of 5 MW:

PPV (MWp_do) Sloped1(y CnBat (ki) P.Gen(Mw) P Inv(Mw) P.Wind T.(Mw) . Turk (m3/s) P FC (MW P Elyz. (M) H2 tank (4 NF A
O] 27 1x6 1x0 0152 0 0 0 0
1] 27 x5 130 0152 0 0 0 0
01 27 x5 130 5 152 i i 0 0
21 27 1x06 130 0152 i i 0 0
11 27 1x0:5 1x0 5 152 0 0 0 0
W 27 1x0:5 1x0 0152 0 0 0 0
sl 27 1x[lch 1[] b 16,0 [ [ [l [l
O] 27 1x1x6 1x0 5 152 0 0 0 o |
Y 27 Talns 5] R E T T T T
£ >
# Total NPY (ME£) Erission (MCO240)  UnmetiGWhirn  IRR(5)  Landtha)  Investment(ME) Cap R3] LCOEERh) Simulate Report ~
1 i 112 0 1859 540 375 4359 0.0233 SIMULATE.. REPOR
2 1.16 0 1809 543 39 42,68 0.0304 SIMULATE.. REPOR
3 49.11 112 0 1825 540 38125 4359 0.0303 SIMULATE.. REPOR
4 49.069 1.19 0 1783 546 05 4181 0.0311 SIMULATE.. REPOR
5 48,696 116 0 1778 543 39,625 4268 00303 SIMULATE.. REPOR
B 48584 1.22 0 1713 549 4 4098 00313 SIMULATE.. REPOR
7 48.25 119 0 1733 548 41125 4181 00315 SIMULATE.. REPOR
= 48,067 116 0 7E B a3 0031 SIMULATE_REPOR__)
3 48.065 1.25 0 1577 552 435 4018 00321 SIMULATE.. REPOR |
< >
Moving right in the table (row 8™) we can also see the min. (0.07294 €/kWh) and max.
(0.14508 €/kWh) price of sell electricity to charge / discharge:
PrmacCEK Prmin DEMY EtotaliGwr)  Ereni@wh)  Epvi@nwh)  EwGwWh)  EYGWH)  Eexpon(GWh)  E Sell(Giwh) E Buy(Giwh) A
0.3615 0.3615 0 117,651 0 117681 0 117,651 114555
0.3615 0.3615 i 113212 155 117681 0 1az1e 115,89
0.3615 0.3615 i 117,681 0 117681 0 117,681 114556
0.3615 0.3615 0 120.762 3101 117,681 0 120,762 117.183
0.3615 0.3675 0 119.212 155 117,681 0 19212 115,89
0.3615 0.3675 0 122313 4552 117661 0 122313 118.457
03615 03615 0 120.762 3101 117681 0 120762 117.193
( oo i) i 117,651 0 117,651 0 117561
e TIETE i 123 863 8.202 117681 0 123863 T8 567 .
< >

And now E sell is 114.3 kWh, a bit lower than in the previous case solution #20 (section 24),
however part of this energy is paid at a higher price, therefore the incomes are higher.
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E ch. bat(Giwh)

E disch, bat (Giwh)

b o oo o oo

b o oo o oo

E elyzer. (GWh)

1.249

1187

oo o0 o000 oo

E gen (GWh)

E FC (GWh)

oo o0 oocoo oo

Haours eq. Gen Bat. life iyr)

oo o0 o ocoo oo

i

oo o0 oo ooo

100
100
100
100
100
100
100
1007
100

Hours Ch. Bat. Hours Disch. E ~

i

oo o0 oo ooo

Now energy charged by the battery bank (energy that enters into the battery) is 1.29 GWh/yr

while the discharged energy (energy that effectively supplies the battery, considering efficiency)

is 1.187 GWh/yr, these values are around 10 times higher than values of section 24.

We can see the incomes due to energy sold the first year are higher than in section 24.

E Sell (Mehr) Sell HZ (MEAY) NPV P (ME) NP Bat (ME) NPV Awe (ME) BPY Inw, (ME) NPV Gen. (ME) NPV WIndT (ME) C. Hydra (NPC) (M1 A

6916 0 ] ] ] ] ] -41.033 ]

7.006 0 -1.371 ] ] ] ] -41.033 ]

6916 0 1] 1] 1] -0.694 1] -41.033 1]

7.092 0 -2z 1] 1] 1] 1] -41.033 1]

7.006 0 -1.371 1] 1] -0.694 1] -41.033 1]

7175 0 -411z 1] 1] 1] 1] -41.033 1]

7.092 0 -2.74z 1] 1] -0.694 1] -41.033 1]

0 n 2509 n 0694 n 41033 n
7.256 0 -5.483 ] ] ] ] -41.033 ] v

< >
Also the total incomes due to energy sold in present value (NPV) are higher than in section 24.
. Hydro (MEC) (b MNPy FC (E) MPY Elyz (ME) NPV Fusl Gen(ME) NPV Fusl FC(ME) NP Buy (ME) MNP Sl (W) MPY HZ Sell (hE) ~

] 1] 1] ] 0 1] 98.462 1]

] 1] 1] ] 0 1] 99.718 1]

] 1] 1] ] 0 1] 98462 1]

0 1] 1] 0 0 1] 100.944 1]

0 ] ] 0 0 ] 499718 ]

] 1] 1] ] 0 1] 10213 1]

0 1] 1] 0 0 1] NTEEE 1]

] 1] 1] ] 0 1] 328 1]
w

< >

We can see the simulation (row 8™, click SIMULATE):
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Hourly simulation  Hourly values separately

0.3

0.2

Monthly and Annual Average Power

Manthly Energy  Annual Energy  Hydragen
Electricity price (€/kWh)

AC Generator Water load /PHS  MULTIPERIOD
¥ — Low limit disch

A A R A [

1h
1 January - 5 January

Simulation of 1 year, all the years the same.

=
=1
30 55
E 5 = Total Load
& 25 45 = — Unmet Load
o 1 £ — Disch. Bat
g 20 35 % «= Charge Batt
e — Wind T.
= 15 3 =2
H = — Sell E to grid
= 25
o 10 2z = 50C
= 15 E
5
g 0 F.08 85 ]
i mn 2 3n 4n n
z 1 January - 5 January
[« > Days disp
POWER CONSUMED OR SUPPLIED (MW) Ener ice See Ower
Batter bank Discharge Plim Charge L2z Lagend
p2 EBATTERY ENERGY (MWh) [JH.LGr
O O [JE. to supply by batt Electrolyzer [CJHR.Gr.
O [] E max disch. batt E.HZtank (HHVHZ) | R Pl S0 imi v Grid
] imits Al
Battery bank Charge Fuel Cell P critical Gen. tl
[] Export Energy Cap. Max. Seroll
1 Eio supply FC P critical Fugl Call ) change
Unmet Lece) - S0C selpoint Gen. (days)
R Wind Turb_ E.max FC Sl
Water P E boughtto AC grid | | Pmex S0C setpoint FC
Sircil AC Generator E saldto AC grid Large:
[ Pmex input Inverter [] Pmax Gen H2 TANK setpaoint (HHY H2) 50C (0-1) T.full charge

Simulation step (min): B0

Back

Save dofa

Save Simulation Data Save Prob. Data

‘COMPONENTS. Wind turbines of 30 M. Battery bank of 5 Mywh. Bat. Inverter of & bya,

STRATEGY: There is no load consurnption -> no control strategy related to the load consumption supply. SOC min.: 10 % Arhitrage: Control variables for grid-connected batteries: charge (only fram
renewable, not from grid) if price of E. (sell is lower than 0.07284 £/kWh; disch. (load + injecting to the grid) if price E. higher than 0.14508 £/kih

Almost all the days batteries perform 1 full cycle (some days more than 1), compared to the
one of section 24, where many days batteries were not used.

Haourly simulation

Hourly values separately  hanthly and Annual Average Power

Monthly Energy  Annual Energy  Hydrogen

AC Generator  Water load / PHS  MULTIPERIOD

HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
30
20
0
10
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8.000
Hydro Turbine AC Generator Export
]
T
0 |
. J .
[
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0
Battery bank Charge Battery bank Discharge Energy in Battery bank
2
1
0
0 2,000 4,000 6,000 8,000 0 2.000 4.000 6,000 8.000 0 2,000 4,000 6,000 8.000
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
20
0 10
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8.000
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Hourly simulation  Hourly values separately  Monthly and Annual Average Fower  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Waler load / PHS - MULTIPERIOD

MONTHLY ENERGY (GWh)
Total Load PV generator Wind Turbines
15
10
0 0
5
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Hydro Turbine AC Generator Export energy
15
10
0 |l - —— —
5
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Fuel Cell Electroyzer Energy (HHV of H2) in H2 tank, end of the month
0 0 0
2 4 6 8 10 12 2 4 6 8 10 12 0
Battery bank Charge Battery bank Discharge Energy in battery bank at the end of the month
0.15
0.15
o 01 0.004 /
0.05 0.05 0.002
0 0 0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Unmet load (by the standalone system) Energy purchased from the AC grid Energy sold to the AC grid
13
10
0 0
3
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12

30. Batteries with low price.

Save the project (Project->Save) and then save it with another name (Project->Save as) and give
the name “MHOGA-optCont-Bat-cheap.mho” (or another name with less characters if the path
from the root is too long, depending on the folder where you save the project).

Let’s suppose that our batteries cost (CAPEX) were much lower, for example 1/3 of the original
cost. To change its cost, in the batteries screen, select the row of the name of the battery and
change it (for example, add “-“ at the end). Then, after changing the name, we can modify any
parameter (if we didn’t change the name, the changes would not be updated). So after changing
the name, we change the cost to 0.5 M€:

Narme Cnorm.(kah) Volt(l) Cost(ve) || COMUsH)  SOCmin(s) Seli_dis/mon) Imax(kA) Eff(%) Floattyr) 10%  20%  30%  40%  50%  60%  70%  80%  90% 100% TYPE
BatShwh- 5 1 [ s B 1 25 92 15 48000 24000 16000 12000 960D 8000 6857 6000 5333 400D Li

The same for the inverter charger, let’s suppose that the cost now is 0.15 M€ instead the
original cost of 0.5 M€, change the name and then change the cost:

GENERAL DATA EFFICIENCY (%) vs. OUTPUT POWER (%) ->
Nome Power(Mviay Lifespan (y1)_Cast(df) Imex_ch_DC{ka&) Ef_charger(%) Veomin(dy) Vdomex(kv) Pmex_ren(M) 0% 2% 3% 4% 6% 10%  20% A
Ims-ChEWvY- H 15 018 5 88 09 11 TEIS 10 30 50 70 8g 93 82
» - 0 100 y 0 100 ng 11 TE16 100 100 100 700 100 100 100

Now we optimize again. Now the optimal system is of 15 wind turbines but it includes battery
of 5 MWh and inverter/charger of 5 MW:
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# Total NPV (ME£) Emission (kiCO24¢)  Unmet(GWhin)  IRR(35)  Land(ha)  Investment(ME) CapFits)  LCOEEMWH) Simulate Report ~

1 50.563 1.15 0 1851 540.08 38313 43.43 0.0306 SIMULATE.. REPOR

z 50.139 1.18 1] 16.02 543.05 39813 42.58 0.0312 SIMULATE.. REPOR

3 49.929 1.12 1] 16.59 540 375 43.59 0.029% SIMULATE.. REPOR

4 49.692 1.22 1] 17.57 546.05 41.313 41.72 0.0319 SIMULATE.. REPOR

5 49683 112 1] 16.43 540 37 688 4358 0.0239 SIMULATE.. REPOR

B 49514 1.16 1] 18.09 543 39 42 68 0.0304 SIMULATE.. REPOR

7 49.269 1.16 0 18 543 39188 4268 0.0306 SIMULATE.. REPOR

g 49.205 1.25 1] 1713 543.05 42813 40.59 0.0325 SIMULATE.. REPOR

9 49.117 1.14 1] 16.26 540.05 3gazs 43.59 0.0303 SIMULATE.. REPOR o
< >

COMPONEMNTS: Batteries BatbMWh- (5 kah): Ts.x 1p. & 15 Wind Turb. WindT1 (2 MW at 15 mfs) ¥ Bat. Inverter Im-ChBhv- of & kWA Y Unmet load = 0%/ Total Net
Presentalue (NPY) = 50,563 ME, IRR = 18.5%

STRATEGY: Thete is no load consumption -> no control strategy related to the load consumption supply. S0C min: 10 % ARB.: Control variahles for grid-connected
batteries: charge (only from renewalbile, not frorm gric) if price of E. (sell) is lower than 0.0729 £/kWh; disch. (load + injecting to the grid) if price E. higher than 0.1451 £/kWh

The previous optimal solution (just 15 wind turbines) is now the third best one (3™ row).

We can see the simulation of the best solution, it is the same simulation as the one shown in
previous section, but the NPV is higher as battery and inverter costs are lower.

Hourly simulation  Hourly values separately  Monthly and Annual Average Fower  Monthly Energy  Annual Energy  Hydrogen  AC Generator \Waterload { PHS  MULTIPERIOD

Electricity price (€/kWh) [¥ — Low limit disch
0.3 IV High limit char.
¥ — Sell

02

A A [ A M m
R e N e e W e V A

Simulation of 1 year, all the years the same.

e

Total Load

Unmet Load
= Disch. Batt
== Charge Batt
= Wind T

Sell E to grid
— 30C

e

o

wn
BATTERY ENERGY (MWh)

o\ -

L R T S N e
e

n

1 21

3 4n 51
1 January - 5 January

A JWER (MW) /H2 Tank /WATER tank (MY

> Diays digp.

We could see the effect of changing the control strategy min. and max. prices of selling
electricity. In the results table, you can change the values of the min. and or max. prices. For
example, in the first row (optimal solution), we change the min. price for discharge to 0.18
€/kWh.

Pr.max.CIEM Pr.min DEMKY Efstal(Gih) Eren(GW/h) Epv{GWh)  Ew(GwWh) Et{Gwh) E export(Givh) E Sall(Gwyh) E Buy(Gwh) A

nn7eadl iR i 117 BR1 i 117 BR1 i 11761 114422

0.07294 0.14508 i 118.212 155 117661 i 119708 116,632

03615 03615 i 117 61 i 117 61 i 17 561 114555

0.07294 0.14508 i 120.762 3101 117 661 i 120661 116.938

03615 03615 i 117 661 i 117 61 i 117561 114555

03615 03615 i 118.212 155 117 661 i 119212 115,89

03615 03615 i 118.212 155 117 61 i 1azie 11569

0.07294 0.14508 i 122.313 4652 117 661 i 12222 118.212

0.0008 0.0008 i 117 661 i 117 61 i 117561 114555 o
L4 >

After clicking in the first row, the results are updated in that row. We can see the total NPV of
the first solution is now reduced and now it would not be optimal:

# Total NPY (ME) Efission (KCOZA Unmet(Gwhiy)  IBR(3:)  Landtha)  Investmenthd) Cap F(%)  LOOEE/KWhH) Simulate Report A
1 50.075 1.15 0 16.41 540.05 30313 4354 0.0305 SIMULATE.. REPOR

We change the price of the table again to the original value and the result are updated to the
original ones:
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#  Total NPY (ME) Em

31. Multi-period optimization.

Save the project (Project->Save) and then save it with another name (Project->Save as) with the
name “MHOGA-optCont-Bat-Cheap-M.mho”.

Now we will use multi-period simulation and optimization. Multi-period implies better
simulation (it simulates all the system lifetime, not just the typical year) and it includes the
reduction in the power of the renewable sources with time, the increase in load (in the case
there is load consumption), different electricity price inflations for the different years, different
resources, etc. However, it implies much higher computation time (usually more than 30 times
compared to the simulation of a typical year). In this guide, just in some examples multi-period
is used, due to the higher computation time, however in real projects you are encouraged to
use multi-period simulation and optimization.

In the upper menu, Project->OPTIONS.

Select “Mutiperiod: simulate all the years of the system lifetime...”

MAIN OPTIONS:

Simulation and optimization:

() Simulation ofthe 1styear and extrapolate results

[@ bMultiperiod: simulate all the years of the system lifetime ( years) Optians ]

Economic aptimization:

() Minirmize Net Present Cost (NPC), usually for off-grid systems and high load on-grid ¥ tdin. NPT
tin. LCOH
@ taximize Met FresentWalue (MPY), usually for low load or no-load on-grid systems >
(@) ax. NPY
(O Min. LCOE
[ Define \Wind Farm with 16 power curves, ane for each wind direction sectar (O hin. LCOH
|:| DC renewable include own charger and contraller 8&3 ”C:':_E'F' il LD

['hen saving the project, update all the results of the table to the present conditions

MNumber of decimal places in results of costs 3 w
MNumber of decimal places in results of energy 3 ™~
0K

Then click in Options button.
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MULTIPERIOD SIMULATION AND OPTIMIZATION OPTIONS:

Show in the sirmulation duting one year:

Obtain randorm values for PURCHASE E. price inc.

~| Average (%): Std. dev. (%):
Iradiation variation over ave v Average (%) El Std. dev. (%)

Obtain random values for

@) Aerage year Annual increase in prices and load (%) / Variation over average in resources (%) / O&M PV - WT (%):
Year Purch.E. SellE SellHZ Inc. AC Inc.DC Inc.HZ dne W e Wind  OMP. OMM. ~
(O¥ear number: 1
1
Annual increase in elechicity and H2 price: Fixed Z
(it fixed. same values as price inflations of LOAD/AC GRID) 3

AL grid Electricity: F’urchase % Sell: 4

Hesold: 3 |%  [JEachyearcif houry sellprice: | Dt | |5
Hourly buy price = sellx |1
y by 6

Annualincrease in lnad consumption:  [] Fixed 2
re [ = weter 1| 3

Forwvariahle unselect "Fixed" Farwvariable unselect "Fixed" Uncheck "MNo ch."  Uncheck "Fixed

Annual decrease in genetation: 1

Py 1styear. °/; atheryears % 12
“ind Turbines. % 13
14
Hydlro Turbines El%
15
k
Battery end of life when capacity reduction af %

Annual variation over average in resources No change

Annual O&M for PV andWind T [«] Fixed

OK

The annual increase in electricity and H2 price are connected to the values set in the LOAD/AC
GRID screen, any change in them is changed in the other screen.

An annual increase in the load consumption of 1% is considered (each year the load is 1% higher
than the previous year), however in this case it is not used (there is no load).

Itis also considered by default that the PV modules generation is decreased 3% after 1 year, and
the rest of the years it is reduced 1%, wind turbines generation is reduced 1% per year, and
battery bank capacity reduction is 20% at the end of its lifetime.

We can define annual values for these data, different for each year, unchecking the
corresponding “Fixed” checkbox. Then in the table at the right appears the columns where you
can change the values.

Also, you can define annual variation in resources, if you uncheck “No change”, and annual O&M
for PV or for wind turbines if you uncheck the checkbox “Fixed” at the bottom.

For example, let’s suppose that the 6™ year the inflation of the sell electricity price will be 5%
and the 12" year it will be -4%, and the rest of the years 2%: uncheck the corresponding “Fixed”
checkbox and change in the table.
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MULTIPERIOD SIMULATION AND OPTIMIZATION OPTIONS:

Ohtain random values far PURCHASE E. price inc. v | Average (%): Std. dev. (%):
Show inthe simulation during ane year: Obtain random values for Iadiation variation over ave ~ | Average (%): El Std. dev. (%)
Asrage year Annual increffSETT PTICEY and load (%) / Variation over average in resources (%) / O&M PV - WT (%):
“ear Purch E. SellE SellHZ Inc. AC Inc.DC Inc. HZ Inc Wy, Irrad. “Wind OMP. OMMW. 2
(O ear number. 1
1 3 2 3
2 3 2 3
Annual increase in electricity and H2 price: | []Fixed
(it fixed, same values as price inflations of LOADIAG GR 3 3 2 3
AL grid Electricity: Purchase: 3 % Sell: 2 23 4 3 2 3
HZ sold: 3 % [ Eachyear diff hourlysell price: | Daie | & 3 2 3
[CHourly buy price = sellx & 3 5 3
Annualincrease in load consumption: 7 3 2 3
so [l % e 8 3 2 3
H2: D % ‘Water: 9 3 2 3
10 3 2 3 Forvarishle unselect "Fixed" Uncheck "o ch."  Uncheck "Fixed
Annual decrease in generation: 1 3 2 3
Py 1styear other years: l:l% 12 3 3
Wind Turbines: E 3 z E
14 3 2 3
Hydro Turhines El%
15 3 2 3
0 16 3 2 3
Battery end of life when capacity reduction of %
17 3 2 3
Annual variation over average in resources:  [¥] No change
18 3 2 3
Annual O&M for PV and Wind T []Fixed _ v

oK

Also, let’s suppose that we want the annual wind speed to change over the average, for example
decreasing 7,89% over the average in year 2, increasing 14.05% over the average in year 3 and
increasing 7% over the average in year 4.

First, uncheck “No change” for annual variation over average in resources.

Annual variation ower swerage in resources -I— Mo change

Annual O& M for PY and Wind T.. W Fixed

Then change the values:

MULTIPERIOD SIMULATION AND OPTIMIZATION OPTIONS: Obtein random values for | [PURCHASEE pricaine. | Average (%) sta dev ey [1 |
Showin the sirulation during one vear. Obioin randam values for | |Inadistion varistion over ave | Average (%) [0 | Std. dev. (%)
@ Aerageyear Annual increase in prices and load (%) / Variation over average in resources (%)  O&M PV - WT (%):
Vear PurchE.  SellE SelHz  Ihc.AC hoDC e H2  heW.  Imad. J§ wind JOMP. OMw. A
Oearnumber. |1 \ .
1 3 2 3 0 0
Annualincresse in electricity and H2 price: [ ] Fixed 2 : : : ! 49
(it fixed, same values as price inflations of LOAD/AC GRID) 3 3 2 3 0 1405
AC orid Electricity: Purchase: 3 % sel: 2 % 4 3 2 3 0 7
Hz sold: 3 %  [JEachyeardif. houry sell p Deta | |5 3 2 3 0 0
[JHoury buy price = sellx 5 3 5 3 0 0
Annual increase it I0ad consurmption Fixad F 3 2 3 0 0
e e [ 8 3 2 3 0 0
He waer [1 Jx B 3 2 3 0 0
1 3 2 5 Forvariable unsalect"Fixed" ) o Uncheck "Fixed
Annual decrease in generation: 1 3 2 3 0 0
PV: Tetyear: % ohervears [ s 12 3 . 3 o 0
13 3 2 3 0 0

ind Turbines:

14 3 2 3 0 0
Hydro Turaines: [0 ]%

15 3 2 3 0 0

16 3 2 3 0 ]

Battery end of lfe when capacity reductionaf 120 | %
7 3 2 3 0 0

Annual variafion over average in resourcesll [ ]No change
18 3 2 3 0 ]

Annusl 08Mfor PV and Wind T:  [] Fixed | &l

oK

We leave the rest of the default values. Click OK, then OK.
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Now, in the main screen, click in the first row of the results table. The optimal solution is
simulated considering the multi-period, and all the columns are updated to the results of the
multiperiod, showing in the energy columns the average values of the 25 years of its lifetime.
Emissions (2" column) is the average of all of the years (considering all the emissions during the
system lifetime, including the emissions due to acquisition and replacement of the components).

#  Total NPV (M£)

Ermission (KCO2A4¢)  Unmet/Gwhir)  IRR(2)  Landtha)  InvestmentbE) CapFi)  LCOEEMRWH) Simulate Report A~
bb: 1.83 0 1782 540.05 38.313 40.85 00326 SIMULATE.. REPOR

The NPV has been decreased. Except for the data of the NPV and emissions, all the data of the
table of costs and energies are referred to the average values of the years of the system lifetime,

that is, annual average values.

Let’s see the simulation of the best solution, clicking in SIMULATE in the first row. By default,
the average year (year 12) is shown.

Haurly simulation  Hourly values separately  Manthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Waterload /PHS  MULTIPERIOD

Electricity price (€/kWh), year 12 ¥ — Low limit disch
0.4 |l High limit char. |
0.3 W — Sell
0.2

A A A A M

Sim. multiperiod, shown average year. PV: 86%;C bat: 93.3%;WT: 88%;50C 1st day: 100%;Water tank 1st day: 20000dam3.

Total Load

Unmet Load
= Disch. Batt
== Charge Batt.
= Wind T.

Sell E to grid
= 50C

n

n
BATTERY ENERGY (Mwh)

o

wn

[ I T A )

Pa\ N

n

n 21

DWER (MVY) /H2 Tank AWATER tank (MY

3
1 January - 5 January

> Days disp

<
POWER CONSUMED QR SUPPLIED (Mvy) e m— SeeOver  [T|Prices ref. to year 0
Batter bank Discharge Plim Charge Legend
P2 BATTERY ENERGY (Mwh) [IHLGr
O | ] Electrolyzer s0c [CIHRGr
o
0O [] E-max disch. bait E.HZtank (HHVHZ) | R ] v Grid
] SOC limits At
D E tE Battery bank Charge P critical Gen. e " SljcmH
xport Energy ap. Max.
Eto supply FC P critical Fuel Cell change
- SOC setpoint Gen. (dleys)
Wind Turb. Srnall
R
— O Eboughtio ACgre | Prax S0 setpnint FC
‘ater Pum
P AC Generator E sold to AC gridt Pmax Large:
[ Pros input Inverer ] Prmax Gen H2 TANK setpaint (HHY HZ) SOC(0-1) | T.full charge
Simulafion step (min): 60~ I Simulaltion multiperiod year: Average ~ I Back Save data: Save Simulation Data Sawve Prob. Data

We can also see the other tabs:
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Haurly simulation

Hourly values separately  honthly and Annual Average Power

Monthky Energy  Annual Energy  Hydrogen

AC Generator  Water load / PHS - MULTIPERIOD

HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
i i, A I
0 0 | I\ | |
10 \ A m | i I w \
0
0 2,000 4,000 6.000 8.000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator Export
o kbl ikl At )
0 0 | |
10 ‘ | |
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank /f accum. Sold
0 0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0
Battery bank Charge Battery bank Discharge Energy in Battery bank
2 4
1 2
0 0
0 2,000 4,000 6,000 8,000 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
20
0 0 10
0
0 2,000 4,000 6000 5000 1 0 4,000 6.000 8.000 0 2,000 4,000 6,000 8.000
Simulation step min). 60 Simulation muliperiod year: Average Back Save data Save Simulation Data Save Prob. Data.

We can change the year shown:

Year 1: same as without multi-period

Hourly sirnulation

0.3

Hourly walues separately  Monthly and Annual Average Power
Electricity price (€/kWh), year 1

Monthly Energy  Annual Energy  Hydragen

AC Generator Waterload /PHS  MULTIFERIOD

¥ — Low limit disch
Iw — High limit char.

W— Sell
mn n 3 4n M
1 January - 5 January
% Sim. multiperiod, shown year 1. PV: 100%:C bat: 100%;WT: 100%;SOC 1st day: 100%;Water tank 1st day: 20000dam3.
= 30 5.5
_-_E 5 F Total Load
e 25 45 = — Unmet Load
g = — Disch. Batt
g 20 5 5 = Charge Batt
= 15 3 = — Wind T
H = — Sell E to grid
= 251 — soc
g 10 2 E
g 15 E
g =
£ A =
e 0 05
w n 21 3n 4n 51
E 1 January - 5 January
< > Days digp.
POWER CONSUMED OR SUPPLIED (MW) Enm e ee Ovar [T Prices ref to year 0
Batter bank Discharge Plim Charge egend
P2 BATTERY ENERGY (Mwh) [JHLGr
O O [] E. 1o supply by batt Electrolyzer soc CIHR.Gr
Ed X
O [] E. max disch. batt E.H2 tank (HHV H2) []R P1 S0C limi (v rid
imits Al
Battery bank Charge Fuel Cell P critical Gen. O
[] Export Energy Cap. Max. Scroll
Unmet Load O Eto supply FC P critical Fuel Cell . change
wind Turb. E. fifzx BT S0C setpoint Gen. (days)”

R

“y'atar P
ater Fump AC Generator

[ Pmax input Inverter ] Prmsx Gen

E hiought ta AC grid Prax
E sold to AC grid [/] Pmax

Simulation step (min): |60~ Simulaltion multiperiod year: 1

~ Back

H2 TANK setpoint (HHY H2)

Save data

S0C setpoint FC

S50C(0-1) T.full charge

Save Simulation Data. Sawve Prob. Data

Remember, in our case we saw wind in year 2 was 7.89% lower than the average, while in year
3 it was 14.05% higher and in year 4 it was 7% higher. Also, each year the wind generation is
reduced 1% due to the degradation of the wind turbine.

Year 2: lower generation
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Hourly simulation

Hourly values separately  Manthly and Annual Average Power

Monthly Energy  Annual Energy  Hydrogen

ACGenerator  Water load / PHS  MULTIFERIOD

~ JWER (MW) /H2 Tank /WATER tank (My

POWER CONSUMED OR SUPPLIED ()

Batter bank Discharge
. 10 supply by hatt
E. by by b
| [] E. max disch. batt

Battery bank Charge

|

wind Turb.

Or

[] Export Energy
Unmet Load

Watar P
SRR AC Generator

[ Pmax input Inwerter [ Priex Gen

3
1 January - 5 January

Electricity price (€kWh), year 2 W — Low limit disch
¥ High limit char
ﬂ ¥ — Sell
1 2n 3n 41 51
1 January - 5 January
Sim. multiperiod, shown year 2. PV: 97%;C bat: 97.8%;WT: 99%:S0OC 1st day: 100%;Water tank 1st day: 20000dam3.
5 & Total Load
15 — Unmet Load
s = = Disch. Batt
158 = Charge Batt
3 B — Wind T.
25 il : geOHCE to grid
2 B
15 E
18
0 D + 05
n n 41 n

ee Over

Plim Charge
Electrolyzer Pz
E.H2tank (HHY H2) []R P1
Fuel Cell P critical Gen.

E ta supply FC
E rmax FC
E boughtta AC grid || Proax

£ soldto AC grid [] P
RS M e TANK setpo

Simulafion step (min): (B0~ Simulaltion multiperiod year: 2

Back

Year 3: higher generation

Hourly simulation

Hourly walues separately  Monthly and Annual Average Power

Monthly Energy  Annual Energy  Hydrogen
Electricity price (€/kWh), year 3

Save dale

Energy price cgend
BATTERY ENERGY (hh)
S0C limits
Cap. Max_

P critical Fuel Cell

S0C setpoint Gen.
S0C setpoint FC

int (HHY H2) S0C(0-1) T.full charige

Sawve Simulstion Data Sawve Prob. Data

AC Generator  Water load /PHS  MULTIPERIOD

Days disp
[ Frices ref.to year 0

[IHLGr
[IHRGr
[v.Grid
At
Scroll
change
(days).
Srnall

Large:

¥ — Low limit disch

Iw — High limit char
03 M — Sell
0.2 A } \ [\ A [\ [
: \\_/—'“\_/I R_/"‘J \/”‘J \_/J — J_\_/ -
171 2n 3n 4n an
1 January - 5 January
é Sim. multiperiod, shown year 3. PV: 96%;C bat: 95.6%:WT: 98%;SOC 1st day: 100%:Water tank 1st day: 20000dam3.
= 30
E 5 & Total Load
e 25 45 = — Unmet Load
= 4 = = Disch Batt
% 20 358 == Charge Batt
= — Wind T
15 3w
3 25 E — el E to grid
] 10 2 0z - S0C
2" SE
= g
£ 2 A 05 %
i m 21 3M 4n 51
H 1 January - 5 January
< > Days disp
POWER CONSUMED OR SUPPLIED (M) EmeimyEs [ Prices ref toyear 0
Batter bank Discharge Plim Charge
P2 BATTERY ENERGY (Myvh) [JHLGr
O O (] E. 1o supply by batt Electrolyzer soc CJHRGr
O [ E. max disch. hatt E.Hetank (HHVH2) []R P1 S0C limit [Jw.id
o imits
Battery bank Charge Fuel Cell P critical Gen. Dax
[] Export Energy Cap. Max. Serall
T E 1o supply FC P critical Fuel Call . change
Wind Turb. E i [FE S0C setpoint Gen (E:San{:”

Or

Water P
S AC Generator

[ Pmax. input Inverter ] P e Gen

E bought to AC grid
E =old to AC grid [v] Pmax

Prmax

Sirmulation step (min): |60~ Simulaltion multiperiod year; 3

Back

H2 TANK satoaint (HHY H2)

Save datm:

S0 setpaint FC

S0C (0-1) T full charge:

Save Simulation Data Save Prob. Dala

We can see the summary of all the years in the last tab MULTIPERIOD:
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Houtly simulation  Hourly values separately  Monthly and Annual Average Power

MULTIPERIOD SIMULATION. ENERGY DURING EACH YEAR (GWh)

Total Load

Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Water load /PHE  MULTIPERIOD

PV Generator

Wind Turbines

150
100
0 0
50
0
0 10 15 20 25 5 10 15 20 25
Hydro Turbine AC Generator Export
150
100
0 0 —
50
0
5 10 15 20 25 10 15 20 25 5 10 15 20 25
Fuel Cell Electrolyzer
0 0 Save Multiperiod data
5 10 15 20 25 10 15 20 25
Battery bank Charge Battery bank Discharge Hydrogen tank cap. or H2 sold (t)
15
1 1
0
0.5 0.5
0 0
5 10 15 20 25 5, 10 15 20 25 5 10 15 20 25
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
100
0 0
50
0

In the middle right of this tab the button “Save Multiperiod data” can be used to save in Excel

format the annual data of the input variables and of the reults. Once saved, you can open the

Excel file, where the economic data are cash flow of each year (not present value), that is, money

that the owner of the system will have to spend or will receive that year.

The final column (total emissions) include emissions of the backup generator (diesel or any other

fuel), the emissions due to the energy bought to the AC grid, etc.; 1st year includes life cycle

emissions (manufacturing, recycling, etc.) of the different components.

A B C D E F
1 |Project: MHOGA-optCont-BatCheap-M.mho. Solution # 1
2
3 |RESULTS DURING THE YEARS OF THE SYSTEM LIFETIME, MULTIPERIOD SIMULATION.
4
5 | Costs and incomes are cash flow of each year (not present value)
6
7 |Year Cum. Inf. Purch. (%) Cum. Inf. Sell E(%)
8 1 2
9 2 6.00 4.04
10 3 9.27 6.12
1 4 1255 824
12 s 15.93 10.41
13 6 19.41 15.93
14 7 22.99 18.25
15 8 26.68 20.61
16 9 3048 23.02
17 10 3439 25.48
18 1 38.42 27.99
19 12 2258 22.87
20 13 26.85 2533
21 14 51.26 27.84
2 15 55.8 304
23 16 60.47 33
2 17 65.28 35.66
25 18 70.24 38.38
2% 19 75.35 4253
27 20 80.61 46.8
28 2 86.03 51.21
29 2 91.61 55.74
30 23 97.36 60.42
31 2 103.28 65.23
32 75 109.38 70.19

mMuLT [ @)

G

Cum. Inf. Sell H2(%)
3

6.09
9.27
1255
15.93
19.41
22.99
26.68
30.48
3439
38.42
42.58
26.85
51.26
55.8
60.47
65.28
70.24
75.35
80.61
86.03
91.61
97.36
103.28
109.38

We can optimize considering the multi-period.

J K L M
AC load(%) DC load(%) H2 load(%)

100 100 100
101 101 101
102.01 102.01 102.01
103.03 103.03 103.03
104.06 104.06 104.06
105.1 105.1 105.1
106.15 106.15 106.15
107.21 107.21 107.21
108.29 108.29 108.29
109.37 109.37 109.37
11046 11046 110.46
11157 11157 11157
112.68 11268 112.68
113.81 113.81 113.81
114.95 114.95 114.95
116.1 116.1 116.1
117.26 117.26 117.26
118.43 118.43 118.43
119.61 119.61 119.61
120.81 120.81 120.81
122.02 122.02 122.02
123.24 123.24 123.24
124.47 124.47 124.47
12572 125.72 125.72
126.97 126.97 126.97

N

Water load(%)
100
101

102.01
103.03
104.06

105.1
106.15
107.21
108.29
109.37
11046
11157
112.68
113.81
114.95

116.1
117.26
118.43
119.61
120.81
122.02
123.24
124.47
12572
126.97

Irred. (%) Wind(%)
-7.89

14.05

7

Scococococococococococococococooooooooo

bococooocococococococoooooo0o0o0o0

The optimization time could be a lot of time as it is much slower than without multi-period. In a

real project, we would not reduce the possible components. However, in this guide, to reduce
computation time, in the main screen, GENERAL DATA tab, we will uncheck PV Gen. and the min.
and max. wind turbines in parallel will be 15.
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GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART
COMPONENTS MIN. AND MAX Mo COMPONENTS IN PARALLEL OPTIMIZATION PARAMETERS SELECTED BY:

Bateries in parallel: Mi

Wind Turbines

@ HOGA (USER

Maximum execution time:

wyind T, in parallel; ki) ||] | h. |15 | min. Parameters

[ JHydro T.
Minimum time for the Genetic Algorithms

Battery bank

Caonstraints under NP maximization . .
Simulation

[JBackup Gen. e e stment cost ME Step (min): Simulation starts:

Inverter/char. bdin. Capacity Factar D o D Prnae_sell 60 s hour El day manth
din. Renew. Fraction I:I %

[IHz (F.C. - Elyzer) e, Unmet load %
hda, Land use ha | Data

Now we have just 4 combinations of components and, for each one, 36 combinations of control
strategies, a total of 144 combinations, but the computation time is much lower than without
multiperiod.

NUMBER OF CASES AND TIME EXPECTED

Computation speed: 0.846 cases/second

EvALALL  FOP (%ALY GEN ALG. (% ALY

MAIN ALG. (COME. COMPONENTS): 4 10(250%) 139 (3475%)

(1)
SEC ALG. (COMB. STRATEGIES): 21 12(57.14%) 183 (871.43%)
MAINALG.  SEC ALG. NUMBER OF CASES %  TIME EXPECTED

OPTION1: EVAL ALL EVALALL 64 100%  Oh1*39"
OPTIONZ: EVAL ALL GEM.ALG 732 B714%  Ohi1424
OPTIONS: GEN ALG  EVALALL 2919 3475%  Oh&7 28"
OPTION 4. GEN.ALG.  GEN ALG 25437 302621 % 8h 18"

Cptimization by means of enumerative method (evaluating all combinations). tis quaranteed to obtain the
optimal solution

In the main screen, save the project and then CALCULATE. Each combination will be simulated
during the 25 years of the lifetime, considering the decrease in generation, the variation of wind
speed and the variation in inflation of sell electricity price. After several minutes, we obtain 4
solutions (corresponding to the 4 combinations of components, each one with the optimal
control strategy). We have the same optimal solution as before.

# Total NPV (M£) Emission (KtCO2Ax) Unmet{GWhie)  IRR(2)  Land(ha)  Investment(ME) Cap F3)  LCOEEKWH) Simulate Report ~

1 45.66 1.83 0 17.62 540.05 38313 40.55 0.0326 SIMULATE.. REPOR

2 45112 1.8 0 17.92 540 375 40.95 0.0317 SIMULATE.. REPOR

3 44866 18 0 17.81 540 37.688 40.95 0.0318 SIMULATE.. REPOR

4 443 1.82 0 17.57 540.05 38125 40.95 0.0322 SIMULATE.. REPOR

v
< >

COMPOMENTS: Batteries BatbhWh- (5 kah): Ts.x 1p 15 %ind Turb. WindT1 (2 MW at 15 m/fs) /f Bat. Inverter Ir-ChEhW- of B MVA  Unmetload =0 22 /f Total Net
PresentWalue (NPY) = 45.66 ME, IRR = 17.6%.
STRATEGY: There is no load consurnption -> no control strategy related ta the load consumption supply. S0C min: 10 2. ARB. Control variables for grid-connected
hatteries: charge (only from renewahle, notfrom grid) if price of E. (sell) is lower than 0.0729 £/kMh; disch. (load + injecting to the grid) if price E. higher than 0.1457 £/kiWh

We save the project.

32. Maximum injection power to the AC grid variable.

Open the previous project “MHOGA1-optCont-Bat-Cheap.mho” (Project->Open). Then save it
with the name “MHOGA1-PmaxVar.mho” (Project->Save as).
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We will modify the project supposing that the maximum power allowed to be injected in the AC

grid is not a fixed value.

Let’s suppose that the utility has set three hourly periods for the maximum power to be injected
to the AC grid (P1, P2 and P3) with the following distribution:

SUMMER periods digtibution:
0-1h 1-2h 2-3h 3k 4-5k 5-Eh E-7h 7-Bh 8-9h 310k 1011k 11-12h

F3 ~| F3 = P3| [P3 «| |F3 =] |P3 ~| |P3 ~| P3 »| P2 ~| P2 »| P2 +] |F2 |
1213k 1314k 1415h 1516k 1617h 1718k 181%h 1920k 20-21h 2122k 22.23h  23-24h

F1 »| |F1 =] [Pt =] P2 | [P2 =| |F2 =] [P2 =] |F2 =] [P2 =] |F2 =] [P2 ~]| [F2 ~|

WIMTER penods distribution:
0-1h 1-2h 2-3h 3-4h 4.5k 5-Eh E-7h 7-Bh 8-9h 9-10h 10-11h - 1112k

F3 = [P3 =] P3 | |P3 =] F3 =] |P3 ~| |P3 =| [P3 «| |P2 ~| P2 »| |P2 »| |F2 |
12413k 1314k 1415k 1516k 1617 1718k 181% 1920k 2021k 2120k 2223k 2324k

F2 | P2 = P2 »| P3 «| [F3 =| |P3 ~| F1 =] [P ~| [P ~| [P ~| P2 +|] |F2 +|

Where summer period in this example is considered to be from March 30" to October 26™.

Let’s suppose that the maximum power allowed to be injected to the AC grid in P1is 15 MW, in
P2is 18 MW and in P3 it is 23 MW.

We cannot define different values for that power directly, but we can define for the maximum
power allowed to be purchased to the AC grid and we can set the max. power injected to the AC
grid is the same as the max. power purchased by the AC grid.

In LOAD/AC GRID window, PURCHASE / SELL E tab, uncheck “Fixed Buy Price” and “Fixed

Pmax”.

In the Sell excess energy to AC grid panel, select “=Pmax buy”, this way the maximum power to
be injected to the AC gris will be the same as the defined power to purchase from the AC grid.

V' Load and options of Selling / Purchasing Energy from the AC grid - m} X
D soues Hous | |AC | |DC [ [HZ | |Water
O Manthly Average @) Load Profile () Import File (Myy, tH2/h, dam3/h) v mmgz?%ﬂ :‘f‘i”” 1 Import Export

AC LOAD (MW) DC LOAD (MW) H2 LOAD (tH2/h) WATER (dam3/day) FROM WATER TANK  PURCHASE/ SELLE
AC GRID AVAILABILITY

|:| Eun:hasl:a frsom AdC tlgrid Unmet L)oad (Non Served Sell Excess Energy to AC grid
nerqg tand-alone system; .
- (] Fixed Sell Price (EWH) 012 Hourly Price P_I’IDHI‘y to supply E not DO\fEI’Ed by renewahles:
[] Fixed Buy Price (Ekivh) 0.15 Hourly Price = @ Storage/Generatar () AC Grid
Pr.sell = pr. buyx

Annual Inflatian (%5) Emizsion (kgCOZ/kiwh)

St Gen priority i PrbuyE>= [0 |
9y [2
3 04 Ermissians data. Annual Inflation (32)
|DF|xed Prma (M) l Fixed Cost P (f/ki] Weet, Power(hivy) 30 [] <P buy [] Sell surplus H2 in tank (difference
between the H2 in the tank at the end
30 Options 40 Hourly Values Energy Generation Chart Frice [£/kth of the year and at the beginning)

Fixed Transfer price ([£/<MWh) IC' Hourly FPrice

Access Charge Price (E/kWWh

[ Fixed Access price (Ekwh) |0 Hourly Price Selt-consumption and Net kettering Sell only 10 3

Back-up Charge Price (£/kvWh |ND net mettering ~ |

Fixed Backupprice GAW 0| | HowyFrice Costof net metering service (Skiwh) |0

(Wil be addecfa the £ purchased) [[] Add negative gen. charge Buy-back: Export E is paid at (£/kiwh) El
Total tax for electricity costs (buy + charges) (%) D Total tax for electricity sold (%) EI Losses in wire and transformer (%): El

Then click on “Hourly Price” button close to the buy price. Select Hourly Periods and accept all
the default values (3 periods, summer/winter, distribution as shown):
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HOURLY PRICE OF THE ELECTRICITY PURCHASED FROM THE AC GRID

Hourly FPrice Data (£/k\Wh)
(O Hourly, all days the same

(1 Eramfile (AZEQhaurty values) Import hourly Price
(®) Hourly Periods

Hourly Periads: .
Nurnberof Hourty Periods: |3 v (@) Summerftinter (O Mon-Fripéteekend () Hourly (from file)

Surmmer calendar: Feriod F1 Price:  |01.15

From day manth Period P2 Price: 012
To day manth Period P3 Price:  |0.08

SUMMER periods distribution:
0-1h 1-2h 2-3h 3-4h 4-5h 5-Gh B-7h 7-gh 8-8h 3-10h 10-11h 11-12h

|P3 v| |P3 v| |P3 vl |P3 v| |P3 v| |P3 v| |P3 v| |P3 v| |P2 v| |P2 v| |P2 v| |P2 vl

1213k 1314h  14-15h  15-16h  16-17h  17-18h  18-19h  18-20h  20-21h  21-22h  2223h  23-24h
|P1 v| |P1 v| |P1 v| |P2 v| |P2 v| |P2 v| |P2 vl |P2 v| |P2 v| |P2 vl |P2 v| |P2 v|

WINTER periods distribution:
0-1h 1-2h 2-3h 3-4h 4-Eh 5-Eh B-7h 7-Bh 8-9h 3-10h 10-11h 11-12h

|P3 v| |P3 v| |P3 v| |P3 v| |P3 v| |P3 v| |P3 vl |P3 v| |P2 v| |P2 vl |P2 v| |P2 v|

12-13h  13-14h 1418k 15-16h  16-17h  17-18h  18-19h  18-20h  20-21h  21-22h 2e-e3h  23-24h
|P2 v| |P2 v| |P2 v| |P3 v| |P3 v| |P3 v| |P1 v| |P1 v| |P1 v| |P1 v| |P2 v| |P2 v|

OK

By clicking in the button “Draw” we can see the hourly distribution of the periods (P1 price of
the electricity purchased to the AC grid 0.15 €/kWh, P2 price 0.12 €/kWh, P3 price 0.08 €/kWh).
These prices will not be used by the software as there is no load and it is not allowed to buy
electricity to the AC grid, but they can be used to see graphically the distribution of the periods.

Price of the electricity PURCHASED from AC grid

0.155
0.15
0.145
0.14
0.135
013
0.125
0.12
0.115
0
0.105

Price per kiwh

0.095
0.09
0.085
0.08

0 1 2 3 4 5 6 7T B 9 1 1 12 13 14 15 16 17 18 19 20 20 2 23 0
1 January

< E
Purchase price: Average 0109 £/k4h: Max: 0.15 £/kih: Min: 0.08 £/k\vh [JHarizontal Grid - [_]aK []vertical Grid Days display

Scroll change (daysy> small: |1 Flarge

Click Back and then OK.
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In the PURCHASE / SELL E tab, click “Hourly Values” close to the options of the maximum power

from the AC grid.
[ Fixed Proax (1w Fixed Cost P [£/kWw
100 Options ] ' Hourly Walues

A small window appears. Change the values to the following Pmax and costs for the different

peridos P1 to P3 (note that P4-P6 are not considered, anyway we write 0 in them):

Hourly periods same of energy hourly price periods

Prnax [Miw] Cost of Power [£/KW )
PeicdP1 15 o
PerodPz [18 o
PeiodP3 [3 o
PeodPd [0 o
PeicdPS [0 o
PerodPE [0 o

0K

Costs have been set to 0 because we will not purchase electricity to the AC grid. Anyway, this
cost would not be considered.

OK and OK. Then, in the main screen, save the project and then CALCULATE.

After a pair of minutes, we see the results.

# Total NPY {ME£) Emission (KCOZ4T Unmet{Gvwhiyr)  IER()  Landiha)  InvestmentWE) CaplFi%) LCOEE/kWWh) Simulate Report ~

1 40.539 1.07 0 17.02 504.05 35.813 41.66 0.0319 SIMULATE.. REPOR

2 40.443 1.15 0 16.41 540.05 38.313 40.56 0.0327 SIMULATE.. REPOR

3 40.226 1.05 0 17.18 504 35 41.72 0.0317 SIMULATE.. REPOR

4 40.196 112 0 16.54 540 3rE 40.61 0.0319 SIMULATE.. REPOR

5 40128 1 0 176 468.05 33.313 4263 0.0313 SIMULATE.. REFOR

B 39.981 1.05 0 17.08 504 35.188 41.72 0.0313 SIMULATE.. REPOR

7 39.95 112 0 16.45 540 37.608 40.61 0.0321 SIMULATE.. REPOR

8 39.804 11 0 16.49 507.05 37.313 40.64 00327 SIMULATE.. REFOR

9 39.726 0.98 0 17.43 465 32k 4z2.71 0.0304 SIMULATE.. REPOR v
< >
COMPOMNENTS: Batteries Batshawh- (5 kah): 15, x Tp. 1 14%ind Turb, WindT1 (2 MW at 15 m/s) # Bat. Inverter Inv-ChBMwW- of 5 MWA S Unmetload = 0 2% /f Total MNet
PresentWalue (MPY) = 40 539 ME, IRR = 17%
STRATEGY: There is no load consumption -> no control strategy related to the load consumption supply. SOC min.: 10 %. ARB.: Contral variables for grid-connected
hatteties: charge (only fram renewable. not fram grid) it price of E. (sell) is lower than 0.0725 £4/kWh; disch. (load + injecting to the grid) if price E. higher than 0.1451 £/kiwh

The optimal is composed of 14 wind turbines, battery of 5 MWh and inverter of 5 MW.

The simulation of the optimal system (January 27-28):
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Water load /PHS  MULTIPERIOD

Electricity price (€/kWh) W — Low limit disch
03 IV High limit char
. v — Sell
02 /_\
A
) o S L
2711 281
27 January - 28 January
g Simulation of 1 year, all the years the same.
535
E 25 4— 5 = Total Load
o 45 = Unmet Load
= 20 4 = = Disch. Batt.
% 15 E == Charge Batt
« = Wind T.
13 =~ & in,
H <~ Iz Sell E to grid
5 - SOC
g 2 &
2 SE
z ol S | 0s®
w 2mn 2811
E 27 January - 28 January
< > Days disp.
POWER CONSUMED OR SUPPLIED (MW £ See Ower
Batter bank Discharge Plim Charge e PR Legend
P2 BATTERY ENERGY {hivh) [JHLGr
O O ] Electrolyzer soc CHRGr
O [ E. mex disch. batt. E. H2 tank (HHY H2) R P1 soc [Jvarid
v imits Alt,
S — Battery bank Charge P critical Gen. con. M SD:mu
xport Energy ap. Max.
] E.to supply FC P critical Fuel Call ) change
N SOC setpoint Gen. (days):
Wind Turb Small
— Or e e 30C setpnint FC
ster Purm
= i p‘ AC Generator E sold to AC grid Pmax H2 TANK sstoaint (HHY H2 S0C 01 T full o Large.
[ Pmax input Imverter [ Pmex Gen setpoint (| ) o1 ull charge
Simulation step (min): B0~ 3 Back Save data; Sawe Simulation Data. Save Prob. Data.

COMPONENTS: Wind turhines of 28 M. Battery hank of 5 Mih. Bat. Inverter of § kA,

STRATEGY: There is no load consumption -> no contral strategy relatad ta the load consumption supphy. S0OC min: 10 %. Arhitrage: Control variables for grid-connectad batteries: charge (onby fram
renewahle, notfrom grid) if price of E. (sell) is lower than 0.07234 £/k\Wh; disch. (load + injecting ta the grid) if price E. higher than 0.14508 £/k\Wh

There is no load consumption

We can see the different hourly periods have different maximum output power to the energy
sold to the AC grid.

Back and save the project.

33. Pumped hydro storage (PHS).

Open the previous project “MHOGA1-optCont-Bat-Cheap.mho” (Project->Open). Then save it
with the name “MHOGA1-PHS.mho” (Project->Save as).

Now let’s suppose that we include pumped hydro storage (PHS). We build a water tank or
reservoir so that water can be pumped to the water reservoir when the renewable power is
higher than the maximum power to be injected to the AC grid and the turbine will run when the
sell electricity price is high. Let’s suppose that the water reservoir maximum capacity is 800 dam3
and the elevation head is 31 m.

In the main screen, click in the checkbox “Hydro T.”. Then, the buttons “HYDRO” and “HYDRO
TURB” are enabled and “!” is added (it means that the data of these buttons should be

introduced).
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" LOAD /ACGRID | GEMERAL DATA | OPTIMIZATION | C1
RESOURCES ~COMPOMENTS
_ soun | ¥ PV Gen.

4/IND |

I~ wind Turbines
! WDORD |

~COMPONENTS
« P GEN.

WIND TURE.
[~ Backup Gen.
! HYDRO TURE.
- BATTERIES ¥ Inverter/cha
" INVERTER/CHAR ™ H2(F.C. - Elyzer]

BACKUF GEN. |

HOE R - Fler |

¥ Battery bank

First click in “! HYDRO” button.

1l HYDRO - O X

Head (Vertical change in elevation between the head water level and the tailwater level), H: |30 m
Losses in power canal and draft tube: |2 m
Awalable head, H' =H - Insses =28 m

Losses inPenstock: |8 %

Estimated Tatal Efficiency Turbine - Generstor: 75 %, just for the estimation of the maw. generatar output power

Flow Data (m3/s)
’70‘ Marthly average  ( Impart houry data fs (m3/s] | Import ‘

ariabill

FLOW(m3/s)
Jarwary |7 Daily Variabilty |0 % Hourly Variabiliy [0 %
Februam |7 voro
Maich |7 7
6

Api 7 -

Ss
May 7 §4

2
June 7 cs

&

=
July 7 g2
pugust |7 1

o
September |7 E F M AN J MOJNTH A 5 0 N D
October [T
Ma, flow: 7 m3ss; Average flow: 6.93 m3/s

November |7 Mar. generator output power: 1.33 Mw
December [T

T 1= Giaph Export |

We accept all the default data with OK. In our case (PHS) the data of this window will not be
considered (available head and water flow of this window would be considered if we had just a
turbine that generates power with the available water flow, run-the-river hydro; this is not our
case).

Now, in the main screen, click in “! HYDRO TURB"” button.
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A HYDRO TURBINES - [m] X

ZIE *]-

HYDRO TURBINE GENERAL DATA EFF. TURBINE (%) vs. FLOW (% of F max.)
Name  Pnom(Mw) Max flow{m3/s) Min heightim) Max height(m)  Cost(ME) Lifespanfy) C O&M{ehn 0% 10% 20% 30% 40% 50%% 60% 70°% 80% 90% 100%
P Turlbdwy 1 4 25 35 1 30 1 0 0 60 80 80 80 90 a0 90 80 a0

[ you want to cansider Fumped Hydro Storage, check one of the check box below (reversible

pump-turbine or pump and turbine different machines) TurMW. F=4m3/s. Pnom=1MW; Pmax (max. height 35m)=1.09MW
Inthat case. data from HYDRO resource will not be considered. Water tank and pumping data 96
(elevation head, friction osses, purmping efficiency and purnp minimum 0ad) considersd will be the 88

anes shown in the LOAD/AC GRID window (Water tab)

Wvaterwill be pumped from regersairwhen there is renewahle energy or when settled by the control 72
stratedy: turbine will generats electicity when watsr consumption orwhen setled by control stratecy o
G 56

&
[ JPHS: Pump machine and pumping data in LOADYAC grid window, Turbine data here S 48
w40
)
[]Supply load with turb_ when load > |50 |% P turb. and Water T.» % 2

40 50 60 70 80 90 100
% MAX. FLOW

Multiplier Gearbox Efficiency: %
Electical Generator Efficiency: o

Emissions CO2 eguiv. (manutacturing...) g CO2 equiv. / kiwh generated

For PHS, we can define a reversible pump-turbine or two different machines (pump and turbine).

Let’s suppose that we will install a reversible pump-turbine, click in “PHS: Reversible Pump-
Turbine, data here....”

FHS: Rewersible Pump-Turbine, data here. Same height and friction losses (data in LOADSAC grid, water)

. .-

The data of the reversible machine is in this window, that is, in the table. Let’s suppose that in
our case is the one of 2 MW (delete the default one and add from database the one of 2 MW).

HYDRO TURBINE GENERAL DATA EFF. TURBINE (%) vs. FLOW (% of F max.)
MName  PrnomiMi) b flow(mdfs) Min height(m)  Max height(m)  Cost(ME) Lifespan fyr) CoO8M (32Ar) 0% 10% 20% 30% 40% 50% B0%  70% B0% 90% 100%
b Tuzmhy ‘ ] 25 ¥ 2 30 1 00 B0 B0 80 90 90 90 80 90 90

We can see that this machine the maximum flow is 8 m3/s, and the minimum and maximum
height are 25 and 35 m. In our case the available head will be 31 m, which, + 10% losses implies
a max. pumping head of 34.1 m, while when turbine runs the min. head is 31 m -10% losses,
27.9 m. As our turbine has 25 m for min. height and 35 for max. height, it is correct.

The efficiency vs. flow data of the table is for the turbine, the pump efficiency will be defined
later (in the LOAD/AC GRID window, tab WATER...).

The maximum power of this machine is (including turbine efficiency for max. flow, multiplier
gearbox and electrical generator efficiencies):

P = Water_flow-density-g-height _max-Total Efficiency =
=8m?/s-1000kg/m>-9,81m/s*-35m-0.9-0.98-0.9 =2.18 - 10° W = 2.18 MW

Click OK and return to the main screen.
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The reservoir capacity, height, penstock losses and pumping efficiency must be defined in the
“LOAD / AC GRID” window, WATER tab.

In the main screen, click “LOAD / AC GRID”, and, in the WATER tab, we must define the reservoir
maximum capacity (800 dam?), the capacity at the beginning of the simulation (let’s suppose it
is at 50%, that is, 400 dam?), the elevation head (31 m) and friction losses (let’s suppose 10%).

The box of the Pump electrical rated power is disabled as this power is the same as the power
of the turbine (it is the same machine), which was defined in the HYDRO T. window. However,
the data of the pump efficiency must be defined here, because the pumping efficiency can be
different than the turbine efficiency defined in the HYDRO T. window. We will suppose the total
pump efficiency (including multiplier and electrical generator efficiencies) is variable. Also we
will consider the minimum pump power is 60% of its rated power.

We want in this case that the surplus energy from the renewable power will be used priority to
pump water if the surplus energy is higher than 50% of the pump rated power (otherwise the
priority will be to charge the batteries).

) Load and options of Selling / Purchasing Energy from the AC grid - O X
Dt @mires Hours [ AC []DC [ JH2 [ |weter
. inutes- hh 1
(O Monthly Average @ Load Prafils (O Import File (M tH2/h. dem3h) 1] vintoe-t per o [FigeR Expart

AC LOAD (MW) DC LOAD (Mw) H2 LOAD (tH2/h) WATER (dam3/day) FROM WATER TANK  PURCHASE / SELL E

DALY WATER CONSUMPTION (dam3/day) HOURLY WATER CONSUMPTION (IN % OF DALY CONSUMPTION)
JanuaryEI(UGWh/day) July D(DGWh/day) 0h 1h 2h 3h 4h Eh Gh 7h &h 4h 10k 1ih

Februaryl  |(1 Gy August (1| (0GWhiday (]

March D(DGWh/dﬂy 12h 13h 14h 15h 1G&h 17h 18h 19h 20h 21h 22h 23h  Total

|
September [0 | {1 Ghyday)
5 s | 1k | |F IF I[F 2 | -
sl T Joowim  Ocober [ ] 0w [EACI
)

HOURLY WATER CONSUMPTION (% OF THE DAY
May [0 |Gy November [0 | (1 Ghyday ( !

10

June 0 Giwh/da: December 0 GiwWh/da: 5
Y, Y,

0

Scale factor for Monday - Friday:, Forthe Weekend: 0 6 18 Var\ab\l\lyminules(%).

WATER TANK, P hour
‘Water tank capacity: dam3; mig ELECTRICAL PUMP.
Capacity at the begining of the simulation (% l [ Tinlet Hydra res Pump electrical rated power: [ My Pump minimurm PDWF‘-I’ % of rated

PUMPING DATA: ) (Reversible: Pump power = hydro turh. power)  Priority to pump if surplus P > P. pump.
Elevation head m - m B Total pump efficiency: 90 >
Friction Losses -
Load profile: | Zero ~
AVERAGE LOAD IN JANUARY (included scale factor), TOTAL 0 MWh/day
el sl il M AClosd ¥ () DCload M H2(HHY) W Bl Water E pumped) |
Wariakhility AT oo He
Daityvarioniy 0 | % [0 w1 |5
Hourly Variahility El El % El %
Winutss varsoiny 0| % (30| % % £o

Carrelation minutes

Generate AL load power factor (cos phi)

0 6 12 18

Addloador [0 [MWAC ~ duing 5 |min hour

from: mmEl hnurElday- mnnth -D IRZEEERy AL max. hourly active power load in the year (inc. AC pumping): 0 MW, Max in 1/2 hintervals: 0 My

da 5
A Awerage hourly AC power: Active 0 bW, Aparent 0 MvA
0K = Graph in steps of 60 ~|min. DC max. hourly power load in the year: 0 MW: DC power hourly average 0 kW
Awverage daily load - 0 GWh/day Awerage hourly value of (Energy_DC_hourly/Energy_Total_hourly): DC Factar= 0%

We change the values shown in the figure. After selecting the checkbox “Var” (variable pump
efficiency), we can click the “Pump eff.” Button, obtaining the following window:
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PUMP VARIABLE EFFICIENCY (EFFICIENCY % VS MAX. FLOW RATE %):

0%  10%  20% W% 4%  50% 0% 70%  80% W% 100%
I E TN TN 20 2N N O O

If reversible pumpfturbine, max. flow rate of the turbine.
If different machines, using purnp of 0 MW -> Max. flow rate 0 m3/s for elevation head + losses of 34.1 m with 78
% efficiency at max. flow

Ok

The max. flow rate is the one of the turbine (8 m3/s) and we must define the efficiency of the
pump for each percentage of that maximum flow rate (from 0 to 100%), for a total elevation
head of 34.1 m (including friction losses: 31 m + 10% = 34.1 m). Let’s suppose the efficiency
values are the default ones, therefore we accept it (click OK).

After changing any data of the reservoir or pumping data, the “OK” button of the LOAD/AC GRID
data window is disabled, we must click in “Generate” to consider the new data, and later click
in “OK”.

The maximum water pumped energy needed to get the reservoir full is (supposing pump
efficiency 78%):

E = volume-density-g-height-(1+friction_losses)/Efficiency =
=800000m?>-1000kg/m>-9.81m/s*-31m-(1+0.1)/0.78 = 3.43098-10** J = 95.305 MWh

The cost of the water tank, pipelines, valves etc. should be added to the hydro turbine cost or it
could be considered in the general costs (Main screen of the software -> Financial Data tab ->
Installation Costs). In our case we will not consider these costs (we will suppose the water
storage infrastructure previously exists).

In the main screen, we will just allow 15 wind turbines in parallel (to reduce the computation
time), as it was the optimal previously. And we will allow between 0 and 1 battery banks in
parallel (to allow the possibility of having or not having batteries in the system):

A AND MAK, Mo COMPOMENTS IN FARALLEL:

Bateries in parallel: kdin, |EI |Max. ‘1 |

P gen. in parallel: kin. |E| |MED<. ‘10 |

Wind T in paraliel Min 18 [Max 15|

1 1

In the main screen, save the project and then click in CALCULATE. We obtain:
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# Total NPY (ME) Emizzion (KICOZA1 Unmet{Gywwhiyr)  IBR(2)  Land(ha) Inwvestmentibe) Cap.F)  LCOEE/yh) Simulate Report  ~
1 49 686 1.16 0 17.67 540.05 40.813 40.24 00326 SIMULATE.. REPORT
2 49.456 1.14 0 17.81 540 40 40 0.0321 SIMULATE.. REPORT.
3 49.236 1.19 0 17.24 543.05 42.313 3949 0.0333 SIMULATE.. REPORT.
4 49212 1.14 0 17.72 540 40.188 40 00322 SIMULATE.. REPORT
5 49.008 117 0 17.36 543 41.5 39.26 0.0327 SIMULATE.. REPORT.
[ 48.762 117 0 17.28 543 41.688 38.26 0.0329 SIMULATE.. REPORT.
7 48.741 1.22 0 16.82 546.05 43813 3877 00339 SIMULATE.. REPORT
L] 48.647 1.16 0 17.51 540.05 40.625 40 0.0326 SIMULATE.. REPORT.
9 48.533 1.2 0 16.94 546 43 3655 0.0334 SIMULATE.. REPORT.
10 48.287 1.2 0 16.88 546 43188 3855 (10335 SIMULATE.. REPORT. «
< >
COMPOMNENTS: Batteties BatShdwvh- (5 kah): 15 Tp. Jf 15 Wind Turb. WindT1 (2 MW at 15 my/s) /¥ Hydro Turb. AC Tur2hdvy of 2 MW, 8 m3/s ) Bat Inverter [nw-ChBhW- of
BrVA S Unmetload = 0 % 4 Total Net Present Value (NFY) = 49688 ME, IRR=17.7%
STRATEGY: There is no load consumption -> no contral strategy related to the load consumption supply. SOC min.: 10 %. ARB.: Control variables for grid-connected hdro
turb . Jpurnp and batteries: Purnp water, charge (only from renewable, not from grid) if price of E. (sell) is lower than 0.0729 €Wh; Hyd T runs, disch. (load + injecting to the
grid) if price E. higher than 01451 £/kWh

The optimal system includes battery (it is better than not including battery). The NPV is a little
lower than in the case without PHS (just with battery storage, section 30).

The limit for charge and discharge is the same value: if price is lower than 0.0729 €/kWh, charge
with the renewables; if it is higher than 0.1451 €/kWh, discharge and inject to the grid.

We can see the simulation of the best system. Check the box “R” at the right of the “Water Tank

(MWh pumped) to see the graphs correctly.

Hourly sirulation  Hourly values separately  Manthly and Annual Average Power

Electricity price (€/kWh)

Monthly Energy Annual Energy Hydrogen  AC Generator  Water load / PHS  MULTIPERICD

¥ — Low limit disch

03 IV High limit char
W — Sell
' yaN
: D
0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 0
1 January
Simulation of 1 year, all the years the same.
£ 30
é Total Load
225 Unmet Load
3 W. tank (E.)
= 20 — Water Pump
g 15 = Disch. Batt
= — Charge Batt
g 10 S T - - — — Wind T
vy ol — — N Hydro T/ TEG
g 5 / — - Sell E to grid
5, —_— e = soc
g -
0 1 2 3 4 5 6 7 8 9 10 1" 12 13 14 15 16 17 18 19 20 21 22 23
1 January
< > Days disp
POWER CONSUMED OR SUPPLIED (W) B [ 5ee Over
Batter bank Discharge Plim Charge [Legend
B BATTERY ENERST=0mm [JHLGr
O | ] Electrolyzer soc CJHRGr
v/
O [] E. max disch. bat. E.H2tank (HHVHZ) R P1 S0C limi [Jv.Grid
v imits Al
D E tE Battery bank Charge P critical Gen. c M 5’0”
xport Energy ap. Max
O Eta supply FC P critical Fuel Cell X change
- S0C setpoint Gen. {clays)
Wind Turb. Sroal
E houhtto AC orid | Pmax S0Csetpaint FC
[ Wvater Fump
AC Generator E sold ta AC grid Pmax . Large!
[ Pmz input Inverter H2 TANK setpoint (HH H2) 50C (0-1) T.full charge
[ Pmax Gen

[3 Back

Save daia

Save Simulation Data

Save Prob. Data

Simulation step (min): 60

COMPONENTS: Wind turbines of 30 MW. H. turhine / pump AC of 2 MW, 8 m3/s. Watertank of 800 dam3 (27.8 h dur.). Battery bank of B Mwh. Bat. Inverter of 5 bVA,

STRATEGY: There is no load consumption -> no contral stratedy related to the load cansurmption supply. SOC min.: 10 %6 Arbitrage: Control variables for grid-connected hdro turb Jpump and batteries
Pump water, charge (only from renewable, notfram grid) if price of E. (sell) is lower than 0.07254 £/kiih; Hyd. T rune.disch. (load + injecting ta the grid) if price E. higher than 0.14508 £/k\Wh. Priority to pump
and store E if surplus P> 50 % P pump

There is no load consumption

We can see that during the charge strategy, if electricity generated by renewable is higher than
50% of the pump rated power (50% of 2 MW = 1 MW), it is used priority in pumping water.
When renewable power is lower than 1 MW, it is used priority to charge the battery. Of course,
considering the maximum capacity of the water reservoir and of the battery.
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For example, January 26™, zooming in the graph from 4 to 6 a.m. we can see that if wind power
is higher than 1 MW, it is used to pump water, but when it is lower than 1 MW, it is used to
charge the battery (next figure).

Simulation of 1 year, all the years the same.

454
95
44 Total Load
354 54 — Unmet Load
= W._tank (E.}
=
* 53z — Water Pump
g 254 52 =3 = Disch. Batt.
g 24 5 — Charge Batt
= 151 51E — Wind T
= = Hydro T/ TEG
= 50 &
~ = — SellE to grid
= c
= 05 49 2
g ., H
s
= BE
@ 051 g
g N a7 -
o 15 4EE
2
455
254
3 44
351 43
4 5 6
[“Legend 26 January
< > Days disp
FOWER CONSUMED OR SUPFLIED (M) [ 5ee Over
- Energy price
Batter bank Discharge Plim Charge Legend
Pz BATTERY ENERGY (Myvh) [JHLGr
O O [C] E. ta supply by bt Electrolyzer []soc CIHFR.Gr
O [ E. mex. disch. batt E.H2tank (HHVHZ) R P1 [ 506 fimi [v.Grid
imits Alt
[ Export £ Battery bank Charge Fuel Cell P critical Gen. Con. M SDUD”
xport Energy ap. Max.
| E.to supply FC P crftical Fusl Cell . change
Unmet Load . S0C setpoint Gen (dlays):
[w] Wind Turb. E max FC i
MR ) S0C setpoint FC mal
oo P E boughtto AC grid || Prax ]
| Water Pum
P AC Generator E sald to AC grid Pmasx Large:
[ Pmax input Inverter [] Prax Gen H2 TANK setpaint (HHY H2) S0C (0-1) T.full charge
Simulation step (min): B0~ Back Save data; Sawe Simulation Data. Save Prob. Data
Other tabs:

Hourly simulation  Hourly velues separately  Monthly and Annual Average Power  MonthlyEnergy  Annual Energy  Hydrogen  AC Generator Waterload /PHS  MULTIPERIOD:
HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
30
= LA Ty o
0 0 [T B | |
10 i ‘ L
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator Export
30
15 T ] }
1 20 n n i
0 |
0.5 10 i [ |
0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank /f accum. Sold
0 0 0
0 2,000 4,000 6.000 8.000 0 2,000 4,000 6,000 8.000 0

Battery bank Charge Battery bank Discharge Energy in Battery bank

0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000

The “Water load/PHS” tab: we can see the water pumped and turbined and the water stored in
the tank, in dam® and in GWh of equivalent store energy. In the lower graph of hourly water

pumped/turb, positive is pumped and negative turbined.
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Hourly simulafion  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Waterload / PHS  MULTIPERIOD

MONTHLY WATER LOAD, PUMPED AND TURB. (dam3). WATER STORED IN TANK AT THE END OF EACH MONTH

3,000 1 J— 800 g

@ I
g 2500 G0 S
S 2,000 =
E 1,500 400 E
5 1,000 T E
E 2
0 0 £

1 2 3 4 5 6 7 ] 9 10 11 12
Maonth
|- Water Load W Water Pumped W Water Turbined Water in tank at the end of the month

MONTHLY ENERGY OF WATER LOAD, PUMPED AND TURB. (GWh). WATER STORED IN TANK AT THE END OF EACH MONTH

=
_ ] 01 2
£ 03 ] 00s 2
e 006 5§
T 02 s
2 0.04 £
2 o 002 &
5 =
w
1 2 3 4 5 6 7 8 9 10 1 12
Month
Hourly Water Load (dam3) PHS Hourly Water Pumped (+) Aurb. () (dam3) Hourly Water Stored in Tank (dam3)
800
0 500
0 400
20 200
0
0 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Hourly Energy of Water Load (MWh) Hourly Energy of Water Pumped (+) furb. () (MWh) Hourly Energy of Water Stored in Tank (MWh)
2 100
1
0 0 50
4
2 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000

Save the project.

34. Green H2.

Open the previous project “MHOGA1-optCont.mho” (Project->Open). Then save it with the
name “MHOGA1-H2.mho” (Project->Save as).

Now let’s suppose that we want to generate hydrogen (by means of an electrolyzer) with the
electricity that cannot be injected to the AC grid (because the renewable generation is higher
than the maximum grid power during some hours) or during the hours when electricity sold to
the grid is at low price. The hydrogen generated will be sold for external use.

In the main screen, select “H2 (F.C. — Elyzer.)” and uncheck “Battery bank” and “Inverter/cha”,
as we will not consider the batteries in our system (and the electrolyzer will have its own
rectifier).

GENERAL DATA | OPTIMIZATION | C

COMPONENTS
v PV Gen.

v Wind Turbines

[ Hydio T.

[~ Battery bank

[~ Backup Gen.

[ Inverter/cha

And then click in the button “H2 (F.C. — Elyzer.)”:
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A H2 COMPONENTS - O X
Electrolyzers H2 Tank

Generation of H2 by electrical energy

Data to modify the consumption and efficiency curves:
Add from Database Zero ~
< + | = Curves change in H2 mass flow limit (% of rateﬂ):
Factor_efiiciency:
Name F Mom(sw) | Acq costME)  C.OBMEAT Lifespan 1) A(WkgM) B (ke P.min (%)
» Elyzer1 Ohiw 10 40 5000000 20 40 10 20

Power consumption in stend-by| 10 |% of nominel power Availability
= . C i i
= LR and L g_ || Wemcost@ka e 0|
: =
z B o Stack replacement cost (% of acg. ost)
T oot g Cold starttime (min): |20 - Each cald start equiv. 1o exgl ageing (min)
> 0% 05 Lifetime and 01&M costs dat Electricity DC
Z g
S 2048 2l E @ years and Ehyr
wo g 0
w 0 005 01 015 02 () Howrs and £ Flsctrolyze
H2 QUTPUT MASS FLOW (t/h)
Ha H,0
Mamingl H2 mass flaw = 0.2 h Itis needed ot least 2 M ta generate HZ &
Equivalent CO2 emissions (manufacturing fuel cells and electiolyzers) g 002 equiv.{ KW rated power
Ic: i i (kKWh icity per kg H2): |0 | |
| [REETETI | ELECTROLYZER + H2 TANK
Annual Inflation Rate for Fuel Cells, Electrabyzers and [ hax. Variation of Fuel Cells, Electrolyzers and H2 Tanks Cost (.g., for an
HE Tank Cost % expected A% reduction on curren cst, inraduce "A0%") %
Limitis remched in 219 years
Fuel Cell and Electralyzer are cannecter 1o AC bus (by means of their inverter and rectifier respectivelly) | Inverter and rectfier tiata

In high power projects, by default there is no Fuel cell considered in the system (“FUEL CELL"
checkbox is unchecked), just electrolyzer. Also by default no H2 tank is considered (all the
hydrogen generated will be sold).

Let’s leave the default electrolyzer (of 10 MW, with a high CAPEX of 40 M€ and 5 M€/year of
OPEX, with an expected decrease of CAPEX of 10% annual with a limit of 90%, which will be
reached in 21.9 years), without any change. You can see that, by default, a power consumption
in stand-by of 10% of the nominal power of the electrolyzer is considered (all the hours when
the electrolyzer is not generating hydrogen, it consumes 10-0.1= 1 MW). Also by default its
lifetime (stack) is defined in years and the maintenance cost in €/year. The stack replacement
cost, by default, is 40% of the CAPEX. Also, a cold start time and an extra ageing due to each
start are defined.

A and B parameters (40 and 10 kW/kg/h, respectively) of the table are the consumption
parameters, with them the electrical energy consumption (MW) vs. H2 generated mass flow
(t/h) is shown in the graph (red line, left axis); the green line (right axis) is the efficiency in % of
higher heating value (HHV) of the hydrogen.

Elyzer10MW. Consumption{MW) and Efficiency(%HHV)

=
= 80%
z 8192 60 T
T 6144 -
= 40 =
7 409 o
oL
5 0=
S 2.048 c
Ui 0 0
LLy

0 0.05 0.1 0.15
H2 QUTPUT MASS FLOW (t/h)

=
na

Mominal HZ mass flaw = 0.2 th; ltis needed at least 2 MW to generate HZ

These data (A and B parameters) together with the data of the top right area (“Data to modify
the consumption and efficiency curves”, see the user manual for more info) make the
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consumption and efficiency curves. You can change these data to fit the real consumption and
efficiency curves of your electrolyzer. Suppose our electrolyzer curves fit with the following
values and the A=31 and B=1.5 kW/kg/h:

Data to modify the consumption and efficiency curves:

Curves change in H2 mass flow limit (% of rated}:
Factor_efficiency:

Narme P Homitded)  Aco cost(ME) | CO&M(EM)  Lifespan th) A KWkg/h) B (KWikoh)  Pomin (%) ~
Elyzer! Dhvy- 10 I 15 100 30000 3 15 5 l

Also we have changed the CAPEX to 15 ME, lifetime and O&M in hours and €/h will be 80,000 h
and 100 €/h, and minimum power will be 5%.

Lifetime and O&M costs data:

(years and £fyr

(@ Hours and £/h

Now the consumption and efficiency curves are (click in the table, in the row of the electrolyzer):

Elyzer1 0MW-. Consumption{MW) and Efficiency(%HHWV)

s 100
I
Z 8192 80T
T 6144 60 =
S =
2 4.096 402
= =
S 2048 0s
i 0 0
- 0 0.05 0.1 0.15 0.2

HZ2 OUTPUT MASS FLOW (t/h)

Morminal H2 mass flow = 0.219 %h; Itis needed at least 0.33 MWW to generate H2

We will add the “Zero” electrolyzer to consider the possibility of not having electrolyzer (add the
“Zero” electrolyzer from the database).

MName F. Momihf) Ach. cost(ME]  C ORMIEM)  Lifespan (h) A (kidkg/h) B (kiwifkgrh) P.min. (%) ~
Elyzer! Ohiit- 10 15 100 80000 i 15 5
» Zero 1] 0 1] 1000000 40 10 20

By default, the electrolyzer is connected to the AC bus (defined in the checkbox at the bottom
of the screeen), and has its own rectifier.

Fuel Cell and Electrolyzer are connected to AC bus (by means of their inverter and rectifier respectivelly) Inwverter and rectifier data

If you click in the button “Inverter and rectifier data” (bottom of the screen)
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ELECTROLYZER:
Efficiency of the rectifier of the electralyzer] |30

o

FUEL CELL:
Efficiency of the inverter of the Fuel Cell [%] vs Output pawer [ of rated]:

The electrolyzer rectifier efficiency is 90% by default, and its cost must be included in the
electrolyzer cost. The maximum input to the electrolyzer will be 10/0.9= 11.11 MW, as the
electrolyzer maximum power involved in the H2 generation is 10 MW (in the simulation screen
of the results, the electrolyzer power is the internal power, that is, the real power involved in
the H2 generation, with a maximum of 10 MW). We leave the data by default. The fuel cell
efficiency is not considered as in our case there is no fuel cell. Click OK to close this little window.

The electricity consumption in compressing the H2 generated and other auxiliary processes must
be set in “Compression electrical consumption (kWh electricity per kg H2)”, by default it is O
and we will leave the default value as we consider this consumption is included in the
electrolyzer consumption curve.

Equivalent COZ emissions (manufacturing fuel cells and electralyzers): kg COZ equiv. / ki rated power

Compression electrical consumption (kWh electricity per kg H2):
[JFUELCELL ELECTROLYZER + H2Z TANK

Annual Inflation Rate for Fusl Cells, Electrolyzers and |- Max. Wariation of Fuel Cells. Electrolyzers and H2 Tanks Cost (e.g. for an
H2 Tank Cost % expected 90% reduction on current cost, introduce "-30%") %

Lirnitis reached in 21.9 years

Fuel Cell and Electrolyzer are connected to AC bus (by means of their inverter and rectifier respectivelly) Inverter and rectifier data

If we click in the “Availability” button (right area), we can set the availability of the electrolyzer

(if not available, it will not work and it will not consume stand-by power, it will be off). By default,
it is available all the year. We could define that it is not available during no sun hours if there is
PV generator in the system or not available if calm wind during a number of consecutive hours
and there is wind turbine. We leave the default data:

ELECTROLYZER HOURLY AVAILABILITY

[Ao-1h [1-2n “2-3n 3-4n [4-5n “]5-6h [“6-7h [A7-8n
[“18-3h [“]a-10h Mo-11h [11-12h F12-13h [#]13-14h []14-15h [“]15-16h
[A16-17h [A17-18h [“]18-19n [“13-20h [“2n-21h [“21-22h [A2z-23n [A23-24n

Jan. Feb. Mar. Apr. May Jun.
Jul. Aug. Sep. Oct. Nowv. Dec.

[CIniot available during no sun hours if thars is Py generator

ot available if calm wind during Dnnse:ut\ve hours and there is ‘Wind turhine

OK

OK to close this small window.
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In the “H2 tank” tab (click on the top of the window in “H2 Tank”), leave the default checkbox
checked. No H2 tank will be considered, that is, all the hydrogen generated will be sold for
external use, it will not be stored to be used later by the fuel cell or by a hydrogen consumption
of our facility. Therefore, no cost for the H2 tank will be considered (actually there will be a tank
to store the hydrogen before being sold, but this cost must be included in the electrolyzer cost,
we would only consider the hydrogen tank if we had an internal consumption of hydrogen). In
the simulation screen of the results, the H2 generated will be shown as the H2 in the tank, that
is, in the H2 tank we really will see the H2 generated that will be sold.

The costs of the real tank which will be in our facility to store the H2 before selling it, plus the
cost of compressors, rectifier etc. must be included in the electrolyzer costs.

1l H2 COMPONENTS - |of x|

Electrolyzers ;H2 Tank

I¥ In H2 generating systems, do not consider H2 tank (costs 0, infinite allowed size)

OK and return to the main screen.

As there is an AC load consumption due to the electrolyzer (when it is in stand-by), we will
include the option to purchase electricity from the AC grid.

In the main screen, click “LOAD / AC GRID”, and, in the PURCHASE / SELL E tab, select “Purchase
from AC grid Unmet Load...”, the purchase price will be the default value (0.15 €/kWh) and the
sell price the hourly file we imported previously. We need to contract the power from the grid,
which will be in this case for example 1.2 MW, with an annual cost of the power of 40 €/kW.

Also click on “Sell surplus H2 in tank...” to indicate we want to sell the H2 produced, and leave
the default price of 10 €/kg and annual inflation of 3% for that price.
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V| Load and options of Selling / Purchasing Energy from the AC grid - ] X

Dl sz Hows [ JAC [1DC [ JH2 [ |wWater
' ! Minutes- each hourin 1
(O Monthly Averags @ Load Profils (OImport File (M, tH2/h, dam/h) 1~ Minioe s porrow o [impen Export

AC LOAD (MW) DC LOAD (MW) H2 LOAD (tH2/h) WATER (dam3/day) FROM WATER TANK ~PURCHASE/ SELL E

| Purchase from AC grid Unmet Load {(Non Served Sell Excess Energy to AC grid AC GRID AVAILABILI
E b g ay g
ner

Stand-alone system

Priority to supply E not covered by renewables:

) Fixed Sell Price gy 012 Hourly Price
Fixed Buy Price (£/kiwh) ourly Price: 0 @ Storags/Gensratar () AC Grid
Pr.sell = pr. buy x
annual Inflation [26): Emission (kgCO2/kwwh} Sto/Gen priority if PrbuyE 3=
3 04 c i Annual Infiation (%) i i
[V]Fixed Pmas (i) Fixed Cost P (BT Max. Power(hi) D:Pmax buy Sell surplus H2 in tank {difference

between the H2 in the tank at the end

Options Houll, Values Energy Generation Charge (Transfer Charge) Price (E/kWvh) of the year and at the beginning)

Aoeess Lhoras Lries [ Fixed Transfer price (E/kWh) IC' Hourly Price Frice (£fkg) Annual Inflation (%)
Fixed Access price (£/kih) Cl Hourly Price Selt-consumption and Met bettering: Sell anly

Back-up Charge Price £/ |ND net mettering “~ |

Fixec Backup price (A0) [0 | | HiaulyPice Cost of net metering service (G |0

(Wil be added to the E purchased) DAdd negative gen. charge Buy-back: Expar £ s paid at (/M)
Total tax for electicity costs (huy + charges) (%) D Total tax for electricity sold () D Losses in wire and transformer (%): EI

OK and, in the main screen, save the project and then CALCULATE.

There are 66 possible solutions of combinations of the components, each one has 6 possible
combinations of control strategy. The optimal system includes 10 MW PV and 15 wind turbines,
with the 10 MW electrolyzer. Remember, we had the constraint of maximum investment cost
100 M€, without that constraint the maximum allowed renewable capacity (10 MW PV and 15
wind turbines) would be the optimal combination to maximize NPV.

GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

Mono-objective optimization. Total No. of cases evaluated: 396. Time: 26"

208
192 =
176
_. 160
W 4
= 144 i
; 128 i
== i i
L2 L
2 96 C
C
80 <
64
48 : & oooo sl 1
2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40 42 44 46 48 50 52 54 56 58 60 62 64 66
Solution # (sorted from best to worst)
[ Show diagram
# Total NPV (ME) Ernission (KICO24a0)  Unmet(GWwhir)  IRR(3E)  Land(he)  InvestmentiME) CapF(%)  LCOEEANWH) Simulate Report A~
1 206209 1B 0 28K 570 71.25 331 00595 SIMULATE.. REPOR
2 205.627 1.77 0 28.02 567 E4.75 3353 0.0533 SIMULATE.. REPOR
3 204.976 1.74 0 28.39 564 B8.25 3399 0.0559 SIMULATE.. REPOR
4 204.249 1.7 1] 29.77 561 BB.75 34.47 0.0557 SIMULATE.. REPOR
5 203.4311 1.68 0 3016 558 G5.25 3493 0.05584 SIMULATE.. REPOR
[ 202.516 1.64 0 30.56 113 6375 3652 0.055 SIMULATE.. REPOR
7 201.554 1.61 0 3047 552 E2.25 36.09 0.0577 SIMULATE.. REFPOR
3 200.458 1.58 0 31.38 549 G075 36.69 0.0573 SIMULATE.. REPOR
9 200.446 1.73 0 2877 534 65.75 3Z6 0.0675 SIMULATE.. REPOR
W
< >
COMPOMENTS: PV gen: PY1-mad (1 Mp_dcha 10 (100% PV#1: slope 274, azimuth 02/ 16 Wind Turb. *WindT1 (2 My &t 16 m/s) #/ Electroliz. Elyzer] Obyy- of 10 M
Unrnetload = 0 %/ Total MNet PresentWValue (NPY) = 206.209 ME, IRR = 26.7%.
STRATEGY: There is no load consurmption -» no control strategy related to the load consumption supply. Control variahles for green hydrogen: Generater H2 (only fram
renewshle, not from grid) if price of E. (sell) is lower than 0.2172 £fldwh

The strategy shows that hydrogen is produced from renewable sources when the sell price of
electricity is lower than 0.2172 €/kWh (optimal limit), if the renewable power is higher than the
nominal power of the electrolyzer (10 MW) the rest is injected to the grid. If price is higher than
0.2172 €/kWh, renewable power is injected to the grid.
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We can see in the column “H2 tank (t)” the amount of hydrogen produced (and sold) during each
year. In the optimal case (first row), 1604 tons of H2.

P.PV(MWp_do) Slope#1(f) CnBaliksh) P .Gen(M¥) P lmv(MW) P.Wind T.(MW) F. Turb (m3/s) P.FC(MW) P.Elyz. (M HE tank (i PN
101 270 1x0 0152 0 0 1 1604.259
a1 270 1x0 0152 0 0 10 T
il 270 1x0 0 152 0 0 10 15891369
7x1 270 1x0 0 15x2 0 0 10 1580.7052
i1 270 1x0 0 152 i 0 10 1571 4611
5l 270 1x0 0152 0 0 10 15613929
41 270 1x0 0152 0 0 10 15505301
3x1 270 1x0 0 15x2 0 0 10 15369487
101 270 1x0 0 14x2 0 0 10 15836394
W
< >

For example, during several days in January there are several hours with the sell price higher
than 0,2172 €/kWh, therefore renewable power is injected to the AC grid (except for the
minimum power of the electrolyzer). See next figure, where this is marked, from 18 to 20 h.
Note that, due to the differences in left and right axis of the two graphs, the graphs are not
synchronized in the bottom axis view.

Haourly simulation

Houtly values separately  Monthly and Annual Average Power

bonthly Energy  Annual Energy  Hydrogen
Electricity price (€/kWh)

AC Generator \Waterload / PHS  MULTIPERIOD

W — Purchase

M — Low limit disch
03 v High limit char.
f \ ¥ — Sell
02 N
01 /] N
0 1 2 3 4 5 6 T 8 9 10 1 12 13 14 15 16 17 18 19 20 4 21 22 23 0
2 January
= Simulation of 1 year, all the years the same. =
Z 0 s0.000 &
= = Total Load
= 25 = Unmet Load
H 50,000 2 — Wind T
& 20 40,000 = PV
= - =+ Electrolyzer
g 3000 & Buy E from grid
——— — H2 tank (HHV)
- - o~
§ L e 200 Sell E to grid
= = —_— 10.000 &
E o o E
a 0 1 2 3 4 5 6 7 8 9 10 1" 12 13 g
2 January
< > Days disp.
POWER CONSUMED OR SUPPLIED (M) S Over
q Plim Charge EnEiEy (8= Legend
Batter bank Discharge 9 g
P2 BATTERY ENERGY (MWh) [JHLGr
O O Electralyzer . [JHRGr
E.max disch. hatt E.H2 tank (HHY HZ) [/]R P1 . O Grid
| S0C limits A
Battery bank Charge P critical Gen.
[ Export Energy Cap. Max. Scrall
E.lo supply FC P critical Fusl Cell ) change
N S0C setpoint Gen. (days):
Wind Turb Small,
R
— O E boughtto AC grid [7] Pmax 50 setpoint FC
‘ater Pum
P AC Generator E sold to AC grid Pmax Large:

Prmax. input Inverer 0
F max. Gen,

B0

Simulafion step (min.) ~

Back

COMPOMNENTS: PY generatar of 10 Myp_dc (100% PV#1: slope 27¢, azimuth 02). Yind turbines of 30 MWW, Electrabyzer of 10 M.

HZ TANK setpoint (HHY HZ)

Save data

S0C (0-1) T.full charge

Save Simulation Data Save Prob. Data

STRATEGY. There is no load consumption -> no contral strategy related to the laad consumption supply. Arbitrage: Control variables for green hydrgen: Generate H2 (only from renewable, not fram grid)

if price of E. (sell) is lower than 0.21722 £/kiwh

There is no load consumption
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Water load / PHS  MULTIPERIOD
HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
g 30
6 20
0 4
9 10
0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator Export
30
20 I
0 0 I
10
)
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
10
60,000
0 5 40,000
20,000
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Battery bank Charge Battery bank Discharge Energy in Battery bank
0.001
0 0 0.001
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8,000
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
03 20
02
g 10
0.1 | |
0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000

The Hydrogen tab: we can see in columns hydrogen generated during each month and the total
sold (black line).

Hourly simulation  Hourly walues separately  Manthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Water load /PHS  MULTIPERIOD

MOMNTHLY H2 CONSUMPTION AND PRODUGCTION (). H2 STORED IN TANK OR SOLD AT THE END OF EACH MONTH

160
140 1.600 %
= o 1400 5
@
@ 1200 £
£ 100 =
1,000 =
I
5 8 800 T
g £
5 e 60 3
T 4 a0 2
20 200 9
0 0
1 2 3 4 5 6 7 8 9 10 1 12
Month
W[ H2load @ H2 produced by Electrolyzer @ H2 consumed by Fuel Cell (from Tank)
¥ B H2 consumed by Fuel Cell (extemal H2) == H2 stored in tank / sold at the end of the month
MONTHLY ENERGY PRCDUCED BY FUEL CELL AND CONSUMED BY ELECTROLYZER (GWh)
7
£5s
C
>
>
@ 3
2
w
2
1
0
1 2 3 4 g 6 7 8 9 10 " 12

Month

||7. Energy generated by Fuel Cell M B Energy consumed by Electrolyzer

Save the project.

35. Probability analysis.

Next, we will perform, for a particular combination, the analysis of probability of variation of
load, irradiation and inflation rate of the price of fuel (if we had diesel or other fuel generator).
Thus we will see how the variations of these variables affect the system.
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Open the previous project “MHOGA1.mho” (Project->Open). Then save it with the name
“MHOGA1-Prob.mho” (Project->Save as).

In the main screen, click the "Probability Analysis" button (above the calculate button):

) Probabilistic analysis of variability of load, irradiation, wind speed and/or water flow (or fuel price inflation) - m} X

(©) DO NOT PERFORM PROBABILITY ANALYSIS (@) PERFORM PROBABILITY ANALYSIS

Tule 1n Monte Carlo Simulation
@ Confidence level (%) max errar of the mean (%) El

(O Relative standard eror lower than () l:l

Analyze variability of the average value of load [[] Analyze variability of the average value of irradiation

Number of series to analyze each combination of components and control strategy:

Monte Carlo simulation with stopping rule

Analyze variability of the average value of water flow

Analyze variability of the average value of wind speed []Analyze variability of the average value of fuel price inflation. Average (%):

Stendard Devistion: mis

hean = 8.492, Std. Dev. = 0.2 mfs

£
a
=
a
2
a

Maximurn = 9.02, Min. = 7.84 m/s 0
Hourly variahility in the series: D % € £ Z

Average wind speed (m/s)
Std. deviation for temperature °C

D Consider correlation between the variables Correlation data

In the simulation, show the case obtained with the following data:
Load: Irradiation: Wind speed Water flow
[Average | [Average | [Average | |Average ~|

D Inthe case ofthe simulation, include hourly variability

In the bahili TsTEPOTT. in the last two charts. show the probability distribution of:
‘Energy soldto AC grid (WEAT) v‘ ‘\ncumes of selling E to AC grid (currency) v|
Il ofthe results table. do not update results

DWhen clicking on simulation buttan, do not consider the characteristic cases Each year different rmean value

0K

We select "PERFORM PROBABILITY ANALYSIS", and also "Analyze the variability of the average
value of wind speed". We leave the number of series to be performed for each component
combination and control strategy in 500 (default) and the stop rule according to the default
value. We also leave the standard deviations that appear by default (for wind speed 0.5 m/s
together with the temperature affecting the wind turbines 1°C).

In the two drop-downs menus at the bottom, select "Energy sold to AC grid (UE/yr)" and
"Incomes of selling E to AC grid (currency)", respectively.

Click on "OK" and return to the main screen.

If we pass with the mouse over the area where the minimum and maximum number of parallel
components are indicated, a window similar to the following appears:
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NUMBER OF CASES AND TIME EXPECTED

Computation speed: 0.048 cases/second

EVAL ALL POP. (% ALL) GEN ALG. (% ALY
MAIN ALG, (COMB. COMPONENTS); 11904 81 (0.68%) 1147 (3.64%)
{1x11904)
SEC. ALG. (COME. STRATEGIES): 1 3(300%) 1 (4100%)
MAIN ALG.  SEC ALG. NUMBER OF CASES %  TIMEEXPECTED
OPTION1: EvAL ALL EvAL ALL 11904 100%  2days19h
OPTION 2 EVAL ALL  GEN.ALG. 406064 400% 117 days 5h
OPTION 3 GEM ALG. EVALALL 1147 364%  Gh 35
OPTION 4 GEM.ALG. GEN.ALG 17027 3951% 11 days 7h

Waringl. Minimum computing time is b6h 35' so that the Main Genetic Algorithm can evaluate a
minimum number of combinations.

With this minimum time it is not guaranteed to obtain the optimal combination of components. but
this is probable to obtain the optimal or a solution near the optimal

Indicating that the calculation speed is now 0.048 cases/second (approximately 500 times lower
than before, since each case is evaluated up to a maximum of 500 times with different wind
speed series, obtained randomly from their probability curves, whose mean values follow a
normal distribution as we have seen). MHOGA would need at least 2 days 19 h to perform the
optimization considering all the combinations, and only 6 h 35’ if using genetic algorithms
metaheuristic technique.

To avoid excessive time dedicated to follow this guide, in our case we will not perform the
optimization including the probability analysis. What we are going to do is simply to see the
effect of the variation of the wind speed in a concrete case. For example, if we want to see how
the probability analysis affects the best solution found, simply click on the first row of the table
(where the best solution is indicated).

The following window appears, indicating that you are performing the 500 probability analysis
combinations for the selected combination (although it will stop earlier if the stop criterion is
reached before):

L] ]
Frobability seres # 129 of 500

Cancel

After a few seconds, that screen disappears and the results in the 1st row of the table are
updated, but now the results we see in the 1st row are the average values of the combinations
of probability analysis evaluated (500 or less if reached the stopping criterion). In our case, the
average results are slightly different from the original result. Each time we click on the same row
of the table, it will slightly change the result, because a new analysis of probability is performed.

Gen Total NPY (ME) Emission (KICO241) Unmet(GWwhiyr  IBR(%)  Landiha)  InvestmentibE) CapF*) LCOEEKYWh) Simulate Report ~
1 49.775 1.12 0 1853 540 375 435 0.0301 SIMULATE.. REPOR

If we click again on the 1st row, but now in the "SIMULATE" cell, the following box appears,
which indicates that you are doing the analysis of 500 probability combinations again (or less if
the stop criterion is met), plus other 5 typical cases (combinations of mean, mean + standard
deviation, mean-standard deviation, mean + 3 standard deviation, mean - 3 standard deviation),
as there is only one variable in the probability analysis (wind speed), 5! = 5 typical cases of
combinations are evaluated, in addition to the 500 (or less if the stop criterion is met) random
combinations.
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L] ]
Frobability senes # 314 of 500+5

Cancel

After some seconds the simulation screen appears:

Hourly simulation  Hourly values separately  Manthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Waterload /PHS  MULTIPERIOD

Prob: Wind Av.; Simulation of 1 year, all the years the same.

2 Total Load
26 Unmet Load
= Wind T.

i Sell E to grid

POWER (M) /H2 Tank ANVATER tank (MWh)
B

]
6
4
2
0
1 2 3 4 5 6 7 8 9 10
[ Legend January
< > Days digp.
POWER CONSUMED OR SUPPLIED (M) [=ee over
; Plim Charge Energy price Legend
Batter bank Discharge 9 g
= BATTERY ENERG' (Mivh) [IHLGr
O O Electrolyzer o THRG
O E. . disch. batt E H2tank (HHVHZ) R P1 v Grid
SOC limits Tlan
Battery bank Charge P critical Gen.
[] Export Energy Cap. Max. Seroll
Eto supply FC P critical Fuel Cell change
Wind Turb S0C setpoint Gen. (days)
Or e BOC setpaint FC Small
PP E boughtto AC grid Pmax 1
‘ater Pump
AC Generator ] E soldto AC grid [v] Prax
[ Pmax input Inverter e —— & H2 TANK setpaint (HHY H2) SOC(0-1) | T.iullcharge
Simulation step (min): 60~ 3 Back Save data Save Simulation Data Save Prob. Data

COMPONENTS: Wind turbines of 30 hiv/.

STRATEGY: There is no load consurmption -> no contral stratedy related to the load consumption supply. Arbitrage: Contral variables for grid-connected battaries: charge (only from renewable, notfrom
grich) if price of E. (sell) is lower than 0 £/kwh; disch. (load + injecting to the grid) if price E. (sell) is higher than 0.11 £/kivh

The simulation of the case of average wind speed (Wind Av.) is visualized. By default, the average
case is displayed, but we could have chosen to display another combination, for example, the
worst extreme, which would be the case of average wind speed - 3-standard deviation, the case
being displayed must be indicated before on the probability analysis screen as shown below:

In the simulation, show the case obtained with the following data:
Laoad: Irradiation: Wind speed W ater Flow

|.-'3.verage j |.-'3.verage j |.-’-‘«verage j |Average j

In the simulation screen, clicking the "Save Simulation Data" button saves the time data of the
simulation case being displayed (in our case, the average case).

Save Simulation Data Save Prob. Data

By clicking the "Save Prob. Data" button, the results of the probability analysis are stored in an
Excel file. If you open the saved Excel file, something similar to this is shown:
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) 4 Y A

A 3 © [ € F 9 ) K L M N [ » a R s T Y
1 [project: MH¢GA1-prob] solution #1
2 | COMPONENTS: Wind tirbines of 30 MW.
3 STRATEGY: There is no no control strateg) tothe load o pply. Cc d batteries: charge batt. not from grid) if price of E. (sell) is lower than 0 €/kWh; disch. batt. (Ioad + injecting to the grid) if price E. (sell) is highe
4
5 RESULTS FOR THE
6 First 500 Next pond to the case shown lat IUM, MAXIMUM, AVERAGE and STD.DEV. of the results of the 500 random series are shown:
7
s
9 Case prob. No. Rad.(kWh/m2/day)  Tamb(sc) Tambw(ec) Wind(m/s) W.Flow(m3/s) or inf. fuel Load(GWh/Hay) Total NPV (Me€) LCOE(Me/kwh) Emission(kiCO2/year)  Unmet(%) Renew.(%)
10 ) 544 1862 1862 85 496 003 11 o 100
1 1 5.4 1862 1994 852 0 97 003 11 [ 100
12 2 544 1862 1629 887 o s57.4 0.028 11 o 100
3 3 544 1862 2017 861 o 52 0.029 11 [ 100
" 4 544 1862 17.69 8.27 0 451 0.031 11 0 100
15 s 544 1862 1819 9.02 o 66.3 0.025 11 0 100
16 6 544 1862 1894 835 o 6.6 0.031 11 o 100
7 7 544 1862 1828 882 o 56 0028 11 o 100
18 s 544 1862 17.88 714 o 191 0.043 11 0 100
19 s 544 1562 1881 835 o 8.2 0.027 11 o 100
20 10 544 1862 184 883 0 6.2 0.028 11 0 100
21 u 544 162 1679 821 o a1 0032 11 o 100
2 12 544 1862 1846 9.08 0 60.7 0.027 11 0 100
2 1 a4 162 1977 858 o 51 0.029 11 o 100
2 1 544 1862 1821 8.08 0 408 0.033 11 [ 100
25 15 s 162 1849 812 o aLs 0032 11 o 100
2 16 .44 1862 196 s 0 387 0.034 11 [ 100
27 17 544 162 204 8.6 o s57.9 0028 11 o 100
28 18 544 1862 1884 837 0 69 0.031 11 o 100
29 19 544 162 187 El o 592 0.027 11 o 100
30 2 544 1862 1846 82 0 434 0.032 11 0 100
31 2 544 1862 178 855 o 509 0.029 11 o 100
2 2 s.44 1862 1993 932 0 643 0.026 11 [ 100
3 2 544 1862 1841 805 o 401 0.033 11 o 100
34 2 s.a4 1862 1819 8.2 0 a4 0.032 11 [ 100
35 2 544 1862 1818 9.34 o 65 0.026 11 o 100
36 2 s.a4 1862 1578 878 0 6 0.028 11 [ 100
a7 27 544 1862 1959 836 o o\ 64 0.031 11 o 100
38 28 5.4 1862 1926 868 0 o 53 0.029 11 [ 100
20 2 s.a0 1862 191 274 a 0 2 .03 11 o 1
prob ®

- AN J

In this case we see the 500 rows corresponding to the random probability cases, one in each
row of the table (cases 0 to 499, the stopping rule of the Monte Carlo Simulation was not met).
In each case the average wind speed and temperature are random (following their probability
curves defined in the probability analysis screen). In each case (each row of the table) the results
of this case are shown: total NPV, LCOE, emissions, unmet load, renewable fraction, etc.

After the first 500 rows, the results for 5 = 5 typical cases of combinations of wind speed,
including the average case, the most optimistic (mean wind speed + 3DT) and More pessimistic
(mean wind speed -3DT):

509 a% sa 1862 Y — 0 0 £ 003 11 0 100
510 Resul data: AVERAGE, :
511 Case prob. No. Rod.(kWh/m2/day) __Tambiec) Tambwiec) Wind(m/s) WFlow(m3/s) or nf.fuel Load(GWh/day) Total NPV (Vi) LCOE(Me/kwh) Emission(kiCO2/year) _ Unmet(5) Renew()
ISE— 5 oz 562 o o ™)
513 so1 a4 1862 1862 5 o o 5.1 0027 11 o 100
e 0 a 18.6: 18.6: 10 o o 7 0,024 11 o 00 )
sis s03 544 1862 1362 s o o 389 003 11 o 100
[ — S FXs) FiXs) 7 5 5 Fxy o085 FEY 5 ™)
517 Resultscorresponding to case shown in simulation:
518 Case prob. No. Rad. Tambieg) Tambw(sc) Wind(m/s) Wlow(m3/s) or nf.fuel Load(GWhyday) Total NPV (M€) LcoE(Me/kwh) Emission(itCO2/year) _ Unmet(%) Renew.(%)
519 S5 a1 186 1562 55 3 3 11 )
520
521/Values MINIMUM, MAXIMUM, AVERAGE and STO. DEV. of each result obtained i the 500 series:
52| Case prob. No. Rad.(kwh/m2/day) Tamb(eC) Tambw(ec) Wind(m/s) W.Flow(m3/s) or inf. fuel Load(GWh/day) Total NPV(Me) LCOE(M€/kwh) Emission(ktCO2/year)  Unmet(%) Renew.(%)
523 MINIMUME saa 1862 1575 714 o 0 7202 002 1135 0 100
524 MAXIMUM sa 1862 22 951 o o 19116 oot 115 o 100
52| MEAN: sa 1862 186 847 0 0 48,65 003 112 0 100
526/STD.DEV.: o o 036 048 o 0 979 0003 o 0 o

1
pob | @ N

It is observed that, in this case, the average case (mean wind speed, 8.5 m/s) has a NPV of 49.6
M€, the optimistic extreme case (mean wind speed + 3- std. dev = 8.5+3:0.5 = 10 m/s) has a NPV
of 74.5 M€ and the pessimistic extreme case (mean wind speed - 3- std. dev = 8.5-3:0.5 =7 m/s)
has a NPV of 19.6 M€

The next line (case 505) shows the case that is represented graphically in the simulation (average
case).

The following lines show the minimum, maximum, mean, and standard deviation values for each
column (from the 0 to 499 cases, i.e., the random cases).

If we return to the main screen of MHOGA and click on the first row of the table, in the cell
"REPORT", after a few seconds the report appears, which shows the average results of the
analysis of probability of that combination of components and strategy:
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iHOGA software. Report.

Univesity of Zeragazs (Spain), with the colsbarstion of SISENER Ingeniems
Project MHOGA-Prob.mhe: Salutan 1
DC Voltage: 1 V. AC: 20 B,

COMPONENTS:

NPC/ NPV M€}

PV gen. PV1-mad, Dx1 Mitip. P total = 0 Mip (1003 FV#) FOWER [MW}

Batt. BatSMWh, 1x0x5 k. E totsl =0 GWh (0 d.aut) WIND
15Wind T. WindT1, 15x2 MW {@14més). P. tctal 20 MW 20
Without Hydro Tubine 25

Without AC Genersior 20

Without Fuel Cell 5

Without Eledrolyzer 0

Wiithout Inverter-charger -

Land wse: 540 ha wT

CONTROL STRATEGY:

THERE IS NOLOAD CONSUMPTION - NO CONTROL STRATESIES RELATED TO THE LOAD CONSUMPTION
SUPPLY

GONTROL STRATEGY FOR GHARGE/DIGHARGE (load + injecting to the grid) OF GRID-GONMEGTED
ATTERIES:

Max elechicty price &ell) for charging: {only fom renewable) 0 £kWh; Min. eleck. price for discharging: 0.11 £4Wh.

ECONOMIC CALCULATIONS:

Initial Investment: 375 ME Loar: 100 %, int. 73 in 35 years, amnual quola: 3218 ME

NPV OF THE SYSTEM (25 years lifatime) (Incames +, sxpenses |

Total Net Present Value (NPV): 48 887 ME. Internal Rate of Return {IRR): 18.22 %. LCOE : 00301 £MNh

Distribution of NPV:

ENERGY BAIANCE DURING 1 YEAR {GWh/year}:

Overall Load Energy: 0 GWVhiyr.

UnmetIoad: 0 GWhiyr {0 % load)

E. Furchased fom AC grid: 0 GWhiyr

Export Energy: 118.442 GWhir

E.sold to AC grid: 113138 GWhiyr

Renawable Capacity Fackor (sold_enesgyi{mnew_peak power8780
Energy delivered by FV generator. 0 GWhir

Energy delivesed by Wind Tubines: 116,433 GWhir
Energy deliverad by Hydro Turbine: 0 GWhir
Energy delivered by AC Generstor: 0 GWhAT
Energy deliversd by Fuel Cell: 0 Githir

Energy atEledrolyzer 0 GWhir

Energy chaged by Batteres: 0 GWhiyr

Energy discharged by Batteries: 0 GWhiyr

OTHER RESULTS:

Battesies Lifetime: 100 years

421 %

Hours eq. of AC Generator oparstion: O hiyr
Hours of Electrolyzer operation: 0 hiyr
Hours of Fuel Call operstion: 0 hiyr

Totsl CO2 emisions: 1.124C02yr

HZ sold in one year: 0 t HZ4T

Wind turbines [MPV): -41 033 M€
BuySell. Bought Energy (NFV): 0 ME. Sold Enemy: Bleckicsl E. (NPV): 57.2 ME. H2 (NPVE 0 ME
Installaticn+financing (NPV): -7.5ME

ENERGY BALANCE DURING 1 YEAR [GWhiyear)

Bs838

LOoAD Exp Sell Wind

1of2 of2

Click on "Close" (upper area of the report) and after selecting or not to save the .rtf file, after
few seconds the report of the probability analysis of this case appears.

This report includes 4 pages, you move from one to the other with the arrow buttons at the top.

H 4 2 of4 b M

You can print or create a PDF file with the button = , you select the printer (physical or pdf

creator) and then you can print or create the PDF.

The first page shows the probability representation of the most representative results, marked
in red the columns of the probability distribution obtained and the green curve is the one that
best fits that distribution. The second page shows the results of other less important variables
(only the mean and standard deviation) and then the results of the characteristic cases are
shown (the 5 representative cases mentioned above, which include the mean and the optimistic
and pessimistic extremes).
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Project: MHOGA1-Prob.mho. Solution# 1
PROBABILITY ANALYSIS:

RANDOM DATA FOR THE PROBABILITY ANALY SIS {PDF and Gaussian curvel:

Load: mean DGWhiday. Std. Dev.: 0

Insdaton: mean 5.45 KWimZiday. Std Dev.: 0

00000000D00000000000

Wind: mean 848 m/s. S, Dev.: 05
1

675 716 755 788 84 877 17 98

00000000000000000000
Wister flow imslevant, them is no hydm tubine

00000000000000000000

RESULTS OF THE PROBABILITY ANALY SIS (PDF and Gaussian curve}.

Total NFV: mesn 48557 WE. St Dev.: 10.012

0.05

106 187 274 38 428 515
Unmetload mean 0%. Std. Dev.: 0

58 858

Lev. Cost of Energy: mean 0.0805 €/Wh. Std. Dev.: 0003

m%
0024 0028 0032 0.027 0041 0045

(COZ Emissions: mean 1.12C0Zyr, Std. Dav. 0

00000000000000000000
Ren. cap. factor mean 431 % S, Dev.i 444

01

262 29 32 /1 383 428 456 N5

Batteres lifespan: mesn 100 yesrs. Std. dev. 0

00000000000000000000
Export E: mesn 116GWhir. Sd. Dev.: 136
004
002] “mll
€2.1 799 82 3.2 109 113 129 139 149

ACgen fuel mean0; Std. Dev.0

00000000000000000000

PV gen energy: mean 0GNhiyr. Std Dev.: 0

00000000000000008000

Charge snergy i Bantary bank: masn 0GWiyr. Se. Dev.: 0

00000000000000000000

Wind turbines group energy: mean 116GWhiyr. Std. Dev . 128
0.04
0.02
891 79.9 89 962 109 119 129 139 149

Energy of AC generstor: mesn 0GWWhyr. Std Dev.: 0

00000000000000000000

Energy soki 1o AC gridt masn 112.1GWh/y. Sid. Dev.: 117

00000D000000000000000
Incomes seling £ to AC grid mean & 8 ME Ayr. Std, Dev.: 07
0.5.

[}
418 485 52 572 823 85 742 799

6887 791 8395 10365 1816 13263
1efs
nE:l.l.T!oF AEL Combinatont

CHARACTERIETC CA.
(foelecied); § \Valac par varable casoisd:
IDATA (v chamotsritts osce):

rradistion, Wird mwﬂumormum
30, memn3

i, meane 50, mean=110, maan.

Avemgs Daly irradaten (MVNTE): Average'Wind Speedimin:
o
1.
A - - - .
a
T T T T s T ; 1
3 El 3 2 3 Bl H
AverageWakr Fow im3e: Avarsgs dally Lasd (OWN):
[ - - - . [ |
T T T T T T T t
2 3 El H [ 2 E] El 5
Ve otersoricio ce s
Tkl MF (W) LCOE )
noas
[T no
an nos
nm
2 [T+
T T T 1
2 a 2 H 2 a Bl H
CO2 Emiscions kAN Uneed Lasd (%)
T T T T T
2 a H a a
[Exatiary Lifadims freare) Fusl concumgiion (ifrexc E8y);

1 a3 s 2 H 3 s
Expor Ensrgy (OARYT £ Sought ) £ Said) K2 Soi (NPCIHPV) (ME):
mn m
.
o, 50
e T T T T oy T T T
1 3 s 2 3 s

OTHER RESULTS OF THE PROBABILITY ANALYSIS:

Hours eq. mnning AC Genesator mean 0 h. Std. Dev.: 0

Annusl cost of fuel of AC Generator: meano MEM 5. Dev:0

Hydre Turbine Energy: mean 0GWhiyr St

Discharge Energy Battery Bank: meanOBme! S Dm0

Hours of Batteries charge: medis 0 hir. Std. Dev.: 0

Hours of Batteries discharge: mean 0 hyr. Std. Dev. 0

Wax. uent of Batteries Charge Regulstor: mean 30 A, Std, Dav: 0
Rectifier max power. mean 0 W. Std. Dev.: 0

Energy purchased to AC grid: mesn 0GWhAr. Std. Dev.: 0
Energy sold to AC grid: mean 113 1GWhiyr Std. Dev: 117

Cast of purchesing E to AC grid: mean 0 M€y Sid. Dev.:0
Incomes of selling E to AC gid: mean 8.8 ME iy Std. Dev.:07
Incomes of selling E to AC gid: mean 8.8 ME iy Std. Dev.:07
Energy of Fuel Call: mean 0GWhyr Std. Dav.: 0

Houwrs unning Fuel Cell: mean 0 h/y. Std. Dev.: 0

Energy of Eleckolyzer: mean 0GWh/y. Std. Dev.:0

Hours unning Electolyzer: mean 0 hiyr. Std. Dev.: 0

Hydrogen sold for extemal use: mean 0 kgyr. Std. Dev.: 0
Incomes of selling H2: mean 0 ME /. Std. Dev.: 0

External fuel purchased to be used at Fuel Call: mean 0 kgfyn. Std. Dew. 0
Cost of external fuel purchased 1o be used at Fuel Cell: mean 0 ME /. Std. Dev.: 0
VARIABLE COST (NFC) (purchase E- sell E = varisbh +oam \el\ab\e*heb+lggulabl
+ rectif+ H2 tank- sell HZ - residusl varistle values of companents stthe end of syzem lifetime): mean 7.2 ME. yr.
Std. Dev.: 10

Cast of purchasing Eto AC gid (NFC): mean 0 ME Sd. Dev.:0

Incomes ofselling E to AC grid NPV mesn 87.2 ME Std. Dev. 10

Variable cog of batteries (NPCjreplacement - residual; mean 0 ME Std. Dev. 0

Variable cost of AC gen. [NPC) (D&M +replacement - residusl): mean 0 ME. Std. Dev.:0

Cost ofregulator +redlifier NPC) {amuisition + replacement -residual): mean 0 ME. Std. Dev.:0

Variable st of Electiolyzer + H2 tank (NPC] {0&M + replacement - residual): mesn 0 ME. Std. Dev.:0
Variable cost of Fuel Cell { [NPC)0&M + eplacement - residualy mean 0 ME Std. Dev.:0

Cost of purchasing extemsl fusl for Fudl Cell (NPC): mean 0 ME. Std. Dav: 0

Incomes of selling H2 for extemal use (NFVE mean 0 ME. Std. Dev: 0

20f4

RE BULTE OF Wiind cpeed, Wiedsr Sow or Fusling.
andLosd(l cssobd), §Walusc per varidis pelsded: mun mean+40, msan=d $0, mEan. 30, memn-2 80,

#1.DATL Wind spoad 85 mis. RESULTE: Tokl MNPV 406 MOLDOE: QORI TR W L lnad 0%, Emissions
1 WCORyr. Randw. Can ek 43 5% ExpotE: 1 7GRy . Batedes dime 100 . . E soldio AT g d i)
LA

-EDJ'L'FL Wi rd spead Smis. RESULTE: Totd NPV- 551 ME LOOE - 00272 Gkt Uhmad load 0% Emissions.
7. Rarew. Can fackor 477 % Expod E- 1315Whtyr. Bateries lifdime 100 w. . E soldioAC gid NPV

l:r'a'.c

#2.DAT #TM‘O nk. RESULTS:Totd NPV "4al'rELE‘CE 0023('4#’ Ll o 0 Y. S 810G
1. W00y, Ranew. Can fackor 546 %. ExpontE - 1550WhY . Batones lfgima 100w . E saldio AC gla e

LIS

#3.DATL Jh'l:ﬂxc\:&’ FESULTS: ‘RxahF\' ﬁsr—:u:-cE on:aac"m' Ut i@ 0% Ermi ssions.
1. WECOEyr Ranew. Can tactor 3.7 % ExponE Bateries e 100y - E soldiohs aldiEv)

T

#5. DATL Wind s ‘5. RESULTE: Totd NPV 155 ME LOOE - 0045 Gk, Uhmedt lo2d - 0% Emissions.
1. keCORyr. Rarew. Can factor: 284 % Expot E- 500y Baliories fedme: 100ye .E scldio AT gid NPVL
=% 4

To close the report we click "Close" and we are asked if we want to save the results of the
analysis of probability in a .doc or .rtf file (which can be open by Microsoft Word). We agree,
save the file and open it with Microsoft Word:
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Project: MHOGAl-Prob. Solution # 1
PROBABILITY ANALYSIS:

RANDOM DATA:

Irradiation irrelevant, there are no PV modules
Wind: mean 8.53 m/s. Std. Dev.: 0.5

Water flow irrelevant, there is no hydro turbine
Load: mean 0GWh/day. Std. Dev.: 0

RESULTS:

Total NPV: mean 49.678 M€. Std. Dev.: 10.124

CO2 Emissions: mean 1.12ktC0O2/yr. Std. Dev.: 0

Ren. frac.: mean 100 %. Std. Dev.: 0O

Export E: mean 118GWh/yr. Std. Dev.: 13.8

Unmet load: mean 0 %. Std. Dev.: O

Batteries lifespan: mean 100 years. Std. dev.: 0

AC gen. fuel: mean 0; Std. Dev.:0

PV gen. energy: mean OGWh/yr. Std. Dev.: 0

Wind turbines group energy: mean 118GWh/yr. Std. Dev.: 13.8
Charge energy in Battery bank: mean O0GWh/yr. Std. Dev.: 0
Energy of AC generator: mean OGWh/yr. Std. Dev.: 0

OTHRER RESMT.TS -
]

Finally, we save the project.

36. Sensitivity analysis.

Now we will perform the sensitivity analysis in the MHOGA1.mho original project.
We open the MHOGA1.mho project and save it as "MHOGA1-Sens.hoga".

To reduce the search space and the computation speed, we unselect PV generators:

COMPONENTS

¥ “ind Turbines

[~ Hypdro T.

|v¥ Battery bank
[~ Backup Gen.
v Inverter/cha

[~ HZ2[F.C. - Elyzer ]

Click the "Sensitivity Analysis" button on the main screen (lower left area, above "Probability
Analysis").

A screen appears with different tabs. We select the left tab, Wind. We click in “Add” two times,
two cases of the sensitivity analysis appear, cases Wind2 and Wind3 (Wind1 is the base case
defined in the wind speed window). We set 1.2 for the scale factor of wind speed for Wind2 case
and 0.8 for Wind3 case.
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W Sensitivity Analysis - O x

Wind I olar I Load Interest and Inflation (general or electricity cost) I AC gen. fuel inflation Components cost

SENSITIVITY ANALYSIS OF WIND SPEED

Wind1: Case base: Average Wind Speed: 249 m/s

Ls]
Windz, | oelmerdedela lr 2 ] A Wwind = 1019 m/s

" From file [hourly values in m/s] Height [m) |‘\[I

(+ Base Casex Scale Fac(r 0.8 l
Wind 3:
€ From file [hourly values in m/s)] Height (m] |1 1]

Ay, wiind = B.79 m/s

Add | Remove last one 1= Graph

With the “Graph” button we can see the three wind speed series:

Sensitivity Analysis of Wind Speed

0 1 2 3 4 5 [ 7 8 9 W0 M 12 13 14 15 16 17 18 19 20 21 22 23 0
1 January

¥ — Wind1: 8.5m/s |W — Wind2: 10.2m/s |W — Wind3: 6.8m/s |

< ;
[ JHorizontal Grid - [J&r []¥ertical Grid Days display

Scroll change (days)-> small: large:

Back and then click in “Interest and Inflation (general or electricity cost)” tab.

We choose “Electricity inflation (....” as we will consider the sensitivity analysis of the electricity
sell price inflation.

We click in “Add” two times, two cases of the sensitivity analysis appear, cases (I-g)2 and (l-g)3.
We set 7% for interest rate (nominal discount rate) and 1% for electricity price inflation for case
(I-g) 2 and 7% and 3% for case (I-g) 3.
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[ Sensitivity Analysis - O x

Wind Solar Load l Interest and Inflation (general or electricity cost) lAC gen. fuel inflation Components cost

SENSITIVITY ANALYSIS OF ANNUAL INTEREST (I AND INFLATION (g) RATES

(1-0) 1: Case base: Interest: 7%: Inflation El icity cost: [ h and sell inflati shown in LOAD/AC GRID)

Inflation refers to
l l-g) 2:  Interest |7 % Inflatior: |1 z] " General inflation

[ & Electricity inflation [Purchase and Sell price inflation] [in base case shown values of buy price inflation % sell price inflation) ]

l 0-g) 3 Interest |7 % Inflation: |3 ‘Z]

Add | Remove last one

We could also define sensitivity analysis of components cost, load (if there was load
consumption), irradiation (if there was PV generation), and AC gen. fuel inflation (if there was a
backup generator).

Click on "OK" (it takes some seconds to close the window) and, in the main screen, save the
project and then "CALCULATE".

After a few minutes the sensitivity analysis ends. We have analyzed 3 cases of wind speed x 3
cases of interest and electricity price inflation = 9 projects.

By default, the sensitivity analysis #1 is shown, corresponding to the base case (same result as
in the MHOGA1.hoga Project).
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V| Project: D:A\PROYECTOS MHOGA 3.4-202403XX\MHOGA1-Sens.mho - m] X

Project Data Data Base Report Visual Help License Updates

 LOAD/AC GRID GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART
M bij i Sensitivity analysis No. 1. Total No. of cases evaluated: 3456. Time: 3' 0"
RESOURCES 50
SOLAR .
o WIND 46 =
HYDRO g4 =
= £
COMPONENTS g 2 12
= 40 Z
P GEN = 5
2 38 [
« WIND TURB % £
HYDRO TURE. 3
+f BATTE 32
4 8 12 16 20 24 28 32 36 40 44 48 52 56 60 64 68 72 76 80 B84 8 92 96 100
~ INVERTERYCHAR Solution # (sorted from best o worst)
BACKUP GEN,

H2 (F.C.-Elyzen [1Show diagram

Water Pump in Load/AC grid
Wind.1: 8. 5m/s Rad.1- 5 48kWh/m2  ~ Load.1: 0GWhiday (-gEN: 7%-312% | ~ |InF.1.Base ~ Pr1xd 1 x1 1 v

Doverege[l |k CJsocd. #  Total NPV (ME) Ermission (ACO2fyn Unmet(@whiyn  IRR()  Land(ha)  InvestmeniME) CapF(%) LCOEE/Wh)  Simulate  Report A
ACWolt 3 1 49.929 112 1] 16.59 540 375 4358 0.0298 SIMULATE.. REPOR
el 2 2911 112 0 182 540 dies 4389 00303 SIMULATE.. REPOR
3 48.292 112 1] 17.94 540 38.75 4358 0.0308 SIMULATE.. REPOR
PRE-SIZING 4 47.82 1.05 1] 18.86 504 35 4418 0.0294 SIMULATE.. REPOR
Energy siorage: [4_| days eutan 5 47.494 114 0 1762 54005 39.375 4359 00313 SIMULATE.. REPOR
[JMex b, paraliel=> Cn min & 47025 114 0 173 E00S A 43B4 00317 SIMULATE.. REPOR
Mes PV gon parallsl > P min 7 47.001 1.05 R 504 1B 4418 00235 SIMULATE.. REPOR
[ IMexWind T. perallel -> P min 8 46.655 1.12 1] 1733 540 40 4359 0.0318 SIMULATE.. REPOR
9 46.214 1.14 1] 17.09 540.05 40625 4364 0.0322 SIMULATE.. REPOR
Max AC Gen. parallel-> Pmin v
< >
COMPONENTS: 16 Wind Turb. WindT1 (2 MW/ at 15 mfs) /f Unmet load = 0 % /f Total Net Present Walue (NPV) = 49929 ME, IRR = 18.6%
Sensitivity Analysis
STRATEGY: There is no load consumption -» no control strategy related to the load consurmption supply. Control variables for grid-connected batteries: charge (only
Probability Analysis from renewakle, natfrom grid) if price of E. (sell) is lower than 0 £kWh: disch. load + injecting to the gric) if price E. (sell) higher than 0.11 £/kWh
8 CALCULATE
5 REPORT
See best Sensitivity Analysis Summary Save Excel tahle

We can select another project by clicking on the drop-down box "Sensitivity analysis #" (above
the results table):

Sensitivity Analysis # 1 R

ity Analpsis # 3
Sensitivity Analysis # 4

ity Analpzsiz # 5
vity Analysis # 6
ity Analpsiz # 7
ity Analpsis # 8

For example, if we choose # 2, the results of sensitivity analysis #2 appear:

L wigin
l Sensitivity Analysis # 2 ~ I

~ JRad.1: 5.45kWh{m2 ~ || Loadl: 0G¥h/day \| (I-gE)2: 72%-1% j Inf.F.1:Base ~ | Pr.1:x1 x1 x1 x1 w

P Ernizsion (kiCOZA)  Unmet{Giihdr) Land(ha)  Irevestrmert ap F3)  LCOEEMKYWh) Simulate Report ~
1 40.095 112 : 540 75 43.45 0.0299 SIMULATE.. REPOR
z 39.277 112 0 540 38125 43.46 0.0304 SIMULATE.. REPOR
3 38.481 1.05 0 504 35 44.03 0.0295 SIMULATE.. REPOR
4 38.458 112 0 540 38.75 43.46 0.0309 SIMULATE.. REPOR
5 37.662 1.05 0 504 35.625 44.03 0.03 SIMULATE.. REPOR
[ 37 661 1.14 0 540.05 39.375 4346 0.0314 SIMULATE.. REPOR
7 37.164 1.14 0 540.05 40 4351 0.0318 SIMULATE.. REPOR
3 36.844 1.05 0 504 36.25 44.03 0.0305 SIMULATE.. REPOR

L] 36.821 112 0 540 40 4346 0.0319 SIMULATE.. REPOR v
< >

COMPONEMNTS: 15 Wind Turb. SWindTT(Z MW at 14 myfs) /f Unmetload = 0 % /f Total Net PresentValue (NPY) = 40,095 ME, IRR =17.2%

STRATEGY: There is no load consumption -» no contral strategy related 1o the load consumption supply. Control variables for grid-connected batteries: charge (only
from renewable, natfrom grid) if price of E. (sell) is lower than 0 £/kWh; disch. (load + injecting ta the grid) if price E. (sell) higher than 011 £/kWh

We see that it corresponds to the base wind, Wind1 (8.5 m/s average wind speed) and the case
of interest and inflation of electricity price (I-gE)2: 7% and 1%. As the inflation of electricity sell
price is lower than the base case, the optimum has a lower NPV than in the base case.
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We can also modify directly the drop-down box of each variable. For example, if we change the
wind drop-down box and select Wind2:

|wind.1: 8.5m/s =]

Wind 2: 10 2mfs
Wind.3: 6.8m{s

We see that analysis number 5 appears, with higher NPV as wind speed is 20% higher than in
the base case

[ Show diagram
l Sensitivity Analysis #5 ~ ]

Rad.1:5.45kWhim2  ~ Loadl: 0GWh/day ! (FgE)2: 7%-1% j Inf.F.1:Base vIPrixixiaa v
; ofal NFY (Mt Emission (COZ24r) Unmet(GWwhhn  IBR%)  Lan MWESITIEN ap.F(*)  LCOE[/kWh) Simulate Report ~
1 64.861 112 1] 22.74 540 375 5575 0.0233 SIMULATE.. REPOR
z 64.233 1.05 1] 2381 504 35 5768 00225 SIMULATE.. REPOR
3 64.043 112 1] 22.35 540 KA ) 85,75 0.0237 SIMULATE.. REFOR
4 63.415 1.05 1] 2317 504 35.625 57.68 0.0229 SIMULATE.. REPOR
5 63.224 112 1] 21.96 540 3875 5575 00241 SIMULATE.. REPOR
B 62.694 0.93 1] 24.37 Bl 3258 59.39 0.0278 SIMULATE.. REFOR
7 62.596 1.05 1] 22.75 504 36.25 57.68 0.0233 SIMULATE.. REPOR
8 62.427 1.14 1] 2157 540.05 38.375 BR7E 00244 SIMULATE.. REPOR
9 62.097 1.14 1] 1.3 540.05 40 bh.g2 0.0245 SIMULATE.. REFOR

< >

If we click on "Sensitivity Analysis Summary" (below the table) a comparative chart of the 9
analyzes projects appears, indicating below the optimal solution of each one:

W Sensitivity Analysis Summary - [m] X
NPC/NPY and CO2 Emissions of the best solution found for each sensitivity analysis

88
80
72

g 64 =

= E

; 56 %

548 e 15

2 4 i

= o

o o

= 32 =
24
18
8

1 2 Y 4 5 6 7 8 9
Sensitivity analysis #
Display in graph:
Back @ NPCand CO2 emissions  (JNPC (O CO2Emissions () COZ Emissions-NPC (O Unmetload - NPC Feport
Best solution found for each sensitivity analysis: SR (2] Saveword
SENSIT. ANALYSIS # 1 (Wind1: 8 5m/s; Load1: 0GWh/day: (FgE)1: 796-342%; InfF 1:Base; Pr1:x1x1 x1 x1); ~

NP = 43593 ME. CO2 Emissions = 1.125 kiyr, Unmetload = 0 GWhAr (05%). IRR = 1852 %, Investment = 37.5 ME. LCOE = 0.03 £/kwh, Capacity factor = 43.5%, Land use =540 ha
Companents: Wind Turbines group AC of 30 My,

SENSIT. ANALYSIS # 2 (Wind1: 8.5m/s: Load: 0GWh/day: (FgE)2: 7%6-1%: InfF.1:Bage; Pr.1:x1 x1 x1 x1);
MNP = 40,086 ME. CO2 Emissions = 1.126 kifyr. Unmet load = 0 GWhdyr (0%6). IRR =17.18 %4 Investment = 37 & ME. LCOE = 0.03 £/kivh. Capacity factor = 43.5% Land use =540 ha
Companents: Wind Turbines group AC of 30 ki,

SENSIT. ANALYSIS # 3 (Wind1: 8.5m/s; Load]: 0GWh/day: (FgE)3: 79%6-3%: Inf F.1:Base: Fr.1:x1 x1 x1 x1)
NPV = B0.BD4 ME. CO2 Emissions = 1125 kifyr. Unmet load = 0 GWhiyr (0%6). IRR =18 82 % Investment = 37 5 ME&. LCOE = 0.03 £/kiwh. Capacity factor= 435% Land use =540 ha
Components: Wind Tuthines group AC of 30 M.

SENSIT. ANALYEIS # 4 (Aind2: 10.2m/s; Load: 0GWh/day; (FgE)T: 7%-3\2%; Inf F.1 Base; Pr1 x1 x1 x1 1}
NP = 77.013 ME. CO2 Emissions = 1.125 kibr, Unmetload = 0 GWhir (05). IRF = 24.08 %, Investment = 37.5 Mg, LCOE = 0023 £/kWh, Capacity factor = 55.7%, Land use = 540 ha
Companents: Wind Turbines group AC of 30 My,

SEMSIT. ANALYSIS # 5 (Wind2: 10.2m/s; LoadT: 0GWh/day: (-gE)2: 7%-1%: InfF.1:Base; Pri:xd x1 x1 x1)
MNP = 64851 ME. CO2 Emissions = 1.125 kijyr. Unmet load = 0 GWhyyr (0%). IRR = 22,74 % Investment = 375 ME. LCOE = 0,023 £/kWh. Capacity factor = 56.7% Land use = 540 ha
Companents: Wind Turbines group AG of 30 My,

Clicking the "Save Excel" button it saves an Excel file where the optimal solution for each of the
sensitivity analysis projects appears:
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B C D E F G H ! J K L M N o P Q
1 [Project MHo_bALsens.mho. Best system found for each case of the sensitivity analysis
2 [Sens.# Wind (m/s) Rad(kwh/m2/d) Load(GWh/d) Interest(%) Inflation EE(Purch/Sell)(%)  Infla.Fuel(%) Pr.PV(x) PrW.T.(x)
3 1 85 5.45 o 7 3\2 1 1 1
4 2 85 5.45 4 7 1 1 1 1
5 3 85 5.45 0 7 3 1 1 1
6 4 10.2 5.45 0 7 3\ 1 1 1
7 5 102 5.45 0 7 1 1 1 1
8 6 102 5.45 0 7 3 1 1 1
9 7 6.8 5.45 o 7 32 1 1 1
10 8 6.8 5.45 0 7 1 1 1 1
1 9 6.8 5.45 0 7 3 1 1 1
12

If we click on the "Report" button a report of the sensitivity analysis appears, that can be printed

or saved in PDF.

7%-32%: Inf F 1:Base; Pr.1: x1 x1 x1 x1)
NPV = 49.593 M€E. CO2 Emissions = 1.125 kt/yr. Unmet load = 0 GWhiyr (0%). IRR = 18.52 %. Land use = 540 ha

NPV = 40.095 ME CO2 Emissions =1 125 kt/yr Unmet load = 0 GWh/yr (0%). IRR =17 19 %_Land use = 540 ha

NPV = 60.504 ME. CO2 Emissions = 1.125 ki/yr. Unmet load = 0 GWhiyr (0%). IRR = 19.82 %. Land use = 540 ha

SENSIT. ANALYSIS # 4 (Wind2: 10.2m/s; Load1: 0GWhiday: (I-gE)1: 7%-3\2%; Inf.F.1:Base: Pr.1: x1 x1 x1 1)

NPV = 77.013 ME. CO2 Emissions = 1.125 kt/yr. Unmet load = 0 GWhiyr (0%). IRR = 24.08 %. Land use = 540 ha

NPV = 64.861 M€. CO2 Emissions = 1.126 kt/yr. Unmet load = 0 GWhiyr (0%). IRR = 22.74 %. Land use = 540 ha

NPV = 90.974 M€E. CO2 Emissions = 1.125 kt/yr. Unmet load = 0 GWhiyr (0%). IRR = 25.4 %. Land use = 540 ha

NPV = 10955 ME CO2 Emissions = 1125 kt/yr Unmet load = 0 GWh/yr (0%). IRR =987 %_Land use = 540 ha

7%-1%; InfF.1:Base; Pr.1:x1x1 x1 x1)
NPV = 5.197 ME. CO2 Emissions = 1.125 kt/yr. Unmet load = 0 GWhyr (0%). IRR = 8.49 %. Land use = 540 ha.

Project: MHOGAT-Sens. mho Optimal solution found for each case of the sensitivity analysis:
SENSITIVITY ANALYSIS
SENSIT. ANALYSIS # 1 (Wind1: 8.5m/s; Load1: 0GWh/day; (I-gE)t
DATA (vs. sensitivity analysi
Capacity factor = 43 5%. Investment = 37.5 M€. LCOE = 0.03 €KWh. E. sold to AC grid (NPC) = 96.125 ME
Average Daily Irradiation (KWhim2): Average Wind Speed (mis):
10
B SENSIT. ANALYSIS # 2 (Wind!: 8.5m/s; Load1: 0GWh/day; (-gE)2: 7%-1% InfF.1 Base; Pr.1: x1 x1 1 x1):
[T NN S N A A S S —
8 Capacity factor = 43 5%. Investment = 37.5 M€. LCOE = 0.03 €/Wh. E. sold to AC grid (NPC) = 88.629 ME
T
T2 3 4 5 6 7 8 9 12 3 4 5 5 71 8 9
Average daily Load (GWh/d): Interest (%) and Inflation EE(Sell) (*%): SENSIT. ANALYSIS # 3 (Wind1: 8 5m/s; Load!: 0GWh/day: (-gE)3: 7%-3%; InfF. 1:Base; Pr.1:x1 x1 3 x1):
| Capacity factor = 43 5%. Investment = 37.5 Mé. LCOE = 0.03 €1ih. E. sold to AC grid (NPC) = 109.038 M€
T 2 3 4 5 & 7 8 8 T2 3 4 5 6 1 8 8
Capacity factor = 55 7%. Investment = 37.5 M€. LCOE =0.023 €lWh. E. sold to AC grid (NPC) = 125.545 ME
Fuel inflation (%): Pr. PV, Wind, Bat, H2 (xfactor):
| | SENSIT. ANALYSIS # 5 (Wind2: 10.2m/s; Load1: 0GWhiday; (-gE)2: 7%-1%; InfF_1-Base; Pr.1-x1 x1 x1 x1).
| | Capacity factor = 55.7%. Investment = 37.5 M€. LCOE =0.023 €kWh. E. sold to AC grid (NPC) = 113.395 ME.
T2 3 4 5 & 1 8 8 T 2 3 4+ 5 6 7 8 9
RESULTS (vs. sensitivity analysis #): SENSIT. ANALYSIS # 6 (Wind2: 10.2m/s; Load1: 0GWh/day; (I-gE)3: 7%-3%: InfF1-Base: Pr.1-x1 x1 x1 x1).
Total NPV (M€): Emis.CO2 (ktfyr): Capacity factor = 55 7%. Investment = 37.5 M€. LCOE = 0.023 €/kWh. E. sold to AC grid (NPC) = 139.507 ME.
80
&0 125
L | SENSIT. ANALYSIS # 7 (Wind3: 6.8m/s; Load1: 0GWhiday; (-gE)1: 7%-32%; InfF.1.Base; Pr.1: xt x1 x1 x1):
2
— —— Gapacity factor = 26 4%. Investment = 37.5 €. LCOE = 0.049 €/KWh. E. sold to AC grid (NPC) = 59.488 ME
T2 5 4 5 & 7 8 9 T 2 3 4 5 6 7 8 9
Capacity factor(%) IRR (%):
2 SENSIT. ANALYSIS # 8 (Wind3: 6.8m/s; Load1: 0GWh/day; (-E)2
&0 2 Capacity factar = 26.4%. Investment = 37.5 M€. LCOE = 0.049 €kWWh. E. sold to AC grid (NPC) = 53.73 ME.
10 15
30 10

If we click on the "Save Word" button

Microsoft Word.

a report in rtf format is saved, which can be open

[Project: MEOGAl-Sens.mho. Cptimal sclution found for each sensitivity
analysis:

SENSIT. ANALYSIS # 1 (Windl: 8.5m/s; Loadl: 0GWh/day;
Inf.F.1l:Base; Pr.1l: =1 =1 =1 x1):

NPV = 4%.553 ME. COZ Emissions = 1.125 kt/yr. Ummet load = 0 GWh/yr
(0%). IRR = 18.52 %. Investment = 37.5 ME. LCOE = 0.03 €/kWh. Capacity
factor = 43.5%. Land use = 540 ha Components: Wind Turbines group AC of
30 Mm.

(I-gE)1: T7%-3.2%;

SENSIT. ANALYSIS £ 2 (Windl: 8.5m/s; Loadl: OGWh/day;
Inf.F.1:Base; Pr.1: xl x1 x1 x1):

NPV = 40.095 ME. CO2 Emissions = 1.125 kt/yr. Ummst load = 0 GWh/yr
(0%). IRR = 17.19 %. Investment = 37.5 ME. LCOE = 0.03 €/kWh. Capacity
factor = 43.5%. Land use = 540 ha Components: Wind Turbines group 2C of
30 Mw.

(I-gE)Z: T7%-1%;

SENSIT. ANALYSTS # 3 (Windl: B.5m/s; Loadl: 0GWh/day;
Inf.F.1:Bass; Pr.1l: xl x1 x1 x1):

NPV = 60.504 ME. CO2 Emissions = 1.125 kt/yr. Unmet lead = O GWh/yz
(0%). IRR = 19.82 %. Investment = 37.5 ME. LCOE = 0.03 £/kWh. Capacity
factor = 43.5%. Land use = 540 ha Compcnents: Wind Turbines group AC of
30 Mm.

(I-gE}3: 7%-3%;

SENSIT. ANALYSIS # 4 (Wind2: 10.2m/s; Loadl: 0GWh/day; (I-g%)1: 7%—3\2%;
Inf.F.l:Bass; Pr.l: xl x1 x1 x1):

NPV = 77.013 ME. CO2 Emissions = 1.125 kt/yr. Unmet lead = 0 GWh/yz
{0%). IRR = 24.08 %. Investment = 37.5 ME. LCOE = 0.023 £/kWh. Capacity
factor = 55.7%. Land use = 540 ha Components: Wind Turbines group AC of
30 MW,

SENSIT. ANALYSIS # 5 (Wind2: 10.2m/s; Loadl: 0GWh/day; (I-gT)2: 7%-1%;
Inf.F.l:Bass; Pr.l: xl x1 x1 x1):

NPV = 64.961 ME. CO2 Emissions = 1.125 kt/yr. Unmet lead = O GWh/y=z
(0%). IRR = 22.74 %. Investment = 37.5 ME. LCOE = 0.023 &/kWh. Capacity
factor = 55.7%. Land use = 540 ha Components: Wind Turbines group AC of
30 MW,

SENSIT. ANALYSIS # & (Wind2: 10.2m/s; Loadl: OGWh/day; (I-gZ)3: 7%-3%;
Inf.F.l:Base; Pr.l: =l =1 =l =1):

NPV = 90.974 ME. CO2 Emissions = 1.125 kt/yr. Unmet lead = 0 GWh/yz

0% TRR = 275 4 % Trrastmant = 27 5 ME TOAR = 1 N27 £/kWh

Finally, we return to the main screen (“Back”) and save the project.
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37. Project with load, minimization of NPC.

Close the software and open it again to create a new project. Project->New, create a new project
with the name “MHOGA2.mho”

Project-> Options, select Minimize Net Present Cost (NPC),...

MAIN OPTIONS:

Sirnulation and optimization

(@) Simulation of the 15t year and extrapolate results
(O Multiperiod: simulate all the yvears ofthe systern lifetime ( years)

Economic optimization

[ @ Minimize MNet Present Cost (NPC), usually for off-grid systems and high load on-grid

> (@ Min. NPC ]

O i LCOH

(O Maximize Met Present Value (MPV). usually for low load or nodload onrgrid systems

e NP
bin. LCOE
[] Define Wind Farm with 16 power curves, ane for each wind direction sectar Min. LCOH

Max. Cap.F. min. LCOE

Dc bl luch h o cantroll
[[]DC renewable include own charger and contraller Ma. IRR

[Iwhen saving the project, update all the resulis of the tahle to the present conditions

MNurmber of decimal places in results of costs 3 ~

Number of decimal places in results of energy 3 ~

oK

In the main screen, GENERAL DATA tab, we can see the constraint of the maximum unmet load
allowed (by default, 1% annual). Click in “More constraints” button, to see all the constraints
(we won’t change them, we will consider the default constraints):

- Minimum number of autonomy days is 3 but it is not considered if there is AC grid as in
our case.

- The third constraint related to the capacity of the battery compared to the peak power
of the renewable sources is not considered as there is AC grid in our case.

- Default values of minimum renewable fraction and maximum LCOE are imply these
constraints are not considered.

- Same for maximum capacity shortage (this should be consider to ensuring a minimum
amount of operational reserve to face the sudden changes in load or in renewable
generation, but we won’t consider it in this example; more info in the user manual).

- Same for maximum land use.

Therefore, only the maximum unmet load allowed is considered by default.
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VI CONSTRAINTS - [m] X

If & combinstion of campenents and strategy does nat meet any of the fallowing restrictions, this selution will be discarded (for that combination itis
sssigned infinite cost):

Maximum Unmet Load allowect * of annual load

{Max. energy not supplied bythe stand-alone system nar by the AC grid)

Minimum number of days of autonamy (bateriss +hydrogen

days
([ifthere is AC generator or fuel cell using extemnal fuel or purchasing unmetioad from AC grid is allowed, number of days of autonomy = infiniturr)

Nominal capacity of hatteries bank (W) < x (peak power of PY generator + max, power from Wind Turkines groug) ()

([Fitthere is AC generatar or fuel cell using extemal fuel or purchasing unmetload fram AC grid is allowed, da nattake into account this constraint)

M O o

Maximum Levalized Cost of Enarey: £kh

Madmurm annusl capaciy shorage % Data-> ACbus' Load operating reserve (%3 (0|  Peakload opersting reserve (%)
[0 | windpoweroper reserve (%
DChus: Lond aperating reserve (<) [0 | Peakload operating reserve (%)

P\ power oper. reserva (%) [0 | Wind power oper. resenve (%)

Batt Land Use (ha/GWh]

P power oper. reserve (%

NN

Mezimum Land Use: hee Data-> Py Land Uss (hai Wind Land Use (ha/d)

In the LOAD/ AC GRID screen, click in AC LOAD (MW) tab.

Add AC load, residential load of 100 MWh/day, by selecting it in the Load Profile (below the
table):

Load profile: |Residential 100Mwh/day |

Wariability

We click on Generate and approx. 0.1 GWh/day is obtained.

V' Load and options of Selling / Purchasing Energy from the AC grid - O X
Data source Hours AC Dc H2 “Water
Minutes- each hourin 1 row

(O Monthly Average @ Load Prafile (O Impart File (W, tH2/h, dam3h) IR 1t 1 prrow Import Export
ACLOAD (MW)  DCLOAD(MW)  H2LOAD (tH2ih)  WATER (dam3/day) FROM WATER TANK ~ PURCHASE / SELL E
Manth 0-h 1-2h 2-3h 3-4h 4-5h 5-6h B-7h 7-8h 88h  810h  1000h 1112k 12130 13-14n 1415k 1516 A

JANUARY 5155 3.386 257 1924 1.847 1847 2155 2924 3924 4155 4386 4617 4925 5463 6.156
FEBRUARY  5.155 3.386 2.57 1.924 1.847 1.847 2.155 2.921 3.921 4.155 4386 4.617 4.925 5.463 6.156

MARCH 479 3.261 2.505 1.962 1.878 1.878 2.13% 2.778 3.62 3.867 4109 4.332 4.609 5.067 5636
APRIL 4424 3116 2.439 2.001 1.908 1908 2116 2632 3316 3578 3832 4.047 4284 4671 5117
MAY 4.059 2982 2.374 2.039 1939 1939 2.097 2.485 3012 3.289 3555 3.763 3978 4274 4598
JUNE 3.693 2.847 2.308 2.078 1.97 1.97 2.078 2.339 2.709 3.001 3.278 3.478 3.663 3.878 4078
JuLy 3.693 2.847 2.308 2.078 1.97 1.97 2.078 2.339 2.709 3.001 3.278 3.478 3.663 3.878 4078
AUGUST 3693 2847 2.308 2.078 197 197 2.078 2339 2709 3.001 3278 3.478 3663 3878 4078

SEPTEMBER 4.059 2982 2.374 2.039 1.939 1939 2.097 2.485 3012 3.289 3.555 3.763 3978 4274 4598
OCTOBER 4424 3116 2.439 2.001 1.908 1908 2116 2632 3316 3578 3832 4.047 4294 4671 5117
NOVEMBER  4.79 3.251 2.505 1.962 1.878 1.878 2.135 2.778 3.62 3.867 4109 4.332 4.609 5.067 5.636
» DECEMBER  5.155 3.386 2.57 1.924 1.847 1.847 2.155 2.924 3.924 4155 4.386 4.617 4.928 5.463 6.156

Scale factor for Monday to Friday: Scale factar for the weekend

Load profile: | Residential 100MWh/day ™
AVERAGE LOAD IN JANUARY (included scale factor), TOTAL 120.15 MWh/day

¥ M ACload ¥ [) DCload ¥ M H2 (HHV) ™ B Water (E pumped) |

Add load profile

Wariahility He

AC jnlo]
Daily variahility El % El % El %
Hourly Variability El % El % El % 6
Minutes Variahility % % %

MW

4
Correlation minutes
2
AC load power factor (cos fi) l:l
0
0 6 12 18

hour

Addloadat |0 [MWAC ~during

R t 5 - R
trom: min E' hD“’Eldﬂy [Irepeatevery | ACmax. hourly active power load in the year (inc. AC pumping): 8.7 MW Max. in 1/2 h intervals: 3.6 MW
days | sverage hourly AC power: Active 4.2 My Aparent 42 MVA
oK = Graph in steps of 60~ |min.

DC e, hourly power load in the year: 0 MW, DC power hourly average 0 M
Average houry value of (Energy_DC_hourby/Energy_Total_hourly): DC Factor = 0%

Average daily load = 0.099 Gwh/day

With the “Graph” button we can see the load:
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W Graph - O X

LOAD
9
(]
7
6
z 5
=
4
3
2
1
0
0 1 2 3 4 5 6 7 8 9 0m 1 12 13 4 15 16 17 18 19 20 21 22 23 0
1 January

[ — ACload ¥ — DCload [¥— H2 (in HHV) [¥— WATER (inpump E) |

‘ > [ ]
[ Harizontal Grid [JAl []¥ertical Grid _ Days display
Scroll change (days)-> emall ' large:

[ Back

In PURCHASE / SELL E tab, let’s suppose that the electricity price will be hourly, by periods, and
the contracted power also by periods. Select “Purchase from AC grid Unmet load ....”
Uncheck “Fixed Buy Price” and “Fixed Pmax”.

and

In the Sell excess energy to AC grid panel, select “=Pmax buy”, this way the maximum power to
be injected to the AC grid will be the same as the defined power to purchase from the AC grid.

V| Load and options of Selling / Purchasing Energy from the AC grid - ] X
DEEEeIES Hours | AC | DG [ Hz | |Water
" " Minutes- h hi 1
O Manthly Average @) Load Profile (O Import File (M, tH2/h, dam3h) 1~ Mmtz; ?2;&;”" o Irport Export

AC LOAD (MW) DC LOAD (MW) H2 LOAD (tH2/h) WATER (dam3/day) FROM WATER TANK ~PURCHASE/ SELLE

Purchase from AC grid Unmet Load (Non Served
Energy by Stand-alone system)

] Fixed Buy Price (E/kih)

Annual Inflation (%) Ermission (kgCO2/kwh)
3 04

Hourly Price

Emissions clata

[ IFixed Prmax ) |  Fixed Cost P (E/kWAT)
El U ' Hourly walue:
Access Chalge Price (Edéh

Fixed Access price (£/kiwh) D Hourtly Price
Back-up Charge Price (E/kWWh
Fixed Back-up price ({£/kiwh) D Hourly Frice

(wvill be added to the E purchased) |:|Add negative gen. charge

Tatal tex for electricity costs (huy + charges) (%) D

Sell Excess Energy to AC grid

Fixed Sell Price (Efkiwh) 012

[ Pr.cell = pr.buyx

Annual Inflation (%4):

Hourly Price

[~] =Prmasx buy

e] Price (E/Mh
Fixed Transter price (£/kvwh) l:l Hourly Price
Sellonly

‘ND net mettering v‘

Cost of net metering senvice (£/kWdh) 0
Buy-hack: Export E is paid at (£/kWvh) El

Self-cansumption and Met Mettering:

Tatal tax for electricity sold (%) El

AC GRID AVAILABILITY

Priority to supply E not covered by renewahles:
@ Storage/Generator () AC Grid

St /Gen. priarity if PrbuyE >= |0

D Sell surplus H2 in tank (difference
between the HZ in the tank at the end
of the year and at the beginning)

10 3

Datato compare with electical supply
anly from A conventional gric:

Total costinstallation of AC grid ME

Q&M annual cost of grid:

Losses in wire and transformer (%): El

Then click on “Hourly Price” button close to the buy price. Select Hourly Periods and accept all
the default values (3 periods, P1 price of the electricity purchased to the AC grid 0.15 €/kWh, P2
price 0.12 €/kWh, P3 price 0.08 €/kWh, distributed in summer/winter):
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HOURLY PRICE OF THE ELECTRICITY PURCHASED FROM THE AC GRID

Hourly Price Data £/ h]
" Hourly, all dayz the same

- _From file (8750 hourly values) @

* Hourly Periods

Hourly Periods: .
Ourl Fenads Mumber of Hourly Periods: IG * Summer/winter  © Mon-Frifweekend © Hourly [from file]

Summer calendar: Period P1 Price:  |0.15
From day lf marith |3_ Period P2 Price;  |0.12

To day If marith W Period P23 Price:  |0.08

SUMMER periods diztribution:
-1h 1-2h 2-3h Fdh 4-Bh 5-Bh EB-7h 7-8h 2-5h 3-10h 10:11h 11-12h

F3 = [F3 =] [P3 | |F3 =] F3 =] |P3 ~| |F3 =] |3 =] [P2 ~| [P2 ¥| |FP2 ~]| [P2 +|
12413 1314 1415h  157Bh 1617k 171%h 1819  1920h  20-21h 2122k 2223h 23-24h

P~ [P =] [P1 ~| P2 | P2 »| P2 ~| P2 ~| [P2 ~| |P2Z ~| |P2 ~| [P2 ~| |P2 +|

WINTER penods distribution;
0-1h 1-2h 2-3h 3-dh 4-Bh 5-Eh E-Fh 7-8h 2-Sh 910k 10-11h - 1112k

Fa «| |P3 »| [P3 »| P32 | |P3 »| |P3 ~| P3 ~| [P3 ~| P2 ~| |P2 ~| [P2 ~| |P2 +|
1213h 1314k 1415 1516k 161Fh 1718k 1819  13-20h  2021h 2122k 2223k 2324k

F2 =| P2 | P2 »| |F3 =] P32 | [P3 =] [P1 =| |P1 =] [P1 =] |P1 =] [P2 ~| |P2 +|
1[4

OK and, in the PURCHASE / SELL E tab, click “Hourly Values” close to the options of the
contracted power Pmax.

[IFixed Praax () Fixed Cost P [£/kWr)

K[l Options 40 I Hourly Walues .

A small window appears. Change the values to the following Pmax and costs for the different
peridos P1 to P3 (note that P4-P6 are not considered, anyway we write 0 in them):

Hourly periods same of energy hourly price periods

Prna [Mw] Cinst of Pawer £k /]
PeicdPl 6 [0
PaicdF2 [8 TR
PeicdP3 [3 5
PeiodP4 [0 n
PeiodP5 [0 b
PeiodPE [0 M

Ok

OK and, in the PURCHASE / SELL E tab, click “Options” close to the options of the contracted
power Pmax.
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CJFixed Prmax (i Fixed Cost P ([£/kWhr)
30 40 Hourly Walues

A window appears. We can choose among: Power limited to the value shown in Pmax; Limited
to an optimized value (it will be optimized during the opitmization, only valid for period P1), or
the third option, which will be the one selected “Not limited: Registered the maximum value

(average of....”

Options for the maximum peak power from the Grid:

YWalue of Pmaw:

" Limited to value shown in Pras

™ Limited to a walue optimized between 0 and Prmax, Mumber of values to consider; |5

{+ Mot limited: Registered the mawimum value [average of |‘|5 j rrir, of the length of the time stepl Data

oK

By using this option, the contracted power to buy electricity from the grid will not be the power
defined, it will be the maximum power registered during the simulation for each period.
However, the maximum power for selling electricity to the AC grid will be the values defined for

each period.

And click in the button Data, leaving the default values (the way in Spain the cost of power is
applied in the electrical bill for high power consumers, when we have the option of registering
the maximum value of the power in the maximeter):

COST OF THE CONTRACTED POWER:

- If max. power registered is lower than A= % of Pmax->  apply % of cost of Pmax
- If rax. power registered is higher than A and lower than B= %% of Prnax -> apphy % of cost of Prax

- If max. power registered is higher than B -» apply 100% of cost of Pmax + times diff. betwen registered and B

Prriax is the contracted power

Fower registered is the maximum power registered by the maximeter

oK

Click OK, OK and OK to return to the main screen of the software.

In the main window, check Wind Turbines so that we consider also them.
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GEMNERAL DATA l OFTIMIZATION | CO

COMPOMENMTS
¥ PV Gen.

l [v Wwind Turbines l

[~ Hydro T.

|v Battery bank

[v Inverter/cha

[~ H2 [F.C. - Elyzer]

In SOLAR, set latitude to 42.572 and longitude -0.312 (Pyrenees in Huesca province, Spain).

Then download hourly irradiation and temperature from PVGIS year 2007.

1l SOLAR RESOURCE

Latitude (3} [+N, 5): |4257 Get data from local DB
) Deowirload from: x
Longitude (2] (+E, /) :|-0.31 :
[ Dowrioad houly data | " Renewable Ninja [vear 2019)
Locate on map | | Download MASA monthly data | (" NASA - Year |2015 ~
Data source [V Hourly liradiation

" Monthly Average @ Import from File FROM RENEWABLE NINJA W Hourly Temperature fpi: [ PV ¥ Wind T.]™ Batt

™ Generation of P gen. (MW) normalized to 1 My I~ Hourly Wind Speed
[equivalent to inadiance kKW ./m2 » PR)

Data Source for Monthly Average Daily liradiation: | P adiation Horizantal Sur

Inadiation . i
av. tilt 5. P Tracking Systern: W

0K Cancel

We obtain:

Il SOLAR RESOURCE - O X
w 0.
Latiucle (3 (+H,-5) Get et fram lacal OB #1:PVpanels slope () PV panels Azimuth ()
0 )
Langitude (%) (+E. W)
Download haurly data. PV gen_ #1- - Ground Reflactance:
[]Fixed albeda Import Alb. | Gr
Locate on map | |Update coorel Download MNaSA monthly data
Optimal Slope#] Optirnize: PV#1 panels slope during the optimization of the systern
Data source for Global irradiation
Steps
(O) Monthly Average (@) Import from File FROM PYGIS pear 2007 @ Hour (kwh/m2) (O Horiz @ Tilt
] Generation of PV gen. (MW) normalized to 1 MWp O [y +| Minutes- each hour in L row (tikt, in kw/m2)
(equivalent to irradiance kW/m2 x PR) (@] Minutes- 1 per row (tilt surf. in kW/m2) B
Data Source for Monthly Average Daiy Irradiation: | Radiation Horizental Surface (kWh/m2) Calculation Method for Hourly Iradiation:
Z‘Lﬁi:‘ﬁ:m" PV Tracking System: |No Tracking o Liu & Jordan Erbs et al
Factor Fil} for the back albedo Collares-Pereira & Rabl Graham
i DL (bifacial modules) (Durusoy 2020):  |0.33
Februray 317 kwhim2 . .
MONTHLY AVERAGE DAILY IRRADIATION, TILTED SURFACE ummer-
harch 4,66 kKiwh/m2 7 Official hour advances:
Apri 45 Kivhim? 6 h to solar hour
May 586 kiWh/m2 5 e
4 of month
June B.16 Kiwh/m2 3
To day
Jul B.87 Kih{mz
&/ 2 of month
August B.44 Kih/m2 1 N
‘Winter:
September 6.02 Kh/im2 = A w0 A s o n oo =l i s
October 488 kitvh/m? MONTH imeEET i
i
Nowermber 4.45 Khjm2 Horizonta) Tited [7] import from hourly file:
Official hour
December 36 Kiwh/m2
0 January
SHADOWS Diaily Average Irradiation (Tt Sud):  5.03 kWh/m2
Total Annual lrradiation (Tilt Surf): 1836 94 kKiwh/m?2
SEtRERT (i) Annual I Back sutface /Ditactfor CPY: 18375 Kih/m2 / 1183 89 Kih/m2
Yariability minutes: cormelation factar: sxd. dev. Update minutes Import Back (hourly, tilt) Import Direct (hourly, tilt)
0K Calculate = Graph in steps of 60 ~ \min. Export G. tilted Export G. horiz.
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In the WIND screen, make sure the anemometer height is 100 m and download just wind speed
from Renewable Ninja (not irradiation neither temperature).

1 WIND RESOURCE

Latitude (%) [+M. -5]:  |4257 Get data from local DB |
Longitude: (%) [+E, ] 1|'D-3‘I Download hourly data | Anemometer Hiight
100 i
Locate on map fro NASA | Dowrnload NASA data |
) WIND RESOURCE
Latitude (%) (+N, -5]: |42.5? Get data from local DB |
Longiude (%) (+€. w) |-0.31 Downlaad houry dat | Download fiom: | gammroio Y23l
own o e (+ Renewable Ninja [year 2019
Locate on map | | Download NASA Monthly data | " NASA- Year |2015 =

Data source

[~ Hourly Temperatule for: [ P [ Wind . Batt

¥ Hourly Wind Spe

" Monthly &verage & Import data file (in m/s) [FROM RENEW!
[~ Generation of wind turb. [MW) normahiz

OK Cancel
A WIND RESOURCE - [} X
Latitude {*) (+N.-5) - |42.57 Getdata rom local DB
Longiude (4 (+E. ) Download hourly data Anemomater Height
[0 |m
Locate on map | Updsis cond | Download NASA Wonthly deta foo_]
Surface Roughness
Data source: S‘EES coss [ %] Lengn 099 | o
O Monthly Average @ Import data file (inmfs) [FROM RENEWABLE NINJA :“'5 it aach o 1 1o o— eI e et o s
[] Generation of wind turb. (W) normalized to 1 M rated p Ml peiEn neither hedges and wih very dispersed
builciings. Onfy smeothly rounded hills
Av sp (s
Jon: 7.78
;Eb ::s ~ M Data ¥— Fit
ar
Apri5.34 02
May. 6.38 -
Jun:5.71 g OF
Jadgs g 016
Aug: 474 ; 014
Sep525 g 012
oct668 o 01
NovB5S 2 gog
DecB46 3 006
s
& 004
Conelation factar 00
Calculation of wind speed for each minute: stel. dev. Elm/s Update min 0
0 5 10 15 2 2 30
Wind speed (mfs)
Calculate = Graphinstepsof | B0~ min A year (mjs o time of calm wind
28 Calm s considered
Form factar of the wind speed serial: 2.8 < m/s
Scaled Average Speed (m/s) oK
Scale by (xby): |1
e

In PV GEN. accept the default PV data:
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VPV GENERATORS

- [m] X
sssi o
Ade P Gen fril ] < +[=
PHOTOVOLTAIC GENERATOR DATA:
Name Power(MWp_dc) CostME)  COBM(%pr)  Lifelyears) NOCTEC)  PowerT. coef(%/C) BIFACIALTY([-) CPY  Emissions(kgCOZKWE)
» PViD | 10 10 1 25 13 0.4 0 NO 800
< >

Efficiency due to degradation of the modules, |osses inwires, dirtin panels, |osses in wires, transformer, etc, Fixed Operation and

Maintenance Cost,

it

Standard conditions.

Consider sffect of Temperaturs
Data of ambient temperature (C)

e — - J4 Fs M |an |mie (g2t w23 |azs 819 o4 N9 |ps \Wind for CPY/
@ Fromfile (8760 hourly values) Import FROM PYGIS year 2007 1= Graph
PV generator is connected to AC bus (it has its own inverter) > PV inverter data

Annual Inflation Rate for PY

Max. Variation of P gen. Cost (e.g. for an expected 70%
Generator Cost

reduction on current P gen. cast introduce *-70%")

Limitis reached in 596 years

OK

In WIND TURB,, also accept the default wind turbines data:

W WIND TURBINES / GROUPS OF WIND TURBINES

- o X
AW T Wl =
GENERAL DATA Output Power (MW) vs Wind Speed
Name Bus Cost(ME) C.Repl(ME) C.OBM (%)) Lifespan () Height(m) EmisCO2(k)  Tmjs  2m/s  3mjs  4mjs | Smis  bm/s  7mjs  Bmjs  9mis im
3 WindT1 AC 2 2 100 15 0 0 0 o5 02 03 05 07 1
< >
Fixed Operation and
Wind speed from the wind resaurce will be converled o the WindT1 it el
in Maintenance Cast
hub height considering roughness 2
e
Losses wires, transformer
%
Surtace Roughness .
Class |1 v| Lengh 003 m =
JAgricultural open area vithout fences neither hedges
‘and with very dispersed buidings. Only smoothly
raunded hills
0
0 2 4 6 W0 124 6 18 20 2 24 2%
Pawer curve measured at air density (kg/m3) WIND SPEED (m's)
[ Wake effect
Height above sea level m V= P in standard conditions (sea level. 15°C), 1.225 kg/m3
Airdensity atthat heightis (S4) 1.198 kg/m3 — P at alttude of the place (247 m). 1.196 kg/m3 Wake effect
[Y] Consider the effect of temperature.
When simulating, adjust power curve with air density: Ambient Tempersture at hub height (£C) . . 5 g .
(@ Use height above sea level andtemp. | Graph OMonthly average it el i F M A M J J A s e} N D
(@) File with 8760 hourly values Import
Omporaidensiysars Impor FROM PVGIS year 2007 15 Graph
[VIDa nat cansider reduction in Power after Annual Inflation Piate expected for Wind Max. Variation of Wind Turbines Cost expected (2.9, for an expected 5%
Turbine Casts: redluction an current Wind Turbines cost. inracuce ™~36%"),
14mjs v | (check itwind t are pitch contolled)
Limitis reached in 42.9 years

Same for batteries and inverters, default values.

In the main screen, CONTROL STATEGIES tab, we uncheck the energy arbitrage (management
of grid-connected batteries).

GEMERAL DATA QPTIMIZATION CONTROL STRATEGIES FINAMCIAL DATA RESULTS CHART
CONTROL STRATEGY AND WARIABLES TO OPTIMIZE
ENERGY ARBITRAGE: System with batteries and grid connected

Global strategy:
@ Load Following
() Cycle Charging

() Try Both

I:‘ Batt. ch§roed by the AC grid #/ discharged if (also for Elyzer-> H2) D Elyzer. full load

Continue up to S0OC stp

Compare with Sell price

[ optirizd strategy of grid-conneted batteties

Wariables to optimize relative to the global strategy:

Prmin_gen Fmin_FC HZTANKstp
F1_gen F1_FC [=H]
Batteries can inject electricity to the AC grid
[J80Cstp_gen S0Cstp_FC []50Cmin [11 day atlow SOC -> charge batteny with AC grid B . ilabil
Pcritical_gen Feritical_FC Flim_charge atteries svailahility

[vwhen batteries are oft compensate autodisch

D S0OCmax | Fixvariahles Wariahles accuracy =100%

If S0Cmin reached, disch. not allowed if SOC(35) < S0Cmin(%) + El
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We click PRE-SIZING and obtain:

ML AND MAK, No COMPONENTS IN PARALLEL:

Bateties in parallal: Min. |1 |Max. |143 |

P4 gen. in parallal: Min. |D |Max. |B |

Wind T.inparallel:Min 1 |Max [18 |
1 1

143 batteries in parallel is no sense, but this is the number of the default battery (5 MWh) in
parallel needed to have 4 autonomy days. As there is AC grid, it has no sense, we change it to
5.

RN, AND bMax Mo COMPONENTS IN FPARALLEL:

Bateries in parallel: Min. |1 | hdie. |5| |

F* gen. in parallel: Min. |D | b, |E |

Wind T.inparallel: Min. |1 Max 18|
1 1

Save the project and then calculate:

GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

Mono-objective optimization. Total No. of cases evaluated: 1890. Time: 1' 37"

40

Total Cost (NPC) (ME)

Solution # (sorted from best to worst)

"] Show diagram

N R RN

# Total Cost (NPC)(ME) Ermission (ktCOZ4 UnmetiGwhivyl  Unmet(26) Doaut CriWh)APpv+Pwily Ben(® LOOEE/KNWh) Simulate Report (
1 39.783 413 0 0 INF 01 8246 0.0767 SIMULATE.. REPORT... (
2 39.822 4.22 0 0 INF 01 81.33 0.0767 SIMULATE.. REPORT... ¢
3 39943 4.06 0 0 INF 01 8343 0.077 SIMULATE.. REPORT... ¢
4 40.049 4.33 0 0 INF 01 80.01 0.0772 SIMULATE.. REPORT... ¢
5 40.154 4.04 1] o INF 01 81.86 0.0774 SIMULATE.. REPORT... (
G 40.219 4 0 0 INF 01827 0.0775 SIMULATE.. REPORT... (
7 40.251 4.01 0 0 INF 01 8487 0.0776 SIMULATE.. REPORT... (
8 40.289 411 0 0 INF 01 8091 0.0776 SIMULATE.. REPORT... (
L] 40.441 3.96 0 0 INF 01 8345 0.0779 SIMULATE.. REPORT... (

< >

COMPOMNENTS: PV gen: P10 (10 Mwip_dchke 2 (100% PY#1: slope 352 azimuth 02) // Batteries Batbhiwh (5 kah): Tsx Tp. /12 Wind Turb. WindT1 (2 MW at 16 m/s) 4/
Bat. Imerter Inw-Chhw of 5 MYA Jf Unmetload = 0 % /4 Total Cost (NPC) = 39.783 ME (0.08 £/kiwvh)

STRATEGY: LOAD FOLLOWING. SOC min.: 10 %%

The optimal system is a PV generator of 20 MW (2x10) + 12 wind turbines of 2 MW + battery
of 5 MWh + inverter-charger of 5 MVA.
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The simulation of the optimal system:

Hourly simulation  Hourly values separately  Monthly and Annusl Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Waterload / PHS  MULTIPERIOD

Simulation of 1 year, all the years the same.

244 55
224 N S 5 Total Load
= Unmet Load
z 20 45 = Disch. Batt
£ == Charge Batt
= 181 _ |—windT.
K 4 F Py
x 164 =
w g Buy E from grid
JRTE 35 - Sell E to grid
S ] —soc
= 12 3w
] i
1 >
:;':“ 10 25 E
g 8
£ 2 Z
e 64
g 15
5 4 _——y
a ~~
— : — A S
I ——— — —d —1 05
0
0 1 2 3 4 5 6 T 8 9 10 1 12 13 14 15 16 17 18 19 20 21 22 23 0
[“Legend 1 January
< > Days disp
POWER CONSUMED OR SURPPLIED (M) EEEYEE [15ee Over
Batter bank Discharge Plim Charge Legend
P2 BATTERY ENERGY (Miwvh) CIHLGr.
] | O Electrolyzer soc CIHRGr
| [ E. max. disch. hatt. E.H2 tank (HHY H2) R P1 SOC limi [ Grid
v imits Alt
OE HE Battery bank Charge P critical Gen. c. M Em\\
xport Energy ap. Max.
O Eio supply FC P critical Fuel Cell change
- SOC setpoint Gen. (days):
Wind Turb. Srmall
=
o O E boughtto ACgid [2] Pmax S0 setpoint FC
ALl AC Generator E soldto AC grid [v] Prax Large
[ Pmax. input Inverter H2 TANK setpoint (HHY H2) S0C(0-1) T full charge

[ Pmax Gen
Save Prob. Data

Save dofa

COMPONENTS: PY generator of 20 Mwp_dc (100% PV#1: elope 35¢ azimuth 02). Wind turbines of 24 My, Battery bank of 5 MwWh. Bat. Inverter of 5 MyvA,

Simulation gtep (min): B0 v 2 Back Sawve Simulation Data

STRATEGY: LOAD FOLLOWING. SOC min: 10 %. P max. grick 0 bW,

We can see in purple dotted line the contracted power for the different periods (6, 8 and 9 MW),
which is the same for purchasing or for selling electricity. In turquoise dotted line we can see
the maximum consumed power from the grid, registered for each period and for each month.
During the year we can see these values are not very different from the contract power values,
so probably the contract power values are not far from the optimal.

In the main screen, in the first row of the results, if we click COSTS, we see the report of the

costs of the optimal solution.

Project: MHOGAZ2.mho. Solution # 1

Distribution of costs (+) and incomes (-}, NPC, during the years. RED: acquisition costs, replac. costs and incomes for
sales. BLUE: O&M. Currency: M€,

Total Cost (NPC): 39.783 M€ (0.08 €£kWh). Initial cost of investment: 57.5 ME. Loan of 100 %, int. 7% in 25 yr., quota: 4.934
My,

TOTAL COST (NPC) 39.783 M€ Financial Cost (NPC): initial pay. + quotas + exra cash: 57.5 M&

: l 4
2

o _.-I-l_-.- --—. 2
-2 A e e e e - - o

01 2 5 7 8 M 1315 17 18 21 I 25
Total Cost of PV Generator (MPC); 22.847 M€

20

01 3 5 13 15 17 19 21 23 25
Total Cost of Wind Turbines group (NPC): 32827 M€

T2 N 19 2

15 20

10 10

5

0 o - ]

01 3 5 7 9 1 12 18 17 19 21 23 25 9 11 12 15 117 19 21 23 25

After closing, it asks for saving the cash flow. We say yes, and then we open it with Microsoft
Excel. At the bottom we can see the results of the power registered and the power costs, for the
different periods and months. We see the maximum power registered, the power to calculate
the cost of the bill and the cost of the bill, for the different periods and months.
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At the end it shows us the optimal contracted power so that the power cost in the bill would be
minimized, in this case 6 MW for P1, 6.74 MW for P2 and 4.22 MW for P3 (if no request of
increasing contracted power; if this request exists, 6 MW for all)

A B C D E F G H | J
43 |RESULTS OF THE POWER REGISTERED AND THE POWER COSTS:
44
45 |*RESULTS OF THE MAXIMUM POWER (MW) FROM THE GRID REGISTERED, 1st YEAR:
46 |MONTH Period P1 Period P2 Period P3
47 1 8.695 8.43 4.644
48 2 8.695 8.464 5.155
49 3 7.66 7.653 4.79
50 4 0.663 6.641 4.424
51 5 2.031 5.425 3.475
52 6 2.006 4.113 3.173
53 7 v} 4.621 3.404
54 8 1] 4.498 3.565
55 9 1.601 5.729 4.02
56 10 6.252 6.625 4.424
57 11 7.66 7.552 4.79
58 12 8.695 8.464 5.155

59 | *Actual contract power is, for the different peridos: 6 MW; 8 MW; 9 MW;
60 | *RESULTS OF THE VALUE OF THE POWER [MW) TO CALCULATE THE COST OF THE POWER IN THE BILL, AND COSTS (M&£), 1st YEAR:
61 |MONTH Period P1{M\ Cost 1st yr.(V Period P2{M\ Cost 1st yr.(N Period P3(M\ Cost 1st yr.{M€)

62 1 10.79 0.0367 8.06 0.0137 7.65 0.0097
63 2 10.79 0.0367 8.13 0.0138 7.65 0.0097
b4 3 8.72 0.0296 8 0.0136 7.65 0.0097
65 4 5.1 0.0173 6.8 0.0116 7.65 0.0097
b6 5 5.1 0.0173 6.8 0.0116 7.65 0.0097
67 6 3.1 0.0173 6.8 0.0116 7.65 0.0057
3] 7 5.1 0.0173 6.8 0.0116 7.65 0.0097
69 8 3.1 0.0173 6.8 0.0116 7.65 0.0057
70 9 5.1 0.0173 6.8 0.0116 7.65 0.0097
71 10 6 0.0204 6.8 0.0116 7.65 0.0097
72 11 8.72 0.0296 8 0.0136 7.65 0.0097
73 12 10.79 0.0367 8.13 0.0138 7.65 0.0097

74 | *Total cost of the power, 1st year: 0.56 M€

75 | *If not considering that contract power of period P1 <= power of P2 <= power of P3....

76 |Optimal contract power would be: 6 MW; 6.74 MW; 4.22 MW; With a total cost of the power, 1st year: 0.507 M€
77 | *If considering that contract power of period P1 <= power of P2 <= power of P3....

78 |Optimal contract power would be: 6 MW; & MW; 8 MW; With a total cost of the power, 1st year: 0.561 M€

Save the project.

38. Add water load consumption.

Save the previous project (“MHOGA2.mho”) with the name “MHOGA2-Water.mho” (Project-
>Save as).

We will add water consumption of 30 dam3/day. Water comes from a tank or reservoir of 100
dam?, which is previously pumped from a river with an elevation head + suction lift of 48 m, and
friction losses in pumping are 10%. Let’s suppose that at the beginning of the simulation the
tank is at 50% capacity (50 dam?). The pump power is 1 MW and its efficiency is variable.

In LOAD/AC GRID screen, WATER tab, set these values:
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V' Load and options of Selling / Purchasing Energy from the AC grid

Datalolce Hows | |AC [ |DC [ JHZ [ |Water
Minutes- each hourin |
OMonthly Average. @ Load Profile. O Import File (MW, 1H2/h, damifh) 1| Mintoa s porrom o [impan Expart

AC LOAD (MW) DC LOAD (MW) H2 LOAD (tH2/h) I WATER (dam3/day) FROM WATER TANK l PURCHASE / SELL E

HOURLY WATER CONSUMPTION (N % OF DALY CONSUMPTION
January 30| (0.0048 Gwhiday) 30 00048 GvehydsyNoh  1h  2h 3k 4k S5h Gh  7h  &h  dh  10h 11h

Februany{30 | (00048 G¥vhyday)  August (0.0048 Gwhydlay) 2 1 Jfe Jfo] ] [ Jf | [oerme =

March (UUU4EGWh/day) 12h 13h 14h 15h 16h 17h 18h 1 h 2lh 2h 23h  Total

9h 20
Sloalonlcaloala ] .

HOURLY WATER CONSUMPTION (% OF THE DAY
May [0 |{@00043 Giwhidey)  November 0.0048 Gihydey) ( !

10
June  [30_ |{00048 Gwhidey) December (0.0048 Gwhydlay), 5 D[I [I D [I
0 Wariahility mmutes(%)

Scale factor for Monday - Friday: [1 Forthe Weekend: |1 0 6 18
WATER TANK hour
Waterlankcapcadnyl ‘TUU | da_mf} l ELECTRICAL PUMP:

Capacity atthe begining of the simulation§ 50 dam3 X .
pecly A @ Pump electical rated pow r Il FPump minimum pnwerlzl % of rated
i)

PUMPING DATA

Elevation head + suction Il |48 " (recommendedt 0.8 MW for Bh/dla Priority to pump if surplus E )D % P. pump
Extra pump

Friction Lossed % Total pump efficiency: 90 % Var. Pump eff.

Load profile: | Residential 100Mvvh/day ~

AVERAGE LOAD IN JANUARY (included scale factor), TOTAL 124.94 MWhiday
¥ M ACload ¥ [) DC load ¥ Ml H2 (HHV) W B Water (E pumped) |

Addd load profile
Wariahility an oo e

Daiby W ariability El El
Hourly Wariability EI El 3
Minutes Variability - % % §
Carrelation minutes 4

Generate ACload pawerfacinr(:osﬂ):

Aodioadol |0 [MWAS ~ duing 5 |min hour

Now let’s select the variable efficiency of the pump, by clicking the button “Pump eff.”. A small
window appears where we can change the efficiency values (%) vs the % of maximum flow rate,
where maximum flow rate is calculated considering the pump rated power, the total head with
losses and the pump efficiency at maximum flow.

PUMP VARIABLE EFFICIENCY (EFFICIENCY % VS MAX. FLOW RATE %):

0%  10%  20% 30%  40% 50%  B0% 70%  B0% 90%  100%
b Jhz s s e JF2 s Jl e [z {[[3_1J

If rewversible pump/turbine, max flow rate of the turhine
If difterent rachines, using purnp of 1 MW -> Max. flow rate 1.738 m3/s for elevation head + losses of B2.8 rm with
90 % efficiency at ma. flow

QK

We change the value for 100% maximum flow, supposing efficiency is 90% and we leave the rest
of the values by default. It shows that the maximum flow rate for 1 MW, 52.8 m head (inc.
friction losses) and 90% pump efficiency is 1.738 m3/s.

As for low % of max. flow rate the efficiency is low, the NPC of the results will be higher than if

we would have chosen fixed efficiency.
We click in OK.

When we set the daily water consumption for each month, MHOGA calculates the pumped
energy needed for pumping that water, considering the elevation head and losses, as we can
see in GWh in brackets close to the values of the daily water consumption introduced previously:
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ACLOAD (MW)  DCLOAD (MW)  H2LOAD (tH2h)  WATER (dar
DAIL'Y WATER CONSUMPTION (dam3/dayk )
January (u.uu4a GWvhiday)  July (00048 Gwhiday)
Februan{30  |(n.004s Giwhiday)  August (0.0048 Gh/day) [
March [30 |(0048 Giwhidey) September [30 | (00048 Gwhjday) [
April [30 |@o04s Gwiidey)  October (0.0048 GWwh/day)

{ 1 |
{

May 00048 G¥vhyday) November (0.0048 Gih/day
June 0.0048 GWhiday)  December 0.0048 Gwh/dlay)

MHOGA recommends a 0.8 MW pump (below the pump power) to pump the load consumption
in 6 h/day.

ELECTRICAL PLIMP:

Fump electrical rated power: hltd!

(recommended 0.5 MW for Bh/day)

Minimum pump power (%) by default is 0% and also the priority to pump (when there is surplus
power from the renewable sources) is when it is higher than 0% (that is, whenever there is
surplus power from renewable, it will be used to pump first, and, if there is still surplus power,
it will be used to charge the batteries):

Fump minirnurm power:lCl %% of rated

Priority to pump if surplus E > El % P. pump

The water consumption distribution during the day (%, sum is 100%) is shown in a graph, we can
change it but we will leave the default values.

HOURLY wWATER COMSUMPTION (I % OF DAILY CONSUMPTION]
I0h 1h 9h  10h 11h

2Zh 3h 4h &h Eh 7h 8h
EEREREFREFRFMERBDP b [ Pow =
12h 13h 14k 15h 16h 17h 18h 19h 20h 21h 22h 23h Tatal

:FFFFFFFFFFFFh

HOURLY WATER CONSUMPTION (% OF THE DAY)

0 5 12 18 Wariability minutes (%] ’F
If you change it, all the values added must be 100%, obviously.

Now we click in “Generate” button and the total average daily load raises to 0.104 GWh/day.
We can see graph of the average day load consumption for a specific month (depending on the
last month that was clicked) in the right (if you click in the daily water consumption of other
month, this graph shows its corresponding average daily load).
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1l Load and options of Selling / Purchasing Energy from the AC grid - [u} x

Datasource: Hows | |AC [ |DC [ [HZ | |water

(O Manthly Average @ Load Profle (O Import File (MW, tH27h, dam?/h) 1w mﬁg:?zﬁ hournTIOY ot Export
ACLOAD(MW)  DCLOAD (MW)  H2LOAD (tH2h)  WATER (dam3/day) FROM WATER TANK ~ PURCHASE / SELL E
DAILY WATEF CONSUMPTION (dem3/day).

January (u 0043 GWhiday)  July

HOURLY WATER CONSUMPTION (IN % OF DAILY CONSUMPTION)
[ ] ooowcwhbey) on 1n 2n 3n an sh en 76 Bh sn 1on 1in

Februany30__|0.0048 Wiy wonmawmany & |l ]l 1] - - EJE Ip Jp JE ] o=me v

( )

March [30 (00048 GWh/dey) Seplember (00048 GWh/day) 12N 130 19h 18 20h 2h 2zh 23 Totel
[t )
[t )

) h
2
U= o [ [
)

HOURLY WATER CONSUMPTION (% OF THE DAY)
May [0 |@0048GWijday) November (0.0048 GWh/day) ! )

10
June [ |@0048Gwihdey) December (0.0048 GWh/day) 5 [l[l [I D D
Scale factorfor Monday - Friday: For the Weskend 0 Veriability mintes (%}{20__|

August

0 6 18
WATER TANK hour
\Water tank capoadity: dam3 ELECTRICAL PUME:
Capactty st the begining of the simulstion: 50 dam3 5
ey b o Punp sscricatmedgowae T ] My o pous {5 % ot
S (recommended 0.8 M for Bhday) %
Elevation head + suction i m Pricrityto pump il suplus £ >[1__| % pump
Extra pump
Friction Losses % Totel pump efficiency: 90 % Var Pump eff.
Load profile: | Residentisl 100MWh/cey ~
AVERAGE LOAD IN JANUARY (included scale factor), TOTAL 124,94 MWhiday
Add load profile
Varisiity — ¥ M ACload W () DCload ¥ M HZ (HHV) ¥ B Water (E pumped)

Daily Variabiliy El

Hourly Variability

8
6
Minuia Vriabilty - 2
.
2
0

(Il
0 6 12 18
Addlosdof [0 |MWAC ~ duing [§Jmin hour

Repeat evel
o in[5_Jhoulp ey ] merin[1_] -D P 1ty | AC max. hourly acive pawer load in e year (inc. AC pumping): 8.7 MW, Max in 1/2 h intervals: 10.5 MW
deyS | average houry AC power: Active 42 MW Aparent 42 MVA

= = e | @ DCmex haurly power load in the year: 0 MW; DC power hourly average 0 MW

Average hourly value of (Energy_DC_hourhy/Energy_Total_hourly): DC Factor = 0%
hverage daily load = 0.104 GWhjday

Iﬁﬁ
EE@

% %
% %
% %

Mw

We can see the load consumption graph witt “Graph in steps of” button. If selected 60 min:

VW Graph — O =

LOAD

Water consumption during this
hour is equivalent to 0.4796 MW
1.5 during 1 h of previous pumping

3 6 9 12 15 18 21 0
1 January

[ —ACload F — DCload [F — Hz (nHHV) [¥ — WATER (n pumpE) |

< >

Days display

AC power consumption is shown in blue color and in turquoise color is water consumption (the
30 dam3/day are converted to dam3/h considering the distribution of the hourly water
consumption and translated to MW previously pumped, taking into account the elevation head
and losses). For example, in 1%t January the water consumption in the hour that goes between 6
and 7 h a.m. is 10% of the day (10/100-30 = 3 dam?), which will have been previously pumped a
height of 48 m plus 10% friction losses (equivalent to a total height of 52.8 m) with a 90% max.
flow efficiency pump. The energy needed to pre-pump that volume of water is:

E = volume-density-g-height-(1+friction_losses)/Efficiency =
=3000m>-1000kg/m>-9.81m/s?-48m-(1+0.1)/0.9 = 1726560000 J = 0.4796 MWh.

That is, equivalent to a consumption of 0.4796 MW during that hour, as shown in the graph.
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We return to the main screen of the program.

We do pre-sizing (button “PRES-SIZING”), obtaining these maximum recommended values:

MAIN. AND MAX No COMPONENTS IN PARALLEL:

Bateries in parallel: Min. hidax.

F% gen. in parallel: Min. EIM&)(. D

Wind T.in parallel Min. M
1 1

As we said before, the max. number of batteries in parallel has no sense as there is AC grid,
therefore we will limit it to for example 5:

RAINL AND kAKX No COMPONENTS IN PARALLEL:

Bateries in parallel: Min. |1 | == |5| |
P4 gan. in parallel: Min. |D | b, |B |
Wind T in parallel: Min. [T [Max [18 |

1 1

Now, save the project and then click in CALCULATE.

After 1 or 2 minutes we get:

# Total Cost (NPC)(ME) Emission (kCOZ24x)  UnmetiGwhiyr)  Unmet(2) Daut Cndwh)APpa+Pw) (i Reni® LCOEEMAWH) Simulate Report (A
1 44.625 4.28 0 0 INF 01 8179 | SIMULATE.. REPORT... (
2 44.686 4.18 ] o INF 01 8291 2 SIMULATE.. REPORT... (
3 44 867 4.4 1] o INF 01 8052 0.0825 SIMULATE.. REPORT_.. (
Ll 44912 11 0 0 INF 01 8387 0.0826 SIMULATE.. REPORT... (
] 45222 4.54 0 0 INF 01 79.06 0.0831 SIMULATE.. REPORT... (
3 45.228 4.05 ] o INF 01 84.75 0.0832 SIMULATE.. REPORT... (
7 45 506 418 1] o INF 01 8243 0.0837 SIMULATE.. REPORT_. (
] 45525 4.27 0 0 INF 01 &8 0.0837 SIMULATE.. REPORT... (
q 45.684 4.39 0 0 INF 01 80.54 0.084 SIMULATE.. REPORT... ( -
< >
COMPOMNENTS: PV gen: FV10 (10 Mvp_dcix 2 (100% PY#1: slope 352 azimuth 0%) // Batteries Batbhvh (5 kah) Ts.x Tp 411 Wind Turb. WindT1 (2 MY at 15 m/s)
Bat. Ireverter Inw-ChBhAvy of B VA Unmetload = 0% } Total Cost (NPC) = 44625 ME (0.08 £:0h)
STRATEGY: LOAD FOLLOWING. S0C min.: 10 %

The optimal includes 20 MW of PV, 11 wind turbines of 2 MW, battery of 5 MWh and inverter
of 5 MVA. The simulation of the optimal (1°* row) for 3 days:
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Hourly simulation  Hourly values separately  Manthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Water load /PHS  MULTIPERIOD

Simulation of 1 year, all the years the same.

22 55
2 Pump at low efficiency dueto == — 5 Total Load
= Unmet Load
Z 13 low water flow load and water 45 W. tank (E.)
£ . . — Water Pump
= 45 tank full (it only supplies water R ~— Disch Batt
= z == Charge Batt.
o, flow load) % — Wind T
g 35 2
g 8 Buy E from grid
= 3w Sell E to grid
S 10 w - 50C
by 258
g, a— ' E
s 7 ;
. / .y [ 2 3
= \ /’ \ P
\/ \ Ll 1s
= \ \
g’ AR -
5 \ \/7 i
0 P S A — 05
21 30
[ Legend 1 January - 3 January
< > Dy disp
POWER CONSUMED OR SUPPLIED (M) E— [15ee Over
Batter bank Discharge Plim Charge Legend
P2 BATTERY ENERGY (Mvh) [JHLGr
O N O Electrolyzer soc CIHRGr
| [] E max disch batt E. H2 tank (HHW H2) R P1 [ Grid
1 S0C limits e
Battery bank Charge P critical Gen.
[] Export Energy Cap. Max. Seroll
i [} Eito supply FC P critical Fusl Call i change
N S0C setpoint Gen. (days):
[] Wind Turb. .
LR S0C zetpaint FC Srall
S E boughtto AC grid [2] Pmax
l i AC Generator E sold to AC grid [«] Praax Large
e -~ [] Pmax Gen H2 TANK setpoint (HHY HZ) 50C (0-1) T full charge
Simulation step (min): [60 [2 Back Save dete: Save Simulation Data Save Prob, Dats

COMPOMNENTS: P generatar of 20 MWp_de (100% PV#1: slope 352 azimuth 0. Wind turhines of 22 My, Battery bank of b bywh. Bat. Inverter of 5 bA,

STRATEGY: LOAD FOLLOWING. SOCmin. 10 % Pmax grid: 0 MW._Priority to pump and store E if surplus P> 0 % P pump

The whole load is covered all the hours of the year

Simulation for the first 3 days of January. We can see the water tank energy in light blue, referred
to the left axis (“R” is not checked”) we can see the maximum energy in the water tank is around
16 MWh:

E = volume-density-g-height-(1+friction_losses)/Efficiency =
=100000m?-1000kg/m>-9.81m/s?-48m-(1+0.1)/0.9 = 5.755E10 J = 15.98 MWHh.

In dark blue, thin line, we can see the pump power. During the hours with low power from
renewable sources, water is consumed from the tank (if tank has enough water) and the AC load
not covered by the renewable sources is supplied by the battery bank (dark blue thick line, if it
has enough energy; if not, it is covered by purchasing from the AC grid, turquoise thin line).
During the hours when the renewable power is high, it supplies the AC load and with the surplus
power the pump works to supply the water load and to store water in the tank; if the surplus
power is higher than the rated power of the pump (1 MW) the batteries are charged (brown
line). We can see during the hours when water load is low and water tank is full, the pump power
is relatively high due to the low efficiency of the pump when it pumps low water flow.

If we click in “R”, it will be referred to the right axis:
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Hourly simulation  Haurly values separately  Manthly and Annual Average Paver

bonthly Energy Annual Energy Hydrogen

Simulation of 1 year, all the years the same.

AC Generator ‘Water load / PHS  MULTIPERIOD

22 16
20 5 Total Load
14 — Unmet Load
18 = W. tank (E.)
_ = — Water Pump
g £ — Disch. Batt
H ol — Charge Batt
= 1 & = Wind T
=
= = PV
o 12 = Buy E from grid
< = — Sell E to grid
£ & — s0C
£ X E
[ y 3 N «
: [— » =
4 ES
2
\ y SN -
2n
Legemd 1 January - 3 January

[«
POWER CONSUMED OR SUPFLIED (MW)
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E. ta supply by bat
pply by
0 0O [ E mex disch batt

Battery bank Charge
1
o | & ind Turb.

[] Export Energy
Unmet Load

“ater P
ater Pump AC Generator

[ Prax. input Inwverter ] Pmax Gen.

Plim Charge
Electrolyzer P2
E. H2 tank (HHY Hz) R P1
Fuel Cell P critical Gen._

E.to supply FC
E.max FC

E boughtto AC grid [+] Prmax
E sold to AC grid

Hz TANE setpoint (HHY HZ)

P crifical Fuel Cell

Days disp.

D See Over
Legend
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Enetipy price
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v .Grid
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Serall
change
(days):

Cap. Max.

S0C setpoint Gen_
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Small:
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If there are many curves in the graph, we can uncheck some of them.

In the rest of the tabs:

Hourly simulation

Hourly values separately  Monthly and Annual Average Power

Monthly Energy  Annual Energy  Hydrogen

AC Generator  Water load fPHS  MULTIPERIOD

HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
8 15 20
15
6 10
10
4 5 5
2 0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2,000 4,000 6.000 8.000
Hydro Turbine AC Generator Export
20
0 0
10
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6.000 8.000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
0 0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0
Battery bank Charge Battery bank Discharge Energy in Battery bank
4
2
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
0 5
0
0 2,000 4,000 6.000 8.000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6.000 8.000
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power

MONTHLY AND ANNUAL AVERAGE POWER (MW)

Monthly Energy  Annual Energy  Hydrogen

AC Ge

nerator Water load /PHS  MULTIPERIOD

(MW)

Average Power
o

105
10
95
9
85
8
75
7
6.5
6
55
45
4
35
3
25
2
15
1
05
0
1 4 5 8 7

Month

10 "

12 13

YEAR

¥ Total Load
@ E. soldto AC grid ¥ B Electrolyzer

M@ Unmetload MO PVgen. VBl WindT. WO Hydro T./TEG B AC Gen

W@ Fuel Cell ¥ B E. bought to AC grid

Hourly simulation  Hourly walues separately  Monthly and Annual Average Power

Monthly Energy  Annual Energy  Hydrogen

AC Generator Waterload /PHS  MULTIPERIOD

MONTHLY ENERGY (GWh)
Total Load PV generator Wind Turbines
e Im = 6
3
3
4
P 2
w 00 2
0 0 0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Hydro Turbine AC Generator Export energy
4
3
0 - —- - ——— 2
1
0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Fuel Cell Electroyzer Energy (HHY of H2) in H2 tank, end of the month
0 NF——m——r————r—=r—=-r 0
2 4 6 8 10 12 2 4 6 8 10 12 0
Battery bank Charge Battery bank Discharge Energy in battery bank at the end of the month
o 0.1 0.002
0.05 0.05 0.001
0 0 0
2 4 6 8 10 12 2 4 6 8 10 12 2 4 6 8 10 12
Unmet load (by the standalone system) Energy purchased from the AC grid Energy sold to the AC grid
3
1
Q 2
05 1
0 0
2 4 6 [ 10 12 2 4 6 8 10 12 2 4 6 [ 10 12
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energly  Hydrogen  AC Generator Water load / PHS - MULTIPERIOD

TOTAL ANNUAL ENERGY (GWh)

28

26

24

22

20

Energy (GWh)

LOAD PURCH EXPORT SOLD PV GEN. WIND T. Charge BAT. Disch. BAT.

Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Waterload /PHS  WMULTIPERIOD

MONTHLY WATER LOAD, PUMPED AND TURB. (dam3). WATER STORED IN TANK AT THE END OF EACH MONTH

2500 - 100 2
2 2000 80 D
s - o =
= 150 IS
£ 1000 0 =
o P
ES) 0 5
0 0 =
1 2 3 4 5 6 7 8 9 10 " 12
Month
|. Water Load W@ Water Pumped [ Water Turbined Water in tank at the end of the month
MONTHLY ENERGY OF WATER LOAD, PUMPED AND TURB. (GWh). WATER STORED IN TANK AT THE END OF EACH MONTH =
§ e —-— 0015 &
03 - =
o 001 §
3 02 2
E 0.005 5
5 o1 £
1 =
w
1 2 3 4 5 6 7 8 9 10 il 12
Manth
Hourly Water Load (dam3) Hourly Water Pumped (dam3) Hourly Water Stored in Tank (dam3)
3 5 100
2 4
50
1 2
0 0 0
0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Hourly Energy of Water Load (MWh) Hourly Energy of Water Pumped (MWh) Hourly Energy of Water Stored in Tank (MWh)
1
04 &
10
0.5
02 5
0 0 0
0 2,000 4,000 6.000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000

Save the project and then save it with the name “MHOGA2-Water-min.mho” (Project->Save as)
because now we will change to 1 minute time step.

Back Save data: h | Save Simulation Data Save Prob. Data

Wvp (100% PV slope 352 azimuth 0¢). Wind turbines of 22 MW, Battery bank of 5 Myvh. Inverter of 5 MyA,

Simulation step (min)

COMPOMNENTS: PV g

STRATEGY: LOAD FOLLOWING. S0C min.: 10 %. P max. grid: 9176 M.

Go to the simulation screen of the optimal solution, tab “Hourly simulation” and change the
time step to 1 minute (please, be patient, it can take even more than 1 minute depending on
the computer speed as it has to simulate all the minutes of the year and all the variables must
be shown), and, in the first tab we see (1 day display, january 1%):
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Waterload / PHS  MULTIPERIOD

Simulation of 1 year, all the years the same.

22 4 16
20 1 Total Load
14 ~— Unmet Load
184 = W. tank (E.)
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[]Legend 1 January
< Days disp
POWER COMNSUMED OR SUPPLIED (M) e i []see Over
Batter bank Discharge Plim Charge Legend
P2 BATTERY EMERGY (Mwh) DH.L.Gr
O O [ E-to supply by bat Electrolyzer soc CHR.Gr
¥
0O 0 [] E. max disch. batt E.HZtank (HHY H2) [|R P . v Grid
S0C limits At
] ExponE Battery bank Charge Fuel Cell P critical Gen. Can. ool
xport Energy ap. Max.
Etosupply FC F crifical Fuel Cell . change
Lomgtioad ) SOC setpoint Gen. (doys)
= n Wind Turb. E.max. FC S
[ O = E bought to AC grid [#] P S0 setpoint FC
R AC Generator E sold to AC gtid [&] Pmax O —————— p—— —— Large:
= - D P max. Gen setpoint (} 4 (0-1y ull charge
Simulation step (min): 1 ~ Back Save data: Save Simulation Data Sawe Prob. Data

We can see the wind generation variability is very high. If we go back to the main screen, in the
results table we can see the first row results has been updated to the simulation in 1 minute

step:

Gen. Total Cost (NPC){ME) Erission (kiCO24r) UnmetiGwhha)  Unmet(3%) Doaut Cnidwh)/(Ppuw+Pud (v Ren(® LCOE
1 45.333 417 0 0 INF 01 Gz i

(EfkWh) Simulate Report (A

Remember that these results in minutes time steps can vary for each computer, as the wind speed
in minutes steps are obtained with a certain randomness.

If we go to the WIND screen, we can change the standard deviation to calculate the wind speed
in 1 minute time steps (from the hourly downloaded or calculated values), default is 1 m/s, but
it implies high variability, we change to 0.2 m/s.
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1l WIND RESOURCE - m] X

Latitude () [+H. 5] |4257 Get data from local DB Vil Aerarme Bl
Longitude [2) [+E, /) |-0.31 Dawnload hourly data Anemomeler Height | | & Monthly Average Speed
100 m " Might speed, Amplitude, F Factor and Hour max speed
Locate on map fro MASA ‘ Download MASA data |

Surface Roughness

Data source
?}EFS Class |1 | Length 0.03 m
" Monthly Averags (¢ Import data file (in m/s) |FROM RENEWABLE NINJA r =5 Minutes- each howrin 1 row  Import @gricultural open area without fences
[T Generation of wind turb. [MW) normalized to 1 MW rated p. ol LIS Minutes- 1 per ram Ee!:g_er heggz?s and mtlh varyddlzphe_lused
LIdINgs. niy smoothly rounde: s

Av.sp. [ms]
Jan: 778
Feb: 573
Mar. B.16
Apr: 5.94
tday: B.38
Jun: 571
Jul 4.98
Aug 4.74
Sep 5.25
Oct: 568
Now: 6.53
Dec: 6.46

2 :
ctor_J082 ¥
Calculation of wind speed for each minute: std ey, 0.3 ] Update min. R

Wind speed (m/s)

| &= Graph in steps of | 1 *|min Export Ay, year [m/s] Infa time of calm wind

5.96 Calm is considered

Seaed A Sneed Form factor of the wind speed serial: 2.8 <13 mis
- Scaled Average Speed [m/'s]
Seale by byl |1 I - = “

596

Then click in “Update min.”, this way the calculation of the wind speed in minutes time step is
redone.

Then click in Graph in steps of 1 min:

WIND SPEED

mfis

I I - -]

1 2 3 4 5 6 7 8 9 M 1 12 13 14 15 16 17 18 19 20 21 22 23 0
1 January

I Horizontal Grid - [_JAR [_]vertical Grid Days display
Scroll change (days)-> small: large:

Now variability is much lower.
Back and OK.

In the main screen of the software, if now we click in the first row of the results table in
SIMULATE, we see the optimal solution simulated in steps of 1 min, now we can see the wind
generation variation is much lower.
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Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Water load /PHS  MULTIFERIOD

Simulation of 1 year, all the years the same.

22 16
20 15 Total Load
14 AC Load
18 ne Unmet Load
z W.tank (E)
£ 1 ZE — Water Pump
s "y — Disch. Batt
= 14 & — Charge Batt
& z - Wind T
o~ 12 9 = PV
= E Buy E from grid
£ 10 = Sell E to grid
£ £ — sac
i g
i
= =
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£
@
0 1
[“Legend 1 January
< > Days disp
And results are updated:
Gen. Total Cost (NPCY(ME) Emission (MCO24r)  UnmetiGWhha)  Unmet(3) Doaut Crlwh)(Poe+Pwity Beni® Simulate Report (A

1 45.931 43 1} 0 INF 01 8165  SIMULATE.. REPORT... (

Save the project.

39. Consider bifacial PV modules.

Save the project and then open the previous project “MHOGA2-Water.mho”. Then, save it with
the name “MHOGA2-Water-bifac.mho”.

We want to consider bifacial PV modules. Let’s suppose that they are 10% more expensive than
the normal PV modules, and the bifaciality factor is 0.7. We want to consider the previous PV
generator of 10 MWp but also a new PV generator of bifacial PV modules, of 10 MWp nominal
power (of the front surface) with a bifaciality of 0.7 and the cost of 11 M€ (10% higher).

To consider bifacial PV modules, you first need to calculate the irradiation over the back surface
of the PV modules.

Goto theirradiation screen. We will consider the default value for the factor for the back albedo,
F(l) = 0.33:

Factor F(l) for the back albedo
(hifacial modules) (Durusoy 2020 |0.33

We need to use average monthly values for the irradiation so that we can calculate the back
surface irradiation. Click in “Download NASA monthly data”, and deselect all the data except

for the Monthly Average Irradiation.
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) SOLAR RESOURCE

Latitucle (%) (+M, -5) 4257 Get data from local DB Data to download: Year 2019~

Longitude ) (+E. W) Dawnload hourly data Manthly Average Imadiation

[ tonthly Average Temperature For Bat.

Locate onmap | Update coord! Download NASA manthly data, [IMonthly Average Wind Speed

Data source At10 m height  [w] Consider roughness
At B0 m height
(O Monthly Average (@ Import from File |FROM PYGIS year 2007 [[]wind Speed ‘Weibull Shape Factor
DGeneratian of PV gen. (MW) normalized to 1 MWp |:|Altitude above sea level

(equivalent to irradiance kW/m2 x PR)

Data Source for Monthly Average Dally Irradiation: Radiation Horizontal Surfa

Irradiation Irradiation
PV Tracking System: NoTi 0K Cancel

Factar Fil) for the back albe

av. horiz. av. tilts.
January 188 3.35 KWh/m2

We download the average monthly irradiation. Then, save the project and click in button
Calculate.

It calculates and we obtain similar irradiation as before for the front surface (see the text
under the graph). For the back surface, 192.82 kWh/m? is the total irradiation of the year.

Diaily Average lrradiation (Horiz. Sud) 442 kKhim2 Diaily Average Irradiation (Tilk Suf): 523 kKwhfmz
Total Annual Irradiation (Horiz. Surf): 161444 kihim2 Total Annual rradiation (Tilt Surf); 1308.58 kvhimz
Annual lrr. Back surface / Directfor CPY: 192,82 kKWh/m?2 / 156287 kWh/m?2

—_—

Now we will use the same values for the front surface as previously, so we will download
hourly irradiation data from PVGIS, 2007 (just hourly irradiation, uncheck the other data):

) SOLAR RESOURCE

Latitude (%) (+h.-5): 4257 Get data frarm local DB -
D load from: - &2
Longitude () (+E. ) : ownload from: (@) PYGIS -Year

Download hourly data o
() Renewakle Ninja (year 2019)

Locate onmap | Update coord. Dowenload MASA monthly data (O NASA- vear 2020 w
Data source [« Hourky Irradiation

OMontth Average @Impor‘t from File FROM PYGIS pear 2015 DHDurIyTemperature for: P\.-’ Wind LE DBEI“-

[Generation of PV gen. (MW) normalized to 1 MWp [ ]Hourly Wind Speed
(equivalent to irradiance kW/m2 x PR}

Data Source for Monthhty Average Daily Irradiation: Radiation Horizontal Surfa

Irradiation
. PV Tracking System: |No T Gl Camezl
an tilt 5.

After downloading, we can see the values of irradiation over the front surface, but also the
irradiation over the back surface calculated before:

Daily Average Irradiation (Tilk Surf): 517 kvh/m2
Tatal Annual Irradiation (Tilt Surf): 186634 kWhime
Annual Irr. Back surface / Directfor CPY: 19282 kKWh/m2 /1207.04 KWh/m?2

In the graph we see both data (front surface in green, back surface in light blue):
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Scroll change (days)-> small: large:

Accept and go to the PV generators screen. Add from the database the PV10-BIF, bifacial PV
generator wit cost 11 M€ and bifaciality 0.7.

PHOTOVOLTAIC GENERATOR DATA:

MNarne Powertdwp)  CostiMe) COBMEAT  Lifelyears) NOCT(C) Paower T. coef.(%/°C)  BIFACIALITY(0-1) CPY  missions(kgCO2fkyv A
PY10 10 10 1 25 43 -0.4 0 NO aon
» PY10-BIF 10 n 1 25h 13 -0.4 0.7 NO a00

Therefore, we will consider two PV generators: the normal one and the bifacial one.
Accept and, in the main screen of the software, save the project and then CALCULATE.

The optimal system includes the normal PV generator, in this case, as its cost is lower than the
bifacial PV generator, although the PV production is a little lower.

# Ermission (KiICO2Ax) Unmet(GWhie)  Unmeti®s) Daut  Cnldh)Ppwv+Pue) v Ren(® LOOEEAWR) Simulate Report (A
1 428 0 0 INF 01 81.77 0.082 SIMULATE.. REPORT... (
2 44.676 418 0 0 INF 0.1 82.88 0.0821 SIMULATE.. REPORT... (
3 44.824 44 0 0 INF 0.1 80.51 0.0824 SIMULATE.. REPORT... (
4 44.909 411 0 0 INF 0.1 8385 0.0826 SIMULATE.. REPORT... (
5 45167 455 0 0 INF 0.1 79.04 0.083 SIMULATE.. REPORT... (
i 45.258 416 0 0 INF 0.1 8255 0.0832 SIMULATE.. REPORT... (
7 45.28 4.06 0 0 INF 0.1 8487 0.0833 SIMULATE.. REPORT... (
8 45.347 4.07 0 0 INF 0.1 8364 0.0834 SIMULATE.. REPORT... (
3 45.431 4.28 0 0 INF 01 813 0.083% SIMULATE.. REPORT... ( o
< >
COMPOMNENTS: PV gen: PV10 (10 Mwp_dck 2 (100% PVv#T: slope 352, azirmuth 0% /f Batteries BatShWh (5 kah): 15« 1p. 40 17 Wind Turb, WindT1 (2 MW at 15 m/s) i
Bat. Inverter Inv-Chabdvy of B My 4 Unmet load = 0 % /f Total Cost (NPC) = 44537 ME (0.08 £/4Mh)
STRATEGY: LOAD FOLLOWING. S0C min.: 10 %.

The 6th best solution includes bifacial PV generator (its PV generation is a bit higher than the
first five solutions, due to bifaciality):
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SOCmin (%) Pmax Grid (MW) Etotal(GWWh) Eren(Giwh) EpuiGivh)  Ew(Gih) Et(Givh) E export(Givh) E Sell{GWwh)
10 0 3821 67.369 29.42 37.948 0 32.709 23185
10 i 3821 70.819 29.42 1398 0 36547 24452
10 i 3821 63919 2942 34499 0 29.941 21,861
10 i 3821 74.268 2942 44848 0 38.448 25,667
10 i 3821 60,460 2942 31.048 0 27.263 20,448
10 0 3821 BI514 37.948 0 3447 24016
10 0 3821 7718 7642 43,298 0 41.414 26 896
10 0 3821 72963 31 565 1398 0 37.327 25272
10 0 3821 66064 31 565 34498 0 31 BGE 22711

<

E Buy A

We can see the report of the sixth best solution, first one which includes bifacial:

MHOGA software. Report

Project: MHOGA2-water-bifac. mho_ Solution # 6
DC Voltage: 1 kV. AC: 20 kV.

COMPONENTS:

PV gen. PV10-BIF, 2x10 MWp. P total = 20 MWp_dc (100% PV#1)
Batt. BatsMWh, 1x1x5 kAh. E total = 0.005 GWh (0 d aut)

41 Wind T WindT1, 11x2 MW (@14mis). P. total 22 MW

Without Hydro Turbine

Without AC Generator

Without Fuel Cell 1
Without Electrolyzer

Inverter Inv-Ch5MW, SMW 10

POWER (MW)

Land use: 456.05 ha

CONTROL STRATEGY:

IF THE POWER PRODUCED BY THE RENEWABLE SOURCES IS HIGHER THAN LOAD: CHARGE
The Batteries are charged with the spare power from renewable

IF THE POWER PRODUCED BY THE RENEWABLE SOURCES IS LESS THAN LOAD: DISCHARGE
Priority to supply net load with storage

The whole not supplied power to meet the load must be supplied by the Batteries. If the Batteries cannot supply the
whole, the rest will be unmet loa

There is no AC Generator

There is no Fuel Cell

LOAD FOLLOWING. SOC min. batteries = 10 % // P max. Grid = 9.171 MW

Pump 1 MW. Priority to pump and store E i surplus P > 0 % P. pump.

COSTS:

Initial Investment: 57.5 ME Loan: 100 %. int. 7% in 25 years, annual quota: 4 934 ME.
NPC OF THE SYSTEM (25 years lifetime):
Total System Costs (NPC) 45 258 ME_ Levelized cost of energy: 0.0832 €/kWh

Distribution of NPC:
PV Generator Costs (NPC): 25131 M€
Battery bank Costs (NPC): 2509 ME
Wind turbines Costs (NPC)- 30.091 M€E
Inverter Costs (NPC): 0.694 M€

Buy/Sell. Bought Energy (NPC): 20.913 ME. Sold Energy: Electrical E. (NPC): -45.581 ME (FCR 0%). H2 (NPC): 0 ME.

Installation + financing + extra cash (NPC): 11.601M€

40. Consider CPV

NPC / NPV (M€}

RES

TV-+ AUX

ENERGY BALANCE DURING 1 YEAR (GWh/year):

Overall Load Energy- 38 21 GWhiyr. From Renswable: 82 55%
Unmet load: 0 GWh/yr (0 % load)

E. Purchased from AC grid: 6666 GWhiyr

Export Energy: 34.47 GWhiyr

E. sold to AC grid: 24.016 GWhiyr

Energy delivered by PV generator: 31.565 GWh/yr

Energy delivered by Wind Turbines: 37.949 GWhiyr

E. delivered by Hydro Turbine: 0 GWhiyr. Pumped 4.26 GWhiyr
Energy delivered by AC Generator: 0 GWh/yr

Energy delivered by Fuel Cell: 0 GWhiyr

Energy at Electrolyzer: 0 GWhyr

Energy charged by Batteries: 1.336 GWhiyr

Energy discharged by Batteries: 1.233 GWh/yr

OTHER RESULTS:

Batteries Lifetime: 10.07 years
Hours eq. of AC Generator operation (all units): 0 hyr. Number of starts (all units): 0
Hours of Electrolyzer operation:  hiyr. Number of starts

Hours of Fuel Cell operation: 0 hiyr. Number of starts: 0

Hours of Hydro Turb.- 0 hiyr. starts: 0. Hours of Pump: 5616 hiyr: starts: 421

Total CO2 emissions: 4.16KICO2/yr

H2 sold in one year: 0t H2iyr

ENERGY BALANCE DURING 1 YEAR (GWhlyear)

I ma B

Save the previous project and then save as with the name “MHOGA2-Water-CPV.mho”.

Let’s consider a normal PV generator of 10 MWp and a Concentrating PV generator (CPV) of 10

MWp from de database. Both will be with sun tracking system in both axes.

In the irradiation screen, select for the PV tracking system: both axes:

PV Tracking System:

Both Axis

Now download hourly data from PVGIS, 2007, only irradiation. The irradiation for the both

axes tracking system will be downloaded:

Daily Average [rradiation (Tilt Surf):

B.B3 kivh/m?2

Total Annual Irradiation (Tilt Surf): 242063 kivh/me

Annual lrr. Back surface / Direct for CP:
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Global annual irradiation is 2420.63 kWh/m2 while direct is 167 (much higher values than
previously with fixed tilt angle of 359).

In the PV screen, change the bifacial PV for the CPV of the database (CPV10). Then, modify the
names of the generator PV10 adding “-T2axes” to increase the costs to 13 M€ adding the cost
of the tracking in two axes. We suppose the CPV10 already includes this cost.

PHOTOVOLTAIC GENERATOR DATA:

Nams Power(Mwp_dc)  CostME)  COBM(%AM  Life(years) NOCT(C)  PowerT.coef(%/2C) BIFACIALITY(D-1) CPY  missions(kgCOZ/MWp A
PV10-T2axes 13 1 25 13 -0.4 0 NO 800
pcpvie T 12 1 25 43 -0.14 0 OK 800

CPV will produce lower electrical generation as direct irradiation is lower than global. However,
depending on the total cost of the PV and the CPV generator (including tracking system), the
optimal solution can include PV or CPV.

Optimize the system. In this case, the normal PV is better than the CPV. The optimal system
includes normal PV, 1 generator of PV10-T2axes.

# Total Cost (NPC)(ME) Emission (KCO24) UnmetiGwhir)  Unmet(>e) Daut CalWh)APow+Pwily Ben(® LOOEEWh) Simulate Report (4

P 02 0 RS R iEeAl SIMOLATE . REPORT ¢

2 44855 3.96 1} 0 INF 01 8323 0.05825 SIMULATE.. REPORT_.. (

3 44 971 41 1} 0 INF 01 8131 0.05827 SIMULATE.. REPORT... (

4 45.0563 3N 1} 0 INF 01 84.0m 0.05828 SIMULATE.. REPORT_.. (

5 45342 4.29 1} 0 INF 01 &1.24 0.05834 SIMULATE.. REPORT_.. (

b 45.348 4.2 1} 0 INF 0.2 8013 0.05834 SIMULATE.. REPORT_.. (

7 45.398 4.43 1} 0 INF 01 74984 0.05835 SIMULATE.. REPORT... (

g 45.11 3.88 0 0 INF 01 847 0.0835 SIMULATE.. REPORT... (

9 45.482 4.18 0 0 INF 01 8244 0.0836 SIMULATE.. REPORT... (v
< >
OMPOMNENTS: P4 gen: PW10-T2axes (10 bwp_dcix 1 (Track. Both axis) § Batteries BatbhWh (5 kah): 15 x T 4 13 Wind Turk, WindT1 (2 bW at 15 més) 4/ Bat.

iy - 1 ME (0.08 £/kh)
STRATEGY: LOAD FOLLOWANG. S0C min.: 10 %
’ . .
Let’s change the cost of the CPV to 8 M€, save the project and calculate again.
Name PowerlMWp_de)  CostME)  CO&M(%AY  Lifefvears) NOCT(C)  PowerT coet(%4C) BIFACIALTY(H) CPY  ‘missions(kgCOZAMR A
PV10-T2axes 10 13 1 25 43 -0.4 0 NO a0
I cPviD-m 10 8 25 13 -0.14 0 OK a00
Now the optimal system includes CPV instead of the normal PV.
# Total Cost (NPCY(ME) Emission (COZ4)  UnmetiGWhir)  Unmet(2) Doaut Cndh) (P Pu W RBen(% LOOEEKWH) Simulate Report L)

; 1041+ TR 0 Y= 1785 07 SIMULATE TREPORT Tt

Z 40.494 1] 0 INF 01 8043 0.0745 SIMULATE.. REPORT... (

3 40616 1] 0 INF 01 7788 0.0747 SIMULATE.. REPORT... (

4 40.7486 1] 0 INF 01 8155 0.0743 SIMULATE.. REPORT... (

5 40.95 0 0 INF 01 7625 0.0753 SIMULATE.. REPORT... (

] 41.11 0 0 INF 0.1 8248 0.0756 SIMULATE.. REPORT... (

7 41.307 0 0 INF 01 74249 0.076 SIMULATE.. REPORT... (

g 41.307 0 0 INF 0.1 8051 0.076 SIMULATE.. REPORT... (

9 41.425 1] 0 INF 01 774z 0.0762 SIMULATE.. REPORT ... (v
< >

LCOMPONENTS P4 gen: CPY10-m (10 Myip_dc)x 2 (Track. Bath axis tteries Batbhdvih (5 kAR Ts x T, 4 17 Wind Turk, WindT1 (2 My at 15 m/fs) /f Bat. Inverter
- o nrmetload = 0% Tatal Cos = (0.07 £/kih)
STRATEGY: LOAD FOLLOWANG. S0OC min: 10 %

41. Grid connected battery-only system
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Now we will create a new project to simulate a battery system connected to the HV AC grid.
There are no renewable sources, battery will be charged by the grid during specific hours and
will be discharged during other hours.

The optimal battery size and management could be optimized by MHOGA, trying to maximize
NPV or minimize LCOE. However, in this case we will suppose the size and operation are pre-
defined by the designer, and we want to simulate the behavior of the system.

Suppose itis a 10 MWh / 10 MW battery bank and we want to charge from 0 to 5 h at 0.2 C-rate
and we want to discharge from 18 to 21 h at 0.3 C-rate. Hourly electricity price (to be purchased
for the charge), included taxes, is: from 0 to 8 h 0.04 €/kWh; from 8 to 18 h, 0.12 €/kWh; from
18 to 24 h: 0.15 €/kWh. The price of the electricity sold to the grid is 80% of the purchase price.

First, we open the software and create the project “Bat-only.mho”.

We only want battery and inverter-charger, therefore in the main screen we only allow these
components:
GENERAL DATA OPTIMIZATION CONTRC

COMPONENTS
[PV Gen.

[[]Wind Turbines
[IHydro T.
Battery bank
I:‘ Backup Gen.
Inverter/char.

[JH2 (F.C. - Elyzer)

In the left zone of the main window, we can change the DC and AC voltage values. Let’s suppose
our battery bank is connected to a DC bus voltage of 1 kV and the AC voltage bus is 20 kV (default
data).

—_

DCValtage kv [ ]S0Cd.
ACYoltage |20 b

In the “CONTROL STRATEGIES” tab, unselect “(Compare wit Sell price)” checkbox, so that the
battery can be charged from the AC grid (if checked, batteries only can be charged from our
renewable sources). Price limits for charge / discharge will not be considered as we will later
define in the batteries availability the hours when batteries will be charged/discharged
compulsorily, regardless the price of electricity.
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GENERAL DATA OPTIMIZATION CONTROLSTRATEGIES FINANCIAL DATA RESULTS CHART

CONTROL STRATEGY AND VARIABLES TO OPTIMIZE

ENERGY ARBITRAGE: System with batteries and grid connected
Global strategy:

@ Load Following Batt. charged by the AC grid Jf discharged if (alsu for Elyzer-» HE) D Elyzer. full load
(O Cycle Charging Continue up to SOC stp Price E<= EIfI;’kWh JfPrice E»= E;’kWh [l D’o/c[ (Compare with Sell price] ]
(O Try Both [J0ptimize strategy of grid-conneted batteries

Variables to optimize relative to the global strategy:

Prain_gen Prain_FC HZTANKSstp
P1_gen F1_FC Fe
-4 - Batteries can inject electicity to the AC grid
[J=0Cstp_gen B0Cstp_FC []80Cmin [1 day at low SOC - chargs batteny with AC grid [ e ———— ]
Pritical_gen Fenfical FC Plim_charge [[J'When batteries are off, compensate autodisch

[Js0Cmax | Fixvariables “Wariables accuracy: =100%

If SOCrmin reached, disch. not allowed if SOC(3%) <« S0Cmin(%) + El

Then, click in “Batteries availability” button, select the hours for charge and for discharge,
change the C-rate of the charge to 0.2 in the first hour and click in “All 1st” to change all the
values, same for the discharge (with 0.3 C-rate), and check the below boxes “Charge batteries
at the selected hours...” and “Discharge batteries at the selected hours...” so that batteries will
be charged and discharged during the hours selected, regardless of the electricity price.

BATTERIES AVAILABILITY
FOR THE CHARGE FROM AC GRID / DISCHARGE
DEPENDING ON THE ELECTRICITY PRICE (ARBITRAGE):

CHARGE UNDER ARBITRAGE: DISCHARGE UNDER ARBEITRAGE:
Crratef All1st Crrate | All1st
Flianuary  F0-1h 0.2 Muanuay  OJ0-1h  [o3
“1-2h nz 1-2n [
[February  [Az-3h 0z [v] February [Jz-3n ik
[“3-4h nz [13-4h E
[w] March Z4-5h 0.2 [ March 4-5h o3
_ [ls-Bh nz [Is-6h |03
[ il %Ef?h 0z [ Al quh 03
7-8h 0.2 7-8h (o3
[ May [s-gh 0.2 [AMay [ls-sh (o3
Ce-10h |02 | [Je-10h |03
[ June o1 oz [ June io-11h 03 |
Cr-1zn (02 Cii-12h |03
] by Cie-1an oz [ duly Cliz-13n (o3
Dmgen  H1ot4h 02 e
[ September %1:_15: % [ september %1:_12: %
[ 0ctaber Ewwsh 0z [P october WEh 03|
18-19h V1E-180 (03
[v]November Ew'mh % [ Mowember 19'2Dh 103 |
20-21h |02 zn-21h (03
[“lDecerber [21-22k |02 [“lDecember  []21-22h |03
[Jee-23n |02 [Jzz-23h |03
[Jes-24n |02 [J23-24h |03

Batt charge with surplus E. at unchecked hours allowed Batt disch. to supply load atunchecked hours allowed

Charge hafteries atthe selected hours

only from renewakles, notfrom grid ('(Sell price)’).
regardless of the price of electricity

Discharge batteries atthe selected hours
injecting power ta the AC grid. at C-rate.
regardless of the price of electricity

reqardless of arbitrage).

[ Rest of the time available for charge (arbitrags) [ JRest ot the tirme bat. svailakble for disch. (arbitrage)

FOR PUMPING HYDRO STORAGE:

[ 1Pump at maximum power at the selected [ Turkine at maximum power atthe selected hours
only from renewables, not from AC grid, {'(Sell price) injecting power to the AC grid
regardless of arbitrage (regardless of arbitrage)
OK

Click OK.

In the “FINANCIAL DATA” tab, let’s suppose all the default data are correct. Nominal discount
rate is 7%, system lifetime is 25 years, installation and variable initial cost is 25% of CAPEX, a
loan of 100% is needed...
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GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

ECONOMIC DATA:
Loan (constant quata. French system)
MNorinal interest rate (capital cost): % 10
{nominal discount rate) Annual real discount ratel (35 Amourt of Ban: %
o of the initial cost of investment

Annual inflation rate (O&M. ) % 48%

In LCOE include real disc. rate in Energy Loan Interest %
Stuchy period (system litetime) YRArs |:| In meximize NPY systems use Inf. sell
[ &t the end of the study period cansider the residual cost of the components Duration of loan years
Currency |Euro (£) ~
Installation costand variakle initial cost EI ME Fix + % of initial cost Extra Cash Flow

Let’s suppose the battery bank auxiliary consumption (for air conditioning, etc.), in AC bus, is 50
kW from 0 to 5 h and from 18 to 21 h (when battery is charged/discharged), and it is reduced to
10 kW for the rest of the hours.

In the “LOAD/AC GRID” window, we click in “AC LOAD (MW)” tab and select “Monthly Average”
for the Data source:

V| Load and options of Selling / Purchasing Energy from the AC grid

Diata source:

(@) tonthly Average () Load Profile () Import File (Myy, tH2/h, dam 3/

AC LOAD (MW) DC LOAD (MW) H2 LOAD (tH2/h) W,

taonth 0-1h 1-2h 2-3h 3-4h 4-5h
b JANUARY 0.05 0.05 0.05 0.05 0.05

Then, in the table, we write 0.05 (MW, that is, equivalent to 50 kW) in the first row (JANUARY)
in the cell of 0-1 h. Then we click in the next column (JANUARY, 1-2 h cell) and all the column
of 0-1 h will be converted to 0.05 MW. We do the same for the hours from 0 to 5 h and from
18 to 22 h 0.05 MW, and for the rest of the hours 0.01 MW (that is, 10 kW).
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V[ Load and options of Selling / Purchasing Energy from the AC grid - O
(D BmE Howrs | AC [ |DC [ [H2 [ |water

@ Morthly Average (O Load Profile O Impart File (M, tH2/h, dam3fh) | M- CRE e in |

Minutes-1 per row Import el

AC LOAD (MW) DC LOAD (MW) H2 LOAD (tH2/h)  WATER (dam3/day) FROM WATER TANK  PURCHASE / SELL E

7-8h 8-9h 9-10h 10-11h 11-12h 12-13h 1314k 1416k 15616k 16-17h  17-18h  18-19h 18200 20-21h  21-22h 2223k 23-24h
0.01 0.01 0.01 0.01 0.01 0.01 0.01 o.01 0.01 o.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
0.0 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
0.0 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
om 0.m on 0m 0.0 0.m 0.0 0.0 0.0 0m 0.01 0.05 0.05 0.05 0m 0.0 0.m
0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
0.0 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
om 0.m on 0m 0.0 0.m 0.0 0.0 0.0 0m 0.01 0.05 0.05 0.05 0m 0.0 0.m
0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
0.01 0.01 0.01 0.01 0.01 0.01 0.01 o.01 0.01 o.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01
P 0M 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.01 0.05 0.05 0.05 0.01 0.01 0.01

| Import AC table Scale factor for Monday to Friday: D Scale factor for the weekend,

AVERAGE LOAD IN DECEMBER (included scale factor), TOTAL 0.56 MWh/day
M ACload W] DCload ¥ M H2 (HHY) B Water (€ pumped) |

Add load profile

Wariahility an

oc
Daily Variahility El % El
0 Jwf |

Hourly variahility ke

"
Minutes ariahility % % %
Carrelafion minutes

Generate AC load power factor (cos phi)
0 (] 12 18

Adlel load of DMWAC ~ | during mm hour
DRep t evary
from: min hour day|1 maonth |1 AT max. hourly active power load inthe year (inc. AT pumping): 0.05 MW bMax in 1/2 hintervals: 0.06 kv
o

Awvarage houtly AC power: Active 0.02 kv Aparent .02 My

I Graphinstepsof B0~ i, DC mew. haurly power load in the year: 0 MW, DC power hourly average 0 Mid

Average daily load = 0 GWh/day Average hourty value of (Energy_DC_hourky/Energy_Total_hourly): DC Factor = 0%

H2

w [0 1w
P!

kN

MW

Then we click in “Generate” button to obtain the load consumption for all the time steps of
the whole year.

Now we click in “Graph in steps of” button and we can see the hourly load consumption:

LOAD

0.045
0.04
0.035

= 0.025
0.02
0.015

0.01
0.005

0o 1 2 3 4 5 6§ 7 & 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 0
1 January

W— ACload [¥ — DCload [ — H2 (in HHV) [¥— WATER (in pump E) |

[JHorizartal Grid [ ]Alt [¥ertical G Days display
Scrall change (days)-> small D large:

Now we go to the tab “PURCHASE / SELL E”.

Here, in the left, we check the box “Purchase from AC grid...” so that the energy consumption

for the battery auxiliary components can be purchased from the grid, and also the energy to

charge the batteries will come from the grid. Let’s suppose the maximum power from / to the

grid is 12 MW, we set this value. Suppose that the cost of the contracted power is 0. Let’s

suppose electricity annual inflation is expected to be 3% (as by default).
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Purchase from AC grid Unmet Load (Non Served
Energy by Stand-alone system)

] Fixed Buy Price {Ekivh) Haourly Price

Annual Inflation (%) Emissian (kgCOZ/Kwh)
Fixed  Prasx (M) Fixed Cost P (£ )
12| optons

Access Charge Price (£/kdvh)

[] Fixed Access price (E/kwWh) l:l Hourly Price

Back-up Charge Price (£/kvWwh)

. Fixed Back-up price [£/kwWh) D Hourly Frice

(The cost of the back-up toll will be added to the E purchased)

ﬂi

Hourly “alues

We uncheck the box “Fixed Buy Price” and then we click in “Hourly Price” button. In the window
that appears, we set the hourly price values of the energy purchased to the AC grid (we could
also import a file with the hourly price during the whole year or we could also set hourly periods):

HOURLY PRICE OF THE ELECTRICITY PURCHASED FROM THE AC GRID

Hourly Price Data (£/kh)
(@ Hourly, all days the same
O From file (8760 hourly values)

Import hourly Price 1= Draw

OHDurIyPeriUds

Hourly price, all days the same:

0-1h 1-2h 2-3h 3-4h 45h 5-6h B-7h 7-8h 8-0h §10h  10-11h  11-12h
|D.D4 ||u.u4 ||n.n4 ||n_n4 ||D.D4 ||D.D4 ||n.u4 ||n_n4 ||D.12 ||D.12 ||u.12 ||u.12 |
1213k 13-14h  1445h 1506k 16-17h 1718k 18-15h  18-20h  20-21h  21-22h  22-23h  23-24h
iz fjoaz otz fjorz fpae [z ffoas s [jots [[oas [tz [z |
We click OK.

In the central zone of the “PURCHASE / SELL E” tab, we click in “Pr. sell = pr. buy x “ and set the
value to 0.8, so that the hourly sold energy price will be the 80% of the hourly purchased energy.

Also we set max. power to 12 MW. Let’s suppose electricity annual inflation is expected to be
3% (as by default).

Sell Excess Energy to AC grid

l Fixed Sell Price [ '-1 2 Haurhy Price
[ Pr.zell = pr. buyx m

Annual Inflation (/ 3

Energy Generation Charge (Transter Charge) Price (£/kYvh
Fixed Transfer price (£/kWh) Cl Hourly Frice

Self-consumption and Net Mettering:

|ND net mettering ~

Costof net metering service (£/kWh) EI
Buy-hack: Export E is paid at (£/k\Wh)

In the right zone of the “PURCHASE / SELL E” tab, we select the priority to supply the energy not
covered by the renewable sources to the “AC Grid”, this way the energy consumed by the
auxiliary will be purchased from the grid instead of using the stored energy in the battery.
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AC GRID AVAILABILITY

Friority to supply E not covered by renewables:

() Starage/Generator (@) AC Grid

We click OK and return to the main window of the software.

In the BATTERIES window, we delete the default battery and select the 10 MWh Li-ion battery
of the database:

W BATTERIES - u] X
Add Battery Zera -
BATTERIES DATA: Float life at[20_| »c Cycles to Failure vs. Depth of Discharge (%)
Name Crom (k&h) Yolt (k) Costlve) COBMEZAM  SOCmin(%) Self_di%s/mon) Ime(ka) Ef(%) Floatyr) 10%  20%  30%  40%  60%  G60%  70%  B80% 90% 100% TF
» Batl OMwh 10 1 3 1

10 1 5 82 18 48000 24000 16000 12000 9600 8OO0  B&B7  BOOD 6333 4000 Li

We can see that the nominal capacity is 10 kAh and the voltage is 1 kV, therefore the energy
capacity is 10kAh-1kV= 10 MWh.

As our battery can supply 10 MW power, we will change the maximum current (Imax) from 5
kA to 10 kA (which, multiplied by 1 kV is 10 MW).

We can change the battery data in the database or here. If we want to change it here, we must
change first the name, we click in the name and add “-2”. Then, we change the Imax to 10 kA:

Mame Crom.(kah) Yaolt{kv) Cost(b€)  COMEAI SOCmIin(%) Self_d(®/mon.) Imax(kA)

4 Batl Ihdyyh-2 10 1 ] 1 10 1 et

Let’s suppose the rest of the values are the default ones (CAPEX 3 M€, annual OPEX 1% of CAPEX,

minimum allowed SOC 10%, roundtrip efficiency 92%, float life at 202C 15 years, cycle life vs.
DOD as shown).

Let’s suppose the average temperature of the battery bank for the different months, considering
the air conditioning, is the default:

rere 3 Je 0 A M ] o ]
& s o ot oo in Jou |

[] Except Schiffer model, consider

Tmean>=Tfloat life O Hour

Float life reduces 50% for every oC increase 1= T Graph
qrc\e life depends on T Data
Capacity depends on T Data

And the cycle life vs temperature and capacity vs temperature are the default ones (shown by
the buttons “Data”):

Cycles to failure (%) vs Temperature (°C): (forfull eqi. cycles and Rainfiow madiels) Capacity (%) ve Temperature (C).
Cyeles (%) =100 (a+ bT + £T°2) .
9% Capacity (%) = 100 (a+ bT + 6T*2) T
80 -
— =g
£ = 80
[0 ] p z ©
0 S .
[ooz ] 2 0 40 50 b= |0.012 =
Temperature (°C) e 32
1 c= |-0.00011 16
Temperature is the average:
{ 0
(@ Ambient temperature during all time (O Ambient temperature during charge/discharge
-20 0 20 40
{ Temperature (*C)
[“]Below 20°C no increase in cycle life
oK
ok
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Let’s suppose the Li-ion battery is similar to the LiFePo4 / graphite batteries tested by the work
of Naumann et al., 2020 (cycle ageing) and 2018 (calendar ageing) (in the user manual you can
see the reference of the article). We select “Naumann” in the ageing model, which includes cycle
degradation and calendar degradation:

Lead-acid Aging battery model Li-ion Aging battery model

(C)wang et al., 2011 (LiFeP04)

() Grot et al., 2015 (LiFeP04)

() saxena et al., 2016 (LiCo02)

() Full equivalent cycles

(O Rainflow (cycle counting)

(@) Naumann, 2020 (LiFePo4 cyc+cal)

Parameters

Click in “Parameters” button and we can see the values of the parameters used by the model,
selecting the “Naumann” tab (we could change any of them):

Wang Grot  Saxema Calendar ageing MNaumann

Data (Naumann et al., 2020): CYCLE ageing Data (Naumann et al., 2018): CALENDAR ag.

Qloss_cyc(%)=(a"Crate+b): (c:(DOD-0.6)"3+d)-FEC~z Qloss_cal(%)=kref-exp(-Ea/R"(1/T-1/Tref)-
(c(SOC-0.5)3+d) "sqrt(t)

kref [0:001257| gg [17226 | Tref [208.1499]

¢ o] zfos ] cpas | oo |
Graph:  Crate DOD(%%) 50¢(%) oo (25 |

20083 | ooern | Ja0s3 |

Capacity loss (%)
Capacity loss (%)

0 5,000 0 10 20
Number of Full Eq. Cycles Time (years)

OK

Click OK.

When battery bank remaining capacity is 80% of the nominal capacity, they will have to be
replaced. We expect the CAPEX will be reduced 2% per year, until a 60% reduction is reached.
For example, if the battery ageing model calculates the duration of battery is 9 years, in the year
9 and 18 they will be replaced.

Annual Inflation Rate expected for . Max. Wariation of Wind Batteries expected (e.q. for an expected 602 N
Batteries Costs: % reduction on current Batteries cost, introduce "-60%4"): %

Limit is reached in 45.4 years

and OK to return to the main screen.

In the INVERTER/CHAR. Window, we delete the default inverter/chargers and leave only the
one 5 MW. If we wanted to supply 10 MW, that is, C-rate = 1, we would need a 10 MW
inverter/charger. However, we want lower C-rates, so we will use the 5 MW inverter. Even we
could choose an inverter of lower power for this application, but we will use this one of 5 MW
(maybe in the future we want to increment C-rate).
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W INVERTER/CHARGERS

Add from Database [Zero v

-]

Include only VDG suitahle from farmily:

EFFICIENCY (%) vs. OUTPUT POWER (%) ->

GENERAL DATA
MName Fower(MVA) Lifespan fyr) Cost (ME) Imax_ch_DCikA) Ef_charger(%) Wdcmin(ky) Vdomax(ky) Pmes_ren(Mw) 0% 2% 3% 4% 5% 0% 20% 0%
3 i Ime-ChEMYY 5 15 153 5 98 08 11 1ET5 10 30 50 7O 88 93 92

Let’s suppose all the default values are correct: OPEX, CAPEX... Charger efficiency is 98%.
However, the inverter efficiency vs. output power is very low and conservative values are shown.
We change the name (add “-2” and then change the inverter efficiency as below):

]

I || | B | B[] = | X ||

EFFICIENCY (%) vs. OUTPUT POWER (%) ->

0% 2% 3% 4% b 10% 20w 30% 0% 50%: B0% 0% 80% 0% 100%
10 &0 40 35 97 37 97 a7 97 a7 37 97 37 97

Iny-Ch5MW-2

EFFICIENCY (%)

0 10 20 30 40 50 60 70 80 90 100
OUTPUT POWER (% OF RATED)

In the main screen of the software, make sure that there is one battery in parallel (min and max
are 1), and constraints with their default values (so they are not considered):

RIN. AND bAX, Mo COMPONENTS IN FARALLEL:

Bateries in parallel: kin. |1 | [EEVS |1| |

I 8
1 1

1 1

Constraints under MNPV maximization:

Max, Investment cost 1E10 FAE
in. Capacity Factor D o [ Prax_sell

Min. Rienew. Fraction

b ]
ba Unrmet load %

Max, Land use 1E10 ha | Data

Then, click “CALCULATE” button to perform the simulation of the system.

We can see the results in the result table (just one combination has been studied).

=
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nission (kKCO2AT) Unmet(GWwhiyr)  IRR(%)

-3.198 1.49 1] 1]

<

Landiha)

0.1

Irvestrent(hE)  Cap Fi26)  LODEE/kWh) Simulate Report Cos
4.375 0.1 0188 SIMULATE.. REPORT... CO!
>

0%.

COMPOMNENTS: Batteries Batl OMWh-2 (10 kAh): 1s. x Tp. 4 Bat. Inverter Inv-ChEMWSZ of 5 MVA J Unmetload = 0 % / Total Net Present Value (MPY) = -3.198 ME. IRR =

STRATEGY: There is no load consumption -» no control strategy related to the load consumption supply. SOC min: 10 % ARB.: Control variables for grid-connected
hatteries: charge (buying E. to the AC grid) if price of E. is lower than 0 £/k4Wh; disch. (load + injecting ta the grid) if price E. higher than 0.77 £/kith

NPV is -3.198 ME, that is, <0, non-profitable system.

In the table we can see results of annual energy, costs, etc. We can also see the hours of battery

charge/discharge, battery duration (10.64 years), etc.

Hours eq. Gen Bat. lifa ()
1} 10.64 1} 1} 1}

Hours Ch. Bat. Hours Disch. Bat. Hours FC - Hours Elyzer.

C. Fuel Gen.(MEfr) C. Fusl FCIMENT
1} o 0

E By (ME )
0148

E Sell (4

If we click in “REPORT” we can see the main results.

MHOGA software. Report

Prject: Batanlyho. Sobton #1
DC Vokiage: 1 kV. AC: 20

COMPONENT S:

Without PV

Batt. Bat10MWh-2. 1x1x10 kAh. E total =
Without Wind Turbines

Without Hydro Turbine =
Without AC Generator .
Without Fuel Cell
Without Electrolyzer
Inverter Inv-Chs MW-2, 5MVV 2

0.01 GWh (15 d.aut) POWER (MW)

Land use: 0.1 ha

CONTROL STRATEGY:

THERE IS NO LOAD CONSUMPTION -> NO CONTROL STRATEGIES RELATED TO THE LOAD CONSUMPTION
SUPPLY

Priority to supply net load with AG grid

The whole not supplied power to meet the load must be supplied by the Batteries. If the Batteries cannot supply the
whole, the rest wil be unmet load.

There is no AC Generator

There is no Fuel Cell

SOC min. batteries = 10 %

CONTROL STRATEGY FOR CHARGE/DICHARGE (load + injecting to the grid) OF GRID-CONNECTED
BATTERIES:

Max. electicity price for charging: (buy to the grid) 0 €/kWh: Min. electr. price for discharging: 0.11 €/kWh

ECONOMIC CALCULATIONS:
Initial Investment: 4.375 ME. Loan: 100 %, int. 7% in 25 years, annual quota: 0.375 ME.
NPV OF THE SYSTEM (25 years lifetime) (Incomes +. expenses -}

Total Net Present Value (NPV): -3 198 M€

Distribution of NPV
Battery bank (NPV): -4.93 M€

Inverter (NPV): -0.634 ME

Buy/Sell. Bought Energy (NPV): -2.346 ME (included 0 M€ due emssions of bought E.). Seld Energy: Electrical E
(NPV): 5647 ME (FCR 0%). H2 (NPV): 0 ME

Installation + financing + extra cash (NPV}: -0.876ME

Internal Rate of Return (IRR): 0 %. LCOE : 0.188 €/kWh

NPC / NPV (M)

BATIERIES.

TRV AR, £ BOUGHT TGAC GRID.

ENERGY BALANCE DURING 1 YEAR (GWh/year):

Overall Load Energy- 0.204 GWh/yr
Unmet load: 0 GWhiyr (0 % load)

E. Purchased from AC grid: 3.605 GWhiyr

Export Energy: 3.069 GWhiyr

E_ sold to AC grid: 2.975 GWhiyr

Renewable Capacity Factor (sold_ encrgyensu_peak_powsr'§760) 0.1 %; Renew. rction 100 %
Energy deliverad by PV generator” 0 GUhiyr

Energy deinared by Wind Turbnos: 0 GWhiyr

E. delivered by Hydro Turbine: 0 GWhiyr. Pumped 0 GWhiyr

Energy delivered by AC Generator: 0 GWh/yr

Energy delivered by Fuel Cell- 0 GWhiyr

Energy at Electrolyzer: 0 GWhiyr

Energy charged by Batteries: 3.385 GWhiyr

Energy discharged by Batteries: 3.124 GWhiyr

OTHER RESULTS:

Batteries Lifetime: 10.64 years
Hours eq. of AC Generator operation (all units): 0 hiyr. Number of starts (all units): 0
Hours of Electrolyzer operation: 0 h/yr. Number of starts

Hours of Fuel Cell operation- 0 hiyr. Number of starts: 0

Hours of Hydro Turb.: 0 hiyr. starts: 0. Hours of Pump: 0 hiyr; starts: 0

Total CO2 emissions: 1.49kCOyr

H2 sold in one year: 0t H2lyr

ENERGY BALANCE DURING 1 YEAR (GWhlyear)

a5

3
25
2
5
1

If we click in “SIMULATE” we can see the simulation:
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Hourly simulation  Hourly velues separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen AC Generator ‘Waterload / PHS  MULTIPERIOD

Simulation of 1 year, all the years the same.

1
124
S ———— 10 Total Load
= 111 Unmet Load
2 9 = Disch. Batt
g 101 == Charge Batt
T o _ Buy E from grid
z ’ g Sell E to grid
w 8 = — 30C
% 7 7 5
] -4
= § W
>
g 59 5 E
£ 4
A s 3
e 3
w
3
_ ,Z :
14
0 1
0 1 2 3 4 5 6 7 ] 9 10 1" 12 13 14 15 16 17 18 19 20 2 22 23 0
[“Legend 2 January
< > Days disp.
POWER COMNSUMED OR SUPPLIED (M) Erpm— [[]5ee Over
Batter bank Discharge Plim Charge Lagend
P2 BATTERY ENERGY (Mih) [JHLGr
1 [ 1 Electrolyzer soc [CIHRGr
0 [] & max disch. batt EHZtank(HHVHZ) R P1 S0C timi [ Grid
| imits Alt.
[] Expont E Battery bank Charge P critical Gen._ can. M SDCmu
xport Energy ap. Max.
1 Eto supply FC P critical Fuel Cell changs
setpoint Gen. 3ys)
Wind Turb 50C int Gi (days)
n urb.
R Small:
P U E hought to AC grid [+] Prmax SOL setaaint FO
‘ater Fump
AC Generator v] E soldta AC grid [v] Pmax
[ Proas input Inverter [ Pmex Gen . HZ TANK setooint (HHY H2) SOC(0-1)| | T.full charge

We can see charge is during the hours selected, at 0.2 rate (except at the end of the charge,
which is not possible) and discharge at 0.3 rate (except at the end).

Click in “Save simulation data” button and save the Excel file.

Open the Excel file and save it as xIsx file. Open the xIsx file and we can see, for example, for
January, the 2" (hiding selected rows and columns):

A B D AA AB AC AD AE AF AG A AL A0 AQ BA [} BC
6 |HOURLY VALUES. All power values are expressed in MW (H2.load is in MW referring to the HHV of H2). The SOC data of the batteries in energy (MWh).
7 |Water tank (Water_tank) is energy needed to pump the water (MWh) while (Water_tank_volume) is the volume stored (dam3).
8 |No.Gen_on is the number of AC generators that are running during this time step. Hours_eq_Gen is the number of equivalent hours (including out-of-range penalty and start-up penalty) of AC generators. The fuel consumption of the Gen. AC (Fue
9 |Costs of purchasing energy to the grid, the fuel cost of the AC Gen. (Fuel.Cost), the cost of the external fuel used by the fuel cell (C.fuel.ext_FC) and incomes of selling E and costs of buying E to the AC grid (Inc.Sell and Cost.Buy) are expressed in !
10 | Load of Hydrogen (H2_load_mass) is expressed in t/h of H2. H2 in tank (H2_Tank_mass), H2 used by fuel cell, from H2 tank (Fuel.FC) or externally purchased (Fuel.ext_FC) and hydrogen generated by the electrolyzer (Prod_H2) are expressedin t o
11 Hydrogen stored in H2 Tank (H2_Tank_HHV) is expressed in MWh HHV of H2

12 |Date Hour AC_load(MW C. bat(MW)  D. bat(MW) Unmet_Load( Export(MW) Sell.grid(MW) Sell.grid.Net(? Purch.grid(MV Pr.Sell.E(€/kW Pr.Buy. E(€/kV Inc.Sell(M€) ~ Cost.Buy(M€) SOC(MWh)  SOCmin.(MWISOCmax(MWh
37 |02-January 0:00 0.05 2 o 0 o o 0 2.09 0.032 0.04 o 0.00008 1.2 1.2 10
38 |02-January 1:00 0.05 2 0 0 0 0 0 2.09 0.032 0.04 0 0.00008 311 12 10
39 |02-January 2:00 0.05 2 0 0 0 o 0 2.09 0.032 0.04 0 0.00008 5.03 1.2 10
40 |02-January 3:00 0.05 2 0 0 0 0 0 2.09 0.032 0.04 0 0.00008 6.95 12 10
41 02-January 4:00 0.05 1.18 0 0 o o 0 1.25 0.032 0.04 o 0.00005 8.87 1.2 10
42 |02-January 5:00 0.01 0 0 0 0 0 0 0.01 0.032 0.04 0 0 10 12 10
43 |02-January 6:00 0.01 0 0 0 0 0 0 0.01 0.032 0.04 0 0 10 1.2 10
44 |02-January 7:00 0.01 0 0 0 0 0 0 0.01 0.032 0.04 0 0 10 12 10
45 |02-January 8:00 0.01 0 0 0 0 0 0 0.01 0.096 0.12 0 0 10 1.2 10
46 |02-January 9:00 0.01 0 0 0 0 0 0 0.01 0.09% 0.12 0 0 10 12 10
47 |02-January 10:00 0.01 0 0 0 0 0 0 0.01 0.096 0.12 0 0 10 1.2 10
48 |02-January 11:00 0.01 0 0 0 0 0 0 0.01 0.09% 0.12 0 0 10 12 10
49 |02-January 12:00 0.01 0 0 0 0 0 0 0.01 0.096 0.12 0 0 10 1.2 10
50 |02-January 13:00 0.01 0 0 0 0 0 0 0.01 0.09% 0.12 0 0 10 12 10
51 |02-January 14:00 0.01 0 0 0 0 0 0 0.01 0.096 0.12 0 0 10 1.2 10
52 |02-January 15:00 0.01 0 0 0 0 0 0 0.01 0.09% 0.12 0 0 10 12 10
53 |02-January 16:00 0.01 0 0 0 0 0 0 0.01 0.096 0.12 0 0 10 1.2 10
54 |02-January 17:00 0.01 0 0 0 0 0 0 0.01 0.09% 0.12 0 0 10 12 10
55 |02-January 18:00 0.05 0 3 0 2.95 2.86 2.86 [ 0.12 0.15 0.00034 0 10 12 10
56 |02-January 19:00 0.05 0 3 0 2.95 2.86 2.86 0 0.12 0.15 0.00034 0 6.87 12 10
57 |02-January 20:00 0.05 0 244 0 2.39 232 232 [ 0.12 0.15 0.00028 0 3.74 1.2 10
58 |02-January 21:00 0.01 0 0 0 0 0 0 0.01 0.12 0.15 0 0 12 12 10
59 |02-January 22:00 0.01 0 0 0 0 0 0 0.01 0.12 0.15 0 0 1.2 1.2 10
60 |02-January 23:00 0.01 0 0 0 0 0 0 0.01 0.12 0.15 0 0 12 12 10

We can see in column BA the SOC: January 2" at 0 h battery SOC is 1.2 MWh (SOC min. is 10%
of 10MWh, that is, 1 MWh, which would be for 202C, however as temperature in January was
set to 182C, the minimum SOC is increased as battery can supply lower energy, because capacity
depends on temperature). During the first hour (row 37), battery is charged at C-rate=0.2, that
is, 2 MW DC (column AA), and also auxiliary consumes 0.05 MW AC (column D), total 2.05 MW
consumption from the grid during the first hour of the day. But battery is charged by means of
the charger with 98% efficiency, therefore from the grid there comes 2/0.98 + 0.05 = 2.09 MW
AC (Purch. Grid, column AG). Buy electricity price at this hour is 0.04 €/kWh (column AL),
therefore the cost of buying electricity to the grid during first hour s
0.04€/kWh-2090kW-1h=83.6 € = 0.00008 M€ (column AQ).
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At the beginning of the second hour of January 2", row 38, battery SOC is 3.11 MWh (column
BA). Previous hour it was 1.2 MWh, and we have added 2 MW during one hour, but roundtrip
efficiency is 92% (considering charge efficiency = discharge efficiency = sqrt(0.92)=0.96),
therefore we have really added to the battery 2MW-1h-0.96=1.91 MWh, which added to the 1.2
MWh we have now 3.11 MWh (column BA).

For the rest charge hours, the evaluation is similar.

At 18 h (row 55) SOC is 100% at the beginning of this hour (column BA 10 MWh). Battery
discharge is 0.3 C-rate, that is, 3 MW DC (column AB). This DC power is converted by the inverter
(efficiency for 30% output power 97%) in 3MW-0.97=2.91 MW. As we have 0.05 MW AC
consumption for auxiliary, we have only 2.91-0.05 = 2.86 MW to be injected to the AC grid
(columns AE and AF), which is valued at 0.12 €/kWh (0.15*80%), column AJ, with a value of
incomes for this hour of 2860kW-1h-0.12€/kWh=343€=0.00034 M€ (column AO).

The SOC at the beginning of the next hour (row 56, column BA) is 10 MWh-3MW-1h/0.96= 6.87
MWh.

We go back to the software, we click in the results table in “COSTS”, seeing the costs during the
system lifetime:
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Project: Bat-only.mho. Solution # 1

Distribution of Incomes (+) and costs (-), NPV, during the years. RED: acqu. costs, replac. costs and incomes for final sale.
BLUE: O&M. Currency: M£.
Total NPV: -3.198 M€, IRR =0 %. Inversion cost: 4,375 ME. Loan of 100 %, int. 7% in 25 yr., quota: 0.375 ME€/yr.

TOTAL NPV -3.198 M€ Financial Cost (NPV): initial pay. + quotas + extra cash; -4.375 M€
Uy
- ponEeE=== =T—TE ] I———. 01 IIIIIIIIIIIIllII.I
-0.5 oz
-1 03
T T s T T T T
0 2 4 & & 10 12 14 16 18 20 22 24 & 8 10 12 14 16 18 20 23 34
Total Cost of PV Generator (NPV): 0 M€ Total Cost of”\flnd Turbines group (NPV): 0 M€
0 0
01 2 5 T 8 M 131517 18 2 2 25 01 2 5 7 8 1 12 15 17 18 21 2 25
Total Cost of Hydro T. (NPV): O M€ Total Cost of AC Generator (MPV): 0 ME
0 0
01 2 5 7 8 1 13 15 17 18 21 2 25 81 2 5 T 8 M 13 1517 18 2 Z 25
Total Cost of Inverter (NPV): -0.694 ME Total Cost of Batteries Bank (NPV). -4.93 ME

0 I =
0.2 I -1
0.4 2

T T -2

0 2 4 & & 10 12 14 16 18

]
&
1
(%]
e

01 3 5 7 8% 11 13 16 17 19 2 23 25

Total Cost of Electrolyzer (NPV). 0 ME Total Cost of Fuel Cell (MPV): 0 M€
0 0
01 2 5 7 8 11 12 18 17 18 21 2 28 01 2 5 7 8 1 12 15 17 18 21 2 25
Total Cost of H2 Tank (NPV). 0 M€ Total Cost of AC Gen. Fuel (MPV) O M€
o ]
01 3 5 7 8 1 12 15 17 19 21 2 25 01 3 5 7 9 1 13 15 17 19 21 23 25
Total Cost of External Fuel for FC (NPV) 0 M€ Total Cost of E purchased from AC grid (NPV): -2.346 ME
Ug—
1 ||||||||IIIIIIII|||| i
0
01 2 5 7 8 1 12 15 17 18 2 2 25 & 2 10 12 14 18 18 20 22 24
Total Incomes of E sold to AC grid (MPV). 5.647 M€ Total Incomes of H2 sold (NPV). 0 ME
0.3
0.2 o
0.1
0 02 4 8 & 10 12 14 16 18 20 2 24 91 2 5 7 8 M 13 15 17 18 21 23 25

We could do multi-period simulation (considering reduction of remaining capacity during the
years): in the main screen of the software, menu Project -> Options, select “Multiperiod...”.

42. Green hydrogen production with electrolyzer at full load and battery

Now we will create a new project to optimize a green hydrogen production system, powered by
renewable sources. We can optimize it by maximizing the net present value (NPV) of the system,
or by minimizing the LCOH or other options.

In this case, we want the electrolyzer to run at full load all the time: if the power from the
renewable sources is not enough, the net electrolyzer load will be supplied from the electrical
grid (purchased to the AC grid). If the grid electricity price is higher than a specific limit, the
priority to supply the net electrolyzer load will be from the battery. If the power form the
renewable sources is higher than the rated power of the electrolyzer, the surplus power will be
sold to the AC grid.
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Therefore:

e Low electricity price: energy from the wind farm is used to feed the electrolyzer (which
runs at full power) and charge the battery at the maximum charge rate allowed. If there
is not enough power from the renewable sources, buy the rest to the grid.

e Medium electricity price: energy from the wind farm is used to feed the electrolyzer
(which runs at full power). If not enough, buy the rest to the grid.

e High electricity price: if the power from the renewable sources is not enough to run the

electrolyzer at full load, the rest will be supplied by the battery; if not enough, buy the
rest to the grid.

In any case, if there is surplus power, it will be sold to the AC grid.

First, we create a new project “H2-prod-wind-bat.mho” (Project -> New). Remember, the path
from the root must not be too long, otherwise the software will show an error.

Let’s suppose we just want to use wind turbines (no PV in this case). The system will also include
electrolyzer, battery and inverter/charger.

Wind T.
!
Inverter/Charger AC " @
2 (Bi-directional AC

inverter) Load/
rid
<| H2 De g
H2
load  Fyercent +
Tank +
Battery

Electrol.

In the main screen, Project —> OPTIONS, leave the default data (we will optimize by maximizing
the NPV of the system):

MAIN OPTIONS:

Simulation and optimization

(@) Simulation of the 1styear and extrapolate results
O Multiperiod: simulate all the years of the system lifetime ( years)

Econamic optimizatian:

(O Minimize Nat Present Cost (NPC), usually for off-grid systems and high load on-grid ——> Min. NPC
Min. LCOH
(® heximize Net Present Value (NPV), usually for low load or no-load on-grid systems >
(@ Max NPy
(O Min. LCOE
[_]Define ‘Wind Farm with 16 power curves. one for sach wind direction sector ) Min. LCOH
[]0C renewable inclucte awn charger and contraller 8m: I‘;f‘; Fmin. LOOE

[[]then saving the praject, update sll the results of the table o the present conditions
Number of decimal places in resufts of costs |3~

Nurnber of decimal places in results of energy |3 <

OK

In the main screen, GENERAL DATA tab, select the following:
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GENERALDATA OPTIMIZATION CONTRC
COMPONENTS
[JpPv Gen

Wind Turbines
[ Hydro T.
Battery bank
[]Backup Gen

Inverter/char.

H2 (F.C. - Elyzer)

First we will introduce the wind data. Let’s suppose we don’t want to use wind speed data;
instead, we want to use as input data the output power of a wind farm normalized to 1 MW
rated power.

Click the WIND button.
This hourly wind farm output power (normalized to 1 MW) file can be downloaded here:

http://ihoga.unizar.es/Desc/windprod.zip

Download and unzip, you will get “windprod.txt” file, which has 8760 rows, one for each hour
of the year, with the production of the wind farm (normalized to 1 MW rated power).

In the wind resource window, in “Data source” panel, select “Import data file“ and “Generation
of wind turb. (MW) normalized to 1 MW rated p.” In our case, steps must be in Hours (as by
default) and then click the button “Import”, then look for the “windprod.txt” file and import it.

\ WIND RESOURCE - O X
Latitucle (4] (+N. -5): Get data fram local DB
Longitude (£ (+E. ) Download hourly data AFERTBIEEr et
;

Locate on map | Update coor Download NASA Monthly data

Surface Roughness
Data source

EEE Class |1 ~ | Length 0.03 m
ours
(O Monthly Averag, @ Import data file (.MW) windprod bt . Gy Minutegfbach hourin T ol poricutural open area without fences
Generation of wind turl, (MW) normalized to 1 MW ratedg ) A -1 per row neither hedges and with very dispersed
buildings. Only smoathly rounded hills

Then, we can see the average values of the imported data for each month and the graph of the

probability density function of the data imported.
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http://ihoga.unizar.es/Desc/windprod.zip

Ji WIND RESOURCE - O X

Latitude (%) (+M. -5) Get data from local DB

Anemometer Height

o

Longitude (£) (+E. ) Download hourly data

Locate on map | Update coord Download NASA Maonthhy data
Surface Roughness

Data source StEES o [ - [ 003 o
OMonthly Average @ Importcetatie (M) [windprod b B e s Agricutursl open area wihout fences
Generation af wind turb. (MW) normalized ta 1 kW rated p. Minutes-1 per row neither hedges and with very dispersed

Idings. Only smoothly rounded hills

Jan: 061

o
hdar: 0.35
Apr:0.36 =
Iy 0.42
un02? 5 18
wioga 218
Aug e L 14
Sep: 0.26 g 12
Det0zs & A
Nov:052 £ o8
Dec03? £ g
£ o4

Carrelation factor
02

Calculation of wind speed for each minute: std. dewv. 1 mis

01 02 03 04 05 06 07

08
Qutput Power normalized to 1 MW rated power Wi

Calculate 1= Graphinsteps of | )60~ min Export Av. year (M
035
Scaled Power (M)
Scale by (x by) Scaled Power (b o

0.35

Clicking in the “Graph in steps of” button, we can see the data during the year (you can move
with the position bar and you can change the number of days to display simultaneously):

Output power generated (MW) by Wind Turb. of 1 MW rated power

0.93
0.9
0.83

0.73
07
0.65
06
055
05
045
04
035
03
025

Mw

015
01
0.05

0 1 2 3 4 5 6 7T & 9 10 11 12 13 14 15 1% 17 18 19 2 21 2 23 0
1 January

[JHorizontal Grid [ ]Al []Vertical Grid  Days display
Soroll changs (days)> smalt: |1 Flarge

Click Back, then OK and return to the main window.

In the main window of the software, click the WIND TURB. button, then the wind turbines screen
appears:
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1. WIND TURBINES / GROUPS OF WIND TURBINES

WindT1

GENERAL DATA
Narms Bus Cost{ME) C Repl (ME) C O&M (%) Lifsspan i) Height(m) EmisCO2(ky  1mfs  2mjs  3mjs  4m/s  Bm/s  bmjs  7mjs  Bmjs  9mjs Im
» WindT1 AC 2 THETT H 20 100 15 0 0 0 nos 02 03 05 0.7 1

Output Power (MW) vs Wind Speed

>

Fixed O i d
Ivind speed from the wind regource will he converted to the WindT1 N‘I:men’;i:::?}”o?:
huk height considering roughness
€fyr
Losses wires, transformer:
%

)

Surface Roughness

£
Class |1~ Llengh 003 =
IAgricultural open area without fences neither hedges
and with very dispersed buildings. Only smoathly
rounded hills
0
0 2 4 6 8 10 12 14 16 18 20 22 24 26
Power curve measured ot air density (kg/m3) WIND SPEED (ms)
Wake effect
Height above sea level m ¥ — P.in standard conditions (sea level, 15°C), 1.225 kg/m3 U
Air dansity f that height s (54) 1136 kg/m3 ¥ — P. at altitude of the place (247 m), 1.196 kg/m3 Wake effect
Cansider the effect of terperature
“Wwhen simulating, adjust power cunve with air density: Arnbient Termperature ot hub height (2C) ; B . " " ” o = 1 14 ) .
(@) Use height above sea level and temp. | Graph (O Monthly average Eiivs mmst J F M A M J J A 8 o N D
S (@ File with 8760 hourly valuss Import
O Importair density (kgim3) Import p FROM RENEWABLE NINJA 1 Graph
Do not consider reduction in Power after: Annual Inflation Rate expected for Wind . ax. Variation of Wind Turbines Cost expected (e.g.. for an expected 35% o
Turhine Costs: % reduction on current\Wind Turbines cost, introduce "-35%"): %

Tdmis  (checkifwindt are pitch controlled)

Lirnitis reached in 42.9 years

By default, a wind turbine of 2 MW is considered. We could change it, add another one, etc.
Let’s suppose we want to consider just one type of wind turbine, of 4 MW, with a CAPEX of 4
M€, a replacement cost of 3.5 M€, and annual OPEX 2% of CAPEX (rest of the data same as the
default one of 2 MW). We can define this wind turbine in the database of the software, or we
simply could change the 2 MW one for the new one. We will do it. First, change the name to
WindT4MW, and then change the rest of the data. It is mandatory to change the name, if not
any other change will not be updated.

GENERAL DATA Output Power (MW) vs Wind Speed
Name Bug ost (ME) C.Repl. (ME) C. O&M (S2/MNifespan (yr) Height(m) Emis.COZ| m/s 2mfs Imyfs 4mfs Bmys Bm/s mfe am/s 9mfe  Im
coindTAMY g Al 4 35 2 20 100 15 0 0 01 04 06 1 14 2

In this case, as we do not use wind speed data (we use the data of the wind production
normalized to 1 MW rated power), the data of the output power vs wind speed is not necessary
to be changed, except for the value of 14 m/s, as the rated power of the wind turbine is
considered to be this value. Therefore, it is mandatory that we change the value for 14 m/s to 4
MW (the rest could be changed, if we want, as shown in the table, but it is not necessary, it
would only be necessary if we were using wind speed as data and not wind production
normalized to 1 MW):

Output Power (MW) vs Wind Speed

9m/s 10m/s  1mfs  12mis  13m/y 16mis  16m/s  17mfs  18mfs  19mfs 20m/s  21m/s  22m/s  23mfs  24dmfs  2bm/s  2Bm/s
z 26 3 34 349 4 4 4 4 4 4 4 4 4 4 4 4

Then we click OK and we return to the main window of the software.

In the main window, GENERAL DATA tab, we can define the minimum and maximum number of
wind turbines to be considered. Let’s suppose we want to consider between 10 and 20 wind
turbines (the software will take into account the different combinations: 10 wind turbines of 4
MW, 11 wind turbines of 4 MW, .... 20 wind turbines of 4 MW):
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V' Project: D)\H2prod-wind-batmho

Project Data Data Base Report Visual Help License Updates

+ LOAD /AC GRID GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART
COMPONENTS
RESOURCES 0 AN, AND M, No COMPONENTS IN PARALLEL:
PY Gen.
SOLAR
Bateries in parallel: Min. |D |Max. ‘5 |
+ WIND [] Wind Turbines 0 g
IAADIRE [JHydro T. @parallel:hﬂin. 10 hex. ‘25)
COMPONENTS ] |
B GEM. [] Battery bank

Now we will define the electrolyzers to be considered in the system.

In the main window, click in H2 (F.C.-Elyzer) button, and the next window appears:

VW H2 COMPONENTS - [m] X
Electrolyzers H2 Tank

Generation of H2 by electrical energy

Data to modify the consumption and efficiency curves:
1P +| = Curves change in H2 mass flow imit (% of rated){ 100 |
Factor_efficiency: -0.45
Neme P Nom(MW) | Ac.cost(ME) |C.O&M (@hn) Liespentyr)  A(WHgH) | B (KWkgh) | P.min (%)
» ElyzertomMw 10 @ 5000000 a0 a 10 1

Fower consumption n stanckay: 10 |% of nominal power Availability

< El 10MW. Cx M d Effic (%HHV)
z lyzer onsumption(MW) and Efficiency( ) o Wt cost (kg HD) El
z 8122 i Stack replacement cost (% of acy, cost
T 6144 2 Cold starttime (min): +Each cold start equiv. to exira ageing {min)
< g
7 409 w g Lifetime and O&M costs data Electricity DC
2 5
5 204 2 £ @ yeors and B
T 0
w 0 005 01 015 02 (O Hours ancl €/ Electrolyze

H2 OUTPUT MASS FLOW (h) .

2 H,0

Norminal H2 mass flow = 0.2 th: ltis needed at least 2 MW to generate H2

Equivalent CO2 emissions (manufacturing fuel cells and electolyzers): kg COZ auiv. / ki roted power

[ i i ion (kWh per kg H2):
[JFUEL CELL ELECTROLYZER + H2 TANK
Annual Inflation Rate for Fuel Calls, Electrolyzers and [ M, Variation of Fuel Cells, Electrolyzers and H2 Tanks Cost(e.g. for an
H2 Tank Cost % expected 90% reduction on current cost introduce "-90%": %

Limitis reached in 21.9 years

Fuel Cell and Elactralyzer are connertad to AC bus (by means of their inverter and rediifier respectivelly) | Inverter and rectiier data

Let’s suppose we want to consider just one type of electrolyzer, of 20 MW (we could consider
more types, just adding more rows to the table).

In our case, we will consider the liftetime and O&M costs in hours and €/h, then select:

Lifetime and O&M costs data:

(Cyvears and By

We could define a new electrolyzer in the database, but in this case we won’t do it, we will just
change the data of the one shown. Let’s change the data of the one of 10 MW to another one
of 20 MW. First, change the name of the electrolyzer of the table, for example to Ely-20MW
(remember, you must change the name in order to change any parameters, if not, no change
will be updated). Let’s suppose the data of the one of 20 MW is: CAPEX 24 M€, OPEX 166 €/h,
lifespan 80,000 h.
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MName P. Morn(kv) Acg. cost(ME]  CO&M (£/h)
» Ely-20bdy 20 24 166

AfWikgh) B (Kékgh)  P.min. (%)
40 2 20

Lifespan
goooa

To consider the decay in the efficiency and fit with the efficiency vs hydrogen mass flow curve
obtained from the electrolyzer manufacturer, we must modify the values of A, B, H2 mass flow
limit and factor efficiency until we fit the curve (see the paper
https://doi.org/10.1016/j.ijhydene.2023.08.273). Let’s suppose that our curve fit with
consumption parameters A = 40 kW/kg/h, B=2 kW/kg/h, H2 mass flow limit = 5% and factor
efficiency 0,45. We obtain the following curves of consumption (red curve, left axis) and

efficiency (green curve, right axis) vs. H2 mass flow:

2 to modify the consumption and efficiency curve®

Curves change in H2 mass flow imit (% of ratec)[5 |

Generation of H2 by electrical energy

Factor_efficiency: BP
4| 4B Bl | * | =|a|~¥ x| ! Y -~
Name P Nom{Mw)  Acg cost(ME)  COBMEH)  Lifespan (g A govkat) B idwikgd) P min. (%)
» Eh-20hdiy 20 24 166 80000 40 20

Power consumption

% of nominal power | Availability
Ely-20MW. Consumption(MW) and Efficiency(%HHV)

z Water cost (€/kg_HR):
= e e——
% 16.384 60 = Stack replacement costeeT acq. cos!
T 12288 “ = Cold start time (min):[20__ | Each colswme@uiv. to extra ageing (min){100 |
= 2
% 8192 E Lifetime and O&M costs data: e =
= 20 = Electricity DC
8 4.096 E (O years and EAr
jﬁ 0 0

0 0.05 0.1 015 02 0.25 03 (@ Hours and £/h

H2 OUTPUT MASS FLOW (t/h) Electrolvzer«
HHY of HE is 39.4 kitthykg Hy H.D

Also let’s suppose the power consumption in stand-by is 0% of nominal power (it is not
considered as all the time it will be at full load), the water cost is 0.06 € per kg of hydrogen
produced, the stack replacement cost is 40% of CAPEX (see the previous figure).

We could define the compression electrical consumption, however in this case we suppose the
electrolyzer consumption (defined previously) includes all the auxiliary consumptions.

As the electrolyzer is connected to the AC bus, it needs a rectifier. Click in the button “Inverter
and rectifier data” (lower area of the window) to define the efficiency of the inverter of the fuel
cell (not used in our case) and the rectifier of the electrolyzer. We can see the default rectifier
efficiency is 90%, we leave this value.

157


https://doi.org/10.1016/j.ijhydene.2023.08.273

ELECTROLYZER:
Efficiency of the rectifier of the electrolyzer. m 3
"

FUEL CELL:

Efficiency of the inverter of the Fuel Cell (32) vs Output power (% of ratec):

0% 2% 3% 4% 5% 0%  20%  a0%

O TN G I =T | O |
0% B0%  E0%  70%  80%  90%  100%

[sa Jlee  J[ez e Jles g4 [sa |

0K

Click in the H2 tank tab (upper area of the window). We will not consider the hydrogen tank,
because we want to sell all the hydrogen produced, we don’t want to store H2 to use later in
our system. The cost of the hydrogen tank, compressor, rectifier, and other auxiliary

components is included in the electrolyzer CAPEX in our case.

W H2 COMPONENTS

Electrolyzers H2 Tank

In H2 generating systems, do not consider H2 tank (costs 0, infinite allowed size)

Then we click in OK and return to the main window.

In the main window, click in BATTERIES, and the battery window appears:
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V[ BATTERIES - ] x

I 1 %+ - v
BATTERIES DATA: Float life at og Cycles to Failure vs. Depth of Discharge (%)
Narme Crom.ikah) Vall(kv) CostME) COBMEEA  SOCmin(%) Sel_di%/mon) Imax(ka) EA(%) Floater) 10%  20%  30%  40%  60%  60%  70%  60%  90% 100% TYF
b Batbhivh | 5 1 15 1 10 1 25 92 16 48000 24000 16000 12000 9800 8000 6857 6000 6333 4000 Li
< >
Batteries Moel Fixad Dperalion and Maintenance Cost[? | €Ar Equivalent CO2 emissions (manufacturing, kg COZ equiv | Kiwh capacity
@4h Li-ion model Ah Auiiary cooling. BMS... cons. AC (% of max F) [0 | S0C ot the begining of simulation % of SOCma
(O KiBaM (ManwelFMcGawan 1993) [Joc cons. LiHion batteries maximurm SOC: %
O Copeti 1994 Bat5MWh of 5 kAh
=
O Schiter 2007 \ z
W 40960 0 5
o o
Mean (°C) 2 32,768 2
Temp. J |18 Jj2z =
Biat. 2 Z B E
0 J ofie | o 24576 a
Mon. w 103
[ Except Schiffer model, consider I ] o
e import hourly file | () pour g 16,384 E
5 =
5 o
Float life reduces 50% for every Cincrease | L= T Graph 8,192 g
[] cydle life depends on T Data 0 =
0 10 20 30 40 50 60 70 80 90 100
[] capacity depends on T CEiE DEPTH OF DISCHARGE (%)
Lead-acid Aging battery model  Li-ion Aging battery model

Murnber of full equivalent cycles (onky > SOCmin): 4799.9

(Owang et al., 2011 (LiFePO4)
(D Grat et al., 2015 (LiFeP04) - " N
() Saxen et al, 2016 (LiCo02) Annual Infltion Fate expected for % Max. Waristion of Wind Bateries expected (2.g, for an expected 60% %

Bafteries Costs reduction on current Batteries cost infroduce *-60%")
(O Full equivalent cydles

(@ Rainflow (cycle counting)
(O Naumann, 2020 (LiFePo4 cyc+cal) Limit is reached in 45.4 years

Remaining capacity at battery end of lfe (%) :
[C]1 there is an AC Gen., every days or equivalent full cycles

charge battery bank at leastup to |9 |5

Parameters

0K

We could change any data, but let’s suppose the default battery: Li-ion battery of 5 MWh (5 kAh,
1 kV), 4800 full equivalent cycles, 1.5 M€ CAPEX ... is ok for us, so we leave all the default data.
Also let’s suppose the ambient temperature for the batteries and ageing model are ok. So we
don’t change anything and click OK.

In the main window, in the left area, we can see the DC bus voltage (for the battery bank) is 1
kV, same as the battery voltage, therefore the software will always consider just 1 battery in
serial (1 kV /1kV =1in serial). The number of parallel will depend on what we want to consider.

DCvaltage |1

ACVoltage kY

In the main window, GENERAL DATA tab, we can define the minimum and maximum number of
batteries in parallel to be considered. Let’s suppose we want to consider between 0 (that is, no
battery bank) and 10 batteries of 5 MWh in parallel (the software will take into account the
different combinations: battery bank of 0, battery bank of 5x1=5 MWh, battery bank of 5x2 =10
MWh,.... battery bank of 5x10 = 50 MWh):

V' Project: D\H2prod-wind-batmho

Project Data Data Base Report Visual Help License Updates

 LOAD/AC GRID GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART
COMPONENTS
RESOURCES
SOLAR CIPV Gen.
" WIND Wind Turbines 0 ]
HYDRO (JHydro . Wind T.in parallel: Min. M
COMPONENTS 1 1
' GEM. Battery bank
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In the main window, click in INVERTER/CHAR. button to define the inverters/chargers (needed
to connect the battery bank in DC bus to the AC bus).

A INVERTER/CHARGERS - [m] X

M| <[> M|+ |=
Include anly VDC suitable from farmiy: | <]

GENERAL DATA EFFICIENCY (%) vs. OUTPUT POWER (%) ->

Nare Power(MA) Lifespan (1) CostiME) Imax_ch_ DC(ks) Ef_charger(%) Vdomin() Voemax(eV) Pmax_ren(M) 0% 2% 3% 4% 6%  10%  20% 09
» T imeCrEMW 5 15 0s 5 8 09 1 TETS 10 30 50 0 85 93 %@

Inv-Ch10MW

88
80
2 linu &n

i <=5 minutes: (30| higher than normin
56
48

g 3 3
3 32 3 3

EFFICIENCY (%)

£y IfP. max. renswable DC > P. max ren.
32
24 O LimitP. from renew. DCto P max. ren,

16

(@ Discard that combination

[IProportional ta 1stone:
Inve 80 90 100

r 0 30 40 50 60 70
3[4 OUTPUT POWER (% OF RATED)

We will consider only the inverter/charger of 5 MVA, therefore we delete the rest (we click in
the rows we want to delete, and then click in “-“)

[44bb]+e

Let’s suppose the data of the inverter/charger of 5 MVA is correct for us, but we want the
inverter/charger to be considered in each combination of components to be proportional to this
one, with battery duration of 4 h (for example, if in a combination the battery bank is of 10
MWh, the inverter/chager will be of 10 MWh/4h=2 MW -> 2 MVA power, and the cost (CAPEX)
will be proportional to the one of 5 MVA, that is 0.5:2/5= 0.2 M€, the maximum current for the
charger, Imax_ch_DC will also be proportional). In the lower area of the window, we click this
option.

[ Propartional to 1st one:
Inverter rated power for

batt. duration thours):
Click OK and return to the main window. Then click in LOAD / AC GRID, by default there is no
load. In the PURCHASE / SELL E tab, update the following (see next figure):

- Select the Purchase energy from AC grid and Sell energy to AC grid options.

- Uncheck the “Fixed Buy Price” box.

- Setto 30 MW the maximum power to buy from the grid and same value to the maximum
power to sell to the grid (we suppose this value is the maximum grid power available).

- Clickin “Pr. Sell = pr. buy x” and set 0.8 the factor. Therefore, we suppose sell electricity
price is 80% of purchase electricity price.

- Select “Sell surplus H2 in tank...” and set to 10 €/kg the price of the hydrogen sold (all
the hydrogen produced will be sold, at this price the first year and the next years
considering the inflation, 3% annual by default).
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V' Load and options of Selling / Purchasing Energy from the AC grid - ] x

Data source: Hours AC oc Ho WristEn
. binutes- h h 1
(O Manthly Average @) Load Prafile () Import File (MW, tH2/h, dem3h) Mimitoa 1 parrow Import Export
AC LOAD (MW) DC LOAD (MW) H2 LOAD (tH2/h) WATER (dam3/day) FROM WATER TANK  PURCHASE/ SELLE
AC GRID AVAILABILITY
Purchagk from AC grid Unmet Load (Non Served Sell Excgss Energy to AC grid
g% by Stand-alone system) Priority to supphy E not covered by renewakles:

[ Fiedsa 0.1z Hourly Prica (@) Storage/Generator () AC Grid

|| Fixed Buy Price i£/K3)h) 0.15 Hourly Price -
Pr.sell = pr. buyx [] Sta/Gen. priatity if Pr.E >= El
Annual Inflation (%) Ernission (kgCO2/kyh)
_ Annual Inflation (%2 lus H2 in tank (difference
the H2 in the tank at the end

heed  Prmia (M) Fixed Cost P (€Ki M. Power(hi) . gar and at the beginning)

. Options Houtl Energy Leneranon Charge (Transter Charge) Price (£/kY/h) m Annual Inflation (24)
ly Walues
Acoees Chargs Price (A Fixad Transfer price (£/kwh) |0.0005 Hourly Frice

Fixed Access price (E/k\wh) D Hourly Price Self-consumption and Net Mettering:

Proax buy

Biack-up Charge Price (/kih [Na netmetiering ]
Fired Backup price (BAWH) [0 | | Hauy Frice Cost of net matering senvice (EWH)  |J
(The cost of the back-up toll will be added tathe E purchased) Buy-back: Export E is paid at (E/kWh) El
Total tax for electricity costs (buy + charges) (%6) El Total tax for electricity sold (34) D Losses in wire and transformer (%): EI

Now let’s suppose that the electricity buy price is hourly (real time pricing tariff) and it has high
differences between the minimum and maximum hourly price of each day. This hypothetical
hourly price file can be downloaded here:

http://ihoga.unizar.es/Desc/Hypothetical hourly pirce.zip

Download and unzip, you will get “Hypothetical_hourly_pirce.txt” file.

Then, click in “Hourly Price” button below the option of “Purchase from AC grid...”:

ACLOAD (MW}  DCLOAD(MW)  H2 LOAD (tH2/h)

Purchase from AC grid Unmet Load (Non Served |
Energy by Stand-alone system)

[ Fixed Buy Price gAsvh) D15

Annual Inflation (22) Emission (kgCO2/kwh):

In the window that appears, select “From file (8760 values)” and import (“Import hourly Price”
button) the “Hypothetical_hourly_pirce.txt” file.

HOURLY PRICE OF THE ELECTRICITY PURCHASED FROM THE AC GRID

Hourly Price Data (£/kWh)
(O Hourly, all days the same

© Frorn file (8760 hourly values) Import hourly Price| |Hupothetical_hourly_pirce. bt ﬁ Dran

() Hourly Periods

This will be the hourly purchase price of the first year (hourly sell price will be 80%). For the next
years of the system lifetime, we assume prices will be updated with an annual inflation of 3%
(as default, we have not changed it).

Click in Draw to see the imported data.
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Click Back, OK and OK to return to the main screen.
In the main screen, CONTROL STRATEGIES tab, we can select the options of the control strategy.

To consider control strategies in grid-connected systems related to the electrolyzer and/or the
batteries, we must select the options of ENERGY ARBITRAGE (right area, next figure). We must
check the box “Batt. charged by the AC grid // discharged if” to consider any option of energy
arbitrage (including the option of using the electrolyzer to sell hydrogen). Also check the box
“(also for Elyzer -> H2)” as we are also considering the electrolyzer, not only battery. And check
the box “Elyzer full load” because we want the electrolyzer to be at full load all the time,
consuming electricity from the grid if necessary.

We must also uncheck the box “(Compare with Sell price)”, because, if this was checked the,
the energy price to compare with would be the sell price, but also, if it was checked, the batteries
and electrolyzer would only be charged by means of the renewable sources, not by the grid. As
we want the batteries to be charged at low electricity price from the grid, and also during these
time steps the electrolyzer must buy electricity to the grid to run at full power (if the renewable
sources cannot fully feed it), we need to uncheck this checkbox.

Also, let’s suppose we want the batteries to be charged only when the purchase electricity price
is low (for example, lower than 0.03 €/kWh in the first year, the next years this price will be
updated with the purchase electricity price inflation) and discharge the batteries to feed the
electrolyzer (if renewables are not enough) when the purchase electricity price is high (for
example, higher than 0.1 €/kWh in the first year):

GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

CONTROL STRATEGY AND WARIABLES TO OPTIMIZE
ENERGY ARBITRAGE: System with batteries and grid connected

(1~ |ialso for Elyzer-> HIR9w| Evzer full load
N Mk | |0€s | |iCampare with Sell pricel)

Global strategy:

Hatt. charged by the AC gric /f dischargeT™y
Price E<=((001 ]

(:} Try Both |:| Optirnize strategy of grid-conneted batteries:

(@ Load Following

Sk Price B> fl

() Cycle Charging Continue up to S0C stp

Yariables to optimize relative to the global strategy:

Prain_gen Prain_FC HZTAMNKstp
F1_gen F1_FC
- - Fe . [] Batteries can inject slectricity to the AC grid
S0Cstp_gen S0Cstp FC D 50Cmin I:‘ 1 day atlow S0C -> charge battery with AT grid B . ilabili
Ftitical_ggen H2TARMKstp I:‘ Flirm_charge atteries availabiliy

[C]When batteries are off compens ate autadisch

[]s0Cmex | Fixvariables “Wariahles accuracy: =100%

If SOCmin reached, disch. not allowed if S0C(%) < SOCmin(¥2) + El
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In the FINANCIAL DATA tab, we can see the general economic data, we leave them by default:

GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

ECOMNOMIC DATA:

MNominal interest rate (capital cost) % Loan (constant quota, French systerrn)
(nominal discount rate) Annual real discount ratel (35):
Armount of loan %

Annualinflation rete (02M.3: [2 | s 19
ptallitistiogista)l ) fd of the iniial cost of investiment
In LCOE / LCOH include real disc. rate in Energy

Study period (system lifetime) years In maximize NP systems use Inf sell j HZ Loan Interest %

[] Atthe end of the study period consider the residual cost of the components
Duration of loan: WEArS

Currency |Eura (£) w

Installation cost and variakle initial cost D ME Fix + % ofinitial cost

Corporate taxes (%) El [t in a year costszincomes, taxes=0 that year
A
MNegative taxes accumulate and are offset [ater when taxes >0

Exra Cash Flow

Now we have everything defined. We can calculate, the software will simulate all the
combinations of components (11 combinations of wind turbines, between 10 and 20 in parallel;
11 combinations of batteries, between 0 and 10 in parallel; 1 combination of electrolyzer: total
11 x 11 x 1 = 121 combinations). The software will evaluate each combination, calculate all the
results of each combination, and then sort them from best to worst considering the objective,
which is in this case the maximization of the NPV.

Click in CALCULATE. After several seconds the system is optimized:

Total NPV (ME Emission (KCOZ240)  Unmet{GWhhr)  IRR(%)  Land(ha) Investment{hE) CapF(%) LCOEEkWh) Simulate Report (A
2549 0 24.46 1296 120 30.43 0.033 SIMULATE.. REPORT... (
b 25.66 0 2383 1368 125 28.41 0.052 SIMULATE.. REPORT... (
275411 27.41 0 2511 1224 115 1.7 0.0844 SIMULATE.. REPORT... (
274.774 24.91 0 2321 1440 130 28.99 0.0873 SIMULATE.. REPORT... (
274.508 26.51 0 24.14 1296.05 122031 30.41 0.0535 SIMULATE.. REPORT... (
274.463 28.44 0 25.78 1152 110 31.93 0.0351 SIMULATE.. REPORT... (
274.24 25.68 0 2353 1368.05 127.031 29.69 0.0325 SIMULATE.. REPORT... (
274136 27.44 0 2477 1224.05 117.031 31.14 00548 SIMULATE.. REPORT... ¢
273.396 24.92 0 2293 1440.05 132031 28.97 00518 SIMULATE.. REPORT... ( v
< >
COMPOMNENTS: 18 Wind Turb. WindT 4w (4 MW at 15 m/s) /. Electroliz. El-20MW of 20 MW/} Bat. Inverter of 0 MVA 4 Unmetload = 0 %/ Total Net Present Value
(NP) = 275.832 ME, IRF = 24.5%.
STRATEGY: There is no load caonsumption -» no control strategy related to the load consumption supply. F. lim. charge: 15 MW, ARB.: Control variables for green
hydrogen: Generate H2 with elyzer. atfull power all the time, buying E. to the AC grid if necessany: Battery supplies power to elyzer. if price E. is higher than 0.1 £/kMh;
charge battery if price of E. is lower than 0.03 £/kdWh

The first row of the results is the optimal system (explained in the area below the results table):
it consists of 18 wind turbines of 4 MW and electrolyzer of 20 MW. No battery nor
inverter/charger are selected (that is, in this case the cost of the battery and inverter/charger is
too high and it is better not to use them, it is not worth).

For each combination, we can see the NPV, emissions, unmet load (no meaning in this case as
there is no load), IRR, land used, investment cost, capacity factor, LCOE (considering energy of
the hydrogen produced as the HHV), the components used and many other results (use the
displacement bar). We can see the simulation, the report and the cash flow detailed if we click
the bold cells SIMULATE, REPORT or COSTS.

If we click in “SIMULATE” in the first row of the table, we will see the simulation of the optimal
system:
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Haurly simulation Haurly values separately Manthly and Annual Average Power  Monthly Energy  Annual Energy  Hydragen  AC Generator Water load /PHS  MULTIFERIOD

Simulation of 1 year, all the years the same.
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EE E
£ 3 50000 &
25 N
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E 20 &
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15 @
20,000
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5 10,000
0 0

2 3 4 5 6 7 8 9 10 " 12 13 14 15 16 17 18 19 20 2 22 23 0

0 1
DLegend 1 January
< > Days disp
POWER CONSUMED OR SUPPLIED (M) E— [Jsee over
Batter bank Discharge L1 Plim Charge Legend
P2 BATTERY ENERGY (Mih) CIHLG
O O Electrolyzer soc CIHRGE
O E. max. disch. batt. E.H2 tank (HHY H2) [«]R P1 o [v.Giid
SOC limits A
Battery bank Charge P critical Gen.
[] Export Energy Cap. Max Serall
E to supply FC P critical Fuel Cell changs
) S0C setpoint Gen. (dlays):
R Wind Turb. Small
—— E houghtto AC grid ] Pmax S0C setpaint FC
‘ater Purnp )
AC Generator E sold ta AC grid Fr
[ Prnase. input Inverter W P @ A e H2 TANK setpaint (HHY H2) SOC(0-1) | T.full charge :WE

Simulation step (min): 60 Save data: Save Simulation Data Save Prob. Data

COMPONENTS: Wind turbines of 72 MW, Electrolyzer of 20 M.

STRATEGY: There is no load consurption -> no contral stratedy related to the load consumption supply. Arbitrage: Control variables for green hydrogen: Generate H2 with elyzer. at full power all the time,
buying E. to the AC grid if necessary

In the first hour of January 1%, we can see that the 18 wind turbines of 4 MW (total 72 MW rated
power) generate roughly 37 MW, in green line (if we go to the wind resource window, and see
the data imported from the wind farm normalized to 1 MW rated power, we can see for the first
hour of the year it is roughly 0.5 MW -> multiplied by 72 MW rated power we obtain roughly 37
MW). In the graph we can see the electrolyzer runs at full power (20 MW, what we see in the
graph, turquoise dot line, is the power consumed in DC by the electrolyzer), but it consumes in
AC 20/0.9 = 22.2 MW (due to the rectifier efficiency of 90%). The rest AC power (37 MW —22.2
MW), approx. 15 MW is sold to the AC grid.

For other hours, for example at 12 h, the wind farm generation (13 MW) is lower than what the
electrolyzer needs in AC (22.2 MW), the rest (9.2 MW) are supplied by the AC grid (purchased
to AC grid). Zoom in the graph:

9 10 1 12 13 14 15 16
1 January

In the right axis there is the H2 production cumulated (in HHV, MWAh) (in systems where
hydrogen is later consumed, it shows the H2 in the tank).

If we change the days to display to 365:
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Hourly simulation  Haourly values separately  Monthly and Annusl Average Powsr  Manthly Energy  Annual Energy  Hydrogen  AC Generator  Water load / PHS  MULTIPERIOD

Simulation of 1 year, all the years the same.

f 110,000

100,000
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In the second tab of the screen, we can see the different components during the year:

EoE o g @ @
S &S oS o

o
&

40,000

POWER (M) /WATER tank (MWh)
BATTERY /HZ Tank ENERGY (MWh)

5
0

Hourly simulatiol onthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator  Water load f PHS  MULTIPERIOD

HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
0 0
0 2,000 4.000 6.000 8,000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator
0 0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
100,000
g @ 50,000
0
0 2,000 4,000 6.000 8.000 0 2,000 4.000 6,000 8,000 0 2,000 4,000 6,000 8,000
Battery bank Charge Battery bank Discharge Energy in Battery bank
0 0 0
0 2,000 4.000 6.000 8,000 0 2,000 4,000 6,000 8,000 0
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
0
0
0 2,000 4,000 6.000 8.000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6.000 8,000

If we click in “Save Simulation Data” button, we will save all the simulation results, which can
be open by Excel.

8 [ D 3 F G H | J K L M N o P Q R s
1 [Project: D: \PllCVECFOS MHOGA 3.4-202403XX\H2-prod-wind-bat.mho. Solution # 1
2
3 COMPONENTS: Wind turbines of 72 MW. Electrolyzer of 20 MW.
4 | STRATEGY: There is no load consumption -> no control strategy related to the load consumption supply. Arbitrage: Control variables for green hydrogen: Generate H2 with elyzer. at full power all the time, buying E. to the AC grid if necessary
6 | HOURLY VALUES. All power values are expressed in MW (H2.load is in MW referring to the HHV of H2). The SOC data of the batteries in energy (MWh).
7 | Water tank (Water_tank) is energy needed to pump the water (MWh) while (Water_tank_volume) is the volume stored (dam3).
8 |No.Gen_on s the number of AC generators that are running during this time step. Hours_eq_Gen is the number of equivalent hours (including out-of-range penalty and start-up penalty) of AC generators. The fuel consumption of the Gen. AC (Fuel.Gen)is expressed in x1E6li
9 | Costs of purchasing energy to the grid, the fuel cost of the AC Gen. (Fuel.Cost), the cost of the external fuel used by the fuel cell (C.fuel.ext_FC) and incomes of selling E and costs of buying E to the AC grid (Inc.Sell and Cost.Buy) are expressed in M€. They are cash flow value:
10 Load of Hydrogen (H2_load_mass) is expressed in t/h of H2. H2 in tank (H2_Tank_mass), H2 used by fuel cell, from H2 tank (Fuel.FC) or externally purchased (Fuel.ext_FC) and hydrogen generated by the electrolyzer (Prod_H2) are expressed in t of H2.
11 Hydrogen stored in H2 Tank (H2_Tank_HHV) is expressed in MWh HHV of H2
12 Date Hour Load(MW)  AC_load(MW]DC_load(MW H2_load(HHV H2_load_mas Water_load(\ PV(MW) Wind(MW)  Hydro(MW) Ef_turb(perce AC.Gen.(MW) No.Gen_on  Hours_eq_Ge Cons.Fuel(x1E Fuel.Cost(M€] F.C.(MW) Fuel.FC(t) Lil
13 01-January 0:00 o o o o o o o o 1 o o 0 o o o o
14 01-January 1:00 o o o o o o 0 39.24 o 1 o o 0 o o o o
15 01-January 2:00 o 0 0 o o 0 0 41.04 0 1 o 0 0 o 0 0 o
16 01-January 3:00 o o o o o o 0 41.04 o 1 o o 0 o o o o
17 01-January 4:00 o o o o o o 0 41.04 o 1 o o 0 o o o o
18 01-January o o 0 o o o o 40.68 o 1 o o 0 o o o o
19 01-January o o o o o o o 40.32 o 1 o o 0 o o 0 o
20 01-January o o o o o o 0 39.24 o 1 o o 0 o o o o
21 01-January o 0 0 o 0 0 0 30.24 0 1 o 0 0 o 0 0 o
22 01-January o o o o o o 0 216 o 1 o o 0 o o o o
23 01-January o o o 0 o o 0 18 o 1 o o 0 o o o o
24 01-January o o o o o o 0 14.76 o 1 o o 0 o o 0 o
25 01-January o o o o o o o 12.96 o 1 o o 0 o o 0 o
26 01-January o o o o o o 0 11.88 o 1 o o 0 o o 0 o
27 01-January 0 0 0 0 0 o 0 12.6 0 1 0 0 0 0 0 0 0
28 01-January o o o o o o 0 14.4 o 1 o o 0 o o o o
29 01-January o o o o o o 0 20.52 o 1 o o 0 o o o o
30 01-January o o o o o o 0 27.36 o 1 o o 0 o o 0 o
31 01-January o o o o o o 0 33.12 o 1 o o 0 o o 0 o
32 01-lanuary 0 0 0 0 0 0 0 37.44 0 1 0 0 0 0 0 0 0
SimElizerFuliLoad ® < >
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In the Hydrogen tab, hydrogen production and cumulated, by moths:

Hourly sirmulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy Annus rator Water load /PHS  MULTIPERIOD

MONTHLY H2 CONSUMPTION AND PRODUCTION (t). H2 STORED IN TANK OR SOLD AT THE END OF EACH MONTH

250

3000 o

= 200 2
= 2500 2
@ S
£ 150 2000 2
5 1500 £
g 100 =
5 2
% 5U 1,000 g
s0 &

I

0 0
1 2 3 4 5 [ 7 8 9 10 " 12
Month
V[ H2 load v B H2 produced by Electrolyzer v @ H2 consumed by Fuel Cell (from Tank)

v @ H2 consumed by Fuel Cell (external H2)  [we= H2 stored in tank / sold at the end of the month

14
12
10
1 2

If we return to the main screen, and click in the first row of the results table, in REPORT cell, we

MONTHLY ENERGY PRODUGED BY FUEL CELL AND CONSUMED BY ELECTROLYZER (GWh)

HIHTI

Month

Energy (GWh)

[

=)

||7. Energy generated by Fuel Cell v B Energy consumed by Electrolyzer |

obtain the report of the optimal system, where it is shown the components, control strategy,
economic results, energy balance and other results (it can be printed, saved in PDF... and when

we close, it asks if you want to save it in .doc or .rtf file which can be open by Microsoft Word):

MHOGA software. Report

Project: H2-prod-wind-bat. mho. Solution # 1
DC Voltage: 1 kV. AC: 20 kV.

COMPONENTS:

Without PV

Batt. Bat5MUh, 1x05 kh. E total = 0 GWWh (0 d.aut)

18 Wind T. WindTAMW. 18x MW (@14m/s). P. total 72 MW

Without Hydro Turbine

Without AC Generator

Without Fuel Cell 50

Elyzer. Ely20MW, 20 MW. w0
20
2

POWER (MW)

Inverter prop. to Inv-ChSMW, OMW
Land use: 1296 ha

wr e Ny
CONTROL STRATEGY:
THERE IS NO LOAD CONSUMPTION - NO CONTROL STRATEGIES RELATED TO THE LOAD CONSUMPTION
SUPPLY

If the spare power from renewable is lower than Plim_charge = 15 MW, priority to charge batteries. Otherwise priority
for the electrolyzer to gensrate H2

CONTROL STRATEGY FOR GENERATING GREEN H2:

Max. electricity prics for generating H2 (buy to the grid): 0.03 €kWh

ECONOMIC CALCULATIONS:

Initial Investment: 120 M€. Loan: 100 %, int. 7% in 25 years. annual quota: 10.297 ME.

NPV OF THE SYSTEM (25 years fstime) (Incomes +, expenses -):

Total Net Present Value (NPV); 275.832 ME. Intemal Rate of Return (IRR): 24.46 %. LCOE : 0.083 €/kWh

Distribution of NPV
Wind turbines (NPV): -99.041 Mg

Electrolyzer+ H2Tank (NPV): -49.629 M€

Buy/Sell. Bought Energy (NPV) -79.333 M€ (included 0 M€ dus emssions of bought E.). Sold Energy: Electrical E
(NPV): 58.993 M€ (FCR 0%). H2 (NPV): 468.842 VE.

Installation + financing + extra cash (NPV): -24M€

NPC / NPV (M€)

ELVZER ~H_TANK. |\

£ EOUGHT TO AC GRID

ENERGY BALANCE DURING 1 YEAR (GWh/year):

Overall Load Energy: 0 GWhiyr.
Unmet load: 0 GWhiyr (0 % load)

E. Purchased from AC grid- 61.045 GWh/yr

Export Energy: 24.305 GWhiyr

E. sold to AC grid: 75.153 GWh/yr

Renewable Capacity Factor (sold_energy/(renew_peak_power*8760): 30.43 %: Renew. fraction: 100 %
Energy delivered by PV generator. 0 GWh/yr

Energy delivered by Wind Turbines: 218.972 GWhiyr

E. deliversd by Hydro Turbine: 0 GWhiyr. Pumped 0 GWhiyr

Energy delivered by AC Generator: 0 GWh/yr

Energy delivered by Fuel Cell: 0 GWhiyr

Energy at Electrolyzer: 175.2 GWhiyr

Energy charged by Batteries: 0 GWhiyr

Energy discharged by Batteries: 0 GWhiyr

OTHER RESULTS:

Batteries Lifetime: 100 years

Hours eq. of AC Generator operation (all units): 0 hiyr. Number of starts (all units): 0
Hours of Electrolyzer operation: 8760 h/yr. Number of starts:

Hours of Fuel Cell operation: 0 hiyr. Number of starts: 0

Hours of Hydro Turb.:  hiyr. starts: 0. Hours of Pump: 0 hiyr; starts: 0

Total CO2 emissions: 26 49kiCO2yr

H2 sold in ane year: 29643 t H2/yr

ENERGY BALANCE DURING 1 YEAR (GWhlyear)

20
w0
w0
- — I

If we return to the main screen, and click in the first row of the results table, in COSTS cell, we
obtain the report of the costs of the system, in detail (it can be printed, saved in PDF... and when
we close, it asks if you want to save it in Excel file):
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Project: H2-prod-wind-bat.mho. Solution # 1
Distribution of Incomes (+) and costs (-), NPV, during the years. RED: acqu. costs, replac. costs and incomes for final sale.
BLUE: O&M. Currency: M£.
Total NPV: 275.833 M£, IRR =24.5 %. Inversion cost: 120 M€. Loan of 100 %, int. 7% in 25 yr., quota: 10.297 M€iyr.
TOTAL MPV: 275.833 M€ Financial Cost (NPV): initial pay. + quotas + extra cash: -120 M€
15 Uy -
: -III I SRR
o I. . N
E 7 8 1113 15 17 18 21 23 25 7 o9 1 12 18 A7
Total Cost ofF‘V Generator (NPV): 0 ME Total Cost OTWmd Turbines group (NF‘V} 99 U4‘I M€
o .—-
-20
e 40
01 2 5 7 8 M 132 15 17 12 21 2 25 0 02 4 & 8 10 12 1418 18 20 = 24
Total Cost of Hydro T. (NPV): 0 M€ Total Cost of AC Generator (MPV) 0 M€
0 0
01 2 5 7 8 11 13 16 17 18 21 2 25 01 3 5 7 9 M 13 16 17 19 21 23 25
Total Cost of Inverter (MPV): 0 ME Total Cost of Batteries Bank (NPV): 0 M€
0 0
81 35 7 5 1 135 17 15 21 = 28 81 385 7 5 m 1315 17 15 21 = 28
Total Cost of Electrolyzer (NPV): -49.629 ME Total Cost of Fuel Cell (WPY): 0 ME
o =
-10 0
-20
0 2 4 8 8 10 12 14 16 18 20 22 24 01 2 B 7 8 M 12 16 17 19 1 2 25
Total Cost of H2 Tank (MPV). 0 M€ Total Cost of AC Gen. Fuel (NPV) 0 M€
g 0
91 2 5 7T 8 1 13 15 17 13 21 23 25 01 2 5 7 8 11 12 15 17 18 2 22 25
Total Cost of External Fuel for FC (MPV) 0 ME Total Cost of E purchased from AC grid (NPV). -79.333 M€
: H
ﬂ I.ll-l /
4
01 2 B 7 8 1 12 18 17 19 1 3| 35 5§ 7 8 1 13 18 17 18 21 22 25
Total Incomes of E sold to AC grid (NPV): 58.993 M£ Total Incomes of H2 sold (MPV): 468.843 ME
2]
5 20
14 10
o4 0
01 2 5 7 9 M 121517 19 21 2 25 01 2 5 7 9 1 12 15 17 19 21 23 25

Now we return to the main screen.

Let’s see how the results change if we change the CAPEX of the batteries. Go to the batteries
screen, change the name of the battery (for example, add “-“) and change the CAPEX to 0.1 M€
(a very high reduction from the 1.5 M€ original), this cost is not real, but we will use it to see if
with low battery prices the batteries are included in the optimal system.

1 BATTERIES

Add Battery |Zero

Add Batteries family |

BATTERIES DATA:

MName Criom.(k&h) Volt(kKY) CostME)
I Batshivh- 5 1 IR

Now return to the main screen and CALCULATE again.
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# Total NPY (ME) Emission (KCO2Ax UnmetiGWwhan)  IRR(2)  Landiha)  Investment(ME) Cap Fl)  LCOEEMWh) Simulate Report A

1 284.217 26.79 1] 24.59 1296.5 122813 30.3 0.0606 SIMULATE.. REPOR

2 28419 27.76 1] 25.25 12245 117813 31.03 0.0817 SIMULATE.. REPOR

3 283.712 2883 1] 2593 11625 112813 3179 0.0831 SIMULATE.. REPOR

4 283.648 25.92 0 2345 1368.5 127813 24.58 0.0797 SIMULATE.. REPOR

5 283.51 26.77 1] 24.58 1296.45 122571 30.3 0.0a08 SIMULATE.. REPOR

B 283.477 27.74 1] 25.24 122445 117531 31.04 0.0519 SIMULATE.. REPOR

7 283.012 2591 0 2344 136845 12763 24.58 0.0799 SIMULATE.. REPOR

g 282.973 28.81 1] 25.93 1152.45 112531 3179 0.0534 SIMULATE.. REPOR

] 202.648 26.75 1] 2458 1296.4 122.26 30,3 0.031 SIMULATE.. REPOR v
< >

COMPONENTS: Batteries BatbhdWh- (5 keah): 15 x 1000 4 18 Wind Tura, Wind T MW (4 bMWY at 15 mfs) & Electroliz. El-200W of 20 MW ¢ Bat. Inverter of 12.5 MWA
Unmet load = 0 % // Total Net Present Value (NPV) = 284.217 ME, IRR = 24.6%.

STRATEGY: There is no load consumption -» no control strategy related to the load consumption supphy. P. lim. charge: 15 MW. S0OC min.: 10 %. ARB.: Control varishles
for green hydrogen: Generate H2 with elyzer. at full power all the time, buying E. ta the AC grid if necessary: Battery supplies power to elyzer. if price E. is higherthan 0.1
£/kvh; charge battery if price of E. is lower than 0.03 £{kvh

Now the optimal system (first row of the results table) includes batteries. It is composed of 18
wind turbines of 4 MW (total 68 MW), electrolyzer of 20 MW, 10 batteries of 5 MWh (total 50
MWh) and inverter/charger of 12.5 MVA (for 4 h battery duration). NPV is higher than in the
previous study.

If we click in SIMULATE in the first row (optimal system), we can see, with 1 day display, for
example for January 19" (move the displacement bar):

Hourly simulation  Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Waterload /FPHS  MULTIPERIOD

Electricity price (€/kWh) ¥ — Purchase
0.3 v — Sell _ _
v — Low limit disch
02 I High limit char.
01
S — —
0 1 2 3 4 5 6 7 (] 9 10 1 13 14 15 16 17 18 19 20 21 22 23 0

1 12
19 January

= Simulation of 1 year, all the years the same. =

R ]

£ = Total Load

2 . 100,000 > Unmet Load

< ]

= 501 50,000 E = Disch. Batt

= z = Charge Batt
£ 404 50000 = — Wind T

= 50 H = Electrolyzer
= 40,000 : Buy E from grid
E 20 ES — H2 tank (HHV)
E 10 20,000 E Sell E to grid
£ [ . E —80C

E 0 1 2 3 4 5 6 T 8 9 10 11 2 13 4 15 16 17 18 19 20 21 22 23 0 g

1
19 January

<
POWER CONSUMED OR SUPPLIED (M) B i
Batter bank Discharge [ Piim Charge
BATTERYEN
O O O " soc
m [] E. mex disch. batt P1 S0C limi
v imits
E HE Battery bank Charge P critical Gen_ c M Soall
xport Energy ap. Max
(] E.ta supply FC P critical Fuel Cell change
wind Turb S0C setpoint Gen. (days)
ind Turb.
[r S0C setpoint FC Smal
— E boughtto AC grid [¢] Pmax
alerFume AC Generator E sald to AC gril [7] Pax N — e B Large:
[ Pmax. input Inverter [ Prosx Gen setpaint (1 4] 0-1) ull charge
Simulation step (min): [60 3 Back Save data: Sawve Simulation Data Sawve Prob, Data

COMPONENTS: Wind turbines of 72 M. Electralyzer of 20 MvW.Battery bank of 50 Miwh. Bat. Inverter of 12.5 kA,

STRATEGY: There is no lnad consumption - na control strategy related to the load cansumption supply. P. lim. charge: 15 M. SOCmin: 10 %. Arbitrage: Cantrol variables for green hydragen’ Generate
H2 with elyzer. at full power all the time, buying E. to the AC grid if necessary; Battery supplies power to elyzer. if price E. is higher than 0.1 £/k\vh; charge battery if price of E. is lower than 0.03 €/kih

This day, at 3h we can see the battery is charged and at 19h it is discharged. It is due to the
control strategy (for each time step, in this case, hours, we see a point for each variable, that
point is the value of the variable for the whole time step). As both the hydrogen cumulated (in
HHV) and the battery SOC are shown in the right axis, and they are very different in this case, to
see the SOC we must unselect the energy in H2 tank: unselect “E.H2 tank (HHV H2)". Also, to
see the electricity price over the simulation graph, click in “See over” and “Legend” to see its
legend. We can also see the grid of the graphs with “H.L.Gr.” and “V.Grid” checkboxes.
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We can see that at 3 h (January 19") the purchase electricity price (upper curve, red) becomes
lower than the “High limit charge” which is 0.03 €/kWh (light blue line), then the battery must
be charged. Wind turbines generation is roughly 25 MW, while electrolyzer AC consumption
(including rectifier is 22.2 MW), therefore roughly 2.8 MW are for battery charge in AC. The
battery must be charged at its maximum rate (2.5 kA - 1 kV - 10 batteries = 25 MW) but also
there is the limitation of the inverter/charger, which is 12.5 MW, therefore the battery is
charged at 12.5 MW DC (brown curve). As there are 2.8 MW AC surplus from the wind farm, we
need from the grid (considering the rectifier efficiency of the inverter/charger of 98%) 12.5/0.98-
2.8, roughly 9.8 MW.

Next hour battery must also be charged, but it cannot charge at 12.5 MW because only few MW
are allowed as the maximum SOC is near to be reached (we can see the red curve, SOC, referred
to right axis). If we uncheck the “E.H2 tank (HHV H2)” checkbox, in red we can see the SOC.

Simulation of 1 year, all the years the same.

Total Load
Unmet Load

= Disch. Batt.

== Charge Batt

= Wind T

=+ Electrolyzer
Buy E from grid
Sell E to grid

= 50C

Soehaashaa
BATTERY /H2 Tank ENERGY (MV¥h)

G N W da B

POWER (M) AWATER tank (MWh)

13 1415 16 718 19 20 21 22 23 0

~

> El Days disp.

At 19 h (January 19%") purchase price is higher than the “Low limit discharge” which is 0.1 €/MWh
(upper graph, turquoise line). As the wind farm only generates roughly 12.5 MW, it cannot
supply the whole 22.2 MW AC power needed by the electrolyzer: the rest (22.2-12.5 = 9.7 MW
AC) must be supplied by the battery. But the blue curve is the discharge of the battery in the DC
bus, in AC is this value multiplied by the inverter efficiency. Inverter efficiency for 9.7 MW (that
is, 85% of the rated power of the inverter) is about 84%, therefore 9.7/0.84 = 11.5 MW must be
supplied by the battery in DC (blue curve). Zoom in the graph:

Simulation of 1 year, all the years the same.

POWER (M) /WATER tank (MWh)

19 January

In the tab of the hourly values separately we can see the charge and discharge of the battery,
and also the energy in battery bank (SOC in MWh) for the whole year.
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Hourly simulation

Hourly values separately  hanthly and Annusl Average Pawer

Monthly Energy  Annual Energy Hydrogen  AC Generator Water load / PHS  MULTIPERIOD

HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
60
0 0 40
20
0
0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator Export
40
20 )
0 0 0
-20
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8.000 0 2.000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
100,000
0 2 50,000
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Battery bank Charge Battery bank Discharge Energy in Battery bank
15 ]
10
10 a0
5 5 20
0 0 0
0 2,000 4,000 6.000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Unmet load (by the standalone system) Purchased from AC grid Sold to AC grid
0
0 2,000 4,000 6,000 8,000

We return to the main window of the software.

Now let’s see the results when we optimize minimizing the LCOH.

Go to Project -> OPTIONS.

Select Min. LCOH.

MAIN OPTIONS:

Simulation and opfimization

Economic optimization

(@) Simulation ofthe 1styear and extrapolate results

(O Multipetiod: simulate all the years of the system lifstime ( wyears)

(O Minirnize Net Present Cost (NPC), usually for oft-gric systers and high load an-grid

(@) Maxirnize Met PresentYalue (NP, usually for low load or no-oad on-grid systems

[]Define WWind Farm with 16 power curves, one for each wind direction sector
[0 renewahle includs own charger and controlisr

[Jwhen saving the project, update all the results of the tsble to the present conditions
MNumber of decimal places in results of costs 3

Number of decimal places in results of energy

> in. NPC
Min. LCOH

O Max. NPV
= .

3

OK

Optimize again. The optimal system is the same (in other cases it can be different). Now, the
column at the left of SIMULATE cell shows the LCOH instead of the LCOE. We can see that the

optimal system has a LCOH of 3.938 €/kg.
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# Total NPV (ME£) Ermission (kiCOZAM  UnmetGWhiAr)  IRR(%)  Landtha)  Investrnent(ME)  Cap F(3 COH(E/kgH2) Sinlate Report A

1 284217 26.79 0 2459 12965 122813 3 39379 LATE.. REPOR

2 284.191 27.76 0 25.25 12245 117.813 31.03 9385 SIMULATE.. REPOR

3 283.712 20.83 0 25.93 11525 112813 31.79 3.9467 SIMULATE.. REPOR

4 283.648 25.92 0 2395 13685 127.813 29.58 3.95 SIMULATE.. REPOR

5 283.541 26.77 0 2458 1296.45 122531 303 3.9523 SIMULATE.. REPOR

i 283.477 27.74 0 2h24 122445 117531 31.04 3.9537 SIMULATE.. REPOR

7 283.012 2591 0 2394 136845 127 531 2959 3.9636 SIMULATE.. REPOR

3 282.973 28.81 0 2593 115245 112531 31.79 3.9644 SIMULATE.. REPOR

3 282.848 26.75 0 2458 1296.4 122.25 30.31 3.9671 SIMULATE.. REPOR v

< >

COMPONENTS: Batteries BatbhMWh- (5 kah): 15.x10p. 4 18 Wind Turl. Wind TAMW (4 bW &t 15 m/s) /f Electroliz. El-20KWY of 20 kv ff Bat. Inverter of 12.5 MVA Jf
Unmetload = 0% /f LCOH = 3.938 £/kgH2. IRR = 24.6%
STRATEGY: Thera is no load consumption -> no control strategy related to the load consumption supply. P lim. charge: 15 bW, S0C min.: 10 2. ARB.: Control varighles
for green hydrogen: Generate HZ with elveer. at full power all the time, buying E. to the AC grid if necessary; Battery supplies power to elyzer. if price E. is higher than 0.1
£/kwh: charge battery if price of E. is lower than 0.03 £/h

If we go to the LOAD / AC GRID window, then tab PURCHASE /SELL E., and we change the
hydrogen price to 3.9379 €/kg:

V| Load and options of Selling / Purchasing Energy from the AC grid - O X
IDsfta BemEs Hours | |AC | 1DC [ [H2 [ |water
Minutes- h i 1
O Manthly Average @ Load Profile. (O Import File (M, tH2/h. dam3fh) 1~ inatoo s porrow o [imReR Export

AC LOAD (MW) DC LOAD (Mw) H2 LOAD (tH2/h) WATER (dam3/day) FROM WATER TANK ~ PURCHASE/ SELL E

Purchase from AC grid Unmet Load (Non Served AC GRID AVAILABILITY

Energy by Stand-alone system)

Sell Excess Energy to AC grid
Priority to supply E not coverad by renewakles:
© Storage/Generator OAC Girid

StofGen. priority if PrbuyE >= D

[] Fixed Sell Price (Efkwhy 012

Pr. zell = pr. buy x
Emission (kgCO2/kMdh):
o[ 3
Ermissions data Annual Inflation (/).-

Hiourly Price:
[ Fixed Buy Price gaonmy 018 Cd

Annual Inflation (%)

Hourly Price

Fixed Praos (i) Fixed Cost P £k

Access Charge Price (E/kMWWh

Hourly Yalues

Fixed Access price (E/kwh) II' Hourly FPrice
Back-up Charge Price (£/kvvh)
Fixed Back-up price [£/kWh) D Houtly Price

(w¥ill be added to the E purchased) |:|Add negative gen. charge

Mex Power(v) [30 [ -Praxbuy

Energy Generation Charge (Transfer Charge] Price (£/kiWh:

Fixed Transter price (£/kWh) CI Hourly Frice
[“]zell only

‘ND net mettering \/‘
Cost of net metering sarvice E/kwh) |0
Buy-hack: Export E is paid at (£/kiWh) El

Sell surplus H2 in tank {difference
between the HZ in the tank at the end
of the year and at the beginning)

Price (£/kd

Annual Inflation (%):

Seli-cansumption and MNet Metterin

Total tax for electricity costs (buy + charges) (%) D

Total tax for electricity sold (#2): D

Losses in wire and transformer (%): EI

And now we return to the main screen, and we click in the first row of the results table, the
results of that combination are updated, obtaining a NPV of 0 (as we have set for the price of
hydrogen the LCOH, therefore NPV is 0):

#  Total NPV (M£)
1 0

Emission (kCO24r) UnretGWhiyr)  IRR(%)
26.79 0 7

Landiha)
12965

Inwvestment(hE]  Cap F(2%)
122,813 303

LCOH(£/kgH?) Simulate

Report A

Now we go back to the LOAD / AC GRID window, then tab PURCHASE /SELL E., and we change
the hydrogen price to the original 10 €/kg.

We could optimize the limits for charge/discharge the battery.

We go to the main screen, and select in CONTROL STRATEGIES tab “Optimize strategy of grid-
connected batteries”, “2 variables” and change variables accuracy to 20=100% (more
precision). We have two variables to be optimized for the control, minimum and maximum
purchase electricity price setpoints to charge/discharge the battery. Each variable will have 21
values (from 0 to 100%, as 100% is 20), therefore there will be 21x21=441 combinations of
control strategy for each combination of components. However, as the “PrCh<PrD” checkbox is
checked, it forces the discharge price to be higher than the charge price, so only 231
combinations will be for the control strategy.
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GEMERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

CONTROL STRATEGY AND VARIABLES TO OFTIMIZE

ENERGY ARBITRAGE: System with batteries and grid connected
Global strategy:

@ Load Following D Batt. charged by the AC grid /f discharged if: (also for Elyzer-» HZ) Elyzer. full load
(O Cycle Charging Continue upto S0C stp [CliCompare with Sell price)
() Try Both mlze strateqy of grid-conneted batteries >

O 3variables: X1 tdif), X2(%), X30%4) 0028 | may, |0.3251

Wariables to optimize relative to the global strategy:
Pmin_gen Prmin_FC HoTANKstp @ables price E.min_ and max.__To¥ >|U-DDDB ‘,Max( |U.3515 | £k "- PrCh<PrD

F1_gen P1_F P2

4 - [] Batteries can inject electricity to the AC grid
50Cstn_gen S0Cstp [Js0Cmin [11 day atlow SOC-> charge battery with AC grid B 5 -
Poritical _gen HZTAMNE st [CIPlim_charge CHEIISS eVl

[]+when batteries are off, compensste autodisch.

[]s0Cmax | Fixvarial@Es Yarighles accuracy: |20 =100% >

If S0Cmin reached, disch. not allowed if S0C{%2) < SOCmin(%) +

We can see that the computation time increases dramatically, as each combination of
components will be evaluated 231 times to obtain the optimal strategy for the batteries (unless
we use genetic algorithms).

To reduce the computation time (if we don’t want to wait 20-30 minutes nor use genetic
algorithms), we can fix the min. and max. number of batteries and wind turbines to the optimal
previous result (10 and 17, respectively):

MIN, AND MAX, No COMPONENTS IN PARALLEL:

Bateries in parallel: hin. b,
0 8
Wind T.in parallel: Min Max. [17]

1

And then we will consider a fixed value of 10 batteries (10x5 = 50 MWh) with the inverter charger
for 4 h duration (12.5 MVA), 17 wind turbines of 4 MW and the electrolyzer of 20 MW.

We calculate again:

The optimal system is a bit better than the previous one (a little more NPV, a little less LCOH).
The optimal price limit setpoints are 0.0188 €/kWh and 0.127045 €/kWh (when we previously
set them by hand, we used 0.03 and 0.1, not very different).

¥ Total NPY [ME€) Emizzion (KICOZAT Unmet(GWwhier)  IRR(%)  Land(ha)  Investment(M€) CapF(%) LCOH{€/kgHZ) Simulate Report
1 284.243 278.72 0 25.25 12245 117.813 31.03 3.9373 SIMULATE.. REPORT...

< >

COMPOMNENTS: Batteries BatbhvWhe (5 kah): 15, 100 417 Wind Turk. Wind T4 (4 My at 156 m/fs) f Electraliz. Ek-20MWy of 20 bWy ¢ Bat. Inverter of 12.5 MVA I
Unmetload = 0 % jf LCOH = 3.937 £kgH2, IRF = 25.3%

STRATEGY: There is no load consurption -> no control stratedy related to the load consumption supply. P. lim. charge: 15 MW, S0C min.: 10 %, ARB.: Control variables
for green hydrogen: Generate H2 with ebyzer. at full power all the time. buying E. to the AC grid if necessary: charge battery if E. price is lower than 0.0188 £/k\Wh: Battery
supplies powerto elyzer. if price E. higher than 0127045 £/d4h

The simulation:
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Hourly simulation  Hourly values separately  PDF  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  ACGenerator \Water load /PHS  MULTIPERIOD

Electricity price (€/kWh) ¥ — Purchase
¥ — Low limit disch

03

02 A\

0.1 _//
— —

0 1 2 3 4 5 6 7 8 9 0 1" 12 13 14 15 16 17 18 19 20 21 2 23 0

3 January
= Simulation of 1 year, all the years the same. g
é =2 Total Load
s 100,000 s — Unmet Load
& 4 — Disch. Batt
E 60,000 E == Charge Batt
= = Wind T.
=3 =
E 60.000 = == Electrolyzer
£ 40.000 : Buy E from grid
g £ — H2 tank (HHV)
™ 20,000 z — Sell E to grid
E w = 50C
z o &
a 12 @
3 January
[< 2
POWER CONSUMED OR SUPPLIED (M) SR ‘See Cwver
w7 Batter bank Disch D Plim Charge gend
] Batter bank Discharge oo BATTERY ENERGY (MWh) CIHLGr
O O [] E-to supply by hatt Electrolyzer 50C [IHRGr
E disch. batt P1 . Grid
O [] € maw disch b H2 tank (HHV HZ) [ R SOC limits %A“
[ Expon £ Battery bank Charge Fuel Cell P critical Gen. Cap. Max Seroll
xport Energy - -
O E o supply FC P critical Fuel Cell . change
Unmet Load Wind Turb B mE FE S0C setpoint Gen. (days)
ind Turb. = i
= S0C setpaint FG Srall
W | E bought to AC grid Prax "
ater Pump
AC Generator E sold to AC grid Pz 3
[ Prose input nverter [ Pt Gon g H2 TANK setpaint (HIHY H2) SOC(01)| | T.tull charge Large
Simulation step (min): B0 v Back Save datac Sawve Simulation Data, Save Prob. Data

‘COMPONENTS'Wmd turbines of 68 M. Electrabyzer of 20 MW Battery bank of 50 Mvwh. Bat. Inwverter of 12.5 My,

STRATEGY. There is no lnad consumption -> no control strategy related o the lnad consumption supply. P lim. charge: 15 Mw. SOC min 10 %. Arhitrage: Cantrol variables for green hycrogen: Generate
H2 with elyzer. at full power all the time, buying E. o the AC grid if necessarny; charge hattery if E. price is lower than 0.018835 £/kiWh;: Battery supplies power to elyzer. if price E. higher than 0.127045 £/kWh

For example, January the 3rd, we can see at 18 h purchase price is higher than the limit,
therefore the difference between the rated power of the electrolyzer and the wind turbine
generating power is supplied by the battery.

2" tab:

Hourly simulation  Houwrly values separately  PDF Monthly and Annual Average Power  Maonthly Energy  Annual Energy  Hydrogen  AC Generator ‘Water load / PHS  MULTIFERIOD
HOURLY POWER DURING THE YEAR (MW), ENERGY IN (MWh)

Total Load PV Generator Wind Turbines
60
0 0 40
20
0
0 2,000 4,000 6,000 8.000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Hydro Turbine AC Generator Export
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 2,000 4,000 6,000 8,000
Fuel Cell Electrolyzer Energy (HHV of H2) in H2 tank // accum. Sold
100,000
g 20 50,000
0
0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Battery bank Charge Battery bank Discharge Energy in Battery bank
15
| ||
10 =
5 5
0 0
0 2,000 4,000 6,000 8,000 ] 2,000 4,000 6,000 8,000 0 2,000 4,000 6,000 8,000
Unmet load (by the standalone system) Purchased from AC gnd Sold to AC grid
30
20
0
10
0
0 2,000 4.000 6,000 8.000 0 2,000 4.000 6,000 8,000 0 2,000 4.000 6.000 8,000

3™ tab (before, in Project->Options, check “In the simulation window, show the probability
density function (PDF) of the main results”).

Inthe simulation window, show the probability density function (FOF) of the main results
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Hourly simulation  Hourly values separately  PDF

PROBABILITY DENSITY FUNCTION (PDF) VS. POWER (MW) OR V8. ENERGY (MWh) DURING THE YEAR

Total Load power. PDF

PV generator power. PDF

0
Power. Mean: 0: Std. dewv: DWW
Hydro turbine / TEG power. PDF

0
Power Mean: 0: Std. dewv: DMWY
AC generator power. PDF

0
Paower. hean: 0 Std. dev: DWW
Fuel Cell power. PDF

0
Power hean: 0 Std. dev: DMWY
Electrolyzer power. PDF

0
Power. Mean: 0; Std. dev: OMW
Battery bank Charge power. PDF

15
1
0.5
0

0 2 4 6 8 10
Power. Mean: 0.673; Sid. dev. 2 B98MyY
Unmet load (by the standalone syst.) power. PDF

0
Power. Mean: 0; Std, dev: (MW

20
Power. Mean: 20; Stel. den: Oy
Battery bank Discharge power. PDF

Manthly and Annual Average Power  Monthly Energy  AnnualEnergy  Hydrogen  AC Generator Water load /PHS  MULTIFERIOD

MNumber of columns

[] Show PDF first col. [] Show PDF last col
Wind turbines power. PDF

0.04
0.02
0

0 10 20 30 40 50 60
Power. Mean: 23 B08; Std. den: 18 837w
Export power. PDF

0 10 20 30 40
Power Mean: 1.233; Std. dewv: 19104k
Energy in H2 tank // accum. Sold. PDF

IR

0 50,000 100,000
Energy. Mean: 58385 383; Std. dew: 33718 246MWWh
Energy in Battery bank. PDF

0 5 10
Power. Mean: 0.623; Bid. dev. 2.833MwW
Purchased from AC grid power. PDF

0 5 10 15 20 25
Power. Mean: 7.267; Std, dew. §.596MwW

03
02

01

om —L

10 20 30 40

Energy. Mean: 42.245; Std. dev: 14.545MWh
Sold to AC grid power. PDF

4

3

2

1

0 |
0

cooo

5 10 15 20 25
Power, Mean: 7.77; Std. dev: 11.047MW

We see the PDF of the different results, for example, we can see that the most of the time of
the year the battery is at high SOC (last column is the highest, and the mean is 42.245 MWh

(nominal battery capacity is 50 MWh).

Variant:

Let’s see what happens if we don’t want the electrolyzer to be at full load all the time, we want
that electrolyzer runs only when electricity price is low. Also, batteries are charged only when
electricity price is low (as previously), but they are discharged when electricity price is high to
inject electricity to the grid (not to supply the electrolyzer as previously).

Therefore:

e Low electricity price: energy from the wind farm is used to feed the electrolyzer and
chage the battery. If not enough, buy to the grid.
e Medium electricity price: Sell all the electricity from the wind farm to the grid.

e High electricity price: Sell all the electricity from the wind farm to the grid and discharge
the battery to inject (sell) to the grid.

We get this control strategy just unchecking “Elyzer. full load” checkbox from the CONTROL

STRATEGIES tab:
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GENERAL DATA OPTIMIZATION CONTROL STRATEGIES FINANCIAL DATA RESULTS CHART

CONTROL STRATEGY AND

Global strategy:
(@ Load Following

WARIABLES TO OPTIMIZE

() Cycle Charging Cantinug up ta S0C stp

(O Try Both

VYariables to optimize re

lative to the global strategy:

Prain_gen Prain_FC HZTAMNKSstp
F1_gen F1_FC Pz
S0Cstp_gen S0Cstp_FC []=0Cmin
Feritical_gen HZTANKstp [JPlim_charge

[]s0Cmax | Fixwariables

“ariables accuracy: =100%

ENERGY ARBITRAGE: System with batteries and grid connected

[]Batt charged by the AC arid /f discharged it [~ (also for Elyeer-> HET || Elyzer full load

[iCarmpare with Sell price)

Optimize strategy of grid-conneted batteries:
O 3 variables: X1 (dif), X2 (%), %3(%) 0023 | max 03251

(@ 2 variahles: price E. min. and max,  Min> 10008 1o pdaee (D3615 | £Ah PrChePtD

Batteries can inject electricity to the AC grid
11 day at low SOC -» charge battery with AC grid

Batteries availahility
[ivhen batteries are off compensate autodisch

If SQCmin reached. disch. notallowed if S0C(%) < SOCmin(¥:) + EI

Now, if we click in the results table, the results are updated to the new control strategy:

LCOH(£/kgH2) Simulate Report
2.5927 SIMULATE.. REPORT...

Investment{ME] Cap.F(24)
117.813 30.78

UnrmetGivhir)
0

IRA(%)
18.04

Land(ha)
122458

#  Total NPV (ME)

161.194

Ernigsion (kKICOZAr)
11.18

1
NPV has been dramatically reduced, as now we will generate much less hydrogen, and hydrogen
is valued at a high price (10 €/kg first year). LCOH is now 2.35 €/kg.

In the simulation, we can see, fir the first day, when electricity purchase price is lower than
0.0188 €/kg (it was the result of the previous optimization), electrolyzer runs at max. power (20
MW DC, 22.2 AC) and the rest is injected to the grid, batteries are fully charged because they
are at 100% SOC the first day. The rest of the hours, we inject to the grid the maximum power
allowed, 30 MW, and the rest is used to feed the electrolyzer (but if the rest power is lower than
the minimum electrolyzer power, it does not work). When electricity purchase price is higher
than 0.127 €/kg (it was the result of the previous optimization), the battery should inject to the
grid, but in this day, at 21 h, it is not done, because just with the wind farm the power is higher
than the maximum that can be injected to the grid (30 MW):

Hourly simulation  Hourly velues separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator Walerload / PHS  MULTIPERIOD

Electricity price (€/kWh) ¥ — Purchase
¥ — Low limit disch
v High limit char.

9 10 1 12 13 14 15 2 3

1 January

Simulation of 1 year, all the years the same.

Total Load
Unmet Load

= Disch. Batt

== Charge Batt

= Wind T.

=+ Electrolyzer
Buy E from grid

— H2 tank (HHV)
Sell E to grid

= S0C

50,000

40,000

30,000

20,000

10,000

BATTERY /HZ Tank ENERGY (MWh)

POWER (MW) /WATER tank (MWh)

1 January

~

> D Days disp.

POWER COMSUMED OR SUPPLIED (M) Ener oo [“15ee Over
Batter bank Discharge [ Piim charge R [Legend
P2 BATTERY ENERGY (M) [JHLGr
O O ] Electrolyzer soc CHRG
0 [ E. e disch. bat E H2tank (HHY H2) [F]R P1 SOC it [Jv.rid
% imits Alt
] Export E Battery bank Charge P critical Gen. Can. M Sng"
xport Energy ap. Max
1 Eiosupply FC P critical Fuel Cell change
N S0C setpoint Gen. (days):
Or Wind Turb Sl
P, E houghtto AC grid [¢] Prax S0C setpoint FC
. AC Generator E sold o AC grid [v] Pmax . Large
[ Pmax input Inverter [] Pmax gGen H2 TANK setpoint (HHY H2) S0C (0-1) T.full charge

If we see the days January 3™ and 4™ (next figure, 2 days display), we can see in the evening of
January 3™ battery discharges injecting power to the grid, and later it is charged by the wind
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farm power because the maximum grid power (30 MW) is reached, therefore the rest power is
used to charge the battery. We can see when electricity price is lower than the high limit charge,
electrolyzer runs at full power and battery is charged at maximum power (or until reach max.
SOC).

Hourly simulation Hourly values separately  Monthly and Annual Average Power  Monthly Energy  Annual Energy  Hydrogen  AC Generator ‘Waterload /PHS  MULTIPERIOD
Electricity price (€/kWh)

¥ — Purchase
IV — Low limit disch

03
v High limit char.
” = A [\
= ———— — ==
in 41
3 January - 4 January
= Simulation of 1 year, all the years the same. §
é £ Total Load
= 5 Unmet Load
= &= = Disch. Batt
ﬁ g == Charge Batt
g o — Wind T.
z 5 == Electrolyzer
= : Buy E from grid
s < Sell E to grid
E z = 80C
g E
g 3
3 January - 4 January
< > Days disp.
POWER CONSUMED OR SUPPLIED (MW) i FHE [ 5ee Over
Batter bank Discharge 1 Plim Charge []Legend
p2 BATTERY ENERGY (Mwh) [AHLGr
O O ] Electrolyzer soc [CIHRGr
¥
0 [ E. mece disch. bat [JE H2tank (HHY HD) (AR Pl o it [vrid
v imits Al
[] ExportE Battery bank Charge P critical Gen. - SDC’D”
xport Energy ap. Max.
1 E.to supply FG P critical Fuel Call change
S0C setpaint Gen. (days)
Or ] Wind Turb. i
VTR E boughtta AC grid 2] Praax SOC setpoint FC
S AC Generator E sold o AC grid [] Prisx Lamge

[ Pmax. input Inverter [] P max Gen.

Simulafion step (min): 60

[ Back

COMPOMNEMNTS: Wind turbines of 63 M. Electrolyzer of 20 M. Battery bank of 50 Mvh. Bat. Inverter of 12.5 MVA,

Save dala

H2 TANK setpoint (HHY HE) S0C(0-1) T.full charge

Sawve Simulation Data

Save Prob. Data

STRATEGY: There is no load consumption -> no contral strategy related to the load consumption supply. P. lim. charge: 15 M. S0C min.: 10 %. Arbitrage: Control variables for grid-connected H2 and
hatteries: charge (buying E. ta the AC grid) if price of E. is lower than 0.018835 £/kWh: disch. (load + injecting to the grid) if price E. higher than 0127045 £/kYWh

We can optimize the system with the new strategy (optimize size and control strategy setpoints).
Go to the main screen, GENERAL DATA tab, change the min. and max. wind turbines to 10 — 20
and batteries in parallel to 0-10 as previously:

GENERAL DATA  OPTIMIZATION CONTROLSTRATEGIES FINANCIAL DATA RESULTS CHART
COMPONENTS
[PV Gen.

Wind Turbines

Parameters

[ Hydro T.
e Genetic Algorithms

Battery bank

We can see the maximum execution time is 15 minutes (default, we don’t change it).

When we pass the mouse over this area, we see the expected optimization time (it depends on

the computer speed):
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NUMBER OF CASES AND TIME EXPECTED

Computation speed: 23.256 cases/second

EVAL ALL POP. (% ALL) GEMN.ALG. (% ALLY
MAIN ALG. (COMB. COMPONENTS); 121 10 (B.26%) 139(114,89%)
{1121y
SEC. ALG. (COMB, STRATEGIES): 441 11 (2.49%) 166 (38.1%)

MAINALG,  SEC ALG. NUMEER OF CASES % TIME EXPECTED
OPTIONT: EVAL ALL EvALALL. 53361 100%  Oh3g' 14
OPTION 2 EVAL ALL  GEN. ALG. 20328 36.1%  Dh14'34"
OPTION 3 GEN.ALG. EVAL ALL. 61299 1149%  Oh43'55"
OPTION 4 GEMN.ALG. GEM.ALG. 23352 438%  Oh1g'44"

Outirnization of the Confrol Strategy by means of Genetic Algarithms.
tis not guaranteed to obtain the optimal Control Stratedy, but this is probable to obtain the optimal or a solution
near the optimal

In our case, it can simulate 23.2 combinations per second, so it would need 38 minutes (OPTION
1) to evaluate all the combinations. However, in order not to use more than 15 minutes, it will
use genetic algorithms for the optimization of the control strategy (OPTION 2, in red). If we click
in CALCULATE, we must wait around 15 minutes to finish.

The optimal system found has an LCOH lower than before (we are minimizing LCOH), although
NPV is lower than before:

# Total NPY (ME) Ernission (kCO24)  Unmet(Gwhiy]  IRR(3%)  Land(the)  Investrment(ME) Cap F(3) LCOH(€/kgH2) Simulate Report A
1 13016 1503 0 1883 7925 87813 3628 L | SIMULATE . REPOR
4 136.701 14.45 0 18.77 G645 92.813 3543 SIMULATE.. REPOR
3 129.102 14.9 0 18.78 79245 87531 36.19 1.9638 SIMULATE.. REPOR
4 122.647 15.14 0 18.89 7204 B2.25 36.92 2.0274 SIMULATE.. REPOR
5 161.739 1517 0 20.05 9365 87.813 3453 2.0373 SIMULATE.. REPOR
& 142.278 17.05 0 2052 72045 B2.531 37.06 2.0547 SIMULATE.. REPOR
7 121.55 15.01 0 15.83 72035 81.969 36.64 2.0898 SIMULATE.. REPOR
i} 127.132 14.21 0 18.68 79235 06.969 35.84 2.0924 SIMULATE.. REPOR
a 167 691 146 0 199 10085 102.813 3378 2.0993 SIMULATE.. REPOR v
< >
COMPONENTS: Batteries Batbhwh- (5 kah): Ts.x 10p. # 11 Wind Turb. *Wind T4 (4 v at 15 mfs) // Electraliz. El-20MW of 20 MW /) Bat. Inverter of 12.5 My i
Unmetload = 0 % /f LOOH = 1.908 £/kgHz2. IRF = 18.8%
STRATEGY: There is no load consumption -» no contral strategy related to the load consumption supply. P. lim. charge: 15 MW, 30C min.: 10 2. ARB.: Caonfrol variahles
for grickconnected HZ and batteries: charge (buying E. to the AC grid) if price of E. is lower than 0.0188 £/4XWh; disch. (load + injecting to the grid) if price E. higher than
0109 £/kivh

We could optimize again, maximizing NPV.
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